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General 

Fundamentals 

Starting LEICA Zeno Office 

About starting LEICA Zeno Office 

As any other program LEICA Zeno Office can be accessed from the Start button on the Windows 
taskbar. LEICA Zeno Office can only be started once, therefore you can't work with more then 
one map at the same time. 

Starting LEICA Zeno Office for the first time, you can choose to have the splash screen and 
Startup dialog box turned on or off. 

How to start LEICA Zeno Office 

Starting LEICA Zeno Officefrom the Start menu 

1. Click on Start  on the Windows taskbar. 
2. Then point to Programs and to LEICA Zeno Office. 
3. Click LEICA Zeno Office to launch it. 

Turning on the splash screen 

1. In the Tools menu, click Options. 
2. On the General tab check Show splash screen. 
3. Click OK. 

Turning on the Startup dialog box 

1. In the Tools menu, click Options. 
2. On the General tab check Show startup dialog. 
3. Click OK. 
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Starting and stopping an edit session 

About starting and stopping an edit session  

To be able to edit any of the features on the map you have to start an edit session. As soon as 
you perform an editing task the edits will be displayed on the map. But you have to save them 
to the database separately. 

 

Choosing which data to start editing 

Editing is just possible on feature classes from one database or on shapefiles from one folder at 
a time. Otherwise, you will be asked to choose a database or folder to start editing from. 

 

Editing feature classes with z-values 

Feature classes containing z-values cannot be edited. Therefore, LEICA Zeno Office will notify 
you if the data to edit includes layers having features with z-values. These layers won't be 
shown in the Target Layer dropdown list. 

 

Saving edits 

You should save your edits when stopping the edit session or at any time you want. Otherwise, 
the changes you've made won't be applied to the data when loading the map again.  

 

How to start and stop an edit session 

Starting an edit session 

1. Start LEICA Zeno Office. 
2. Add the Editor toolbar. 
3. Choose the collection of data to edit, if editable data from more than one database or 

folder is comprised within your map. Otherwise, skip to step 4. 
4. In the Editor menu, click Start Editing to activate the Editor toolbar.  

Tips 

• If the collection of data selected to edit is defined at a different 
coordinate system than the data frame in which the data is shown, a 
message box appears to notify you. Regardless, it is possible to edit data 
defined at a different coordinate system. But some editing tasks may 
return unexpected alignment or accuracy problems. To not get the 
message displayed again, check the "Don't warn me again" box. 

• In the Advanced-tab of the LEICA Zeno Office Options you can check the 
option 'Start an Edit session when a Map Document is opend' to start an 
Edit session automatically. 

Saving your edits in the middle of an edit session 

2 



General 

1. In the Editor menu, click Save Edits. 

All the current edits are saved to the database. 
Optionally, turn on a timed save edits command. Therefore, click Options in the LEICA 
Zeno Office dropdown menu, and then click the Advanced tab. Check the Autosave Saved 
Edits checkbox and select the desired timing. 

Stopping an edit session 

1. In the Editor menu, click Stop Editing. 
2. To save the edits, click Yes. 

Select No to quit without saving. 
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Last Actions 

About last actions 

LEICA Zeno Office logs the user actions to control the work and to provide detailed information 
for support. The last ten actions can be displayed directly, a report containing more entries can 
be generated in the LEICA Zeno Office options dialogue. 

How to get the last actions 

Displaying the last actions 

Click the button Show last ten actions  and a window will appear  
   
Alternatively scroll with the up and down arrows on the last actions bar  
   

 
   

Displaying the logged actions in the Internet Explorer 

Please refer to LEICA Zeno Office Options 
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General 

Formatting tags 

The following formatting elements and tags are supported in LEICA Zeno Office: 

Element 
description 

Start 
tag End tag 

Valid 
attributes/values Note Example syntax 

Example 
output 

Font name 
and/or font 
size 

<FNT> </FNT> name = {True type 
font} 
size = {1-}  

Set either 
name or 
size or both 

<FNT name = 
"Arial" size = 
"12">Text</FNT> 

Text 

Color (RGB) <CLR> </CLR> red, green, blue = 
{0-255} 

Missing 
attributes 
assumed = 
0 

<CLR red = 
"255">Text</CLR> 

Text 

Color 
(CMYK) 

<CLR> </CLR> cyan, magenta, 
yellow, black = {0-
100} 

Missing 
attributes 
assumed = 
0 

<CLR magenta = 
"100">Text</CLR> 

Text 

Bold <BOL> </BOL> none   <BOL>Text</BOL> Text 

Italic <ITA> </ITA> none   <ITA>Text</ITA> Text 

Underline <UND> </UND> none   <UND>Text</UND> Text 

All capitals <ACP> </ACP> none   <ACP>Text</ACP> TEXT 

Small 
capitals 

<SCP> </SCP> none   <SCP>Text</SCP> TEXT 

Superscript <SUP> </SUP> none   E = 
mc<SUP>2</SUP> 

E = mc2 

Subscript <SUB> </SUB> none   H<SUB>2</SUB>O H2O 

Character 
spacing 

<CHR> </CHR> spacing = {1-} Expressed 
as the 
percentage 
adjustment 
to regular 
character 
spacing. 
0% means 
no 
adjustment. 

<CHR spacing = 
"200">Widely 
spaced text</CHR> 
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Word 
spacing 

<WRD> </WRD> spacing = {1-} Expressed 
as the 
percentage 
of spacing 
between 
words. 
100% 
means 
regular 
spacing. 

<WRD spacing = 
"200">Word 
spacing</WRD> 

  

Line leading <LIN> </LIN> leading = {1-} Expressed 
as the 
adjustment 
to regular 
line spacing 
(in points). 
0 points 
means no 
adjustment. 

<LIN leading = 
"25">Text with a 
leading value of 25 
points</LIN> 
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General 

Contacting Technical Support and Training Services 

You can contact Leica Geosystems Technical Support Center for technical assistance by 
telephone, fax, or e-mail during our normal business hours, Monday through Friday, excluding 
Leica Geosystems holidays. 

Before you call Technical Support 

Before you call Leica Geosystems for technical support, you should be at your computer running 
your LEICA Zeno Office software. Be prepared to give the following information: 

 

• Your Leica Geosystems customer number 
• The software application and version that you are using 
• The type of hardware you are using including connected hardware, such as TPS and 

GPS sensors 
• The operating system you are using 
• The exact wording of any messages that appeared on your screen 
• What happened and what you were doing when the problem occurred 
• How you tried to solve the problem 
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Definition of units 

Setting distance units 

Setting distance units is necessary when loading data recorded in different units than the 
coordinate system of your data. Keep in mind, if using the COGO and TPS tools the specified 
changes won't be considered. Thus, you should set the direction measuring units on the 
SurveyMeasurement Formats tab of the Options dialog box accessed from the Tools menu. 

For instance, the units of the measurements to be loaded are in International Feet (1 Foot = 
0.3048 m), whereas the data is defined at a State Plane coordinate system and its linear units 
are U.S. Survey Feet (1 Foot_US = 0.3048006096 m). Writing the abbreviation for International 
Foot, “ft”, after the measurements will convert the units automatically. 

Each time you're setting a distance within an editing tool, the linear units can be specified. If 
you don't define any specific distance units the dataset's coordinate system units will be used. 

There are several distance units provided by LEICA Zeno Office: 

Metric units 

Distance 
units 

Abbre- 
viation 

Meters 
per 
unit Description 

Kilometer km 1,000 1,000 meters exactly 

Meter m 1 International meter 

Millimeter mm 0.001 1/1000 meter exactly 

Imperial or international units 

Distance 
units 

Abbre- 
viation 

Meters 
per unit Description 

Foot ft 0.3048 Standard foot used in the US. Also known as 
international foot or imperial foot used before the metric 
system. 

Mile mi 1609.344 Also referred to as a statute mile, equal to 5280 
international feet. 

Nautical 
mile 

nm 1852 This unit of distance is primarily used in sea and in 
aviation. It is defined to be the average distance on the 
earth's surface represented by one minute of latitude. 
The nautical mile was defined to be exactly 1852 meters 
or 6076.11549 feet, also known as the international 
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nautical mile. 

Chain ch 20.1168 66 international feet 

Yard yd 0.9144 3 international feet 

Rod rd 5.0292 1/4 chain or 16.5 international feet 

Link lk 0.201168 1/100 international chain or 66/100 international feet 

Inch in 0.0254 1/12 of an international feet 

U.S. survey units 

Distance 
units 

Abbre- 
viation Meters per unit Description 

Survey 
foot 

ftUS 0.3048006096 The State Plane Coordinate Systems uses the US 
survey foot. To exactly convert to meters multiply 
US survey feet by the fraction 1200/3937. 

Survey 
mile 

miUS 1609.3472186944 5280 survey feet 

Survey 
chain 

chUS 20.1168402337 66 survey feet 

Survey 
rod 

rdUS 5.0292100584 1/4 survey chain 

Survey 
link 

lkUS 0.2011684023 1/100 survey chain 

Survey 
yard 

ydUS 0.9144018288 3 survey feet 
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Setting the number of decimal places displayed for 
measurements 

About setting the number of decimal places displayed  

It is possible to modify the default number of decimal places measurements are displayed with. 
Then all the measurements will be reported by using the specified number instead of four 
decimal places.   

Keep in mind, if using the COGO and TPS tools the specified changes won't be considered. Thus, 
you should set the number of decimal places on the SurveyMeasurement Formats tab of the 
Options dialog box accessed from the Tools menu. 

 

How to set the number of decimal places displayed 

1. In the Editor menu, click Options. 
2. On the General tab, type the desired number of decimal places. 
3. Click OK. 
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Setting direction measuring systems and units 

About direction measuring systems and units 

Setting direction measuring systems and units used for editing angles, directions, or deflections 
can be done on the Units tab of the Editing Options dialog box. 

Keep in mind, if using the COGO and TPS tools the specified changes won't be considered. Thus, 
you should set the direction measuring systems and units on the SurveyMeasurement Formats 
tab of the Options dialog box accessed from the Tools menu. 

Once you've set the direction measuring system and units as desired, any input data will be 
recognized in the specific system and units by each editing tool. 

 

Direction measuring systems 

The direction measuring systems supported by LEICA Zeno Office are: North Azimuth, South 
Azimuth, Quadrant Bearing, and Polar. Thereby the Polar system is set as the default angular 
measurement system. 

 

Direction measuring units 

The direction measuring units supported by LEICA Zeno Office are: decimal degrees, 
degrees/minutes/seconds, radians, gradians, and gons. Whereby the decimal degrees are set as 
the default units of angular measure. 

 

How to set direction measuring systems and units 

Setting the direction type 

1. In the Editor menu of the Editor toolbar, click Options. 
2. On the Units tab, click the Direction Type dropdown list and select a direction measuring 

system. 
3. Click OK. 

Setting the direction units 

1. In the Editor menu of the Editor toolbar, click Options. 
2. On the Units tab, click the Direction Units dropdown list and select the desired type of 

direction measurement unit.  
3. A number of decimal places is used when displaying angles and directions. To specify this 

number set a precision.  
4. Click OK. 
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Using scalar references and defining measurement units 

About using scalar references and defining measurement 
units  

Scalar references are used to define units for measurements based on a common standard. 

The base units are: 

• Radian for angle 
• International meter for distance 
• Degrees Celsius for temperature 
• Millibar for pressure 

Customizing unit display 

You can create your own scalar reference and display format for this unit. With this 
measurement old and only locally known measurement units can be created - e.g. the old 
german length unit: Elle. 

How to use scalar references and define measurement 
units 

Adding the scalar references to the Catalog entries 

1. Click the Tools menu and click Options. 
2. Click the General tab. 
3. Check Scalar References. 
4. Click OK. 

The scalar references node appears in Data Manager. 

Creating a new scalar reference to define south azimuth 

1. In Data Manager, right-click Scalar References, point to New, and click Scalar Reference. 
2. Type a unit name for the new scalar reference. 
3. Click the Base Unit Type dropdown arrow and click Angle. 
4. Type the number of radians for each base unit.  
5. Type a value for the zero offset.  
6. Click OK. 

Creating a new scalar reference to define Fahrenheit 

1. Right-click Scalar References, point to New, and click Scalar Reference. 
2. Type a unit name for the new scalar reference. 
3. Click the Type dropdown arrow and click Temperature. 
4. Type the number of degrees celsius for each base unit.  
5. Type a value for the zero offset. 
6. Click OK. 

Changing display units 

1. Click the Tools menu and click Options. 
2. Click the Survey Measurement Formats tab. 
3. Click the Defined Formats dropdown arrow; click the type of unit for which you want to set 

the display settings. 
4. Click the display unit that you want to use. 
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5. Type the number of decimal places to be used for displaying the units. 
6. Click Set As Display Format. 
7. Click OK. 

Creating a custom display for south azimuth directions using degrees 
and minutes 

1. Click the Tools menu and click Options. 
2. Click the Survey Measurement Formats tab. 
3. Click the Defined Formats dropdown arrow and click the type of unit for which you want to 

customize the display settings. 
4. Click the display unit on which you want to base the new format. 
5. Check Advanced. 
6. Click the New button. 
7. Click the Based on Scalar Reference dropdown arrow, and click the scalar reference on 

which you want to base the display format.  
8. Type a name for the display format. 
9. Double-click the Abbreviation field and type new abbreviations for the subfields.  
10. Delete unwanted subfields by clicking the leftmost column of the subfields section and 

pressing Delete. 
11. Click Set As Display Format. 
12. Click OK. 

Saving custom units of measurement 

1. Follow the steps in the previous task to create a custom display unit. 
2. Click Save. 
3. Navigate to the location in which you want to save the unit of measurement file. 
4. Type a name for the file. 
5. Click Save. 
6. Click OK on the Options dialog box. 
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User Interface and Toolbars 

Basic user interface elements 

The Basic user interface elements - a Main menu and Standard toolbars - will be shown 
automatically as soon as you start LEICA Zeno Office. While the Main menu toolbar just consists 
of menus, the Standard toolbars - such as GPS, TPS, LEICA Zeno Office - provide useful tools to 
work with. You can place a toolbar wherever you want to. If you press the Ctrl key while 
dragging the toolbar the docking will be disabled. Otherwise the toolbar will be docked at the 
top or bottom or to the left or right side of the application window and thereby moved and 
resized with the window. 

Types of commands 

There's a variety of types of commands to work with: 

• The arrangement of commands into a list is done by Menus. A context menu will be 
available as soon as you right-click any object - features, layers, the map and so on.  

• As soon as you click Buttons and menu items a script is run. 
• To perform a specific task select a Tool. But before a script will be run the interaction 

with the display has to be enabled.  
• Selecting options from a dropdown list is provided by Combo boxes.  
• To type in text, for instance the scale at which to view the map, text boxes and edit 

boxes are available. 
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The Zeno Office window 

The LEICA Zeno Office window including explanations of the table of contents, data frames, and 
other elements and concepts: 

• The Table of Contents lists all the layers in the map and shows what all the features 
represent 

• The active data frame is highlighted with bold text ('Layers') 
• A layer displays geographic features and defines how they are drawn in a map  
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The Overview window 

   
The overview window allows you to see the full extent of the data. A red box in the window 
represents the extent you are currently viewing.  
   
   



Printed Documentation 

 

The Magnifier window 

By using a magnifier for the display of your data on the map there's no need to change the 
extent of your view since the magnifier window will display the view you set up.   

   

18 



User Interface and Toolbars 

 

Locking customization, documents, and templates 

About locking customization, documents, and templates  

By locking customization, documents, and templates you can avoid changes of others. On the 
Options tab of the Customize dialog box, choose the Lock Customization facilities to store a lock 
within the document you're currently working on. As soon as you open such a document the 
customization functionality will be locked.  

 

How to lock customization, documents, and templates 

Locking customization 

1. In the Tools menu, click Customize. 
2. On the Options tab, click Lock Customization. A dialog box displays. 
3. In the dialog box, enter a password and confirm it. Keep in mind that the password 

requires at least five alphanumeric characters. 
4. In the Lock Customization dialog, click OK. 
5. Click Close. 

Tips 

• As long as the Customize dialog is open, the specified password can be 
modified or removed. Therefore click Unlock Customization on the 
Options tab dialog. 

Unlocking customization 

1. In the Tools menu, click Customize. 
2. In the Unlock Customization dialog, type the password to unlock your selection. 
3. Once you've clicked OK, the Customize dialog opens.  

      Instead of the dialog a message will display, if an incorrect password was entered.  
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Saving your customizations 

About saving your customizations  

Three places are provided to store the customizations you made for the user interface: 

• In the map document open at the present time. 
• In a base template. Such a map template lets you create a new map very quickly. 
• In a Normal template - the default template. Any changes made to the user interface 

will be saved and therefore loaded anytime you're using LEICA Zeno Office. 

To view the currently loaded document and templates open the Save in combo box of the 
Customize dialog box on the Commands tab. In LEICA Zeno Office, use this setting to decide 
where to save the changes you want to make, either in the document, the Normal template, or 
another template. The Normal template is set by default. 

 

Deciding where to save customizations 

Decide to store the changes in the current map document, if you want to display these 
customizations only when working with a specific map. Now, any additional changes will be 
stored in the current document instead of being saved, by default, in the Normal template. 

Whereas storing the changes in the Normal template will always display them as soon as LEICA 
Zeno Office opens.  

 

The Normal template 

Once you've installed the software and you've started LEICA Zeno Office for the first time, a 
default Normal template will be stored in your profiles location. This folder can differ with the 
operating system you're using: 

• Windows XP TabletPC Edition 

C:\WINNT\Profiles\<your username>\Application Data\ESRI\ArcMap\Templates\ 

• Windows 2000 

C:\Documents and Settings\<your username>\Application Data\ESRI\ArcMap\Templates\ 

When saving some changes in your Normal template then they are stored to this file. 

 

How to save your customizations 

Saving your customizations in a template 

1. First, create a new document to customize the user interfaces as you prefer. 

When modifying the user interface, the document name must be selected in the dropdown 
Save in combo box.  
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2. In the File menu, click Save As. 
3. Click the Save as type dropdown arrow to select LEICA Zeno Office Templates (*.mxt). 
4. Navigate to the folder where the template should be stored. 
5. Type a name. Be aware, the name Normal.mxt is reserved for the Normal template. 
6. Click Save. 

Updating customizations in an existing template 

1. In the File menu, click Open. 
2. Click the Files of type dropdown arrow to select LEICA Zeno Office Templates (*.mxt). 
3. Navigate to the folder comprising the desired template. 
4. Select the template and click Open. 

The template gets opened as a document. 

5. Customize the interface. Keep in mind that the template name must be selected in the 
dropdown Save in combo box. 

6. In the File menu, click Save. 

Changing where customization changes are stored by 
default 

1. In the Tools menu, click Customize. 
2. On the Options tab, uncheck Save customizations to Normal template by default. 

Thus customizations will be stored in the current document by default. 

3. Click Close. 
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Hiding and showing toolbars 

About hiding and showing toolbars  

Hiding and showing toolbars is possible from the toolbars list in the View menu or the Customize 
dialog box. Only the Main menu can't be hidden. 

To show a particular toolbar a check mark has to be set right next to the name of the toolbar. 
Then the toolbar appears as a floating toolbar on the desktop or at its previous position, if it was 
already checked before.  

 

How to hide and show toolbars 

Hiding and showing toolbars from the View menu 

1. Click View, and point to Toolbars to view all toolbars available. 
2. Check the toolbar that you want to get displayed. 

Uncheck the toolbar that you want to hide. 

Tips 

• The toolbars list can be accessed from the context menu. Therefore, 
right-click any toolbar or the status bar. 

Toggling toolbars from the Customize dialog box 

1. In the Tools menu, click Customize. 
2. On the Toolbars tab, either check a toolbar to display it, or uncheck a toolbar to hide it. 
3. Click Close. 
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Setting toolbar options 

About setting toolbar options  

Setting toolbar options allows you, for instance, to adjust the size of icons on buttons or to 
define on which toolbars ToolTips will display. See the topic below to get to know how: 

 

How to set toolbar options 

Displaying toolbars with large icons 

1. In the Tools menu, click Customize. 
2. On the Options tab, check Large icons to be displayed. 
3. Click Close. 

Showing ToolTips on toolbars 

1. In the Tools menu, click Customize. 
2. On the Options tab, check Show ToolTips on toolbars. 
3. Click Close. 
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Adding custom commands and toolbars 

About adding custom commands and toolbars  

After having generated your own commands and toolbars, insert these objects to LEICA Zeno 
Office to be able to use them as you would use any built-in object. It is also possible to add 
somebody else's objects comprised within an ActiveX DLL.  

 

How to add custom commands and toolbars 

1. In the Tools menu, click Customize. 
2. Select Add from file. 
3. Navigate to the relevant file including the command. 
4. Select the file and click Open. 

The Added Objects dialog box is shown which lists the new objects that have been 
registered with LEICA Zeno Office. 

5. Click OK. 
6. On the Toolbars tab, check either the custom toolbar which was inserted, or check the 

toolbar to which the custom command should be added. 
7. On the Commands tab, look for the Categories list to click the custom command's category 

in there. 
8. To insert a command, click and drag it from the Commands list and drop it on the toolbar. 
9. Click Close. 
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Creating custom toolbars 

About creating custom toolbars  

In addition to the toolbars provided by LEICA Zeno Office, it is possible to create custom 
toolbars, for instance, to arrange commands according to how you use them or to include 
buttons required to run your custom scripts. 

As you can create custom toolbars, you can also delete or rename them. Only the built-in 
toolbars can neither be deleted nor renamed. 

 

How to create custom toolbars 

Creating a new toolbar 

1. In the Tools menu, click Customize. 
2. On the Toolbars tab, click New. 
3. Type in a name of the toolbar. 
4. Click the dropdown arrow of the Save in combo box to select a template to store the 

toolbar in. 
5. Click OK. 

The toolbar appears in the application as a floating toolbar. 

6. Click Close. 

Renaming a toolbar 

1. In the Tools menu, click Customize. 
2. On the Toolbars tab, click the relevant toolbar. 
3. Click Rename. 
4. Type the new name.  
5. Click OK. 
6. Click Close. 

Deleting a toolbar 

1. In the Tools menu, click Customize. 
2. On the Toolbars tab, click the relevant custom toolbar. 
3. Click Delete to remove the toolbar from the Toolbars list. 
4. Click Close. 
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Creating shortcut keys 

About creating shortcut keys  

Contrary to access a menu using access keys, a command's shortcut key will perform the 
command without open and navigate a menu first. Shortcut keys are well-known when working 
on Windows platform, for instance, use Ctrl+V to paste a copy of an object.  

Whereas many shortcuts can be created for one and the same command, each of the shortcuts 
can just be defined for one command. 

Once shortcut keys are being stored in a document any other shortcut key will be abolished in 
the base templates or the Normal template. 

 

How to create shortcut keys 

Assigning a shortcut key 

1. In the Tools menu, click Customize. 
2. First, click Keyboard and then click the category comprising the relevant command to 

change. 
3. Select the command to which to assign a shortcut. 
4. Click in the shortcut key text box. 
5. Press the keys that should be used for a shortcut. 

If the keys are already assigned to another command, that command's name shows up 
below. 

6. Click the dropdown arrow in the Save in combo box, and select a template in which to 
store the shortcut. 

7. If no other command has the keys assigned to it, click Assign. Otherwise see the Tip 
below. 

The shortcut then gets displayed in the Current Key/s list. 

8. In the Customize Keyboard dialog box and in the Customize dialog box, click Close. 

Tips 

• If another command has already the shortcut key assigned to it, this 
command/key will be abolished as soon as you click the assigned button. 
Thus the new shortcut key will perform your command instead of the 
original one.  

Removing a shortcut key 

1. In the Tools menu, click Customize. 
2. First, click Keyboard and then click the category comprising the relevant command to 

change. 
3. Select the command from which to delete a shortcut. 
4. Click the dropdown arrow in the Save in combo box, and select a template to remove the 

shortcut settings from. 
5. Choose the shortcut in the Current Key/s list and click it. 
6. Click Remove. 
7. In the Customize Keyboard dialog box and in the Customize dialog box, click Close. 
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Resetting built-in shortcut keys 

1. In the Tools menu, click Customize. 
2. Click Keyboard. 
3. Click the dropdown arrow in the Save in combo box, and select a template to reset the 

shortcuts of. 
4. Click Reset All. 
5. Click Yes to reset your shortcuts. 
6. In the Customize Keyboard dialog box and in the Customize dialog box, click Close. 
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Changing a toolbar's or menu's contents 

About changing a toolbar's or menu's contents  

Changing a toolbar's or menu's contents can simply be done by adding, moving, and removing 
commands. In addition, you can gather commands together for a specific task (browsing or 
querying) to visually split them from other tasks. 

It is also possible to undo the changes you made - by purpose or accidentally - to a built-in 
toolbar by returning it to its original contents. 

 

How to change a toolbar's or menu's contents 

Adding a command to a toolbar or menu 

1. Before you can insert a command to a toolbar you have to display the relevant toolbar. 
2. In the Tools menu, click Customize. 
3. On the Commands tab, you'll find the Save in combo box. 
4. There, click the dropdown arrow to select the template in which to store the changes to 

the toolbar. 
5. Click the category comprising the desired command. 
6. Click the command and drag it to any location on the target toolbar. Then drop it. 
7. Repeat steps 5 and 6 to insert additional commands. 
8. In the Customize dialog box, click Close. 

Tip 

• To view the currently loaded document and templates open the Save in 
combo box of the Customize dialog box on the Commands tab. In LEICA 
Zeno Office, use this setting to decide where to save the changes you 
want to make, either in the document, the Normal template, or another 
template. The Normal template is set by default. 

Moving a command 

1. Before moving a command you have to display the toolbar including the command. 
Additionally, if you want to move the command to a different toolbar, you have to display 
this one, too. 

2. In the Tools menu, click Customize. 
3. To position the command, drag and drop it. 

4. In the Customize dialog box, click Close. 

Tip 

• To view the currently loaded document and templates open the Save in 
combo box of the Customize dialog box on the Commands tab. In LEICA 
Zeno Office, use this setting to decide where to save the changes you 
want to make, either in the document, the Normal template, or another 
template. The Normal template is set by default. 
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Removing a command 

1. Before removing a command you have to display the toolbar including the command. 
2. In the Tools menu, click Customize. 
3. Drag the desired tool to remove from the toolbar. 

The mouse pointer appears as a line through a circle. 

4. Drop the command. 
5. In the Customize dialog box, click Close. 

Tips 

• Removing a command from a toolbar, does not permanently delete it. It 
remains in the Commands list in the Customize dialog box, and maybe 
on another toolbar. Therefore, you can again insert that command to the 
same toolbar or another one. 

• To view the currently loaded document and templates open the Save in 
combo box of the Customize dialog box on the Commands tab. In LEICA 
Zeno Office, use this setting to decide where to save the changes you 
want to make, either in the document, the Normal template, or another 
template. The Normal template is set by default. 

Adding a new, empty menu to a toolbar 

1. Before adding a new, empty menu you have to show the destination toolbar. 
2. In the Tools menu, click Customize. 
3. In the Categories list on the Commands tab, click New Menu. 
4. To insert the New Menu, click, drag and drop it on the toolbar. 

It then appears in the toolbar. 

5. To define a caption, right-click New Menu in the toolbar. A text box appears. 
6. Type in an appropriate caption. 
7. Press Enter. 
8. In the Customize dialog box, click Close. 

Tips 

• To access menus and their contents more quickly, hold down the Alt key 
and press the underlined letter (the access key). While creating the 
caption of a command you can also define a new access key by typing an 
ampersand (&) in front of a letter. 

• To view the currently loaded document and templates open the Save in 
combo box of the Customize dialog box on the Commands tab. In LEICA 
Zeno Office, use this setting to decide where to save the changes you 
want to make, either in the document, the Normal template, or another 
template. The Normal template is set by default. 

Adding a command to a context menu 

1. In the Tools menu, click Customize. 
2. On the Toolbars tab, check the Context Menus toolbar. 
3. On the Context Menus toolbar, click Context Menus to view a list of all context menus. 
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4. Click the arrow for the desired context menu to which to add a command. 

The context menu's commands are listed. 

5. On the Commands tab in the Customize dialog box, click the relevant category including 
the command. 

6. To insert the command, click, drag and drop it on the context menu. 
7. In the Customize dialog box, click Close. 

Tip 

• To view the currently loaded document and templates open the Save in 
combo box of the Customize dialog box on the Commands tab. In LEICA 
Zeno Office, use this setting to decide where to save the changes you 
want to make, either in the document, the Normal template, or another 
template. The Normal template is set by default. 

Grouping commands 

1. Before grouping commands together you have to display the toolbar comprising the 
commands. 

2. In the Tools menu, click Customize. 
3. On the toolbar, right-click the command placed to the right of where you want to locate 

the grouping bar. 
4. Check Begin a Group. A grouping bar is displayed in the toolbar. 
5. In the Customize dialog box, click Close. 

Tips 

• The Customize dialog box has still to be opened even if you don't use it 
in an operation like grouping commands. It is required to place the 
application in a state in which modifying the properties of interface 
elements is enabled. 

• To view the currently loaded document and templates open the Save in 
combo box of the Customize dialog box on the Commands tab. In LEICA 
Zeno Office, use this setting to decide where to save the changes you 
want to make, either in the document, the Normal template, or another 
template. The Normal template is set by default. 
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Changing a command's appearance 

About changing a command's appearance  

There's no need to program when you want to change a command's appearance such as the 
display type, caption, or image of a menu, button, or tool. Depending on where a button or tool 
is dropped it will either have the display type Image Only (onto a toolbar) or Image and Text 
(onto a menu). The display type of menus remains as Text Only. In combination with the 
appropriate display types a text is always shown, the so-called caption. 

When changing other command properties, like a ToolTip, programming is required. As soon as 
you point over any command a ToolTip pops up in a floating yellow box. 

 

How to change a command's appearance 

Changing the caption 

1. To modify a caption of a command, you need to display the relevant toolbar including that 
command. 

2. In the Tools menu, click Customize. 
3. Right-click the desired command to modify on the toolbar. 
4. On the context menu, a new caption can be typed in the text box. 
5. Once you've pressed Enter the new caption is applied. 
6. In the Customize dialog box, click Close. 

Tips 

• To access menus and their contents more quickly, hold down the Alt key 
and press the underlined letter (the access key). While changing the 
caption of a command you can also create a new access key by typing an 
ampersand (&) in front of a letter. 

• To view the currently loaded document and templates open the Save in 
combo box of the Customize dialog box on the Commands tab. In LEICA 
Zeno Office, use this setting to decide where to save the changes you 
want to make, either in the document, the Normal template, or another 
template. The Normal template is set by default. 

Changing the image 

1. To modify an image of a command, you need to display the relevant toolbar including that 
command. 

2. In the Tools menu, click Customize. 
3. Right-click the desired command to modify on the toolbar. 
4. Move the mouse pointer to Change Button Image. 
5. Either select one of the images shown. Or click Browse to navigate to a custom image, and 

then click Open. 

The new image displays on the toolbar, if the display type is Image Only or Image and 
Text. 

6. In the Customize dialog box, click Close. 
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Tip 

• To view the currently loaded document and templates open the Save in 
combo box of the Customize dialog box on the Commands tab. In LEICA 
Zeno Office, use this setting to decide where to save the changes you 
want to make, either in the document, the Normal template, or another 
template. The Normal template is set by default. 
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Changing the appearance of the table of contents 

About changing the appearance of the table of contents  

The default settings for the look of the table of contents won't necessarily suit your needs. 
Therefore it's possible to adjust the look. 

You might have already recognized the several tabs of the table of contents: the Display tab, 
the Source tab, the Surveying tab and the Data Manager tab. Each tab represents different 
tasks: i.e. the Display tab displays the drawing order of the layers that you can modify. The 
Source tab arranges layers by where they're stored on disk to simplify editing all layers in a 
given folder or database. The Surveying tab organizes your multiple feature editing. The Data 
Manager tab helps you to manage and organize your data. 

If there's no need to edit your map it is possible to hide the Source tab, since you can't modify 
the drawing order of layers anyway from this tab.  

 

How to change the appearance of the table of contents 

Setting the line and patch for layer symbology 

1. Click Options in the Tools menu on the Standard toolbar. 
2. On the TOC tab click the Line or Area dropdown arrow and select the appropriate shape. 
3. Click OK. 

Showing the Display and Source tabs 

1. Click Options in the Tools menu on the Standard toolbar. 
2. On the TOC tab check the boxes to show the Display, Surveying, Data Manager and 

Source tabs. 
3. Click OK. 
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Zoom to extend  

About zoom to extend  

Zooms the map display to show the current Survey Feature, if Surveying has already started on 
it. 

How to zoom to extend 

Right-click on the name of the feature in the Survey Features tab or on the current feature in 
the map and select 'Zoom to SurveyFeature Extent' 
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Zoom to Surveying Extend 

About Zoom to Surveying Extend  

Zooms the map display to show all active or inactive Survey Features, if surveying has already 
started on it. 

How to Zoom to Surveying Extend 

1. Click the Zoom to Surveying Extend button  
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General 

What you can do with LEICA Zeno Office Data Manager  

After connecting to a folder, database, or Internet server, you can browse through its contents 
with the Data Manager; you can look for the map you want to print. The Data Manager does 
have the similar behaviour as the Microsoft Explorer. 

When you've found the data you want to use, add it to a map in LEICA Zeno Office.  

Browse for maps and data 

The Catalog provides several different views of data's contents. Select a folder, database, or 
Internet server in the Catalog tree, then examine the list of geographic data it contains in the 
Contents tab. 

Search for maps and data 

If you know something about the data you are looking for, but not where it is located, Data 
Manager can help. Its search tool will look on disks, in databases, and on ArcIMS internet 
servers for data that satisfies your criteria. 

Manage data sources 

The Data Manager makes it easy to organize your data. Rename shapefiles and copy tables to 
another geodatabase just as you would rename and copy files with Windows Explorer. You can 
create layers in Data Manager and place them in a shared folder on the network where everyone 
can access them. Others can add those layers to maps without having to know how to access 
the database, how to classify the data, or even the format in which the data is stored. 

Overall, Data Manager will revolutionize how you do your work - all work you need in one in the 
map integrated application.  
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Adding folder connections 

About folder connections  

To access data stored on a CD, floppy disk, or another computer on the network, you must add 
connections to those locations. It is also possible to disconnect folder connections that you are 
no longer using. 

How to manage folder connections 

Connecting to a folder 

1. Click the Data Manager tab. 
2. Right mouse click on Catalog. 
3. Click on the context menu Connect to Folder. 
4. Navigate to your folder. 
5. Click Ok. 

A new folder connection appears in the Data Manager. 

 

Disconnecting from a folder 

1. Click the folder connection that you want to remove from the Catalog. 
2. Right mouse click and click the Disconnect From Folder command. 

The folder connection is removed from the Catalog tree. 
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Internet servers 

The Internet Servers folder in Data Manager lets you add and manage connections to ArcIMS 
Internet servers. ArcIMS is an ESRI product that enables organizations to put maps and data on 
the Internet. 

When you connect to an ArcIMS server, you'll be able to browse the services available on that 
server. These services enable you to access maps and data over the Internet as 'live' data 
sources, without having to download them to your computer first.  

Some ArcIMS services may be password protected. In order to access these secure services, 
you have to provide a username and password when you make the connection to the server 
containing the services. For example, this is how you access services which are provided on a 
subscription-only basis. 

   

Connecting to Internet servers 

About connecting to Internet servers  

To access services provided by an ESRI ArcIMS Internet server, add an Internet server 
connection to the Catalog. To establish the connection, you specify the server's URL. In addition 
to the services which are freely available, you may have permission to access secure services. 
To include these in the list of available services, you must first provide login information. 

On starting Data Manager, all Internet servers are disconnected; a little red "x" will appear on 
the icon, indicating that it is unavailable. The first time an Internet server is double-clicked, the 
Catalog connects to it. If your login information isn't saved with the connection, you will be 
prompted for it. If the connection attempt is successful, the "x" disappears and you can access 
the available services. 

Learn more about Internet servers and services 

Your Internet Servers folder may already contain a connection to an Internet sever. This 
connection, called www.geographynetwork.com, gives you access to the Geography Network, by 
clicking on the File menu from LEICA Zeno Office, choosing Add data from Internet, then 
selecting Geography Network. 

How to add an Internet server to Data Manager 

1. Go into the Data Manager Internet Servers folder and double-click Add Internet Server. 
2. In the dialog that appears, type in the URL of the Internet server to which you want to 

connect. 
3. If you will be accessing secure services on this server, check 'Show secure services' and 

type the username and password for the services. (For example, this is how you access 
services which are subscription only). 

4. If you only want to access particular services on this server, click 'Get List'. A list of all 
services which are available on the server appears. Check the services you want to be able 
to access from this server. 

5. Click OK. 
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Specifying a coordinate system 

About specifying a coordinate system  

Specifying a coordinate system is needed when collecting data from different sources to add it 
to a map. As each data is probably stored in different coordinate systems you have to make 
sure that it can be displayed together and will overlay properly.   

Coordinate systems and data frames 

As soon as you insert a layer to an empty data frame the coordinate system will be set 
according to that layer. LEICA Zeno Office lets you add subsequent layers defined at different 
coordinate systems to the data frame, while transforming these layers to the data frame's 
coordinate system. The automatic transformation will only be generated if the layer's coordinate 
system can be determined. If not, then you have to provide information for this particular 
coordinate system. 

Map units 

The spatial data in the data frame will be displayed in units - so called map units. Once a 
coordinate system is specified on the Coordinate System tab the map units are determined and 
can't be modified anymore. 

When there are no map units determined, the reason can be either a not specified coordinate 
system or an empty data frame. Thus you have to specify a system or just add a layer to the 
empty data frame. 

How to specify a coordinate system 

Finding out what coordinate systems your data is currently displayed 
with 

1. Right-click the data frame of which to detect the coordinate system and click Properties. 
2. The details of the current data frame coordinate system will display on the Coordinate 

System tab. 

Tip 

• Modifying a coordinate system of a data frame doesn't affect the 
coordinate system of the source data comprised in it. 

Finding out what map units your data is currently displayed with 

1. Right-click the data frame of which to detect the map units and click Properties. 
2. The current map units will be displayed on the General tab. 

Modifying the parameters of a coordinate system 

1. Right-click the data frame containing the coordinate system to modify and click Properties. 
2. On the Coordinate System tab click Modify. 
3. Set the coordinate system properties as appropriate. 
4. Click OK. 
5. Click OK on the Data Frame Properties dialog box. 
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Tip 

• Modifying a coordinate system of a data frame doesn't affect the 
coordinate system of the source data comprised in it. 
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Defining a CAD, shapefile or raster layer's coordinate system 

About defining a CAD layer's coordinate system  

The way you define a CAD layer's coordinate system is the same way you define coordinate 
systems for feature classes in geodatabases, shapefiles, and rasters that aren't grids. 

 

A CAD layer often does not have any information defining which coordinate system was used to 
create its features. In this case, the CAD layer's coordinate system will be "unknown". You can 
work with CAD layers even if their coordinate system hasn't been defined, but you may not be 
able to take advantage of all the available functionality. 

 

The Spatial Reference tab in the Raster Properties dialog box shows the raster's extent and 
map projection, and lists its parameters. The projection defines how coordinates describing 
locations on the earth's surface are mathematically transformed to accurately represent them 
on a flat map sheet. If the raster doesn't have a coordinate system, you can assign one by 
clicking the Edit button. If the raster is a grid, you will see the Define Project Wizard. 

 

A shapefile often doesn't have any information defining which coordinate system was used to 
define its features. In this case, the Shape column's Spatial Reference property will be " 
unknown" or " assumed geographic" . If the features' bounding coordinates are within the range 
of -180 and 180 in the x direction and -90 and 90 in the y direction, LEICA Zeno Office assumes 
the data to be geographic and its datum to be NAD27. You can work with shapefiles even if their 
coordinate system hasn't been defined,  

 

You can define a CAD file's, a raster's or shapefile's coordinate system in LEICA Zeno Office in 
several ways. You can: 

• Select one of the predefined coordinate systems. 
• Import the coordinate system parameters used by another data source. 
• Define a new, custom coordinate system. 

Afterwards, you can modify individual parameters as required. A CAD layer's coordinate system 
parameters must be saved in the same folder as the CAD layer in a .prj file with the same prefix 
as the CAD file. 

Once a coordinate system has been defined, you can modify individual parameters. 

How to define a CAD layer's coordinate system in Data 
Manager 

Defining a CAD, shapefile or (nongrid) raster layer's coordinate system 

1. Click the CAD feature dataset, CAD drawing, shapefile or raster data whose coordinate 
system you want to define. 

2. Right mouse click, then click Properties. 
3. Click the Spatial Reference tab. 
4. Click the Edit button. 
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5. In the Spatial Reference Properties dialog box, click Select, choose a predefined coordinate 
system, and click Add. Or, click Import and then choose the data source whose coordinate 
system parameters you want to copy.Or, click New, click Geographic or Projected, and 
then define a new custom coordinate system. 

6. Click the Save As button. 
7. Navigate to the folder where the CAD file whose coordinate system you are defining is 

located. 
8. Type a name for the coordinate system file using the same prefix as the CAD file and click 

Save. 
9. Click OK in the Spatial Reference Properties dialog box. The name of the coordinate 

system appears in the Projection section of the CAD Properties dialog box. 
10. Click OK. 

Selecting an existing coordinate system 

1. In the Spatial Reference Properties dialog box, click Select. 
2. Navigate to the coordinate system you want to use. 

For example, you can use one of the predefined coordinate systems in the Coordinate 
Systems folder that was provided with Data Manager. Or, you can use a projection file that 
was created with ArcInfo Workstation. 

3. Click the coordinate system. 
4. Click Add. 

The coordinate system's parameters are listed in the Spatial Reference Properties dialog 
box. 

5. If you wish, click Modify to change the coordinate system parameters. Or, click Clear and 
repeat steps 1 through 4. 

6. Click the Save As button. 
7. Navigate to the folder where the CAD file whose coordinate system you are defining is 

located. 
8. Type a name for the coordinate system file using the same prefix as the CAD file and click 

Save. 
9. Click OK in the Spatial Reference Properties dialog box.  

The name of the coordinate system appears in the Projection section of the CAD Properties 
dialog box. 

10. Click OK. 

Importing a coordinate system 

1. In the Spatial Reference Properties dialog box, click Import. 
2. Navigate to the data source whose coordinate system parameters you want to copy. For 

example, you can get coordinate system information from coverages, rasters, or feature 
datasets and feature classes in a geodatabase. 

3. Click the data source. 
4. Click Add. 

The coordinate system's parameters are listed in the Spatial Reference Properties dialog 
box. 

5. If you wish, click Modify to change the coordinate system parameters. Or, click Clear and 
repeat steps 1 through 4. 

6. Click the Save As button. 
7. Navigate to the folder where the CAD file whose coordinate system you are defining is 

located. 
8. Type a name for the coordinate system file using the same prefix as the CAD file and click 

Save. 
9. Click OK in the Spatial Reference Properties dialog box. 
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The name of the coordinate system appears in the Projection section of the CAD Properties 
dialog box. 

10. Click OK. 

Defining a new geographic coordinate system 

1. In the Spatial Reference Properties dialog box, click New and click Geographic. 
2. Type a name for the custom coordinate system. 
3. Type the appropriate semimajor and semiminor or inverse flattening values and type a 

name for your custom Spheroid and Datum. 

Or, click the Datum or Spheroid dropdown arrow and click a predefined datum or spheroid. 

4. Type the appropriate Radians per unit and type a name for your custom units. 

Or, click the Angular Unit dropdown arrow and click a predefined unit of measure. 

5. Type the appropriate degrees, minutes, and seconds defining the prime meridian and type 
a name for this line of longitude. 

Or, click the Prime Meridian dropdown arrow and click a predefined line of longitude. 

6. Click OK. 
7. Click the Save As button. 
8. Navigate to the folder where the CAD file whose coordinate system you are defining is 

located. 
9. Type a name for the coordinate system file using the same prefix as the CAD file and click 

Save. 
10. Click OK in the Spatial Reference Properties dialog box.  

The name of the coordinate system appears in the Projection section of the CAD Properties 
dialog box. 

11. Click OK. 

Defining a new projected coordinate system 

1. In the Spatial Reference Properties dialog box, click New and click Projected. 
2. Type a name for the custom coordinate system. 
3. Click the dropdown arrow and click one of the supported projections. 
4. Type the appropriate parameter values for the projection. 
5. Click the Linear Unit dropdown arrow and click a predefined unit of measure. 

Or, click "<>" in the dropdown list, type the appropriate meters per unit, then type a 
name for your custom units. 

6. Define the projection's datum by selecting a predefined geographic coordinate system or 
defining a new geographic coordinate system. Afterwards, you can modify the geographic 
coordinate system's parameters if you wish. 

7. Click OK. 
8. Click the Save As button. 
9. Navigate to the folder where the CAD file whose coordinate system you are defining is 

located. 
10. Type a name for the coordinate system file using the same prefix as the CAD file and click 

Save. 
11. Click OK in the Spatial Reference Properties dialog box. The name of the coordinate 

system appears in the Projection section of the CAD Properties dialog box. 
12. Click OK. 

Modifying a coordinate system's parameters 
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1. In the Spatial Reference Properties dialog box, click Modify. 

The Geographic or Projected Coordinate System Properties dialog box appears. 

2. Follow the steps for defining either a new geographic or a new projected coordinate 
system to change the appropriate parameters. 

3. Click OK. 
4. Click the Save As button. 
5. Navigate to the folder where the CAD file whose coordinate system you are defining is 

located. 
6. Type a name for the coordinate system file using the same prefix as the CAD file and click 

Save 
7. Click OK in the Spatial Reference Properties dialog box.  

The name of the coordinate system appears in the Projection section of the CAD Properties 
dialog box. 

8. Click OK. 

Saving a coordinate system to a file 

1. In the Spatial Reference Properties dialog box, click Save As. 
2. Navigate to the location where you want to place the coordinate system file. For example, 

place it in a shared folder on the network. 
3. Type a name for the coordinate system file and click Save. 
4. Click OK. 

The coordinate system file appears in the folder's Contents list. 
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Organizing your data 

About organizing your data with Data Manager  

With Data Manager, managing maps and geographic data is as easy as managing files with 
Windows Explorer. You can use all standard Windows shortcuts and drag and drop techniques to 
copy, move, rename, or delete items in the Catalog. 

These features make it easy to organize not only data sources on disk (such as shapefiles), but 
data stored in databases as well. 

How to manage your data 

Copying an item 

1. Click the item you want to copy. 

2. Click the Copy button . 
3. Click the folder or geodatabase to which you want to copy the item. 

4. Click the Paste button . 

Renaming an item 

1. Click the item you want to rename. 
2. Click File and click Rename. 
3. Type the new name. 
4. Press Enter. 

Deleting an item 

1. Click the item you want to delete. 

2. Click the Delete button . 

Tip 

• When you delete a database connection you are deleting the connection 
itself, not the database or its contents. When you delete a personal 
geodatabase you are deleting the Access database file and all the data it 
contains. 

Creating a new folder 

1. Click the folder or folder connection in which you want to create a new folder. 
2. Click the File menu. 
3. Point to New and click Folder. 
4. Type a new name for the folder. 
5. Press Enter. 

Creating a new personal geodatabase 

1. Click the folder or folder connection in which you want to create a new personal 
geodatabase. 

2. Click the File menu. 
3. Point to New and click Personal Geodatabase. 
4. Type a new name for the personal geodatabase. 
5. Press Enter. 
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The Catalog tree 

 
 

Repositioning the Catalog tree 

About positioning the Catalog tree  

The main elements of the Data Manager tab are the Catalog tree, which displays the contents of 
the Catalog, and the tabs, which provide different views of the contents of the selected item in 
the Catalog tree. You can reposition the Catalog tree to make it easier to explore the selected 
item's contents. By default, the Catalog tree is docked on the left side of the LEICA Zeno Office 
window, but you can dock it on the right, the top, or the bottom of the window if you prefer. 

How to reposition the Catalog tree 

Undocking the Catalog tree 

1. Click and drag the bar at the top of the Catalog tree with your mouse pointer to a location 
outside the LEICA Zeno Office window. A rectangle with a thick line indicates where the 
Catalog tree will be placed. 

2. Drop the panel. The Catalog tree is floating on the desktop, but it is still working with the 
application. 
If the Table of Contents window, where the Data Manager tab is shown, is not visible, then 
click View > ta ble of Contents. 
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Working with file types 

About file types 

Ma r aren't initially visible in the 
Catalog. Some of these files may contain information that you need when working with 

ny files that you would see in a folder in Windows Explore

geographic data. To see these files, you must add their types to the Catalog's file types list. You 
can also remove file types that you no longer need.  

How to manage file types 

A

1. 
n click Properties 

dding a file type 

Click the Data Manager tab. 
2. Right mouse click on Catalog, the

 
3. Click the File Types tab. 
4. Click New Type. 
5. Type the file extension. 
6. Type a description of the new file type. 
7. Click Change Icon. Or, click Browse, then navigate to and click the application whose icon 

you want to use for the file type, then click Open.  
8. Click OK in the Change Icon dialog box. 
9. Click OK in the File Type dialog box.  

The new file type is added to the list.  

10. Click OK in the Catalog Options dialog box. 

Removing a file type 

1. Click the Data Manager tab. 
2. Right mouse click on Catalog, then click Properties 

 
3. Click the File Types tab. 
4. Click the file type that you want to remove. 
5. Click Remove.  
6. Click OK. 

Importing a file type 

1. Click the Data Manager tab. 
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2. Right mouse click on Catalog, then click Properties 

 
3. Click the File Types tab. 
4. Click New Type. 
5. Click Import File Type From Registry. 
6. Scroll down until you see the file type you want to use and click it in the list. 
7. Click 

The file type's properties appear in the File Type dialog box.  

8. Click OK. 

9. Click OK. 

OK. 

The file type is added to the list. 
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Folder names using reserved extensions 

Data stored in folders using a reserved extension at the end of the folder name are not 
accessible through LEICA Zeno Office. For example, the extension .mxd is the reserved 
extension for a map document.  

Reserved extensions include: 

 

.dt1 

.gif 

 

.jpg 

.lan 

.lgg 

.lyr 

.mdb 

.mxd 

.mxt 

.ntf 

.ovr 

.png 

.prj 

.raw 

n 

.sbx 

.bil  

.bip 

.bmp 

.bsq

.dbf 

.ers 

.gis 

.img

.loc 

.sb
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.shp 

.shx 

.sid 

.stk 

.sxd 

.tif 

.txt 

.xml 
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Hiding folders and items 

About hiding folders and items  

The Catalog lets you work with data sources in many different formats and has folders that help 
anage them. You can customize the Catalog to show only the folders and items that you 

rk with. For example, you might only want to see the shapefiles in a folder, and not 
awings. 

first start LEICA Zeno Office, the Database Connections, Internet Servers, Geocoding 
ices, and Search Results folders are visible. For example, if you don't use data stored in a 

remote database or provided by an Internet server, you can hide those folders.  

you m
want to wo
the CAD dr

When you 
Serv

How to hide folders and items 

1. Click the Data Manager tab. 
2. Right mouse click on Catalog, then click Properties 

 
3. Click the General tab. View the Options dialog 
4. Uncheck the items and folders you want to hide in the Catalog. 

Check the items and folders you want to show in the Catalog. 

5. Click OK. 
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Modifying the search results 

About shortcuts and modifying the results of your search 

 
One of the reasons you might be searching for items is so you can see which ones must be 
updated. Shortcuts in Data Manager like Windows shortcuts—deleting, copying, and moving the
shortcut has no influence on the original item.  

How to modify the search results 

Updating the search results 

1

rs containing the Search's criteria. 

2. Modify the Search's criteria, if appropriate. 
3. Click Find Now.  

All shortcuts are removed from the search's current list of results. As the Catalog finds 
items which satisfy the new search criteria, shortcuts to those items are added to the 
search results list.  

Click the Close butto o e Search dialog box.  

. Right-click a Search and click Properties.  

The Search dialog box appea

4. n t  hide th

Deleting a shortcut 

1. 
2. 

 the search results list.  

Click a shortcut in the Catalog tree.  
Click the Delete button.  

The shortcut is removed from

Selecting a shortcut's origi

Right-click a shortcut in the 

nal item 

1. Catalog tree and click Go To Target.  

The original item is selected in the Catalog tree.  
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Data organisation 

Creating feature datasets 

About creating feature datasets  

The p re dataset includes the definition of a spatial reference. Thus 
a coor for the feature dataset. To define a 
coo tem, make use of an existing 
feature dataset or a standalone feature class as a template, or even create a custom geographic 
o

set, any feature class you want to add to this 
system. Thus both the coordinate systems and 

the coordinate domains must match. Except the spatial reference co ains m-domains. These 
can b e classes. 

rocess of creating a new featu
dinate system and the coordinate domains will be set 

rdinate system, either select a predefined coordinate sys

r projected coordinate system. 

Once the spatial reference is assigned to the data
dataset must be defined for the same reference 

nt
e different for the feature classes and the feature dataset including all th

 

How to create feature datasets 

Creating a feature dataset with a predefined coordinate system 

2. Right-click the relevant database in which to create a feature dataset in the Catalog tree. 
 click Feature Dataset. 

4. Type a name for the feature dataset. 
, click Edit.  

atial reference, or navigate to the desired feature class or 
feature dataset whose spatial reference should be us  as a template. 

8. em. Therefore, click Modify, then 
adjust the parameters, and click OK. 

x- and y- and maximum x- and y-coordinate 
 precision for the coordinate values. 

10. If the feature class shall contain z-values, click the Z Domain tab.  
hen set the precision 

necessary for the z-coordinates. 
12. e M Domain tab.  
13. Type the minimum m-value and maximum m-va , then set the precision 

necessary for the m-values. 
14. Click OK. 
15. Check Show Details, to view the details of the dataset's spatial reference. 
16. Click OK. 

1. Click the Data Manager tab. 

3. Then, point to New and

5. To set the spatial reference of the dataset
6. Click Select or Import. 
7. Navigate to the desired sp

ed
You can modify any parameters in this coordinate syst

9. On the X/Y Domain tab, type the minimum 
values for the dataset. Set also the required

11. Type the minimum z-value and maximum z-value for the dataset, t

If the feature class shall contain m-values, click th
lue for the dataset

Tips 

• The coordinate system can also be saved as a .prj file. Therefore, click 
Save As. 

Defining new geographic coordinate systems 

1. Follow steps 1 through 5 for 'Creating a feature dataset with predefined coordinate 
systems' mentioned above. 

2. Click New and select Geographic. 
3. Type a name for the coordinate system. 
4. Decide, to either type the parameters for a custom datum, or select a predefined datum 

from the dropdown list. 
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5. Decide, to either type the ang
dropdown list. 

ular unit, or select a predefined angular unit from the 

6. Decide, to either type the degrees, minutes, and seconds defining the prime meridian's 
e meridian from the dropdown list. 

8. Follow steps 9 through 15 for 'Creating a feature dataset with predefined coordinate 

9

longitude, or select a predefined prim
7. Click OK. 

systems' mentioned above. 
. Click OK. 

Defining new projected coordinate systems 

1. Follow steps 1 through 5 for 'Creating a feature dataset with predefined coordinate 
systems' mentioned above. 

2. Click New and select Projected. 

6. To define the geographic coordinate system, click Select or New. 
7. Navigate to the desired geographic coordinate system, or navigate to the desired feature 

class or feature dataset whose geographic coordinate system should be used as a 

8 e system. Therefore, click Modify. 
9. Click OK. 

ate 
systems' mentioned above. 

3. Type a name for the coordinate system. 
4. To type the appropriate parameter values for that projection, select a projection from the 

dropdown list. 
5. Decide, either to type the linear unit, or select a predefined linear unit from the dropdown 

list. 

template. 
. You can modify any parameters in this coordinat

10. Follow steps 9 through 15 for 'Creating a feature dataset with predefined coordin

11. Click OK. 
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Creating feature classes 

About creating feature classes  

NOTE: Since LEICA Zeno Office do
fe e help manual. 

 
operties can consist of the spatial index or the geometry 

 a standalone feature class, the spatial reference 

e spatial reference. 

es not provide to create custom 
atures no explanation will be found in th

Any other feature class can be created in a geodatabase by assigning the properties of the
geometry field to each class. These pr
type of the feature classes, or when generating
of that class. 

Any number of feature classes can be included in a feature dataset as long as they're all defined 
to the sam

How to create feature classes 

Creating a feature class in a feature dataset 

1. Click the Data Manager tab. 
log tree, right-cli2. In the Cata

class. 
ck the relevant feature dataset in which to create a feature 

3. Then point to New and click Feature Class. 
4. Name the feature class. Optionally, type an alias for the feature class. 
5. Click Next. 
6. Inserting a field to the feature class can be done by clicking the next blank row in the Field 

Name column, and then typing a name. 
7. Click in the Data Type column next to the new field's name and select its data type. 
8. Optionally, click the field next to Alias and type an alias for this field. 
9. If you want to avoid nulls to be saved in this field, click the field next to Allow nulls. Then 

click the dropdown arrow and select No. 
10. Click the field next to Default value and type the value. Thus a default value will reference 

to this field.  
11. Click the field next to Domain, click the dropdown arrow to select a domain from the 

domains listed which apply to this field type. Thus a domain will reference to this field. 
12. To define other properties specific to the type of field, choose to either click the property in 

the dropdown list or to type the property. 
13. If several table fields have to be set, repeat steps 6 through 12. 
14. Select the name of the geometry field in the Field Name column. 
15. Additionally, click the field next to Alias and type an alias for the geometry field.  
16. If you want to avoid nulls to be saved, click the field next to Allow nulls. Then click the 

dropdown arrow and select No. 
17. To define the type of features to be stored in this feature class, click the field next to 

Geometry type, and click the dropdown arrow to choose the relevant types. 
18. Spatial index grid parameters have to be set for the feature class. Therefore, click the 

fields next to the desired grid size to be specified and type the grid value. 
19. Shapes can store z-values in a feature class. To enable this, click the field next to Contains 

Z values, and click the dropdown arrow to select Yes. 
20. Shapes can store m-values in a feature class. To enable this, click the field next to 

Contains M values, and click the dropdown arrow to select Yes. 
21. Click Finish. 

Tips 

• An ObjectID and geometry type fields have to be assigned to all simple 
feature classes in the geodatabase. Thus they are set by default and 
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can't be deleted in the wizard. 

Creating a standalone feature class 

1. Follow steps 1 through 20 for 'Creating a feature class in a feature dataset' as mentioned 

3. To define the spatial reference for the feature dataset, click Select or Import. 

omain tab, type the minimum x- and y- and maximum x- and y-coordinate 
values for the dataset. Set also the required precision for the coordinate values. 

Type the minimum z-value and maximum z-value for the dataset, then set the precision 

9 k the M Domain tab. Otherwise skip to step 
11. 

the dataset, then set the precision 

above. 
2. To set a coordinate system for the feature class, click the Spatial Reference Properties 

button. 

4. Navigate to the desired spatial reference, or navigate to the desired feature class or 
feature dataset whose spatial reference should be used as a template. 

5. You can modify any parameters in this coordinate system. Therefore, click Modify, then 
adjust the parameters, and click OK. 

6. On the X/Y D

7. If z-values are stored in the feature class, click the Z Domain tab. Otherwise skip to step 
9. 

8. 
necessary for the z-coordinates. 

. If m-values are stored in the feature class, clic

10. Type the minimum m-value and maximum m-value for 
necessary for the m-values. 

11. Click OK. 

Tips 

• The coordinate system can also be saved as a .prj file. Therefore, click 
Save As. 

• You might want to change the settings of a predefined (or a template's) 
coordinate system. Or you want to define a custom coordinate system 
from scratch. To do so, just open the Coordinate System dialog box and 
click Custom. 
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The survey dataset 

The survey dataset is a comprehensive collection of survey information in the geodatabase. 
Learn more about survey datasets.  

The survey project 

The survey data model includes the survey project. The survey project represents a unit of 
work, and is used as a logical structure that owns and manages a group of measurements, 

 is a candidate for owning any new survey data 

points, coordinates, and computations that function and belong together. 

When creating a survey project, you give it a name and define its coordinate system. Once 
added to the geodatabase, a survey project
added to the geodatabase. 

Learn more about survey projects 
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Creating indexes 

About indexes for geodatabase data  

To improve the performance of queries make use of indexes for geodatabase data. 

In LEICA Zeno Office, it is possible to design attribute indexes which the database management 
vely 

Click the Data Manager tab to open the Properties dialog box. This box lets you create attribute 

system (DBMS) uses as an alternate path to query a table for particular records more effecti
than having to search through the entire table. 

indexes either for single or multiple fields in a geodatabase feature class or table. 

How to create indexes for geodatabase data 

Creating a new attribute index 

Click the Data Manager tab.  
In the Catalog tree, right-click the relevant table or feature class for which to create an 
index.  

3. Click Properties. 
4. On the Indexes tab, click Add. 
5. Type the name for the index. 
6. If your field values are unique, then check the Unique check box.  
7. To create an ascending index, check the Ascending check box. Thus data is returned in 

ascending order. 
8. Select the field or fields for which to build an index. 
9. To move the fields to the Fields selected list, click the arrow button. 
10. You can arrange the fields in the index by using the up and down arrows. 
11. Click OK. 
12. If you click Apply, the index will be built. To build the index and close the Properties dialog 

box at once, simply click OK. 

1. 
2. 
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Creating new shapefiles and dBASE tables 

About creating new shapefiles and dBASE tables  

ew 
shapefile, you must define the type of features it will contain, whether those features will 
You can create new shapefiles and dBASE tables in Data Manager. When you create a n

represent routes, and whether those features will be three-dimensional. These properties can't 
be modified after the shapefile has been created. The shapefile's coordinate system can be 
defined later. In the meantime, the coordinate system will be classified as "Unknown". 

How to create new shapefiles and dBASE tables 

Creating a new shapefile 

1. Select a folder or folder connection in the Catalog tree. 
lick Shapefile. 

3. name for the new shapefile. 
 and click the type of feature the shapefile will 

rence Properties dialog box, click Select and choose a predefined 

m you want to copy. 

ates will contain m 

efile will store three-dimensional features, check Coordinates will contain z 

The new shapefile appears in the folder's Contents. 

2. Right mouse click, point to New, and c
Click in the Name text box and type a 

4. Click the Feature Type dropdown arrow
contain. 

5. Click Edit to define the shapefile's coordinate system. 
In the S6. patial Refe
coordinate system. 

Or, click Import and choose the data source whose coordinate syste
 Or, click New and define a new, custom coordinate system.

7. Click OK. 
8. If the shapefile will store polylines representing routes, check Coordin

values. 
9. If the shap

values. 
10. Click OK. 

Creating a new dBASE table 

1. Select a folder or folder connection in the Catalog tree. 
2. Right mouse click, point to New, and click dBASE Table. 

A new dBASE table appears in the folder's Content's. 

3. Type a new name for the table and press Enter. 
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Survey-aware feature classes 

On h 
the rvey-aware 
features. You can make links between each survey point’s GIS coordinate and the vertex of one 

e key benefit of LEICA Zeno Office is that you can associate the geometry of features wit
 stored survey data. Features that are associated with survey data are called su

or more features. A linked feature vertex does not need to share the same location as the 
survey point (see left graphic). 

 

Using links, features can be snapped to survey points, as shown in the right graphic. 
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Wizards 

Project Wizard 

About the Project Wizard  

To work with Leica Zeno Office a Personal Geodatabase is required. This is an Microsoft Access 
Database and contains usually Survey Datasets and Projects, Feature Datasets and Feature 
Classes and of course, your data. 

The database and its content can be created step by step with the respective tools or using the 
Project Wizard. This wizard guides you through the whole configuration process and lets you 
easily prepare your database. 

How to create a Project using the Project Wizard 

1. Start the Project Wizard in File - New - Project... 
2. On the first page of the wizard name the project (the database will get the same name) 

and select the destination folder. Leica Zeno Office will create a .mdb (Personal 
Geodatabase) and a .mxd (Map Document) file in that folder. 

3. If necessary, enter additional information, e.g. the name of the project manager. 
4. An existing map document can be browsed and used as template. This function creates a 

new map document with the same layers and symbols as well as a new database 
containing the same data model. Please note, that by default,  the spatial reference is the 
same, but can also be changed in step 6. 

5. Click Next. 
6. On the second page specify the coordinate system and the spatial domain. 
7. Click next. 
8. On the third page the required data packages can be selected and configured. 

• Enter a Point prefix in the Point settings window. 
• Enter ground to grid corrections in the COGO settings window. 
• Specify transformation parameter sets in the GPS settings window: 

In the Settings dialog predefined a parameter set (if any existing) will be shown 
Click Select… if you want to choose another predefined transformation set or manage 
transformation sets. 
The default parameter set (labeled with an *) will be used for this coordinate system. 
New… lets you define a new parameter set: 

Modify an existing parameter set with Modify… 
Finish dialog by clicking OK four times. 

• If desired, select a geoid file or CSCS file. 
• Enter default standard deviations and specify corrections in the TPS settings 

window. 

8. Click Next. 
9. On the fourth page Feature Datasets

Enter the values by double clicking in the values field. 

 and Feature Classes can be created or imported from 
already existing databases. 

10. To create a new Feature Dataset, right click on the database and select New... 
11. Name the Feature Dataset and specify the coordinate system. 
12. To create a new Feature Class, select the parent Feature Dataset and click into the name 

field. 
13. Enter name,  type and check 2D/3D. 
14. Select and right click on a Feature Class if you want to add attributes. 
15. Click Finish to close the wizard and to create the Personal Geodatabase and a Map 

Document containing all the data. 
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Tips 

• Pre-defined transformation sets cannot be deleted. 

• The pre-defined and user defined transformation sets will be stored in 
LeicaZenoOffice\ArcGIS\SurveyAnalyst\GeoTransformationSets.xml. 
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New Feature Dataset wizard 

the new 
Feature Dataset. 

3. Select New and then Feature Dataset 
4. On the first page of the wizard name the new Dataset. 
5. To assign a coordinate system you have the possibilty to select an existing one, to import 

one from a geodataset or to define a new one. Set the values for the X/Y, Z and M domain 
extents. See also how to specify a coordinate system

This wizard allows you to generate a new Feature Dataset. 

1. Click the Data Manager tab. 
2. In the Catalog tree, right-click on the Database in which you want to create 

.  
6. Click Finish to create the new Feature Dataset and close the wizard. 
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New Feature Class wizard 

This wizard allows you to generate a new Feature Class. 

1. Click the Data Manager tab. 
2. In the Catalog tree, right-click on the Feature Dataset in which you want to create th

Feature Class. 
Select New and th

e new 

 select the desired kind of 

 Feature Dataset or 

Click Finish to create the new Feature Class and close the wizard. 

   

3. en Feature Class 
4. On the first page of the wizard name the new Class and

contents. 
5. On the Configuration Keyword page accept the default setting. 
6. On the next page you'll define the fields, data types and properties ofthe new Feature 

Class. Optionally, these informations can be imported from an existing
Class respectively. 

7. 
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Survey Datasets 

About Survey Datasets 

A survey dataset is a collection of computations, measurements, and survey points that are 
shared within a predefined geographic area. It provides a framework of survey points to the 
geodatabase for use as control on the geometry of features in feature classes. 

 survey dataset, you will be required to:  When creating a

• Define a spatial reference 
• Specify measurement packages 
• Choose specific feature classes to be survey-aware  

Spatial reference 

When creating a new survey dataset, you need to define its spatial reference. The spatial 
reference describes a coordinate system, spatial domain, and numerical precision for 
representing stored geometry. Before you define the spatial reference, it is important to identify 
the combined geographic extents of all the survey-aware feature classes in your geodatabase 
that you want to associate with your survey dataset. The survey dataset domain should be 
made as large as the total extent of your management area. 

Learn more about spatial references and spatial domains 

Packages 

When creating a survey dataset you also need to specify the categories of survey information 
that will be stored in the survey dataset. These categories of survey information are called 
packages. New packages can be added to a survey dataset after it has been created; it is not 
possible, however, to remove packages from a survey dataset. 

Survey-aware feature classes 

When creating a survey dataset, you can elect the feature classes in the geodatabase that must 
be associated with your dataset - making the feature classes survey-aware. A feature class can 
only be made survey-aware for one survey dataset. If required, you can also remove survey-
aware feature classes from the survey dataset. 

Learn more about survey-aware feature classes 

How to create survey datasets 

1. In the Data Manager tree, right-click on the geodatabase in which you want to create a 
new survey dataset. 

2. Point to New. 
3. Click Survey Dataset. 
4. Type a name for the survey dataset. 
5. Click Next.  
6. Check the measurement data types that you will use in the new survey dataset. These 

define the data type packages. 
7. Click Next. 
8. Click Select or Import to choose a spatial reference for the survey dataset. 
9. Navigate to the spatial reference that you want to select, or navigate to the feat e class 

or feature dataset from which you want to import the spatial reference. Click Add. 
10. Type the latitude and longitude extents to define the x, y domain of the survey dataset.  
11. Check the feature classes that you want to make survey-aware. 
12. Click Finish. 

ur
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Tips 

• The survey dataset name cannot begin with a number. 
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Survey Projects 

About Survey Projects 

urvey projects are used to manage and work with the data stored in the survey dataset. 
ey points, measurements, and computations in a survey dataset are created, maintained, 

and owned by survey projects. Ownership is assigned when the projected is created. 

Survey points and measurements can be shared between projects; through a computation, one 
project may use points or measurements owned by another project. 

You use projects to import coordinates, compute coordinates for new or existing points, or to 
make use of the survey points and measurements available from other projects. 

New survey projects are created using the Survey Project wizard, and project folders let you 
organize your projects. The project requires a coordinate system, which is used when you work 
with your data in computations or when you import your data.  

Since the survey project does not store geometry, there is no dependence on a spatial reference 
precision; only the coordinate system portion of the spatial reference is used for the survey 
project. The survey project also requires a point name prefix. The wizard ensures that this is 
unique across all projects in the survey dataset. This allows survey points in the survey dataset 
to be uniquely identified even though they have the same name. 

-to-grid corrections are used for coordinate geometry computations. The scale correction 
is applied to all distance measurements entered in COGO computations, and the angle 
correction is applied in all computations that use direction measurements. 

Three types of corrections can be applied in computations when calculating coordinates, and are 
defined through a project. The corrections are based on: 

• An approximate height above mean sea level and earth radius 
• The projection used by computations to account for meridian convergence 
• Meteorological conditions defined by the temperature and pressure recorded for 

instrument setups 

S
Surv

Ground

Project point name prefix 

Survey points are identified by a name—for instance, traverse points might be named T1, T2, 
T3, and so on. The same point names are often used for different points in other projects. 
However, since points are shared across the entire survey dataset, they must be represented 
uniquely within the point namespace of the survey dataset. 

Each survey project has a point name prefix that, like the project name, is unique within the 
survey dataset.  

Coordinate system 

You are not limited to using the same coordinate system for all the survey projects in a survey 
dataset. Although the survey dataset has a coordinate system defined by its spatial reference, 
each project can have its own coordinate system. After they are computed, coordinates are 
stored in the native coordinate system of the survey project. 

Project locking 

When sharing a survey dataset in your organization, you may want to prevent some users from 
editing a given survey project. For example, the project that contains your control points should 
not be available for general editing. You can lock projects to prevent them from being edited. To 
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edit a project you need to acquire a project lock. You are automatically given this lock when you 
create a new project. 

How to create and manage new Survey Projects 

Creating a new folder 

2. Point to New and click Survey Project Folder. 

Make sure the project name does not start with a number. 

1. In the Data Manager, right-click the survey dataset or the folder in which you want to 
create a new folder. 

3. Type a name for the folder. 

4. Press Enter. 

Creating a new survey project 

1. In the Data Manager, right-click the survey dataset or the project folder in which you want 

o step 8. 
6. Click Select or Import to choose a coordinate system for the survey project. 

 

9. Type the point name prefix that you want to use for this project. 

ant to use values other than the 
default values. These defaults apply no correction to the coordinates calculated using 

d distances, and for 

rrection Method arrow and click the method that should be applied 
for computations in this project. 

n Correction and Meteo Correction methods. 
16. Click 

to create a new project. 
2. Point to New and click Survey Project. 
3. Type a name for the project. 
4. Click Next. 
5. If you want to accept the default coordinate system, which is the same as the coordinate 

system for the spatial reference of the survey dataset, skip t

7. Navigate to the spatial reference that you want to select, or navigate to the feature class 
or feature dataset from which you want to import the spatial reference. Click Add.

8. Click Next. 

10. Click Next. 
11. Type a scale correction and angle correction if you w

COGO computations. 
12. Type default standard deviation values for the measured angles an

centering the target and instrument. 
13. Click Next. 
14. Click the Sea Level Co

15. Repeat step 14 for the Projectio
Finish. 
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G

are 
e 

lass is a collection of features with the same 

A feat ame spatial reference. 
Featu  inside or outside a feature 
dataset. Simple feature classes that are outside a feature dataset are called standalone feature 

ses that store topological features must be contained within a feature 
dataset to ensure a common spatial reference.  
D ject classes (tables)

atabases 

eodatabase items 

Geodatabases organize geographic data into a hierarchy of data objects. These data objects 
stored in feature classes, object classes, and feature datasets. An object class is a table in th
geodatabase that stores nonspatial data. A feature c

tributes.  type of geometry and the same at
   

ure dataset is a collection of feature classes that share the s
re classes that store simple features can be organized either

classes. Feature clas

ata Manager contains tools for creating ob , feature classes, and feature 
datasets. Once these items are created in the geodatabase, further items such as subtypes, 
simple relationship classes and composite relationship classes can also be created.  

Spatial reference 

When creating a new feature dataset or standalone feature class, you must specify its spatial 
, 

patial domain is 
) values, and 

ion of 
ecimal places. Once the spatial reference for a feature dataset or 

e modified—the spatial 

ce is 
 

ata can grow. You must be careful to choose an appropriate x, y, 
nd 

 the feature dataset can have z-values that are less 
es will be stored to three decimal places. The same rule applies to x- and 

 
required x-, 

es for your database change, the data has to be reloaded into feature 
classes with a spatial reference that accommodates the new value range.  
earn how to set an appropriate geodatabase spatial domain  

A collection of predefined geographic and projected coordinate systems is installed with ArcGIS. 
You can create custom coordinate systems, or you can import a coordinate system from an 
existing feature class, feature dataset, coverage, or shapefile. You can read more about spatial 
references and spatial domains in the ArcSDE Administration Guide and Understanding Map 
Projections.  

reference. The spatial reference for a feature class describes its coordinate system (for example
geographic, UTM, or State Plane), its spatial domain, and its precision. The s
best described as the allowable coordinate range for x,y coordinates, m- (measure
z- (elevation) values. The precision describes the number of system units per one unit of 
measure. A spatial reference with a precision of 1 will store integer values, while a precis
1,000 will store three d
standalone feature class has been set, only the coordinate system can b
domain is fixed.  
All feature classes in a feature dataset share the same spatial reference. The spatial referen
an important part of geodatabase design because its spatial domain describes the maximum
spatial extent to which the d
m, and z domain. For example, if you create a feature dataset with a minimum z-value of 0 a
a precision of 1,000, none of the features in
than 0, and all z-valu
y-values. The exception to the rule is m domains; feature classes within the same feature 
dataset can have different m domains. 
The spatial domain for a feature class or feature dataset cannot be changed. If the 
y-, m-, or z-value rang

L

Spatial index grid size 

LEICA Zeno Office uses grids to quickly locate features in feature classes. Identifying a feature, 
selecting features by pointing or dragging a box, and panning and zooming all require LEICA 
Zeno Office to use the spatial index grid to locate features.  
A feature class can have up to three grids. The size of each must be at least three times the 
previous grid size. For most feature classes, only a single grid size is required. Feature classes 
with features of very different sizes may require additional grids so that larger features can be 
queried faster.  
When you create an empty feature class in Data Manager or import data to create a new feature 
class, you can choose a default grid size or specify your own. Once the feature class is created, 
you can change the grid size any time.  
Leica Zeno Office doesn't use the spatial index grid for feature classes in Informix ArcSDE 
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g
g
eodatabases. As other strategies are used to locate features in Informix, yo
rid size. For a more detailed discussion of spatial indexes and grid sizes, s

Configuration and Tuning Guide for <DBMS> PDF file.  

u can ignore the 
ee the ArcSDE 

Field properties 

 create a new table or feature class, you can specify any number 

, 

  
fault 

n 
e 

The exceptions are fields of type ObjectID, binary large object (BLOB), GlobalID, and Geometry, 
a ult value and domain property. Alias is the only property of an 
Object modify, while BLOB and Geometry fields have special 

n be 

scribes the number of decimal places for float and double fields. When 

 

 scale, if your 
se a float. If you create a double 

e created as double. 

R

nnot be deleted. Required fields 

as their aliases and geometry type, that you can modify, but these fields 

When you use Data Manager to
of fields to be included. You can also specify settings for fields, such as the field type and the 
maximum size of the data that can be stored in the field.  

Default Field Properties 

Each field type has special properties. All fields have properties, such as default value, domain
allis, and allow nulls. You can set the allow nulls property to "no" if you do not want the field to 
store null values. If you set the allow nulls property to "yes", then the field will allow null values.
Use the default value property if you want the field to be automatically populated with a de
value when a new feature or object is created with the LEICA Zeno Office editing tools. You ca
set a domain, which is a valid set or range of values that can be stored in the field by using th
domain property.  
Learn more about subtypes and attribute domains  

ll of which do not have a defa
ID and GlobalID field you can 

properties you can modify.  
The properties of the geometry field describe the kind of features that can be stored in a feature 
class, the size of the spatial index, and the spatial reference for the features.  

Field precision and scale 

The precision and scale of a field describe the maximum size and precision of data that ca
stored in the field. The precision describes the number of digits that can be stored in the field, 
while the scale de
creating a new field in a geodatabase feature class or table, you can specify the field's type, 
precision, and scale. When the field is actually created in the database, the field type may be 
changed based on the precision and scale values you specify.  
Use the following guidelines for choosing the correct field type for a given precision and scale:  

• When you create a float, double, or integer field and specify 0 for precision and scale, 
the geodatabase will attempt to create a binary type field if the underlying database
supports it. Personal geodatabases support only binary type fields, and precision and 
scale are ignored.  

• When you create float and double fields and specify a precision and
precision is greater than 6, use a double; otherwise, u
field and specify a precision of 6 or less, a float field is created in the database. If you 
create a float field and specify a precision greater than 6, a double field is created.  

• If you specify a scale of 0 and a precision of 10 or less, you should be creating integer 
fields. When creating integer fields, your precision should be 10 or less or your field 
may b

equired fields 

All tables and feature classes have a set of required fields that are necessary to record the state 
of any particular object in the table or feature class. These required fields are automatically 
created when you create a new feature class or table, and ca
may also have required properties such as their domain property. You cannot modify the 
required property of a required field.  
For example, in a simple feature class, OBJECTID and Shape are required fields. They do have 
properties, such 
cannot be deleted.  
You will see that some types of feature classes have a number of required fields.  

Field, table, and feature class aliases 
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The names of feature classes and tables in a geodatabase are the same as the names of the 
physical tables in the DBMS in which they are stored. When storing data in a DBMS, often 
names for tables and fields are very cryptic, and you req

the 
uire a detailed data dictionary to keep 

track of what data each table stores and what each field in those tables represents. For 
e  have a feature class called "Pole" that has a field called "HGT". 
W  dictionary, you may have a difficult time determining that Pole 
stores utility poles and HGT has values for pole heights.  

 
in special characters such as spaces. 

In the above example, you may set the alias for the "Pole" table to "Utility Poles", and the alias 
n LEICA Zeno Office, when using data with aliases, the alias 
ature classes, tables, and fields. However, in Data Manager 

these objects are always represented by their true names. You can view the alias for feature 

xample, your database may
ithout consulting your data

The geodatabase provides the ability to create aliases for fields, tables, and feature classes. An 
alias is an alternative name to refer to those objects. Unlike true names, aliases do not have to
adhere to the limitations of the database, so they can conta

for the "HGT" field to "Height". I
name is automatically used for fe

classes, tables, and fields by examining their properties.  
Aliases can be specified when creating a feature class or table and can be modified at any time. 
Similarly, when creating new fields, the alias is set as a property of that field and can be 
modified at any time.  

Feature datasets 

Feature datasets exist in the geodatabase to define a scope for a particular spatial reference. All 
feature classes that participate in topological relationships with one another (for example, a 
geometric network or topology) must have the same spatial reference. Feature datasets are
way to group feature classes
topological relationships with each other.  
Feature datasets also have a natural organizational quality, much like a folder o

 a 
 with the same spatial reference so that they can participate in 

n a file system. 
Since for many geographic information system (GIS) applications the majority of the data for a 

 spatial reference, it is possible to use feature datasets as 

Bear in mind that topologically related feature classes must reside in the same feature dataset. 
 

particular database has the same
organizational containers.  

If you are interested in organizing feature classes purely by category you can arrange layer files
into logical groups within folders at a shared location, without regard to the organization of the 
feature classes in the geodatabase.  

Relationship classes 

Relationship classes define relationships between objects in the geodatabase. These 

r, but that creating, editing, or deleting one will have a specified 
re 

relationships can be simple one-to-one relationships, such as you might create between a 
feature and a row in a table; or more complex one-to-many (or many-to-many) relationships 
between features and table rows. Some relationships specify that a given feature, row, or table 
is not only related to anothe
effect on the other. These are called composite relationships, and they can be used to ensu
that the links between objects in the database are maintained and up-to-date. Deleting a 
feature, such as a power pole, can trigger the deletion of other features, such as a transformer 
mounted on the pole, or the maintenance records in a related table.  
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Before you create your geodatabase 

If you want your database or any geodatabase working most effectively, its schema shou
designed very carefully. While creating your geodatabase, keep in mind the following question

• What kind of Survey Projects will you work with? 
• In what projection should the data be saved? 
• What kind of data should be saved in the database? 

 

ld be 
s: 

Do they vary? 
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Creating your database 

About creating a database  

The Data Manager lets you first create a database before generating your
geodatabase. In conjunction with the process of gene ating the geodatab

 personal 
ase a new .mdb file will 

 

r
be created on disk. 

How to create a database 

Creating a new personal geodatabase 

1. Click the Data Manager tab. 
2. In the Catalog tree, right-click on the desired location where to create the geodatabase. 
3. Point to New and select Personal geodatabase. 

LEICA Zeno Office sets the name of the geodatabase to edit mode. 

4. Thus, type a new name for it. 
5. Press Enter. 
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Browsing the attribute domains of a geodatabase 

About browsing attribute domains  

fore it is 

n be saved geodatabase-wide. 

o display the dialog box you either have to open the Feature Class or Table Properties dialog 
box, or the geodatabase's properties have to be displayed to show the box as a part of them. 

 

The Domains Property dialog box enables the managing of Attribute domains. There
possible to insert, delete, or modify attribute domains. After having finished the changes the 
Attribute domains ca

T

How to browse attribute domains 

Browsing the domains of a personal geodatabase 

1. Click the Data Manager tab.  
2. 
3. To open the Database Properties dialog box, click Properties. 

Right-click the relevant personal geodatabase in the Catalog tree. 

4. Click the Domains tab. 

Browsing the attribute domains of a geodatabase from a feature class 
or table 

1. Click the Data Manager tab.  
2. Right-click a feature class or table in the Catalog tree. 
3. Click Properties. 
4. On the Subtypes tab, click Domains to open the Database Properties dialog box. 
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Compacting the database 

About compacting your database  

Compacting the database on a regular basis will lead to an increase in performance and to a 
decrease in the size of the database. 

As the MDB file is used to save personal geodatabases within, the use of the database might 
cause a fragmentation of the MDB file on the disk. Thus with the personal geodatabase's size 
increasing over 250 MB the performance will degrade.  

 

How to compact your database 

1. On the Data Manager tab, right click the relevant personal geodatabase to compress. 
2. Click the Compact Database command.  
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Copying geodatabase data 

About copying geodatabase data  

Copying or moving data - such as entire feature datasets or individual feature classes - between
geodatabases can be done by using the tools provided in the Data Manager.  

Keep in mind that copying of Survey Datasets and S

 

urvey Projects is not possible. 

e copy of the data will have the same properties as the original, for instance any attribute 
domains references in the original geodatabase will be maintained when copying.  

But copying data is just possible, if the spatial reference of the feature class matches the one of 

A dialog box opens listing the data copied as soon as the data is pasted in the same 
geodatabase or in another one. If there are any name conflicts then they'll be automatically 
resolved. Such names appear highlighted in red. In addition, within the dialog box it is possible 
to define configuration keywords for the objects copied. 

 

Th

the feature dataset in which you want to paste the data. 

How to copy geodatabase data 

1. Click the Data Manager tab. 
2. In the Catalog tree, right-click the desired data to copy. The data can be a feature dataset, 

feature class, or table. 
3. Click Copy. 
4. To paste the copy, right-click the relevant geodatabase and click Paste.  

A dialog box opens that lists the data copied. Resolved name conflicts are highlighted in 
red. 

5. To rename any of the resolved names, type over the target name. 
6. Optionally, to assign a configuration keyword for any of the objects being copied, type it 

under Config. keyword for that object. 
7. Click OK. 

A progress indicator displays the progress of the data copy. 

77 



Printed Documentation 

Importing shapefiles 

About importing shapefiles  

LEI t of shapefiles either into new or 
existi andalone feature classes. 

ve the same 
spatial reference since it is not possible to modify the spatial reference of the dataset.  

CA Zeno Office provides a wizard to simplify the impor
ng feature datasets in the database, or into the database as st

As you might already know, when creating a feature dataset a spatial reference must be 
specified. Thus any feature class which you want to import to a dataset must ha

 

How to import shapefiles 

Importing shapefiles using default values 

1. Click the Data Manager tab. 
2. In the Catalog tree, right-click the relevant shapefile to import into the geodatabase. 
3. Point to Export and select Shapefile to Geodatabase Wizard. 
4. Click Next. 
5. Navigate to the desired database into which to import the shapefile, or just type its path. 
6. Depending on how you want to import the shapefile select one of the following options:  

e feature dataset from the dropdown list, 
ataset in the database.  

ss. 

7. 
8. Click Next. 
9. To keep the default parameters, click the first option. 

- Click the first option and select the name of th
to import the shapefile into an existing feature d

- Click the second option and type the name of the new feature dataset, to import the 
shapefile into a new feature dataset. 

- Click the third option, to import the shapefile as a standalone feature cla

Type a name for the new feature class. 

10. Click Next. 
11. Ensure to have specified the right options for your data import operation. To change 

anything, simply go back through the wizard by clicking the Back button. 
click Finish. 12. At the end, 

Tips 

• Alternatively, you can click the geodatabase and use the Import menu to 
import shapefiles into geodatabases. 
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Importing tables 

About importing tables  

LEICA Zeno Office also provides a tool to import a dBASE and INFO attribute table into a 
geodatabase while any illegal or duplicate field names will be automatically detected and 
corrected. Additionally, you can modify the default settings for the process of correcting. 

 

How to import tables 

1
2. levant INFO or dBASE table to import. 
3. 

port the table, or just type its path. 
5. Optionally, to change illegal and duplicate field names or to specify a configuration 

gs.  

tically and the default storage 
should be used. 

7. In the Corrected Fields column, you'll find all the names listed. To change a default name, 

8. lick in the Delete 
Field? column and click Yes.  

9. 
10. 

. Click the Data Manager tab. 
In the Catalog tree, right-click on the re
Point to Export and select Table to Geodatabase. 

4. Navigate to the desired geodatabase into which to im

keyword, click Change Settin

Skip to step 9, if the field names should be corrected automa
configuration 

6. Click Item Names. 

click this name and type a new one. 
If none of the original fields should be included in the new table, double-c

Click OK. 
Click OK to import the table. 
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Survey data in the geodatabase 

Like other geographic information, survey measurement data can be managed in a GIS using 
dat bles. It is possible to store this information as an 
integ ey data model is based on the four data types (shown 

abase management system (DBMS) ta
ral part of the geodatabase. The surv

below): measurements, survey points, coordinates, and computations. 

 

The survey dataset 

A survey dataset is a comprehensive database of survey information and can be managed as an 
integrated layer with traditional GIS layers in a geodatabase. 

A survey dataset contains four object classes: 

• Survey points. Named locations that are observed through various surveys. Survey 
points can be observed multiple times and by many surveys over time.  

• Coordinates. Survey points can have many coordinates associated with their location, 
especially as new surveys are performed through time. A survey point can have 
multiple coordinates, but there is always one coordinate that is used for publication to 
the GIS layers or used in computations. GIS feature geometry can be linked to the 
location of the survey point.  

• Measurements 
• Computations 

Collectively, the computations, measurements, coordinates, and survey points are called survey 
objects, and are stored in tables called survey classes.  

 

In addition to comprehensive survey data management, the other key goal of LEICA Zeno Office 
is to incrementally improve the accuracy of GIS feature geometry in the geodatabase as the 
survey accuracy is improved. This is done by linking features to survey point locations. During 
the initial design stage, you declare that selected feature classes are survey-aware.  
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Shapefile to geodatabase geometry type mapping 

Shapefile to geodatabase geometry type and attribute type mapping includes all feature and 
attribute types. As shapefile feature types are quite similar to geometry types contained within 
a geodatabase, they will be mapped directly. See the following table:  

Shapefile Geodatabase 

point point 

point M point with measures 

point Z point with Zs 

polyline line (polyline) 

polyline M line (polyline) with measures 

polyline Z line (polyline) with Zs 

polygon polygon 

polygon M polygon with measures 

polygon Z polygon with Zs 

multipoint multipoint 

multipoint M multipoint with measures 

multipoint Z multipoint with Zs 

multipath multipatch 
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Working with database connections 

About database connections  

Database connections are not continuously active after they have been created. All connections 
are disconnected when you start Data Manager. The first time you select a database connection, 

 attempts to connect to  your login information isn't saved with the 
ection, you will be prompted for it. When a connection is established, you can access the 

database's contents. 

Database connections remain connected until Data Manager is closed. However, you can also 
disconnect manually.  

the Catalog  the database. If
conn

How to manage database connections 

Connecting to a database

e database connections you e. 
our login information isn't database connection, a login dialog box will 

appear. Type the required information, then click OK. 

 

1. Click th
2. If y

 want to us
 saved with the 

Tip 

• You can connect to Interne ay that you connect to t servers in the same w
remote databases. 

Disconnecting from a database 

click the database conn disconnect. 
2. Click Disconnect. 

"x" appears on the data n. 

1. Right- ections that you want to 

A red base connection's ico

Tip 

• You can disconnect from Internet servers in the same way that you 
disconnect from remote databases. 
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Tables 

Ab

ts 

out tables 

One of the database components is a table consisting of a series of rows and columns. Thus 
tables are stored in a database. Each row in a table describes a geographic feature - i.e. a 
parcel, building or road- and each column stands for a particular attribute of the feature - i.e. i
length, name or square area. 

Working with attributes 

Using tables in LEICA Zeno Office allows you to look over the attributes of geographic features 
sin icular attributes and then to 
sel er time you can also update 
the attributes to reflect these changes.  

 

ce a table makes it possible to first identify features with part
ect them on the map. As geographic features might change ov

The elements of a table 

 There's an example of a table with element descriptions to become acquainted with the 
ents of a table. elem
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The elements of a table 
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About tabular data sources 

LEICA Zeno Office allows you to work with data from a variety of sources. The source of the 
data may determine the level of functionality that is available.  

ObjectID fields 

A field of type ObjectID is required when you open a table window in LEICA Zeno Office. The 
ObjectID guarantees a unique ID for each row in the table. This field is normally named OID or 
ObjectID for tables and FID for layers.  

e following data sources, however, do not contain an ObjectID field with their tabular data: 

• OLE DB data 
• Delimited text file data 
• Unregistered data from a personal geodatabase 

If you open one of these tables, LEICA Zeno Office temporarily adds an ObjectID field to it to 
support some operations on the table. The following functionality is anyhow not available: 

• Select by Attributes. You cannot select records in the table by attribute values. 
• Modifying Data. You cannot add or delete fields or edit the values in the table from 

the user interface in LEICA Zeno Office.  

Th

Accessing delimited text file data 

LEICA Zeno Office allows you to directly access data in delimited text files and work with them 

as tables. LEICA Zeno Office' Data Manager, and the 'add data' browser  in LEICA Zeno 
Office, lists files with a .txt, .asc, .csv, or .tab extension. 

Files with a .txt, .asc or .csv extension are interpreted as comma delimited, while files with a 
ension are interpreted as tab delimited by default. Files with these extensions will be 

interpreted as a text file table, even if it doesn't contain tabular data. To avoid this problem, 
give your delimited text files a .csv or a .tab extension.  

.tab ext

Adding fields 

When adding a field using the table window in LEICA Zeno Office an Add Field dialog is 
displayed, which lists the same field types regardless of the data source. Each data source 
automatically maps these field types to a field type that is native to that data source. To add a 
field, you need to specify the field type, precision, and scale if the field is a numeric type. For 
string types, you need to set the field type and the length. 
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Creating a table 

About creating tables 

You can create tables in a geodatabase with an easy-to-use table designer. If you accept the 
 in 

e designer checks the names you type using a set of 
common rules, but each database is slightly different. If you want more control over a field's 

etails about using configuration keywords with ArcSDE, see the ArcSDE Configuration and 
S> PDF file.  

designer's defaults, you will create a table that uses simple row objects to represent each row
the table.  
When defining a table's fields, be aware that each database has its own rules to define which 
names and characters are permitted. Th

data types or structure, create the table directly in the database.  
For d
Tuning Guide for <DBM

How to create tables 

Creating a table to store simple objects 

1. In the Data Manager tree, right-click the database in which you want to create a new 
table.  

2. Point to New.  
3. Click Table.  
4. Type a name for the table. To create an alias for this table, type the alias.  

ck n 

7. Click Next.  
 

 Alias, and type the alias for this field.  
11. To prevent nulls from being stored in this field, click the field next to Allow nulls, click the 

hen click No.  
ult value with this field, click the field next to Default value, and type 

the value.  
own 

ve been defined.  
16. Click Finish.  

5. Click Next.  

If your geodatabase doesn't use SDE, skip to step 8.  

6. If you want to create the table using a custom storage keyword, cli  Use configuratio
keyword, then type the keyword you want to use.  

8. To add a field to the table, click the next blank row in the Field Name column, and type a
name.  

9. Click in the Data Type column next to the new field's name, then click its data type.  
10. To create an alias for this field, click the field next to

dropdown arrow, t
12. To associate a defa

13. To associate a domain with this field, click the field next to Domain, click the dropd
arrow to see a list of the domains that apply to this field type, and click the domain.  

14. To set other properties specific to the type of field, either click the property in the 
dropdown list, or type the property.  

15. Repeat steps 8 through 14 until all the table's fields ha

Tips 

• All simple tables in the geodatabase require an ObjectID type field. The 
ObjectID field uniquely identifies each object stored in the table in the 
database. The default ObjectID field can't be deleted in this wizard.  

• When creating a new table, you can use another table as a template. 
Click Import, navigate to the table whose field definitions you want to 
copy, then click OK. Now you can edit the field names and their data 
types.  

• If you have entered a field that you don't want included in the new table, 
select it by clicking its tab in the grid, then press the Delete key.  
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Creating a table that stores custom objects  

tree, right-click the database in which you want to create a new 
table.  

2
3
4. Type a name for the table. To create an alias for this table, type the alias.  

ant to store.  

1. In the Data Manager 

. Point to New.  

. Click Table. 

5. Click the second option to store custom objects in the table.  
6. Click the dropdown arrow to see a list of available custom row objects, and click the object 

you w
7. Click Next.  
8. Follow steps 6 through 16 for 'Creating a table to store simple objects' (see above).  

Tip 

• If you don't have any custom objects registered on your system, the 
option to specify one when creating a table will be unavailable. 
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Joining attribute tables 

About joining attribute tables  

Data comes from a variety of sources. Often, the data you want to display on your map is not 
directly stored with your geographic data. For instance, you might obtain data from other 

 organization, purchase commercially available data, or download data from 
 

table, you can associate it with your geographic features and display the data on your map. 

es 

departments in your
the Internet. If this information is stored in a table, such as a dBASE, INFO, or geodatabase

Learn more about joining attribute tabl

Joins versus relates 

LEICA Zeno Office provides two methods to associate data stored in tables with geographic 
features: joins and relates. When you join two tables, you append the attributes from one onto 
the other based on a field common to both tables. Relating tables defines a relationship between 
two tables—also based on a common field—but doesn't append the attributes of one to the 
other. Instead, you can access the related data when necessary. 

Which one should I use? 

You'll want to join two tables when the data in the tables has a one-to-one or a many-to-one 
relationship—for example, you have a layer showing store locations, and you want to join a 
table of the latest monthly sales figures to it. 

You'll want to relate two tables when the data in the tables has a one-to-many or many-to-
many relationship—for example, your map displays a parcel database, and you have a table of 
owners. A parcel may have more than one owner, and an owner may own more than one 
parcel. 

Joins and relates are reconnected whenever you open the map. This way, if the underlying data 
in your tables changes, it will be reflected in the join or relate. 

When you're through using a join or relate, you can remove it. 

If your data is stored in a geodatabase and has relationship classes defined, you can use these 
directly without having to establish a relate in LEICA Zeno Office. The relationship classes will 
automatically be available when you add a layer that participates in a relationship class to the 
map. Note that the many-to-many relationship is defined differently when your data is stored in 
a geodatabase. In general, if you have relationship classes defined in your geodatabase, you 
should use these instead of creating new ones in LEICA Zeno Office. 

Learn how to perform a spatial join 

How to join attribute tables 

Joining attributes in one table to another 

1. In the table of contents, right-click the layer you want to join, point to Joins and Relates, 
and click Join. 

2. Click the first dropdown arrow and click Join attributes from a table. 
3. Click the dropdown arrow and click the field name in the layer that the join will be based 

on. 
4. Click the dropdown to choose the table to join to the layer. If the table is not currently 

part of the map, click the Browse button to search for it on disk. 
5. Click the dropdown arrow and click the field in the table to base the join on. 

89 



Printed Documentation 

6. Click OK. 

pended to the layer's attribute table. The attributes of the table are ap

Tips 

• If you want to permanently save joined data with your geographic 
features, export the data to a new dataset (for example, shapefile). 
Right-click the layer in the table of contents, point to Data, and click 
Export data. 

• You can also join two tables using a predefined relationship class. 

• When editing joined data, you cannot edit the joined columns directly. 
However, you can directly edit the columns of the origin table. To edit 
the joined data, you must first add the joined tables or layers to LEICA 
Zeno Office. You can then perform edits on this data separately. These 
changes will be reflected in the joined columns. 

Removing a joined table 

1. In the table of contents, right-click the layer containing a join you want to remove and 
point to Joins and Relates. 

2. Point to Remove Join(s) and click the join you want to remove. 

Tip 

• If you want to permanently save joined data with your geographic 
features, export the data to a new dataset (for example, shapefile). 
Right-click the layer in the table of contents, point to Data, and click 
Export data. 

Managing joined tables 

1. In the table of contents, right-click a layer or table and click Properties. 
2. Click the Joins and Relates tab. 

All the joins for the layer or table are listed on the left side of the dialog. You can add new 
joins or remove existing ones. 

Tip 

• If you want to permanently save joined data with your geographic 
features, export the data to a new dataset (for example, shapefile). 
Right-click the layer in the table of contents, point to Data, and click 
Export data. 

Relating the attributes in one table to another 

1. In the table of contents, right-click the layer you want to relate, point to Joins and Relates
and 

, 
click Relate. 

r load the table from 
2. Click the dropdown arrow and click the field in the layer the relate will be based on. 
3. Click the dropdown arrow and click the table or layer to relate to o

disk. 
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4. Click the dropdown arrow and click the field in the related table to base the relate on. 
5. Type a name for the relate. You'll use this name to access the related data. 
6. 

The relate is now established between the two tables. You can now access records using 
the relate (see below). 

Click OK. 

Tip 

• If a feature class in a geodatabase participates in a relationship class, 
that relationship class will be immediately available for use. You don't 
need to relate the tables in LEICA Zeno Office. 

Accessing related records 

1. Open the attribute table for which you've set up a relate. 
2. Select the records in the table for which you want to display related records. 
3. Click Options, point to Related Tables, and click the name of the relate you want to access. 

 the related records selected. The related table displays with

Tips 

• Once you define a relate, you can access the related records from either 
table participating in the relationship. 

• You must set up a relationship before you can access related records. 
See 'Relating the attributes in one table to another' (above). 

• If your map contains layers from a geodatabase that participate in 
relationship classes, those relationship classes will be listed automatically 
along with any relates you define. 

Removing a related table 

ck the layer containing a relate you want to remove and 
point to Joins and Relates. 

2. 

1. In the table of contents, right-cli

Point to Remove Relate(s) and click the relate you want to remove. 

Managing related tables 

1. In the table of contents, right-click a layer or table and click Properties. 

log. You can add 
move existing ones. 

2. Click the Joins and Relates tab. 

All the relates for the layer or table are listed on the right side of the dia
new relates or re
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Locating and viewing specific records in a table 

About locating and viewing specific records in a table  

To se  in a table it is feasible to either use the navigation buttons at the 
bottom of the table window that let you move to the next, previous, first, or last record. Or to 

in a specific record number. 

ere's also an 
 table.    

arch for a specific record

type 

If you don't want to use the buttons and you don't know the specific number th
option to search the table for a specific value in the selected fields or the entire

How to locate and view specific records in a table 

Viewing all or only the selected records 

Selected. 
1. Open the table. 
2. To view all records, click Show All. To view just the selected ones, click Show 

Finding records with particular attribute values 

Click the heading of the column comprising the relevant text to search for. 
ns and then click Find & Replace. 

Type the text in the Find what text box. 
4. Click the Text Match dropdown arrow to select the desired type of search. 

 text, click Find Next again. 

1. 
2. Click Optio
3. 

5. Click Find Next. 
6. To find another record including the same
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Sorting records in a table 

About sorting records in a table  

To obtain information about the content of a table you can sort the records or rows in it. 

Sorting by more than one column 

The eful 
info d in order 
from left to right. Whereby the values in the column farthest to the left will be sorted first and 

rted last. 

re's also an option to sort a table by several columns at once to derive more us
rmation. Before you start to sort the relevant columns they have to be arrange

the values in the column farthest to the right will be so

How to sort records in a table 

Sorting records in a table by one column 

1. Select the heading of the column containing the values to use to sort the records. 
2. Right-click the selected heading and choose either Sort Ascending or Sort Descending by 

clicking on it.  

Sorting records in a table by more than one column 

1. Rearrange the table's columns needed to sort in the order as mentioned above. 
2. Click the heading of the first relevant column. 
3. To select all columns you'll need to sort the table's record, press the Ctrl key and while 

holding, click each column's heading. 
4. Right-click one of the selected column headings and choose either Sort Ascending or Sort 

Descending by clicking on it.  
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Making field calculations 

About making field calculations  

Entering values with the keyboard is not the only way you can edit tables. In some cases, you 
might want to perform a mathematical calculation to set a field value for a single record or even 
a or lets you perform simple as well as advanced 
ca
ll records. The LEICA Zeno Office field calculat
lculations on any selected record. 

Advanced calculations with VBA statements (Leica Zeno Office on 
ArcGIS only) 

The field calculator also lets you perform advanced calculations using VBA statements that 
pro e selected field. For example, using 
dem rgest age group by percentage of the 
population for each county in the United States. You can create a script that preprocesses your 
d elect Case blocks. This lets you 
pe

cess the data before calculations are made on th
ographic data, you might want to find out the la

ata using logical constructs such as If...Then statements and S
rform sophisticated calculations quickly and easily. 

How to make field calculations 

Making simple field calculations 

1. Optionally, start an edit session in LEICA Zeno Office. Calculating a field is faster o
an edit session, but you won't be able to undo the calculation. 

utside of 

5. Use the Fields list and Functions to build a calculation expression. You can also edit the 
expression in the text area below. Alternatively, you can just type a value to set the field 
to (for example, "Single Family"). 

6. Click OK. 

2. Open the table you want to edit. 
3. Select the records you want to update. If you don't select any, the calculation will be 

applied to all records. 
4. Right-click the field heading for which you want to make a calculation and click Calculate 

Values. 

Tips 

• Use double quotes when calculating strings. 

• If you are working with the attribute table of a geodatabase feature class 
that participates in a geodatabase topology or a geometric network, the 
Calculate Values command will be disabled when you are not in an edit 
session. 

Making advanced field calculations (Leica Zeno Office on ArcGIS only) 

1. Optionally, start an edit session in LEICA Zeno Office. Calculating a field is faster outside of 
an edit session, but you won't be able to undo the calculation. 

2. Open the table you want to edit. 
3. Select the records you want to update. If you don't select any, the calculation will be 

applied to all records. 
4. Right-click the field heading for which you want to make a calculation and click Calculate 

Values. 
5. Check Advanced. 
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6. Type VBA statements in the first text box. The VBA statements can include LEICA Zeno 
Office methods. 

7. Type the variable or value that is to be written to the selected records. 
8. Click OK. 

Tips 

• Use double quotes when calculating strings. 

• After entering VBA statements, you can click Save if you want to write 
them out to a file. The Load button will prompt you to find and select an 
existing calculation file. 

• For more information on VBA, consult any Visual Basic reference. The 
Visual Basic Editor—accessed by clicking the Tools menu, pointing to 
Macros, and clicking Visual Basic Editor—also contains an online 
reference to Visual Basic commands. 

• If you are working with the attribute table of a geodatabase feature class 
that participates in a geodatabase topology or a geometric network, the 
Calculate Values command will be disabled when you are not in an edit 
session. 

Updating area for a shapefile (Leica Zeno Office on ArcGIS only) 

1. Optionally, start an edit session in LEICA Zeno Office. Calculating a field is faster outside of 
an edit session, but you won't be able to undo the calculation. 

2. Open the attribute table of the layer you want to edit. 
 

icking the Options button and selecting the new field option). 

vanced. 

3. Right-click the field heading for area (if there is no field for area values, you can add a
new field for area by cl

4. Click Calculate Values. 
5. Check Ad
6. Type the following VBA statement in the first text box:  

      
      Dim dblArea as 
double 
      Dim pArea as 
IArea 
      Set pArea = 
[shape] 
      dblArea = 
pArea.area  

7. Type the variable dblArea in the text box directly under the area field name. 
8. Click OK. 

Tip 

• The property area returns a field type of double. For best results, your 
area field should also be a double field type. 

Updating perimeter for a shapefile (Leica Zeno Office on ArcGIS only) 
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1. Optionally, start an edit session in LEICA Zeno Office. Calculating a field is faster outside
an edit session, b

 of 
ut you won't be able to undo the calculation. 

he field heading for perimeter (if there is no field holding perimeter values you 
can add a new field for perimeter by clicking the options button and selecting the new field 
option). 
Click Calculate Values. 

5. Check Advanced. 
 box.  

2. Open the attribute table of the layer you want to edit. 
3. Right-click t

4. 

6. Type the following VBA statement in the first text

      
      Dim 
dblPerimeter as double 
      Dim pCurve as 
ICurve 
      Set pCurve = 
[shape] 
      dblPerimeter = 
pCurve.Length 

7. Type the variable dblPerimeter in the text box directly under the perimeter
8. Click OK. 

 field name. 

Tip 

• The property length returns a field type of double. For best results, your 
length field should also be a double field type. 

Updating length for a shapefile (Leica Zeno Office on ArcGIS only) 

1. Optionally, start an edit session in LEICA Zeno Office. Ca
an edit session, but you won't be able to undo the calcul

lculating a field is faster outside of 
ation. 

2. Open the attribute table of the layer you want to edit. 
ld holding length values you can 

4. 
. 

6. 

3. Right-click the field heading for length (if there is no fie
add a new field for length by clicking the options button and selecting the new field 
option). 
Click Calculate Values. 
Check Advanced. 
Type the following VBA statement in the first text box:  

5

      
      Dim dblLength 
as double 
      Dim pCurve as 
ICurve 
      Set pCurve = 
[shape] 
      dblLength = 
pCurve.Length    
   
  

7. Type the variable dblLength in the text box directly under the length field name. 
8. Click OK. 
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Tip 

• The property length returns a field type of double. For best results, your 
length field should also be a double field type. 

Adding the x,y coordinates in a point layer to a new field (Leica Zeno 
Office on ArcGIS only) 

1. Optionally, start an edit session in LEICA Zeno Office. Calculating a field is faste
an edit session, but you won't be able to undo the calculation.  

r outside of 

2. 
3. 

e Options button and selecting the new field option). 
4. 
5. 
6. 

Open the attribute table of the layer of the layer you want to edit.  
Right-click the field heading for the X field (if there is no X field you can add a new field by 
clicking th
Click Calculate Values.  
Check Advanced.  
Type the following VBA statement in the first text box.  

      
      Dim dblX As 
Double 
      Dim pPoint As 
IPoint 
      Set pPoint = 
[Shape] 
      dblX = pPoint.X  

7. Type the variable dblX in the text box directly under the X field name.  
8. Click OK.  

You can repeat the same process for updating a field with the y coordinates of each point 
in the layer. 

Tip 

• The property X returns a field type of double. For best results, your X 
field should also be a double field type.  

Ad a polygon layer to a new 
field

1. 

ding the x,y coordinates of the centroid of 
 (Leica Zeno Office on ArcGIS only) 

Optionally, start an edit session in LEICA Zeno Office. Calculating a field is faster outside of 
an edit session, but you won't be able to undo the calculation.  

2. 
3. 

4. 
5. 
6. t in the first text box.  

Open the attribute table of the layer of the layer you want to edit.  
Right-click the field heading for the X field (if there is no X field you can add a new field by 
clicking the options button and selecting the new field option).  
Click Calculate Values.  
Check Advanced.  
Type the following VBA statemen
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      Dim dblX As 
Double 
      Dim pArea As 
IArea 
      Set pArea = 
[Shape] 
      dblX = 
pArea.Centroid.X  

7. Type the variable dblX in the text box directly under the X field name.  

coordinates for the 
lygon in the layer.  

8. Click OK.  

You can repeat the same process for updating a field with the Y 
centroid point of each po

Tip 

• The property X returns a field type of double. For best results, your X 
field should also be a double field type.  

98 



Data Manager 

Con

Con

The D
click t ata 
conve  
geoda om several different formats. 

ted values based 
's format and the type of data it contains.  

With e Data 
Mana

verting Data 

verting data to a different format  

ata Manager of LEICA Zeno Office makes it easy to change a data source's format. Right-
he data source whose format you want to change and point to Export. A list of the d
rters that are appropriate for the selected data source will appear. Similarly, when a
tabase is selected, you can import data fr

The data converters are wizards, conversion parameters will be set to sugges
on the data source

LEICA Zeno Office you have the following possibilities (Right-click on the source in th
ger and select Export): 

ce Sour Target 

Survey Project ASCII, Leica System 1200 DBX, GSI, TDS, 
SDR, Geodimeter job 

Feature Class Geodatabase, Shapefile 

Geodatabase Geodatabase, Shapefile, dBase 

Layer Shapefile, Feature Class 

Feature Dataset, Feature Class XML (LEICA Zeno Office Professional only) 

Shapefile AutoCAD DXF 

Shapefile Atlas GIS File (AGF) 

ASCII Survey Project 

Leica System 1200 DBX Survey Project 

GSI Survey Project 

Geodimeter job Survey Project 

SDR Survey Project 

TDS Survey Project 
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How data is converted 

ICA Zeno Office to import spatial data from shapefilesUse the specific tools provided by LE , 
tables, and CAD feature classes into a geodatabase. 

Importing a shapefile, or CAD feature class by making use of such a tool generates a simple 
feature class to save both the geometry and attributes from the input data. As well as importing 
a table generates a table in the geodatabase while automatically registering it with the 
geodatabase system tables. 

Spatial reference 

 CAD feature classes because 

By default, using the import tools provided will ensure that the new feature class is specified at 
 projection as the one of the feature cl urce data. It is also possible to 

nt projection  

for the imported data. LEICA Zeno Office will the automatically.  

Spatial references must be specified when importing shapefiles and
then new standalone features, new feature classes and feature datasets, or a new feature class 
in an existing dataset will be created.   

the same
select a differe

ass of the so

n project the features 

Spatial index grid size 

When 
determ

using the import tools an approximate spatia ed. The grid size is 
ined by the spatial reference, the averag mber of features 

l grid size will be suggest
e feature size, and the nu

contained in the source file. 

 

Importing a geodatabase fea

Importing a geodatabase feature class can be done using the "Feature class to Geodatabase" 
er to import feature cla eodatabase to another, or to 

import features from one feature class into a new feature class within the same geodatabase. 
eby only simple feature classes will be gen  preserved object identity. 

ture class 

tool. You can choose eith sses from one g

Wher erated without a

 

Copying and moving geodatabase data 

LEICA Zeno Office also provides tools to copy and move geodatabase data. Using these tools 
u copy both entire feature datasets and individual feature classes between geodatabases 

hile object identities and subtypes will be retained.   

Copying data is just possible, if the spatial reference of the feature class matches the feature 
dataset in which you want to paste the data. The existing feature dataset can either be in the 
same, or in a different geodatabase. 

 

lets yo
w

Data conversion versus data loading 

Before you can start to import shapefiles into a geodatabase each shapefile feature class has to 
be loaded into a new feature class.  
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Loading objects from other feature classes 

About loading objects from other feature classes  

To read some detailed information about the tools provided to convert shapefile and coverage
features, and INFO and dBASE tables to a geodatabase go to 

 
how data is converted. When 

converting such features and tables a new feature class or table has to be created since these 
tools and wizards do not support existing ones. To still run the import process for loading data 
into existing simple feature classes and tables LEICA Zeno Office provides the Simple Data 
Loader. 

How to load objects from other feature classes 

Adding the Load Objects command to LEICA Zeno Office 

click Data Converters. 
3. To add the Load Objects command, click it, then drag it from the Commands list and drop 

1. On the LEICA Zeno Office Standard toolbar, click View, point to Toolbars, and then click 
Customize. 

2. On the Commands tab, 

it on the Editor toolbar. 
4. Click Close. 

Loading data with the Load Objects command 

ropdown arrow to select a feature class or subtype into which to 
load the data. 

4. To start the Object Loader Wizard, click Load Objects. 

5.  
7. Repeat steps 4 and 5 until all of the source data is specified. 

11. Leave the Matching Source Field blank for any data that should not be loaded from a field 
in the source data into the target data. 

12. Click Next. 
ip to step 17. 
ded applying an attribute 

query, click the second option. 

 class or subtype into which you're loading data. Click No, 
to avoid validating the new features after they are loaded. 

20. Click Next. 
21. Control the options set for loading the data. To modify something, simply click Back to 

1. First, you must add your data to LEICA Zeno Office. 
2. Click Editor and click Start Editing. 
3. Click the Target Layer d

Browse to the source feature class.
6. To insert it to the list of source data, click Add. 

8. Click Next. 
9. You might want to match a source field with a field in the target feature class or table. 

Therefore, in the Matching Source Fields list, click the dropdown arrow and select the 
relevant field from the source data to match to the target field. 

10. Repeat step 9 until all of the fields to be loaded from the source data are matched. 

13. To load all of the source data, click the first option, then sk
14. To limit the features or rows from the source data to be loa

15. To open the Query Data dialog box, click Query Builder. 
16. Once you've created a query, click OK. 
17. Click Next. 

18. Click Yes, to have the loaded features to be snapped to existing features in your edit 
session. Click No, to avoid snapping the new features. 

19. Click Yes, to have any new invalid feature to be selected after the loading process by the 
rules associated with the feature

pass through the wizard. 
22. At the end, click Finish. The data is loaded. 
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Exporting data as DXF 

About exporting data as DXF 

You can export shapefiles to the CAD format AutoCADTM DXF. So if you want to export data from
a geodatabase or a feature dataset you have to convert the data into shape prior to the CAD
export. 

 
 

How to export data as DXF 

1.

2. 
 In the Data Manager tree, right-click the shapefile which you want to export into a dxf-file.  

Point to Export.  

me for the new dxf-file and click Finish or  

3. Click Shapefile to DXF...  
4. Select the desired decimals.  
5. Type in a na

6. If you want to export more than one shapefile click Batch.  
7. Add a new row and specify source, target and decimals (repeat if necessary).  
8. Click Finish  

 
Notes 

• The number of decimal digits to use when writing coordinates and other 
noninteger numbers in the DXF file. This must be a number from 0-9. 

t as point entities. • Point shapefiles are written ou

• Line shapefiles are written out as unclosed PolyLine entities in a block. 
Then an INSERT of the block is added to the entity section. Blocks are 
named BLKnnnnnn where nnnnnn is a number from 1-999999. 

•  
• Polygon shapefiles are written out as closed PolyLine entities in a block. 

Then an INSERT of the block is added to the entity section. Blocks are 
named BLKnnnnnn where nnnnnn is a number from 1-999999. 

• During the conversion additional attribute information about lines and 
points is extracted from the shape dbf file if the following items are 
present: 

• LAYER - A character that specifies the layer name. The default 
layer will be SHP_POINT, SHP_LINE or SHP_POLY depending on 
the type of the shapefile. 

• COLOR - A numeric item containing the color of each dxf entity. 
The default color is white (7). 

• ELEVATION - The Z value of the entity. The default is 0.0. 
• THICKNESS - A numeric item whose value is the thickness of the 

entity. The default is 0.0. 
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Import/Export survey data 

About converting survey data 

n 
hoice of different data collector formats, an ASCII import and export wizard allows 

you to import/export coordinates for survey points. 

You can import and export data collector files recorded using a total station or GNSS sensor. I
addition to a c

Operation codes and feature codes 

ts include blocks of text that are used to describe methodologies used in 
y ent formats of operation codes and feature codes. These require 

a converters. The differences occur not only between different 
h converter format. 

r formats: 

 1200 DB

Data collector file forma
the field.  There are man  differ
a variety of different survey dat
data converter formats but also for eac

Leica Zeno Office supports the following survey data converte

• ASCII 
• Leica System  
• Geodimeter 
• GSI 
• SDR 

Coordinate 
TDS Raw 

• TDS 
• 

Defining an import or export template for ASCII files 

Survey point data is often stored in ASCII files in a variety of d
I port/Export wizard lets you create templates that define the

ifferent formats. The ASCII 
 structure of these ASCII files. 

int attribute 
field s. You 
a he units used for 

es. 

m

When defining the template, you specify the special delimiter characters between po
s, or you interactively specify the start and end column positions for attribute field

 t en ecify how the converter should interpret these fields and specify tc n h sp
the coordinat

Importing/exporting coordinates from a local coordinate system 

Often a field survey will start with assumed coordinates based on an unknown coordinate 
rdinates into 

There are al inate 
system that es, you 
can select th e import file. 

system. The data exchange allows you to define a transformation to bring these coo
the projected coordinate system of the survey project.  

so cases in which the coordinates being imported have a projected coord
 is different from the coordinate system of the survey project. In these cas
e projected coordinate system for th

What is t

While in set. To 
identify the s y, you need to use the point prefix together with 
the point name. While naming these points in the field, you can separate the point name from 
the prefix using a separator character. 

he prefix separator must be specified for the importer so that it can correctly interpret the 
prefix and can search the correct project for the survey point identified in the importer file. 

he point prefix separator? 

 the field, you will often use survey points that already exist in your survey data
urvey point and its project correctl

T

Defining default standard deviations 
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When importing survey point coordinates, it is possible to also import the error information in 
matrix. When the importer does not find this 

sign some default values that you define. 
the form of a standard deviation or covariance 
error information in the import file, it can as

Creating a log file 

The importer and exporter will allow you to specify the name and location of a log file that 
records the results of an import. 

How to convert data 

Import Survey Data 

ck Data > Import Survey Data on 
the Survey Dataset layer. 

rmat of the file that 
you want to import. 

e Browse button and navigate to and select the data collector file or ASCII file. 
e its path and name. 

orting an ASCII file format, skip to step 12. 
the Operation Code Handler dropdown arrow and choose the code handler you 
to use for your selected file format. 

peration Code Settings specific to the code handler you selected. Click OK 
eration Code Settings dialog box. 

 
12. If you want to use an existing import template, click the Format Template dropdown 

Otherwise, follow steps 13 through 28 to create a new ASCII import template. 

.  
16. Click Free for files that have a special character between coordinate fields and point 

d type a 
keyword if required. 

21. Skip to step 26 if you clicked Position on the previous page of the wizard. 

24. Right-click a column header and click the field type that it represents. 
 should be identified for import. 
d click the unit type for the coordinates in the 

ASCII file. 

ted. 

31. Click the second option if you want to specify that the source file has a projected 
he target project, or that it has a local 

coordinate system. 

1. Right-click the survey project into which you want to import the survey data in the Data 
Manager tab or right-click the Survey Dataset layer in the Display tab. 

2. Click Import Survey Data in the Data Manager or cli

3. Click the Survey Data Converter dropdown arrow to choose the fo

4. Click th
You can also directly typ

5. Click Properties.  
6. If you are imp
7. Click 

want 
8. Click Settings. 
9. Change the O

on the Op
10. Click OK on the Survey Format Properties dialog box. 
11. Skip to step 30 if you are not importing an ASCII coordinate file.

arrow to select it, then skip to step 29. 

13. Click New to create a new template. 
14. Type a name and description for the template. 
15. Click Next

name fields; otherwise, click Position to use interactive field-column definition. 
17. Type the number of lines to ignore at the top and the bottom of the text file, an

18. Click Next. 
19. Check all the types of delimiters that should be used to identify columns. 
20. Click Next. 

22. Click the header row in the horizontal position where two field columns should be 
separated. 

23. Repeat step 22 for all the fields. 

25. Repeat step 24 for each of the fields that
26. Click the Linear Units dropdown arrow an

27. Click Finish. 

The template is created. 

28. Click the Template name dropdown arrow and click the new template you crea
29. Click OK. 
30. Click Next. 

coordinate system that is different from t
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Otherwise, skip to step 35. 

32. Click Transformation. 
33. Click the Transformation Method dropdown arrow and click the method you want 

34. Type the transformation parameters, if required, and click OK. 

rd deviations for position and elevation. 
38. Click Next. 

 navigate to the location in which you want to save 
g file name and click OK. You can also directly type its 

path and name. 
 click OK on the Import Survey Data Wizard dialog box. 

   

to use. 

35. Click Next. 
36. Type the point prefix separator string. 
37. Type default standa

39. Click the Browse button and
the log file. Provide a lo

40. Click Finish and

Tip 

• To remove a column, right-click the column header and click Remove. 

   

Export Survey Data 

1. Right-click the survey project from which you want to export the survey data in 
anager tab or right-click the Survey Dataset layer in the Display tab. 

 to choose the format you want 

e 

5. Enter a file name and click Save. 
settings. 

7. If you are exporting an ASCII file format, skip to step 13. 
dropdown arrow and choose the code handler 

se an existing export template, click the Format Template 

 template. 

rt column header and a footer. 
reation date. 

 
to the right column get exported. Please note, that the same order will be 

23. Click 
24. r text (optional). 
25. Click Finish. The template is created. 

ption if you want to specify that the source file has a 

the Data M
2. Click Export Survey Data in the Data Manager or click Data > Export Survey Data 

on the Survey Dataset layer. 
3. Click the Survey Data Converter dropdown arrow

to export survey data to. 
4. Click the Browse button and navigate to the folder in which you want to store th

exported data. 

6. Click Properties. Please note, that not every converter requires additional 

8. Click the Operation Code Handler 
you want to use for your selected file format. 

9. Click Settings. 
10. Change the Operation Code Settings specific to the code handler you selected. 

Click OK on the Operation Code Settings dialog box. 
11. Click OK on the Survey Format Properties dialog box. 
12. Skip to step 28 if you are not exporting an ASCII coordinate file. 
13. If you want to u

dropdown arrow to select it, then skip to step 27. 
wise, follow steps 15 through 25 to create a new ASCII export14. Other

15. Click New to create a new template. 
16. Type a name and description for the template. 
17. Click Next.  
18. Specify if you want to expo
19. Select how the survey points should be sorted, e.g. by name or c
20. Specify the separator character. 
21. Click Next. 
22. Use the arrow buttons to select the attributes which should be exported. All values

moved 
used. 

Next. 
Define a header and foote

26. Click the Template name dropdown arrow and click the template you want to use. 
27. Click OK. 
28. Click Next. 
29. a) Click Next if the survey points to be exported are in the coordinate system of 

the target survey project. 
b) Click the second o
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projected coordinate system that is different from the target project, or that it has 
a local coordinate system. Specify the coordinate system or Transformation. 

 

30. Click Next. 
31. Choose if you want to export the current coordinate of a point or if you want to 

export all coordinates of a point. Click Next. 

Tip 

• The system computes automatically a mean coordinate for survey 
points including more than one coordinate. This coordinate is set to 
current by default.  

 

1. the unit and rounding (precision) which should be used for the exported 
data. 

3. Click the Browse button and navigate to the location in which you want to save 
the log file. Provide a log file name and click OK. You can also directly type its 
path and name. 

4. Click Finish. 

Choose 

2. Click Next. 
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Import of System 1200/900 data 

About importing data from Leica System 1200 and GPS 900 
sensors 

You can d  
Leica GPS 900
measurements as well as featur rmation stored in feature classes. 

The importer creates for every code in the source data a new feature class in the database.  

Naming convention:  
Points: 
Lines: ame'_code description'  

me'_code description'  

The code de
   

Imported feature can be reviewed for QC and afterwards merged with existing feature classes. 

irectly import data from Leica System 1200 GNSS and TPS sensors as well as from
 sensors. The import includes survey data like survey points and TPS 

e including code info

      SFPNT_'code name'_code description'  
E_'cod       SFLIN e n

Polygons:  SFPOLY_'code na
Example:   SFPNT_TREE_TR  

scription is ignored if not available in the imported data.  

How to import data from Leica System 1200 and GPS 900 

Import of survey data 

1. Right-click the Survey Dataset layer in the Display tab. 
2. Click Data > Import Survey Data. 
3. Select the Project in which you want to import the data and click Next. 
4. Click the Survey Data Converter dropdown arrow to choose Leica System 1200 DB 

Converter. 
5. Click the Browse button and navigate to and select the file you want to import. 
6. Click Next.  
7. a) Click Next if the survey points to be imported are in the coordinate system of the target 

survey project. 
b) Click the second option if you want to specify that the source file has a projected 
coordinate system that is different from the target project, or that it has a local coordinate 
system. Specify the coordinate system or Transformation and click Next. 

8. Enter a point prefix separator string, e.g. SP for survey point (optional). 
9. Type default standard deviations for position and elevation either using basic entry or 

advanced entry (optional). 
10. Click Next. 
11. Click Finish. The data gets imported and shown in the map.   

Tip 

• A feature class gets created in the database for every code included in 
the imported data. The data gets automatically added to the map 
document. 

• You can also import survey data by right-click on a survey project in 
Data Manager tab. Using this approach the layers don't get added to the 
map automatically. 

Merge imported feature into existing feature classes without attributes 
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U
th

se this approach if features with code only where collected (no attributes). The codelist and 
e data model of the target feature classes can be different.  

e classes and edit the features if 
necessary. 

2.

y Attributes or Select By Location. 

1. Review the imported data in the temporary featur

 Select all features of a single feature class which should be transferred to a target feature 
class. This can be done interactive by using the Select Features tool or automatically using 
Select B

3. Click the Copy Feature tool  which can be found in the category Leica Survey Featur
Tools of the Customize dialog. 

4. Select a Target Layer to which the selected features should be copied. Point featur
only be copied to point feature classes, polyline and polygon features can be copie

e 

e can 
d to 

both, polyline and polygon feature classes. 

transferred objects should be kept only. 
age indicates the successfully completed operation. Click OK again. 

5. Check Delete Original Feature if desired (optional). This can be helpful if not yet 

6. Click OK. A mess

Tip 

• For interactive selection it can be helpful to set the selectable layers. For 
that click Selection > Set Selectable Layers... Alternatively turn other 
layers off. 

M

U and attributes where collected. The codelist and the data 
m es need to be the same.  

 edit the features if 

o a target feature 
 using 

tributes or Select By Location. 

erge imported feature into existing feature classes with attributes 

se this approach if features with code 
odel of the target feature class

1. Review the imported data in the temporary feature classes and
necessary. 

2. Select all features of a single feature class which should be transferred t
class. This can be done interactive by using the Select Features tool or automatically
Select By At

3. Select the target feature class as target in the Editor toolbar. 
4. Click Copy. 
5. Click Paste. 

Tip 

• For interactive selection it can be helpful to set the selectable layers. For 
that click Selection > Set Selectable Layers... Alternatively turn other 
layers off. 

• The attribute names and data types in the codelist have to match with 
the target feature class to ensure correct attribute mapping.  

• Feature class names need to be the same, but are case 
insensitive. 

• Data types need to be compatible. Example: a value from type 
double  can be added to a text field, but a value from type text 
cannot be added to a double field. 
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Export of System 1200/900 data 

About exporting data for Leica System 1200 and GPS 900 
sensors 

You can directly export data for Leica System 1200 GNSS and TPS sensors as well as for Leica 
GPS 900 sensors. The export includes survey points including quality information which can be
used in the field e.g. as control points. 

 

How to export data for Leica System 1200 and GPS 900 

Export of survey data 

1. Right-click the Survey Dataset layer in the Display tab. 
 

ey Data Converter dropdown arrow to choose Leica System 1200 DB 
Converter. 

5. Click the Browse button and navigate to the folder in which you want to store the exported 
data. 

7. Click 

the source file has a projected 
coordinate system that is different from the target project, or that it has a local coordinate 

u want to export the current coordinate of a point or if you want to export all 

2. Click Data > Export Survey Data. 
3. Select the Project from which you want to export the data and click Next.
4. Click the Surv

6. Enter a file name and click Save. 
Next.  

8. a) Click Next if the survey points to be exported are in the coordinate system of the target 
survey project. 
b) Click the second option if you want to specify that 

system. Specify the coordinate system or Transformation and click Next. 
9. Choose if yo

coordinates of a point. Click Next.  

 

Tip 

• The system computes automatically a mean coordinate for survey points 
including more than one coordinate. This coordinate is set to current by 
default.  

 

9.

 

 Click Finish. The data gets exported.  

Tip 

• You can also export survey data by right-click on a survey project in 
Data Manager tab. 
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Select Features 

Selecting features 

About selecting features  

Before working with features or viewing their attributes, you have to select the relevant features 
by either using the Edit tool to click on them or to draw a box around multiple features. 

As soon as you select a certain number of features this number will be shown in the lower-left 
corner of the LEICA Zeno Office window. In the center of the selection set, a small "x" is 
displayed to indicate the selection anchor to which tasks like rotating, moving, or scaling are 
referred. 

Assign layers to be selectable or not using the Edit tool. Therefore, in the Selection menu 
choose Set Selectable Layers and use the Selectable Layers list. 

How to select features 

Selecting features using the Edit tool 

1. Click the Edit tool . 
2. Point over a feature and click. 

The selected feature is highlighted. 

Tips 

• You might want to select several features. Thus, either hold down the 
Shift key while selecting the features. Or drag a box around a group of 

features with the Edit tool . 

• If you want to select several features in an area, click once with the Edit 
tool, keep the mouse button pressed, and drag a box around the 
features. To select the features, release the mouse button.  

Making a layer selectable 

1. In the Selection menu, click Set Selectable Layers. 
2. To enable selecting a layer, check the check boxes next to its name. Otherwise, uncheck 

the boxes. 

Layers having their names unchecked will still be displayed on the map. 
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Identifying features 

About identifying features  

To identify a feature on the map, just point to the feature, pause your mouse, and a map tip 
appears. To get more information about a feature, using the Identify tool will show the 
attributes of the feature. 

Step through the topic of exploring features on a map. 

How to identify features 

Identifying features by pointing to them 

1. Click on Identify  on the Tools toolbar. 
2. Point your mouse over the relevant feature. Once you've clicked, an identification text box 

appears for all the features in all visible layers under the pointer. 

Displaying map tips 

1. Right-click the desired layer for which to display map tips in the table of contents and click 
Properties. 

2. On the Display tab check Show Map Tips. 
3. On the Fields tab click the Primary display field dropdown arrow to select the relevant 

attribute field to be shown as a map tip. 
4. Click OK. 
5. Point your mouse over a feature to see the map tip. 

Tip 

• If no map tip appears even after having enabled them, check if the layer 
is turned on and the features contained in the layer are not being hidden 
by features in overlapping layers. 
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Selecting features by searching with an SQL expression 

About selecting features by searching with an SQL 
expression  

LEICA Zeno Office lets you define a SQL expression of one or more criteria to select features or 
table records in any data format supported. The criteria can contain attributes, operators, and 
calculations. 

SQL stands for Structured Query Language. 

How to select features by searching with an SQL 
expression 

1. In the Selections menu, click Select By Attributes. 
2. Click the Layer dropdown arrow to select the layer that consists of the relevant features. 
3. Click the Method dropdown arrow to choose a selection method by clicking it. 
4. To add a field name to the expression box, double-click the field. 
5. To add an operator to the expression, click it. 
6. If you click the Complete List button you can view all your values. Double-clicking a value 

adds it to the expression. 
7. Click the Verify button to ensure that you're using proper syntax or that the criteria you've 

defined will select any features.  
8. Click OK. The number of features selected appears in the status bar at the bottom of the 

LEICA Zeno Office window. 

Tips 

• On the Select By Attributes dialog box you'll find the Query Wizard 
button. Clicking that button lets you generate the selection expression, if 
you've never selected features by their attributes before. 
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Selecting features interactively 

About selecting features interactively  

If you click a feature, or drag a box around a feature, or select a record of a feature in the 
attribute table , then a feature will be selected and it gets highlighted on the map. You might 
want to specify the layers from which you are going to select features before using one of the 
methods mentioned. This is very helpful when features overlap with others from different layers 
or they are very close to each other. 

How to select features interactively 

Selecting features by clicking them in the map 

1. In the Selection menu, click Set Selectable Layers. 
2. Select the relevant layers. 
3. Click Selection, point to Interactive Selection Method, and then click Create New Selection. 
4. Use the Select Features tool to choose the desired feature by clicking it. 
5. Optionally, hold down the Shift key while selecting several features. Thus additional 

features get highlighted at once. You might want to remove a feature from the selected 
set. Do so by clicking the Selection menu, pointing to Interactive Selection Method, and 
then clicking Remove From Current Selection. Choose the feature, it then gets deselected. 

Tips 

• If you selected features you didn't want to, then either just click the map 
where there are no features or click a feature of a layer that is not 
selectable to deselect all desired ones at once. Or click the Selection 
menu and click Clear Selected Features. 

Selecting features by clicking them in a table 

1. In the table of contents, right-click a layer and click Open Attribute Table. 
2. Click to the left of a record to select a feature in the table. 
3. Hold down the Ctrl key while clicking several features, if you want to select additional 

ones. While still holding the Ctrl key, you can also deselect a selected feature, just click it 
again. 
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Selecting records in a table 

About selecting records in a table  

Selecting features can be done on different ways. One of the ways is to make use of an attribute 
table to interactively select records one at a time by pointing at them or selecting several 
records at once. 

As soon as some records are selected, the features referencing them get highlighted on the 
map. 

It is also possible to add to your selected set applying another selection method, read some 
more details about selecting at the topic of querying maps. 

How to select records in a table 

Interactively selecting records in a table 

1. First, you have to open the attribute table for a layer on your map. 
2. Click the leftmost column in the table next to the desired record. Click and drag the mouse 

to select records one after another. 
3. Press and hold the Ctrl key to add records to your selection set by clicking them. 

Selecting records in a table by attributes 

1. In the table to query, click Options and click Select By Attribute. 
2. Click the Method drop down arrow to choose a selection procedure by clicking it. 
3. Double-click the field you want to select from. 
4. Click the logical operator as desired. 
5. Either scroll to and double-click the value in the Unique sample values list you wish to 

select. Or type a value directly into the text box. 
6. To verify your selection click on Verify. 
7. Click OK. 

Selecting all records 

1. Click Options in the table. 
2. Click Select All. 

Clearing the selected set 

1. Click Options in the table. 
2. Click Clear Selection. 
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Selecting graphics 

About selecting graphics  

Once you've selected a graphic with the Select Graphics tool, selection handles will be drawn 
around the graphic and you'll be able to work with it. LEICA Zeno Office lets you also select 
several graphics at the same time. They all appear with selection handles, whereas one of them 
- the prior one - has blue selection handles and the remainder of them have green ones. The 
prior will be used, for instance, to align other graphics with. To change the priority, click on the 
desired graphic while holding down the Ctrl key.  

How to select graphics 

Selecting graphics one at a time 

1. Click on Select Graphics  on the Draw toolbar. 
2. Point over the graphic to select and click it. Selection handles indicate the selected 

graphic. 

Tips 

• To select a group of graphics at once, drag a rectangle around them. 

Selecting all graphics 

1. In the Edit menu, click Select All Elements. 
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Specifying how selected features highlight 

About specifying how selected features highlight  

Selected features can be highlighted in any color or symbol. Adjust the settings as you prefer 
either for all layers at the same time or for each layer particularly. 

How to specify how selected features highlight 

Specifying the highlight color for all layers 

1. In the Selection menu click Options. 
2. Click the color box to select a color. Either the edges of polygons or the entire point (line) 

will be highlighted in this color. 
3. Click OK. 

Specifying the highlight color for an individual layer 

1. Right-click a layer in the table of contents and click Properties. 
2. On the Selection tab click the With this color option and select the desired color. 
3. Click OK. Any setting made with the Selection Options dialog box will be overridden. 
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Displaying information about selected features 

About displaying information about selected features  

You may want to zoom to a feature or display its attributes or even create a report. To do so, 
just select the feature desired. 

 

How to display information about selected features 

Zooming to selected features 

1. Right-click the layer comprising the selected features in the table of contents. 
2. Point to Selection and click Zoom To Selected Features. The zooming is done 

automatically. 

Displaying the attributes of selected features 

1. Right-click the layer comprising the selected features in the table of contents. 
2. Click Open Attribute Table. 
3. Click Show Selected features to get  the records of the selected features automatically 

displayed . 
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Edit Features 

About survey-aware feature classes 

A survey-aware feature class can be edited in the following ways: 

• Existing features can be linked to survey points. An association between survey points 
and features is created; feature locations are not updated immediately. 

• Existing features that are linked can be updated to match the geometry of the survey 
points. 
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Adding and deleting vertices 

About adding and deleting vertices  

After having created a feature it is possible to reshape it by adding or deleting vertices. 
Therefore, you can update your features when receiving new or better geographic data. 

 

How to add and delete vertices 

Adding a vertex 

1. Start an Edit session. 

2. Click the Edit tool .  
3. Choose the relevant line or polygon to which to add a vertex by double-clicking it. 
4. Point to where the vertex shall be inserted and right-click. 
5. Click Insert Vertex. 
6. To finish modifying the line, right-click over any part of the sketch and select Finish Sketch 

from the context menu. 

Deleting a vertex 

1. Start an Edit session. 
2. Click the Edit tool . 
3. Choose the relevant line or polygon from which to delete a vertex by double-clicking it. 
4. Point over the desired vertex. As soon as the pointer changes, right-click and click Delete 

Vertex. 
5. Once you've finished the sketch by right-clicking over any part of the sketch and clicking 

Finish Sketch the feature will be reshaped. 
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Moving vertices 

About moving vertices  

Modifying how features are drawn can be done by moving a vertex in a sketch in different ways 
such as dragging the vertex, specifying new x,y coordinates, and moving the vertex relative to 
its current position. 

 

Dragging a vertex 

You might have obtained additional information of the features' location resulting in having to 
reshape the features. Therefore, it is possible to drag a vertex of a specific feature. 

 

Specifying new x,y coordinates 

You might even have obtained exact coordinate information of the features' location. Thus, you 
can specify new x, y coordinates for the vertices of a feature to locate it more precisely. 

For instance, resurveying a parcel can result in receiving new points for the parcel corner by 
using a Leica GPS sensor. Then it is possible to move the existing corner of the parcel to the 
new GPS Survey Point. 

 

Moving a vertex relative to its current location 

As a third option the vertex can also be moved relative to its current location. 

 

How to move vertices 

Dragging a vertex 

1. Click the Edit tool . 
2. Double-click the desired line or polygon whose vertex should be moved. 
3. Click to select the relevant vertex. 
4. Point over the vertex until the pointer changes. 
5. Then, click and drag the vertex to the new location. 
6. Click somewhere outside the selected feature to finish the operation. 

Moving a vertex by specifying x,y coordinates 

1. Click the Edit tool . 
2. Double-click the desired line or polygon whose vertex should be moved. 
3. Click to select the relevant vertex. 
4. Point over the vertex until the pointer changes. 
5. Then, right-click and click Move To. 
6. Set the x,y coordinates of the new location of the vertex. 
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The vertex is moved. 

7. Click somewhere outside the selected feature to finish the operation. 

Moving a vertex relative to its current location 

1. Click the Edit tool . 
2. Double-click the desired line or polygon whose vertex should be moved. 
3. Click to select the relevant vertex. 
4. Point over the vertex until the pointer changes. 
5. Then, right-click and click Move. 
6. Set the delta x,y coordinates to define the direction of moving. 

The vertex then gets moved. 

7. Click somewhere outside the selected feature to finish the operation. 
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Linking survey points to feature geometry 

About linking survey points to feature geometry  

You can create a link between a survey point and a feature vertex using the Link tool or the Link 
command. 

The Link tool lets you snap and click on a feature vertex and then snap to and click the related 
survey point.  

If there are many unlinked features that need to be associated with nearby survey points, you 
can use the Link command instead of the Link tool. The Link command operates on the 
selected features. For each feature vertex, the command finds nearby survey points and 
automatically creates links. Before processing, the command lets you specify the search 
tolerance for finding the survey points. While the Link command is running, more than one 
survey point may be found within the specified tolerance of any of the feature vertices. In these 
cases, a Link Conflicts dialog box appears that contains the set of locations for all places where 
conflicts were found. 

The Link Conflicts dialog box lets you view each of the conflicts individually, and allows you to 
directly create the appropriate links. When a conflict has been fixed, click the Solved button to 
remove it from the set. 

If necessary, you can close the Link Conflicts dialog box to continue with a different task, and 
then return to solve the remaining conflicts later in the edit session. You can do this by clicking 
Show Link Conflicts on the Survey Editor menu. 

After making the link between a survey point and a feature vertex, link-lines are displayed on 
the map.  

Each feature is aware of the survey points to which it is linked.  

You can change the scale at which the Link Conflicts window displays conflict locations. There 
are three methods for doing this: 

• Zoom percentage - lets you define a magnification based on the current map scale. 
• Absolute scale - lets you define the scale directly. 
• Scale relative to tolerance circle - You can also specify a display scale based on the 

tolerance that you specified for the link command. 

How to link survey points to feature geometry 

Using the Link tool 

1. Click the Editor menu on the Editor toolbar and click Snapping. 
2. Check Vertex for the feature layer to which you want to create links. 
3. Check Survey Points in the Snapping Environment window. 

4. Click the Link tool  on the Survey Editor toolbar. 
5. Snap to and click the vertex of the feature you want to link. 
6. Snap to and click the survey point you want to link the vertex with. 
7. Verify that the link line is displayed and that the link symbol is displayed on the feature 

vertex. 
8. Repeat steps 5 through 7 for each link you want to create. 

Tip 

• A single survey point may have links to multiple feature vertices. 
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Using

1. Zoom and pan the map to the scale and location of the features that you want to link to 
survey points. 

 the Link command and solving link conflicts 

2. Click the Edit tool  on the Editor toolbar. 
3. Click and drag a box around the features on the map to create a feature selection. 

5. ons dialog box, type a value for the linking tolerance. 
incid   

7. Click OK. 
8. 

r specified tolerance are 
linked to feature vertices. 

 tool 

4. Click the Survey Editor menu in the Survey Editor toolbar and click Link. 
In the Link Opti

6. Check Always link co ent feature vertices.

This ensures that vertices sharing the same location will automatically be linked. If this 
box is not checked, coincident vertices are treated as conflicts. 

Continue with steps 9 through 14 if the Link Conflicts dialog box appears. Otherwise, this 
task is complete; no conflicts occurred, and all points within you

 to create the correct links. 9. Use the Link
10. Click Solved once you have created the correct link. 

11. Click the Next Page  and Previous Page  buttons to navigate to the next conflict 
that you want to view or solve. 

icts or if you want to continue with a 12. Click Close if you have completed solving all confl
different task. 

13. Repeat steps 9 through 12 for each conflict as required. 
14. Return to the stored conflicts by clicking the Survey Editor menu on the Survey Editor 

toolbar and clicking Show Link Conflicts. 

Tip 

• When using the Link command, you can ensure that feature vertices that 
share the same location are automatically linked and not detected as a 
conflict by checking the Always link coincident vertices box. 

Flashing the location of the Link Conflicts window on the map 

1. Right-click inside the Link Conflicts window and click Flash Location. 

flashes on 
the map. 
The area on the map covered by the current view in the Link Conflicts window 

Tip 

• e location of a vertex displayed in the Link Conflicts window, To flash th
right-click in the window and click Flash Vertex. 

Displaying the scale of the Link Conflicts window as a factor of the link 
tolerance 

1. Right-click the Link Conflicts window and click Properties. 

alue for the factor. 
. 

2. Click Scale Relative To Tolerance Circle. 
3. Type a v
4. Click OK
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 scale of the Link Conflicts window using an absolute scale 

 Right-click the Link Conflicts window and click Properties. 
2. Click Absolute Scale. 

4. Click OK. 

Displaying the

1.

3. Click the Scale dropdown arrow and click the scale you want to use. You can also type the 
scale directly. 
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Breaking links between survey points and features 

About breaking links between survey points and features  

You must explicitly break links using either the Unlink tool or the Unlink command. The Unlink 
tool works by letting you click the survey point or vertex that you want to unlink. You can 
remove all the links for selected features using the Unlink command. 

How to break links between survey points and features 

Using the Unlink tool 

1. Click the Editor menu on the Editor toolbar and click Snapping. 
2. Check Vertex for the feature layer for which you want to remove links. 
3. Check Survey Points in the Snapping Environment window. 

4. Click the Unlink tool  on the Survey Editor toolbar.  
5. Snap to and click the vertex of the feature you want to unlink. 
6. If there are mulitple links to a survey point that need to be removed, snap to and click the 

survey point. 
7. Verify that the link lines and link symbols are no longer displayed. 
8. Repeat steps 5 through 7 for each link that you want to break. 

Using the Unlink command 

1. Zoom and pan the map to the scale and location of the features that you want to unlink. 

2. Click the Edit tool  on the Editor toolbar. 
3. Click and drag a box around the features on the map to create a feature selection. 
4. Click the Survey Editor menu on the Survey Editor toolbar and click Unlink. 
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Symbolizing feature links 

About symbolizing feature links  

Survey points often represent the location of features. It is possible to create links with their 
surveyed location. These links can be displayed on the map. 

Three different states in relation to survey data are existing: 

• Unlinked 
• Linked to survey points 
• Linked and snapped to survey points 

You can choose whether or not to display this information, and you can choose the symbols that 
should be used to represent the different link states. 

How to symbolize feature links 

Switching on symbols for feature links 

1. In LEICA Zeno Office, click the View menu and click Data Frame Properties. 
2. Click the Feature Link tab. 
3. Check Show Vertex States to display a link symbol on feature vertices that are linked and 

a snap symbol on feature vertices that are snapped. 
4. Check Show Link Lines to display link-lines between survey points and feature vertices. 
5. Click OK. 

Changing the symbols for feature links 

1. In LEICA Zeno Office, click the View menu and click Data Frame Properties. 
2. Click the Feature Link tab. 
3. Click the Snapped State Symbol Selector button. 
4. Click the Category dropdown arrow and click a symbol category. 
5. Scroll through the available symbols and click the symbol you want to use. 
6. Click Color to choose a color for the new symbol. 
7. Type a symbol size. 
8. Type a symbol rotation value if you want the symbol to be rotated. 
9. Click OK on the Symbol Selector dialog box. 
10. If you want to change the Feature Link Line symbol, click the Link Line Symbol Selector 

button and repeat steps 4 through 9. 
11. Click OK on the Data Frame Properties dialog box. 

Changing the scale range for feature link symbols 

1. In LEICA Zeno Office, click the View menu and click Data Frame Properties. 
2. Click the Feature Link tab. 
3. Click the Scale Range button. 
4. Click Don’t show when zoomed. 
5. Type the minimum scale in the Out beyond 1 text box. 
6. Click OK on the Scale Range dialog box. 
7. Click OK on the Data Frame Properties dialog box. 
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Updating features 

About updating features 

Survey points and the feature vertices they are linked to do not need to share the same 
location. However, links can be used to update the geometry of the features to coincide with the 
survey points. 

There are three different ways in which this update can be applied: 

• Linked vertices of the selected features are shifted to exactly match the location of 
survey points. Unlinked vertices remain unaltered. 

• Linked and unlinked feature vertices are all shifted in response to a transformation. The 
transformation parameters are defined based on the existing links. The final locations of 
the linked vertices may not coincide with their associated survey points. 

• A combination of both the above methods. The transformation is applied first, then the 
linked vertices are shifted to exactly match the location of survey points. 

Different types of transformations - Simple, Affine, and Helmert transformations - are available. 
The type that can be used depends on the number of links: 

• For one link, a translation is applied to all selected features (Simple transformation). 
• With two links, a rotation, translation, and scale are applied to all selected feature. 
• For more than two links, you can choose a Helmert or an Affine transformation. 

How to update features 

1. Zoom and pan the map to the scale and location of the features that you want to update. 

2. Click the Edit tool  on the Editor toolbar. 
3. Click and drag a box around the features on the map to create a selection of the features 

that you want to update. 
4. Click the Survey Editor menu on the Survey Editor toolbar and click Update Feature 

Vertices. 
5. Check Set feature vertex to the location of the survey point if you want the linked feature 

vertices to exactly match their survey point locations. 
6. Check Apply transformation algorithm if you want to transform the unlinked feature 

vertices based on the existing links. 
7. Click the transformation dropdown arrow and click the transformation method you want to 

apply. 
8. Click OK. 
9. Confirm that the update occurred as expected by verifying the features’ new locations and 

their link symbology. 
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Copying and pasting features 

About copying and pasting features  

Besides copying and pasting attributes of a feature LEICA Zeno Office lets you also edit the 
feature by itself. Make use of the tools available on the Standard toolbar to copy a feature and 
paste it into another layer taking into account that the source and target layer are of the same 
type (point, line, or polygon). Only copying polygon features into line layers is enabled. 

To ensure copying features combined with their attributes the copy has to be pasted into the 
same layer as the original feature. 

 

How to copy and paste features 

Copying and pasting features using basic editing tools 

1. Click the Target Layer dropdown arrow to select the layer consisting of the relevant type of 
features to copy. 

2. Click the Edit tool . 
3. Select the desired feature. 

4. Click on Copy  on the LEICA Zeno Office Standard toolbar. 

5. Click on Paste  on the LEICA Zeno Office Standard toolbar. 

Thus the feature is pasted on top of the original one. 
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Copying parallel line features 

About copying parallel line features  

The task of copying parallel line features is available in the Copy Parallel menu. If you want to 
have the same line feature copied parallel at a specific distance to the original feature make use 
of this command. To have the feature copied to the right (left) side of the original line feature 
set a positive (negative) distance.  

 

How to copy parallel line features 

1. Click the Edit tool . 
2. Select the relevant line to copy. 
3. Click the Target Layer dropdown arrow to choose the layer to which the new line should 

belong. 
4. In the Editor menu, click Copy Parallel. 
5. Specify the distance (in map units) the copied should be pasted at. 
6. Select the desired method: Mitered, Bevelled or Rounded 
7. Press Enter. 

A parallel copy of the line is drawn at this distance from the original feature. 
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Combining features from different layers 

About combining features from different layers  

A new feature can also be created by combining several features into one. The features can be 
contained within different layers whereas the type of the different layers has to be the same. To 
perform that task make use of the Union command, the new feature without any attribute 
values will be created in the current layer whereby the original features and attributes are 
retained.  

 

How to combine features from different layers 

1. Click the Edit tool . 
2. Select the relevant features to be combined into one. 
3. Click the Target Layer dropdown arrow to choose the desired layer to which the new 

feature should belong. 
4. On the Editor menu, click Union. 
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Moving and rotating features 

About moving features  

Moving features can be done by either dragging, specifying delta x,y coordinates, or by rotating. 
To place features associated to other features more precisely use snapping. 

 

Dragging 

Use the edit tool to drag a feature when you know where you want to place it.  

 

Specifying x,y coordinates 

To locate a feature more precisely enter x, y coordinates of the new location considering the 
current location of the selected feature as the origin (0,0) of the local coordinate system. 

 

 

Specifying positive (negative) x-values will move the feature to the right (left), positive 
(negative) y-values up (down). 

 

Rotating 

The third option to move a feature is to use the Rotate tool. Thus select the tool and rotate the 
selected feature to a particular orientation by dragging the mouse pointer. Alternatively, you 
can adjust a rotation angle so that the relevant features will automatically be rotated around a 
selection anchor - indicated as "x" in the center of the features). 

 

Using snapping 

To simplify the precise placement of features in association to other features the snap tool is 
provided by LEICA Zeno Field. Set up the snapping environment to perform that task. 
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How to move or rotate features 

Dragging a feature 

1. Click the Edit tool . 
2. Select the relevant feature(s) to move. 
3. Click and drag the feature(s) to the new location. 

Moving a feature relative to its current location 

1. Click the Edit tool . 
2. Select the relevant feature(s) to move. 
3. In the Editor menu, click Move. 
4. Set the relevant coordinates and press Enter. 

Tip 

• On the LEICA Zeno Field Standard toolbar you'll find the Undo button. 
Click it to undo edits.  

Rotating a feature 

1. Click the Edit tool . 
2. Select the relevant feature(s) to move. 

3. Click on Rotate . 
4. To rotate the feature to a particular orientation, click over any part of the map and drag 

the mouse pointer. 

Tips 

• The selection anchor is used as the center point to rotate features 
around it. You might want to move the selection anchor. Therefore, point 
over it, press the Ctrl key, and drag the selection anchor to the new 
location. 

• To rotate a feature by a specified angle, click the Rotate tool, press A, 
and set the desired number of degrees. A positive number indicates a 
clockwise direction; a negative number a counterclockwise direction. The 
current orientation is set to 0 degrees, so that the angle is applied 
relative to it.  
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Scaling features 

About scaling features  

The Scale tool lets you scale a feature based on a selection anchor that is usually placed in the 
center of the feature you selected. A small "x" indicates the selection anchor. For instance, 
several features can be scaled to fit together in a more accurate way than they do at the current 
scale. 

Access the Scale tool from the Editor toolbar. In general, the tool has to be inserted to the 
toolbar. Therefore, open the Customize dialog box and select it from the Editor category on the 
Commands tab. 

How to scale features 

1. Click the Edit tool . 
2. Select the relevant feature. 

3. Click the Scale tool . 
4. You might want to move the selection anchor. 
5. To scale the feature, click and drag the pointer over it. 
6. To finish scaling the feature, release the mouse button. 
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Deleting features 

About deleting features  

Deleting features from the map and the database can easily be done using the Delete button. 

 

How to delete features 

1. Click the Edit tool . 
2. Click the desired feature to delete. 

3. Click on Delete  on the LEICA Zeno Field Standard toolbar or click Delete in the Edit 
menu. 
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Exporting selected features 

About exporting selected features  

To be able to work with a set of selected features outside of the current layer you're working on 
it is possible to export that set to either a new shapefile or geodatabase feature class, or to a 
new layer only created for this set of features. 

 

How to export selected features 

Exporting selected features to a new data source 

1. First, select features using any selection method (interactively, according to location, or by 
attribute). 

2. Right-click the layer comprising the selected features, point to Data, and then click Export 
Data. 

3. Click the Export dropdown arrow to choose Selected Features by clicking. 
4. Click Use the same coordinate system as this layer's data source. 

5. Click on Browse  and navigate to where the exported data should be saved. 
6. Type the name for the output data source. 
7. Click the Save as type dropdown arrow to select the output type. 
8. Click Save. 
9. Click OK. 

Creating a new layer from the selected features 

1. First, select features using any selection method (interactively, according to location, or by 
attribute). 

2. In the table of contents, right-click the layer, point to Selection, and then click Create 
Layer From Selected Features.  

3. The new layer is added to the map. 
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Changing the properties of a sketch 

About changing the properties of a sketch  

The Sketch Properties dialog box is provided to modify the properties of a sketch you're working 
with. There are several options to choose from such as  

• remove parts from a multipart feature, or  
• add and delete vertices. 

 

How to change the properties of a sketch 

Deleting multiple vertices from a feature 

1. Click the Edit tool . 
2. Choose the relevant feature to modify the shape of by clicking it. 
3. To make changes, double-click the feature.  
4. Right-click one of the vertices and select Properties. 
5. Choose the relevant vertices to be removed by holding down the Shift key and clicking 

vertices from the table. To select several vertices at once, use the Shift or Ctrl keys. 
6. Either, press the Delete key. Or right-click over each of the selected vertices and click 

Delete Vertex.  
7. On the Edit Sketch Properties dialog box, click Finish Sketch. 

Inserting a vertex at the midpoint of a segment 

1. Right-click over a segment of the edit sketch and click Properties. 
2. Choose the relevant vertex to insert a new vertex before by selecting it in the list. 
3. Right-click the selected vertex and click Insert Before. 
4. Click OK. 
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Creating point features and vertices 

About creating point features and vertices  

Vertices only differ from point features in being connected by segments and therefore 
characterizing line or polygon features. But both are created the same way. 

See the sections below to get to know the different ways of generating point features and 
vertices. 

 

Screen digitizing 

The Sketch tool lets you screen digitizing. Thus you can design point features and sketch 
vertices very easily. In addition, making use of the snapping environment will simplify the 
precise placement of points and vertices. 

 

Using the map's coordinate system (Absolute X,Y) 

A point or vertex can also be generated by using the map's coordinate system as the origin. 
Therefore, select the Absolute X, Y tool. 

 

Relative to the location of the last vertex (Delta X,Y) 

Instead of the coordinate system you can also use the last vertex in the sketch as the origin for 
creating a new vertex. Therefore, select the Delta X, Y tool. 

 

Using the Distance–Distance tool 

If the exact coordinates to locate a new point or vertex are not available you can use the 
Distance-Distance tool to generate a new feature. For instance, you can locate a point at a 
specified intersection at a distance of 10 map units from the corner of one building and 20 map 
units from the corner of another. 

 

Using the Direction–Distance tool 

Instead of specifying distance information for two points, it is possible to just define a distance 
from one point and a direction from another. A bearing line will be established to create a 
vertex. 

 

Using the Intersection tool 
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The Intersection tool lets you define an intersection of two segments which don't have to 
necessarily intersect on the map. Thus the tool will imply the intersection to place the new point 
or vertex. 

 

Multipoint features 

LEICA Zeno Field also provides tools to define multipoint features. 

 

How to create point features and vertices 

Creating a point or vertex by digitizing 

1. Right-click in the Survey Feature tab and select a new point feature class. 

2. Make sure that the Absolute X, Y tool is active. 
3. To create the point, simply click on the map. 

The generated point or vertex is marked as selected on the map. 

Creating a point or vertex using the map's coordinate system (Absolute 
X, Y) 

1. Right-click in the Survey Feature tab and select a new point feature class. 

2. Click the Absolute X, Y tool  
3. Specify the coordinates.  
4. Press Enter. 

Creating a vertex relative to the location of an existing vertex (Delta X, 
Y) 

1. Right-click in the Survey Feature tab and select a new point feature class. 

2. Click the Delta X, Y tool  
3. Select the vertex or type in the name of the vertex 
4. Specify the delta coordinates 
5. Press Enter. 

Creating a point or vertex using the Distance–Distance tool 

1. Right-click in the Survey Feature tab and select a new point feature class. 

2. Click the Distance-Distance tool  
3. Select the centerpoint of the first circle. 
4. Specify the radius length for the first circle and press Enter. A circle will be drawn at the 

map. 
5. Select the centerpoint of the second circle. 
6. Specify the radius length for the second circle and press Enter. A second circle will be 

drawn at the map. 

When pointing over the two locations where the radii of the circles intersect they will get 
highlighted. 

7. Select the desired solution from the dialog box or from the map. 
8. Press Enter. 
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Creating a point or vertex using the Direction–Distance tool 

1. Right-click in the Survey Feature tab and select a new point feature class. 

2. Click the Direction-Distance tool  
3. Click a point to define from where to measure the direction to the next vertex. 
4. To obtain an approximate direction toward the next vertex, move the pointer. 
5. Specify the direction by typing in the value or clicking into the map. 
6. Press Enter. 
7. Click a point to define from where to measure the direction to the next vertex. 
8. To obtain an approximate direction toward the next vertex, move the pointer. 

A circle will be dragged out automatically as soon as you move the cursor. The centerpoint 
of the circle is at the second point defined and the direction line specified is intersected by 
the circle. To set the size for the circle, press the D key, type a distance in map units to 
the new vertex or click into the map and press enter. One of the two intersection points 
will be the new vertex. 

9. Thus select the one of the intersection points which corresponds to the position of the new 
vertex. Either one or the other intersection point is highlighted depending on which one is 
closer to the cursor. As soon as you click the highlighted point, the new vertex will be 
located. 

10. Press Enter. 

Creating a point or vertex using the Intersection tool 

1. Right-click in the Survey Feature tab and select a new point feature class. 

2. Click the Intersection tool  
3. If you want to work with offsets, check the appropriate box 
4. Place the pointer - displayed as crosshairs - over the first desired segment to create an 

intersection with, and click. 

A line extends from that segment across the map display. Thus the first angle used to 
construct the point of intersection is visible. 

5. Place the crosshairs over the second segment and click. 
6. Specify the offsets. 

7. The implied intersection is generated and the new vertex or point will be located at this 
intersection point. 

8. Press Enter. 

Creating a multipoint feature 

1. Right-click in the Survey Feature tab and select a new multipoint feature class. 

2. Make sure that the Absolute X, Y tool is active. 
3. To establish parts of the multipoint feature, click on the map. 
4. When the last point of the multipoint feature is created, right-click over any part of the 

map and click Finish Sketch. 
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Creating segments that are circular arc curves 

About creating segments that are circular arc curves  

It can be useful to create a circular arc curve. Choose on of the methods provided to perform 
this task: 

Using the Arc tool 

The Arc tool lets you create arcs by defining three points. 

Using the Tangent Curve tool 

The Tangent Curve tool lets you create a tangent curve thereby two parameters have to be 
defined. There are several options to do so: arc length, chord, radius, or delta angle. 

In addition, the placement of the curve has to be established, either to the left or to the right of 
the line referring to the drawing direction of the line. The curve then gets generated starting at 
the last vertex of the existing segment. 

 

How to create segments that are circular arc curves 

Creating a segment that is a circular arc curve using the Arc tool 

1. Right-click in the Survey Feature tab and select a new polyline or polygon feature class. 

2. Start the Add three point Arc tool  
3. To define the startpoint of the arc, click once or accept the last vertex. 
4. Click the second point of the arc. 
5. To define the endpoint of the arc, click once again. 

Creating a segment that is a circular arc curve using the Tangent Curve 
tool 

1. After having created a segment using one of the other sketch tools, start the Add 

tangential arc tool  
2. When moving the cursor, the arc remains tangent to the previous segment by bending and 

changing length automatically. 
3. To set the endpoint of the arc, click once again. If you select the endpoint of an existing 

line, this line will be used as tangent of the endpoint. 
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Drawing points, lines, and circles 

About drawing points, lines, and circles  

Several graphic shapes - such as points, lines, circles, and polygons- are provided to display 
cartographic elements on the layout and to highlight features within the data. 

If you are in layout view, you can easily add a graphic to the map layout. Whereas in data view, 
you can display the graphic combined with your data. 

How to draw points, lines, and circles 

Adding a graphic 

1. On the Draw toolbar select the type of graphic to add. 
2. To add the graphic you have to point over the display and to click the mouse. It might be 

that you have to click more than once, for instance, to add a rectangle (click and drag the 
mouse pointer). 

Deleting a graphic 

1. Click on Select Graphics  on the Draw toolbar. 
2. Select the graphic that should be deleted. 
3. Right-click, point to delete and click. 

Changing the color or symbol of a graphic 

1. Click on Select Graphics  on the Draw toolbar. 
2. Double-click the graphic to view its properties. The properties differ depending on the type 

of graphic selected. 
3. You may want to modify the fill color. Thus click the Fill Color dropdown arrow to select a 

new color. 
4. Click OK. 

Editing vertices of a graphic 

1. Click on Select Graphics  on the Draw toolbar. 
2. Click the relevant graphic of which to edit the vertices. 

3. Click on Edit Vertices  on the Draw toolbar.  
4. Right-click over the line and click Add Vertex.  
5. To delete a vertex, right-click over a vertex and click Delete Vertex. 
6. To move a vertex, click and drag it. 

Converting features into graphics 

1. In the table of contents, right-click the desired layer to be converted to graphics. 
2. Click Convert Features to Graphics. 
3. To convert all features, click All. To convert just the selected features, click Selected. 
4. Click OK. 

Tip 

• Once you've added a graphic to your map, you can move it, resize it, 
change its color, or edit it. To change the location of features relative to 
each other it is therefore really useful to convert the features within a 
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layer to graphics. Using this method the source data represented by the 
features' layer will be retained. 
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Extending lines 

About extending lines  

Contrary to Trimming lines, the task of Extending lines will extend a selected line to an existing 
one. For instance, if roads are not drawn till where you want them to on the map, simply select 
the boundary line and click on the road edge line feature. 

How to extend lines 

1. Select the line to which the other line should be extended  
2. Select the Extend tool  
3. Click on the desired line to extend. 
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Trimming lines 

About trimming lines  

Use the Trim command to reduce an overshoot of a line feature so that it will end at a specific 
boundary. 

To trim a line you either can use a defined length from the last vertex, or a trim line. 

 

How to trim lines 

1. Select the line at which the other line should be trimmed  
2. Select the Trim tool  
3. Click on the desired line to trim. 
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Creating donuts 

About creating donuts  

Donuts are Polygon Features with holes, e.g. a lake with an island in it. In LEICA Zeno Field 
donuts are created by clipping the exterior polygon with the interior polygon. 

How to create donuts 

1. Start an Edit session. 

2. Select the inner polygon. 
3. Click Editor and select Clip. 
4. In the Clip dialog box, select the 'Discard the area that intersects' option. 
5. Click OK. 
6. Delete the inner polygon if necessary. 
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Hyperlinks 

About hyperlinks  

Accessing documents (such as pictures) or Web pages associated with features by using the 

Hyperlink tool  is a convenient way to link a picture of a building with it's building feature in 
the database. Therefore you can provide additional information for map users. 

To do so you have to define a Hyperlink for the features in a layer. You can choose one of the 
following: 

• Field-based hyperlinks  
• Dynamic hyperlink  

 

Field-based hyperlinks 

Using field-based hyperlinks specifies the target document or URL for each feature in a field in 
the layer's attribute table. The values of the field can consist of the full path to the target 
document or the full URL of the target Web page. 

 

Dynamic hyperlinks 

While using dynamic hyperlinks to specify the target document or URL for a specific feature in 
the Add Hyperlink dialog box there is no need to use a field to supply the targets for the 
specification. The target of your specification can be a file or an URL and its name is stored with 
the layer in your map. 

There is no limit of the number of dynamic hyperlinks specified for a feature.   

 

How to define and access hyperlinks 

Defining dynamic hyperlinks 

1. Click on Identify Features  on the Tools toolbar. 
2. Click the desired feature to specify a hyperlink. 
3. Right-click the feature in the Identify Results window. A menu opens. 
4. Click Add Hyperlink on the menu. 
5. Specify the desired hyperlink target.  
6. If you want to link to a document, click Link to a Document and type the full path name to 

the document.  
7. If you want to link to a Web page, click Link to a URL and type in the full URL to the Web 

page whereby the http prefix of the URL can be omitted.  
8. Click OK. 
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Tip 

• Dynamic hyperlinks are also stored with the layer, if you save the layer 
to a file. 

Managing dynamic hyperlinks 

1. Click on Identify Features  on the Tools toolbar. 
2. Choose the relevant features to manage its dynamic hyperlinks. 
3. Right-click the feature in the Identify Results window. A menu opens.  
4. Click Manage Hyperlinks on the menu. 
5. You can either remove, add, or test dynamic hyperlinks. 
6. Click OK. 

Tip 

• The Manage Dynamic Hyperlinks dialog box does not list field-based 
hyperlinks as the name implies, just dynamic hyperlinks. 

Defining field-based hyperlinks 

1. Double-click the desired layer to define hyperlinks in the table of contents. 
2. On the Display tab check Support Hyperlinks using field. 
3. Click the dropdown arrow to choose the field comprising the hyperlink targets.  
4. Click the Document or URL option to select the type of hyperlink the chosen field contains. 
5. Click OK. 

Accessing a feature's hyperlink 

1. To access a hyperlink for a feature the layer comprising the feature has to be checked in 
the table of contents. 

2. Click on Hyperlink tool  on the Tools toolbar.  

Once you've clicked the button, the visible features specified by a hyperlink are either 
drawn or outlined in blue. A feature representing a polygon will be outlined. Point to such 
a highlighted feature and you'll see the cursor is turning into a pointing hand and a popup 
tip displays the name of the target. 

3. To evoke the hyperlink defined, click the feature. If there are several hyperlinks defined, a 
dialog will be shown from which you can select the one that should be launched. 
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Display Features 

Drawing all features with a single symbol 

About using a single symbol to draw features  

The use of single symbols to map locations of features helps you make better decisions based 
on patterns and trends revealing by the feature symbols. 

While creating a new layer a single symbol will be drawn automatically by LEICA Zeno Office.  

 

How to draw a layer using a single symbol 

1. In the table of contents, right-click the desired layer to draw using a single symbol and 
click Properties. 

2. On the Symbology tab click Features. Single Symbol is automatically selected. 
3. Click the Symbol button to modify the symbol. The Symbol Selector dialog box opens. 
4. You may want to choose a new symbol by clicking it or modify specific properties of the 

symbol. 
5. Click OK on the Symbol Selector dialog box. 
6. Type a Label for the feature, then the label is shown next to the symbol in the table of 

contents. 
7. Click OK. 

Tips 

• If you want to quickly modify the symbol your features are drawn with, 
click the symbol in the table of contents to open the Symbol Selector 
dialog box. 

• If you want to quickly modify the color of a symbol, right-click the 
symbol in the table of contents to open the Color Selector dialog box. 

149 



Printed Documentation 

 

Drawing features to show categories like names or types 

About categorizing features  

Categorizing features means to represent each set of a unique feature type that consists of the 
same attribute value by its own symbol. 

There's an option that either LEICA Zeno Office assigns automatically a symbol to each unique 
value based on a color scheme you select, or you explicitly assign a specific symbol to a specific 
attribute value. 

Given the attribute values represented by symbols, you can define a style that consists of 
several symbols to draw the features within the style. Thus the attribute values will be matched 
to the symbol name to draw the feature. If there's no matching symbol the features won't be 
drawn. 

 

How to draw features in categories 

Drawing a layer showing unique values 

1. In the table of contents, right-click the desired layer to be displayed showing unique 
values and click Properties. 

2. On the Symbology tab click Categories. LEICA Zeno Office selects the Unique Values 
option. 

3. Click the Value Field dropdown arrow to select the relevant field comprising the values you 
want to map. 

4. Click the Color Scheme dropdown arrow to choose a color scheme by clicking it. 
5. Click Add All Values to add all unique values to the list. If you only want to display 

particular unique values,  click the Add Values button. 
6. Create more descriptive labels, by clicking a label in the Label column and typing a new 

one. 
7. Click OK. 

Drawing features by referencing specific symbols in a style 

1. In the table of contents, right-click the relevant layer to be displayed showing unique 
values and click Properties. 

2. On the Symbology tab click Categories. 
3. Click Match to Symbols in a Style. 
4. Click the Value Field dropdown arrow to select the relevant field comprising the values you 

want to map. 
5. Click the Match to symbols in a style dropdown arrow and choose the style comprising 

symbol names that match attribute values.  
6. Then click Match Symbols to add all unique values having a matching symbol in the style. 

If you only want to display particular unique values, click the Add Values button. 
7. Create more descriptive labels, by clicking a label in the Label column and typing a new 

one. 
8. Click OK.  

Tips 

• If the style - to choose under step5- is not loaded, click the Browse 
button to browse for it on disk. 
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Drawing features to show multiple attributes 

About showing multiple attributes when drawing features  

Most of the time, geographic data has more than one attribute to characterize the features it 
comprises.  

For instance, one and the same road can be displayed using two attributes, one related to the 
type of the road and the other one related to the traffic volume along the road. To represent the 
two different attributes it is possible to draw different road types in different colors and different 
traffic volumes using different line widths. 

 

How to show multiple attributes when drawing features 

1. In the table of contents, right-click the desired layer to be displayed showing multiple 
attributes and click Properties. 

2. On the Symbology tab click Multiple attributes. LEICA Zeno Office selects the Quantity by 
category option. 

3. Click the first Value Field dropdown arrow to select the field comprising the values you 
want to map. 

4. Click the Color Scheme dropdown arrow to choose a color scheme by clicking it. 
5. Click Add All Values. 
6. Click Symbol Size or Color Ramp, depending on how the quantitative value should be 

symbolized. This example shows Symbol Size. 
7. Click the Value dropdown arrow to select the quantitative value you want to map.  
8. Click OK twice. 
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Drawing features to show quantities like counts or amounts 

About drawing features based on quantities  

When you want your map to communicate how much of something there is, you need to draw 
features using a quantitative measure. This measure might be a count, a ratio such as a 
percentage, or a rank such as high, medium, or low. 

You can represent quantities on a map by varying the color or symbol size you use to draw 
features. For example, you might use increasingly darker shades of blue to represent 
increasingly higher rainfall amounts or larger circles to represent cities with larger populations. 

Generally, you'll need to classify your data when you display it. You can either manually define 
classes or apply one of the standard classification schemes to do so automatically just specify 
the number of classes you want to show. Once you've defined the classes, you can add more 
classes, delete classes, or redefine class ranges. 

It's always a good idea to examine your data before you map it. For instance, you may find that 
you have a few extremely high or low values or null values where no data is available. These 
values can skew a classification and thus the patterns on the map. Fortunately, you can choose 
to exclude these values before you classify your data. 

You may also want to normalize your data before you map it. Often, ratios are easier to 
understand than the raw data values. For example, dividing total population by area yields the 
number of people per unit area, or a density. Dividing a store's sales figure by the total sales for 
all stores yields a percentage of sales at that store. 

How to draw features to show quantities 

Representing quantity with color 

1. In the table of contents, right-click the layer you want to draw showing a quantitative 
value and click Properties. 

2. Click the Symbology tab. 
3. Click Quantities. LEICA Zeno Office automatically selects Graduated colors. 
4. Click the Value dropdown arrow and click the field that contains the quantitative value you 

want to map. 
5. To normalize the data, click the Normalization dropdown arrow and click a field. LEICA 

Zeno Office divides this field into the value to create a ratio. 
6. Click the Color Ramp dropdown arrow and click a ramp to display data with. 
7. Click the Classes dropdown arrow and click the number of classes you want. 
8. Click Classify. 
9. Click the Method dropdown arrow and click the classification scheme you want. 
10. Click OK on the Classification dialog box. 
11. Click OK on the Layer Properties dialog box. 

Tip 

• You can set the number of significant digits for labels by clicking the 
Label column heading. This displays a menu that lets you format the 
labels. 

Creating your own color ramp for a layer 

1. In the table of contents, right-click the layer that shows a quantitative value and click 
Properties. 

2. Click the Symbology tab. 
3. Click Quantities. 
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4. Double-click the top symbol in the list and set the start color for the ramp. 
5. Double-click the bottom symbol and set the end color. 
6. Optionally, double-click any middle symbol to set its color. This lets you create a multicolor 

ramp. 
7. Click all the middle symbols you've set the color of. By selecting one or more middle 

symbols, the color of those symbols is included in the new ramp. Otherwise, LEICA Zeno 
Office only uses the top and bottom symbols. 

8. Right-click a symbol and click Ramp Colors. 
9. Optionally, right-click the Color Ramp dropdown list and click Save to save your new ramp 

to your default style. You only need to save the ramp if you want to use it again on 
another layer. 

10. Click OK. 

Representing quantity with graduated symbols 

1. In the table of contents, right-click the layer you want to draw showing a quantitative 
value and click Properties. 

2. Click the Symbology tab. 
3. Click Quantities and click Graduated symbols. 
4. Click the Value dropdown arrow and click the field that contains the quantitative value you 

want to map. 
5. To normalize the data, click the Normalization dropdown arrow and click a field. LEICA 

Zeno Office divides this field into the value to create a ratio. 
6. Type the minimum and maximum symbol sizes. 
7. Click the Classes dropdown arrow and click the number of classes you want. 
8. Click Classify. 
9. Click the Method dropdown arrow and click the classification scheme you want. 
10. Optionally, click Exclusion to remove unwanted values from the classification (for example, 

null values). 
11. Click OK on the Classification dialog box. 
12. Optionally, define the color of the base symbol. 
13. Click OK on the Layer Properties dialog box. 

Tips 

• As you zoom in on the map, the graduated symbols won't get bigger. If 
you want them to get bigger, you need to set a reference scale. Right-
click the data frame and click Set Reference Scale. Now, when you zoom 
in, all the symbols in the data frame will get larger. 

• You can set the number of significant digits for labels by clicking on the 
Label column heading. This reveals a menu that lets you format the 
labels. 

• To change the color of a base symbol, see 'Defining the color of a base 
symbol' in Working with color. 

Representing quantity with proportional symbols 

1. In the table of contents, right-click the layer you want to draw showing a quantitative 
value and click Properties. 

2. Click the Symbology tab. 
3. Click Quantities and click Proportional symbols. 
4. Click the Value dropdown arrow and click the field that contains the quantitative value you 

want to map. 
5. To normalize the data, click the Normalization dropdown arrow and click a field. LEICA 

Zeno Office divides this field into the value to create a ratio. 
6. If the value represents a measurement on the map—an area or distance—click the Units 

dropdown arrow and click a unit. Otherwise, skip to step 9. 
7. Click Circle or Square as the symbol. 
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8. Click Area or Radius. For example, click Radius if your data represents the distance an 
earthquake was felt from its epicenter. Click Area if the value represents an area. 

9. Click OK. 

Tips 

• When you draw features with graduated symbols, the quantitative values 
are grouped into classes. Within a class, all features are drawn with the 
same symbol. Thus you can't discern the value of an individual feature; 
you can only tell that its value is within a certain range. Proportional 
symbols represent data values more precisely. The size of a proportional 
symbol reflects the actual data value. For example, you might map 
earthquakes using proportional circles, where the radius of the circle is 
based on the magnitude of the quake. The difficulty with proportional 
symbols arises when you have too many values; the symbols may 
become indistinguishable. Also, the symbols for high values can become 
so large they obscure each other. 

• If the symbol for the maximum value fills the box on the dialog, it will 
probably be too big on the map. Try reducing the symbol size for the 
minimum value, normalizing the data, or excluding some values. If it's 
still too large, use graduated symbols instead. 
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Work with attributes 

Adding attributes 

About adding attributes  

The Attributes dialog box  lets you insert attributes to a selected feature very easily. Decide 
to either add an attribute value for a single feature, or for all features in a layer at the same 
time. 

 

How to add attributes 

1. Start an Edit session 
2. Select the feature or features to which to add an attribute value 
3. Click the Attributes dialog box 
4. Click in the Value column to type in a value or select one of the predefined values 
5. Press Enter. 
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Copying and pasting attributes 

About copying and pasting attributes  

LEICA Zeno Office lets you edit the attributes of features by providing the tools for copying and 
pasting. It is possible to copy and paste: 

• just individual attribute values from feature to feature, 
• all attribute values from feature to feature, or 
• all attribute values from one feature to an entire layer. 

 

How to copy and paste attributes 

Copying and pasting individual attribute values from feature to feature 

1. Select the relevant attribute value to copy. 
2. Right-click the attribute value and click Copy. 
3. Click the primary display field of the desired feature to which to paste the value. 
4. Click where the value should be pasted. 
5. Right-click where the attribute value should be pasted and click Paste. 

Copying and pasting all attribute values from feature to feature 

1. Right-click the primary display field of the relevant feature to copy the attribute values of. 
2. Click Copy. 
3. Right-click the primary display field of the desired feature to which to paste the attribute 

values. 
4. Click OK. 
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Deleting attributes 

About deleting attributes  

Deleting attributes of a specific feature can easily be done using the Attributes dialog box. 

 

How to delete attributes 

1. Right-click over the desired value to delete. 
2. Click Delete. 

The default value for the field - usually <null> - will replace the deleted attribute. 
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Creating new attribute domains 

About creating attribute domains  

The Domains properties dialog box is provided to help you create a new attribute domain. 

 

At any time in the life of a geodatabase, a new attribute domain can be created using the 
Domains properties dialog box. 

How to create new attribute domains 

Creating a new attribute range domain 

1. Click the Data Manager tab. 
2. Right-click the geodatabase in the Catalog tree and click Properties. 
3. To type a name for the new domain, click the first empty field under Domain Name. 
4. To type a description for the domain, click the description field of the domain. 
5. Click the field next to Field Type, click the dropdown arrow, and select the type of attribute 

field to which to apply this domain.  
6. Click the field next to Domain Type, click the dropdown arrow of the list, and select Range. 
7. To set a minimum (maximum) value, click the field with the minimum (maximum) value 

for the range domain.   
8. Click the field next to Split policy (Merge Policy), click the dropdown arrow, and select the 

split policy (merge policy). 
9. If you click Apply, the domain will be created. To create the domain and close the dialog 

box at once, simply click OK. 

Tip 

• Keep in mind that range domains just can be created for numeric and 
date fields. 

Creating a new coded value domain 

1. Click the Data Manager tab. 
2. Right-click the geodatabase in the Catalog tree and click Properties. 
3. To type a name for the new domain, click the first empty field under Domain Name. 
4. To type a description for the domain, click the description field of the domain. 
5. Click the field next to Field Type, click the dropdown arrow, and select the type of attribute 

field to which to apply this domain. 
6. Click the field next to Domain Type, click the dropdown arrow of the list, and select Coded 

Values. 
7. To set the first valid code, click the first empty field under Coded values. 
8. To type a description for this coded value, click the Description field of this value.  
9. To type several valid values and their descriptions, repeat step 5. 
10. Click the field next to Split policy (Merge Policy), click the dropdown arrow, and select the 

split policy (merge policy). 
11. If you click Apply the domain will be created. To create the domain and close the dialog 

box at once, simply click OK. 
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Viewing attributes 

About viewing attributes  

Viewing attributes of selected features is available when using the Attributes dialog box. A list of 
selected features appears at the left side of the dialog box and the number of all the selected 
features displays at the bottom. Listing features is determined by their primary display field, 
grouping them by their layer names. 

The attribute properties of the displayed layers (like Type or Owner) and the appropriate 
attribute values are shown at the right side of the dialog box. 

Using the feature layer's attribute table lets you view and edit the feature's attributes right on 
the map.  

 

How to view attributes 

1. In the Editor menu, click Start Editing. 

2. Click the Edit tool . 
3. Choose the relevant features whose attributes to display. 

4. Click Attributes . 
5. Select the layer name comprising the desired features. 
6. To view the primary display fields of the selected features in the layer, double-click a layer 

name. 

To hide them, double-click again. 

7. To view the appropriate feature's attribute values, click a primary display field. 

Thus, the relevant feature flashes on the map. 

8. To close the dialog box, click Close. 

Tips 

• To remove features from the selection without clicking on the map, right-
click the relevant feature and click Unselect. 

• If you want to view a feature's attributes, click on Identify Features  
on the Tools toolbar. Then click the desired feature. The attributes will be 
shown in the Identify Results window. 
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Editing attributes 

About editing attributes  

As the database is just as accurate and up-to-date as the information comprised within, it will 
be necessary to edit the information to update the database as well. Using LEICA Zeno Office, it 
is possible to edit the attributes of features either shown on the map or included in other 
database tables (which are not represented geographically on the map) within an edit session. 
Use the Attributes dialog box to edit attributes of features shown on a map. The advantage of 
editing attributes through a table is the possibility of quickly modifying several features at once. 

Once you've finished editing don't forget to save the edits and end the edit session. 

 

How to edit attributes 

Open an attributes table 

1. In the table of contents, right-click the layer for which a table should be displayed. 
2. Click Open Attribute Table. 

Editing text in records 

1. Start an edit session in LEICA Zeno Office. 
2. Open the table that should be edited. 
3. Select the cell including the attribute value that should be modified. 
4. Type the new values and press Enter. The table gets updated. 

Tips 

• If you want to display the Editor toolbar, click Editor Toolbar in the Tools 
menu. 

Adding new records 

1. Start an edit session in LEICA Zeno Office. 
2. Open the table that should be edited. 
3. Click on Move to end of table  . 
4. To add a new record at the bottom of the table, click a cell in the last empty record and 

type a new value. 

Tips 

• If you want to display the Editor toolbar, click Editor Toolbar in the Tools 
menu. 

Deleting records 

1. Start an edit session in LEICA Zeno Office. 
2. Open the table that should be edited. 
3. To delete records, select the desired ones. To select more than on record, hold the Ctrl 

key while clicking the relevant records. 
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4. Once, you've  pressed the Delete key, the geographic features related to the records, if 
any, are also deleted. 

Tips 

• If you want to display the Editor toolbar, click Editor Toolbar in the Tools 
menu. 
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Modifying attributes 

About modifying attributes  

The Attributes dialog box allows you to modify the attribute values of either a single feature or 
of all features in a layer at the same time. 

 

How to modify attributes 

1. Click the primary display field of the feature whose attribute value should be modified. 
2. Click the value in the Value column. 
3. Set a new attribute value. 
4. Press Enter. 

Tip 

• On the LEICA Zeno Office Standard toolbar you'll find the Undo button. 
Click it to undo edits.  
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Edit Attributes 

About Edit Attributes  

Displays the attributes window for the currently selected feature to check and edit the stored 
attributes. 

 

 

How to edit Attributes 

1. Select the desired feature. 

2. Click the Edit Attributes button  
3. Click the Attribute to be edited in the Property column and type in the new value. 
4. When finished, close the window. 
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Attribute Validation 

About validating attributes 

Feature attributes can be mandatory or limited to a certain range. If Survey Features are 
finished LEICA Zeno Office validates the attributes of that features for missing and invalid 
values. A message box shows invalid attributes and feeds them into the attribute dialog to be 
modified. It is not possible to finish a Survey Feature with missing or invalid features. 

This functionality can be manually started with Edit - Validate selection also. 

How attributes are validated 

1. Start an Edit session 
2. Create a new or modify an existing Survey Feature 

3. After clicking finish the Survey Feature will be validated automatically and missing or 
invalid attribute values will be shown. 

4. Modify the attribute values and close the attribute dialog 
5. Finish the Survey Features (the validation will be done again) 
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Presenting attribute data 

In an interactive map, readers can directly display and query the tabular attribute information 
associated with the map features. In a static map, this information—if displayed at all—is 
usually in a formatted report, or is simply used to symbolize or label map features. 

However, to make the data easier to store and maintain, attribute data in a GIS database is 
often abbreviated, coded, or unformatted. In order to make it easy for map readers to 
understand the data, you should reformat it, provide aliases, or filter the data before including 
in the map. You can do this using the Fields tab on the layer’s Properties dialog box. Here are 
some things to keep in mind when presenting attribute data to the map readers. 

Display Only Relevant Data: There may be attributes in the layer’s data table that do not convey 
useful information for a given map. Make sure these fields are not visible. 

Field Name Aliases: Field aliases should clearly describe what the attribute values represent, 
including how they are measured (for example “(m)" for meters or “(km)" for kilometers). 
Aliases should also communicate whether the values represent a raw count, a rate, or a ratio of 
other information, such as a percentage (“%)." 

Format Data Appropriately: Attribute data that represent specific kinds of information, such as 
currency or dates, should be formatted such that map readers will know what kind of 
information they are reading. Large numbers should be formatted with the appropriate 
thousands separator to make them easier to read. 

Coded values versus descriptions: When data from a geodatabase is displayed, ensure that the 
descriptions for coded domains or subtypes are shown. 

The following images illustrate the difference between not doing anything special to present 
attribute information (top) and using the above suggestions to present the same data (bottom). 
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General 

About map projections 

Whether you treat the earth as a sphere or a spheroid, you must transform its three-
dimensional surface to create a flat map sheet. This mathematical transformation is commonly 
referred to as a map projection. One easy way to understand how map projections alter spatial 
properties is to visualize shining a light through the earth onto a surface, called the projection 
surface. Imagine the earth's surface is clear with the graticule drawn on it. Wrap a piece of 
paper around the earth. A light at the center of the earth will cast the shadows of the graticule 
onto the piece of paper. You can now unwrap the paper and lay it flat. The shape of the 
graticule on the flat paper is very different than on the earth. The map projection has distorted 
the graticule. 

A spheroid can't be flattened to a plane any easier than a piece of orange peel can be 
flattened—it will rip. Representing the earth's surface in two dimensions causes distortion in the 
shape, area, distance, or direction of the data. 

A map projection uses mathematical formulas to relate spherical coordinates on the globe to 
flat, planar coordinates. 

 

Map projections are designed for specific purposes. One map projection might be used for large-
scale data in a limited area, while another is used for a small-scale map of the world.  
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Projection parameters 

A map projection by itself isn't enough to define a projected coordinate system. You can state 
that a dataset is in Transverse Mercator, but that's not enough information. Where is the center 
of the projection? Was a scale factor used? Without knowing the exact values for the projection 
parameters, the dataset can't be reprojected. 

You can also get some idea of the amount of distortion the projection has added to the data. If 
you're interested in Australia but you know that a dataset's projection is centered at 0,0, the 
intersection of the equator and the Greenwich prime meridian, you might want to think about 
changing the center of the projection. 

Each map projection has a set of parameters that you must define. The parameters specify the 
origin and customize a projection for your area of interest. Angular parameters use the 
geographic coordinate system units, while linear parameters use the projected coordinate 
system units.  

Linear parameters 

False easting—A linear value applied to the origin of the x-coordinates. 

False northing—A linear value applied to the origin of the y-coordinates. 

False easting and northing values are usually applied to ensure that all x or y values are 
positive. You can also use the false easting and northing parameters to reduce the range of the 
x- or y-coordinate values. For example, if you know all y values are greater than five million 
meters, you could apply a false northing of -5,000,000. 

Scale factor—A unitless value applied to the center point or line of a map projection.  

The scale factor is usually slightly less than one. The UTM coordinate system, which uses the 
Transverse Mercator projection, has a scale factor of 0.9996. Rather than 1.0, the scale along 
the central meridian of the projection is 0.9996. This creates two almost parallel lines 
approximately 180 kilometers away, where the scale is 1.0. The scale factor reduces the overall 
distortion of the projection in the area of interest. 

Angular parameters 

Azimuth—Defines the center line of a projection. The rotation angle measures east from north. 
Used with the Azimuth cases of the Hotine Oblique Mercator projection. 

Central meridian—Defines the origin of the x-coordinates. 

Longitude of origin—Defines the origin of the x-coordinates. The central meridian and longitude 
of origin parameters are synonymous.  

Central parallel—Defines the origin of the y-coordinates. 

Latitude of origin—Defines the origin of the y-coordinates. This parameter may not be located at 
the center of the projection. In particular, conic projections use this parameter to set the origin 
of the y-coordinates below the area of the interest. In that instance, you don't need to set a 
false northing parameter to ensure that all y-coordinates are positive.  

Longitude of center—Used with the Hotine Oblique Mercator Center (both Two-Point and 
Azimuth) cases to define the origin of the x-coordinates. Usually synonymous with the longitude 
of origin and central meridian parameters. 

Latitude of center—Used with the Hotine Oblique Mercator Center (both Two-Point and Azimuth) 
cases to define the origin of the y-coordinates. It is almost always the center of the projection. 
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Layers, data frames, and the table of contents 

In general, a layer represents geographic information, whereby each layer is just the 
representation of a particular type of feature. To arrange layers use the table of contents where 
each layer is listed. For more details an illustration of a table of contents is provided.  

How layers reference data 

Referencing the data comprised in shapefiles, geodatabases, images, grids, and so on instead of 
storing the actual geographic data renders it possible that a layer on a map will always reflect 
the most up-to-date information in the GIS database.   

The table of contents - TOC 

The TOC gives you a good overview of all the layers and their represented features on the map 
by listing them with a check box right next to each layer. Checking the check box gets the layer 
displayed on the map. 

The order of layers within the list represents the sequence of the layer's drawing on the map. 
For instance, a layer at the bottom of the list will form the background of your map. 

You would like to know how to change the drawing order of a layer? 

 

Organizing layers into data frames 

It is possible to not just list the layers but also to organize them into data frames by simply 
grouping the layers that should be displayed together in a separate frame. As soon as you start 
creating a map a data frame will be set up and listed at the top of the table of contents. By 
default, the data frame is named "Layers". If you want to change that name, simply rename a 
data frame. 

Optionally, more data frames can be inserted to a map. If you do so, then there's always one of 
the data frames the active one with which you can work. You'll recognize the active data frame 
because its name gets displayed in bold text in the TOC and the frame gets highlighted on the 
map. A new layer will always be added to the active data frame.  

You would like to know how to add a data frame to a map? 
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Referencing data in the map 

About referencing data on maps 

Referencing data on maps means as soon as data is added to a map, a pathname to that data 
will be stored in the map. 

The stored pathname render it possible that LEICA Zeno Office can locate the data needed to 
open a particular map. If for some reason the data for a layer is not found, the layer won't be 
displayed but it still appears in the TOC. If a particular layer is not drawn and a red exclamation 
mark is shown next to it in the TOC, then this layer has to be repaired. For detailed information, 
go to Repairing broken data links. You can also remove such a layer or just leave it unrepaired 
till you might have access to the data. 

Referencing data is possible for data stored in databases (geodatabase or SDE) or as files 
(shapefiles, personal geodatabases, CAD files, ...). You may want to modify how the file-based 
data is referenced. Therefore LEICA Zeno Office provides several options: absolute full paths, 
relative paths, or UNC paths. These are explained in the following sections.   

 

Absolute full paths 

It could look like:  

C:\Surveying\Project1\Boundary.shp.  

Everyone who wants to share maps stored with paths to data with the absolute full path option 
has to keep the exact same folder structure for the data on each computer. 

 

Relative paths 

This is the default in Leica Zeno Office. If you want to use data out in the field then relative 
pathnames are the best option to choose. Relative paths allow the map and its data to be 
moved to any other computer/disk drive because they don't store the drive name within its 
name. Therefore they can be understood as the specification of the location of the data the map 
is consisting of associated to the current location on disk of the map document itself. But the 
same directory structure should be used at the new location to ensure that the map can still 
reference its data. In addition to storing the data referenced in the same folder as the map, it is 
also possible to store it in a folder above or below the map's folder.  

A relative path can look like:  \Project1\Boundary.shp 

 

UNC paths 

To make it possible that you can share a map with others without needing to map the network 
computer as a disk drive on each local machine of the others an UNC path was created. This 
path lets you generate a map referencing data on a computer on your organization's network.  

An UNC path can look like:  \\GISServer\GIS\Project1\Boundary.shp, for instance. 
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How to reference data in a map 

Storing relative pathnames to data for a map 

1. In the File menu, click Map Properties. 
2. Click Data Source Options. 
3. Click Store relative pathnames and then OK. 
4. Click OK on the Map Properties dialog box. 
5. Save the map. 

Storing UNC pathnames to data in a map 

1. The Source tab of the LEICA Zeno Office TOC lists all stored file-based data. The data for 
these locations has to be shared on the computer that you set to be the data server for 
this map. 

2. To use UNC pathnames, you first have to close the relevant map.  
3. If the map is already using relative paths, you have to either move the map document, or 

rename the folder(s) comprising the data used by this map. 
4. Once you've opened the map, red exclamation points appear before each layer’s name. If 

not, peruse the Source tab for the relevant layers. Then repeat steps 2 and 3. 
5. Choose one of the red exclamation points for a layer with a known name of the feature 

class on the data server computer. After clicking the red point, the Data Source dialog box 
opens.  

6. Click on Connect To Folder to type or browse to the server and share name where the data 
is stored. 

7. Click OK. 
8. Navigate to your feature class, select it and click the Add button. 
9. Repeat steps 5-7  for any layers to repair. 
10. Save the map. 

Updating a link to a data source 

1. Right-click the layer in the table of contents and click Properties. 
2. On the Source tab click Set Data Source. 
3. Click the Look in dropdown arrow to navigate to the data source. 
4. Select the data source and click Add. 
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Working with the edit cache 

About working with the edit cache  

Working with an edit cache will accelerate editing and selecting features from a large amount of 
data. The reason is that LEICA Zeno Office then just retrieves the relevant data from the 
database instead of all the data, thereby only the feature's geometry is cached. 

If there's an operation calling for access to feature attributes the database will be queried. 

 

How to work with the edit cache 

Adding the Edit Cache toolbar 

1. Right-click the Main menu. 
2. Select Edit Cache. 
3. Dock the toolbar to the LEICA Zeno Office window so that the toolbar appears any time 

LEICA Zeno Office is started.  

Creating an edit cache 

1. Add the relevant data to edit. 

2. On the Tools toolbar, click on Zoom In .  
3. Zoom in to the desired area on the map to edit. 

4. On the Edit Cache toolbar, click on Build Edit Cache . 

The features displayed in the current extent are held in memory locally. 

Tip 

• On the Edit Cache toolbar, click on Zoom to Edit Cache  to return to 
the edit cache extent during an edit session. 
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About visualizing survey data 

In LEICA Zeno Office, you can draw, query, and edit the survey data stored in a survey dataset. 
Using survey layers to draw measurements and survey points, you can visualize survey datasets 
and survey projects on the map. 
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Presenting the map tools 

With a static map, the user simply reads and interprets the information displayed on the map. 
With an interactive map, on the other hand, the user is responsible for finding and displaying 
information included in the map beyond the initial display. Users do this through the tools you 
include in the map. How to access and use the tools must be readily apparent to the map 
reader. 

There are different levels of map-reading ability that may require different approaches to 
presenting the tools. The average GIS user, for example, knows how to pan, zoom, use the 
Identify button, find features, form a query to select features, and use a tool to link or hyperlink 
to documents containing additional information. NonGIS users may be less familiar with these 
tools. These users can be divided into three groups: 

• The general public, who may be less accustomed to working with computer software. 
• Professionals who are accustomed to working with computer software but not maps. 
• Professionals in fields that use GIS, who understand digital maps and the most basic 

aspects of using them, but don’t otherwise use GIS. 

You should consider the audience for the map when deciding how to present the tools. 

If the map allows users to select different locations to display, include a way to choose place 
names and then present a map that displays the place that is chosen. This is typically done on 
Websites where a user may type in an address or choose a place name in order to get the map 
that shows the relevant information for that location. This approach may be more intuitive than 
using interactive tools, especially for nonGIS users. 

Map readers need to be shown which tools to use to get additional information, regardless of 
whether they are familiar with GIS or not. Maps displayed on Websites should have a portion of 
the Web page devoted to showing which tools to use to click on the map to get specific kinds of 
information. 

People who have ArcReader can use the ArcReader Tutorial to learn how to use map-reading 
tools. The principles in the ArcReader tutorial also apply to almost every software application 
that views digital maps.  
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The Magnifier window 

By using a magnifier for the display of your data on the map there's no need to change the 
extent of your view since the magnifier window will display the view you set up.   
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Opening magnifier and overview windows 

About magnifier and overview windows  

A magnifier window and an overview window lets you see more details or get an overview of a 
particular area without having to adjust the map display. You only can operate both of the 
windows in data view.  

To use a magnifier window another window than the one your map is displayed on has to be 
opened to see the magnified view of the part of the map you're passing over. 

Same thing to do for using an overview window. But this window will display the full extent of 
your data while marking the currently displayed area by showing a small box. 

 

How to open a magnifier and overview window 

Opening a magnifier window and setting the view 

1. In the Window menu, click Magnifier.  
2. Once the magnifier window appears, pass it over the data to see a magnified view. 
3. To lock a specific view, right-click on the title bar and click Snapshot. 

Opening an overview window to pan and zoom the map 

1. In the Window menu, click Overview.  
2. To modify the map display in the active data frame, you can drag, shrink, or expand the 

box in the overview window.  
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Moving around the map 

About moving around a map  

Moving around a map basically means to change the view of the map data, or to just pan and 
zoom around the data when browsing a map, or to display data at a specific scale, and so on. 

 

How to move around a map 

Zooming in or out 

1. Click on Zoom In  or Zoom Out  on the Tools toolbar. 
2. Point over the map display, either click once to zoom around a point, or click and drag a 

rectangle defining an area to zoom in or out on. 

Tip 

• If there is more than one data frame defined, the Zoom Tool will just 
work in the active data frame. To activate another data frame, click the 
desired one in layout view. 

• If the data frame is set to a fixed extent or fixed scale, the Zoom buttons 
will not be enabled. To enable the zoom function, click Data Frame 
Properties in the View menu, and on the Data Frame tab, click Automatic 
extent. 

Panning 

1. Click on Pan  on the Tools toolbar. 
2. Point over the map display, click and drag the mouse pointer. 

Tips 

• If you're in data view, it is possible to pan the map by dragging the scroll 
bars. 

• If there is more than one data frame defined, the Pan Tool will just work 
in the active data frame. To activate another data frame, click the 
desired one in layout view. 

• If the data frame is set to a fixed extent or fixed scale, the Pan button 
will not be enabled. To enable the pan function, click Data Frame 
Properties in the View menu, and on the Data Frame tab, click Automatic 
extent. 

Zooming to the full extent of the data 

1. Click on Full Extent  on the Tools toolbar. 
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Tips 

• If there is a Visible Scale Range set, your layer won't get displayed 
 when zooming in or out. Disable the visible scale range by right-clicking 
on the layer in the table of contents and clicking Visible Scale Range.  

• If there is more than one data frame defined, the Full Extent Tool will 
just work in the active data frame. To activate another data frame, click 
the desired one in layout view. 

• If the data frame is set to a fixed extent or fixed scale, the Full Extent 
button will not be enabled. To enable the extent function, click Data 
Frame Properties in the View menu, and on the Data Frame tab, click 
Automatic extent. 

Moving back or forward one display 

1. Click on Back  or Forward  Extent on the Tools toolbar. 

Tips 

• If there is a Visible Scale Range set, your layer won't get displayed when 
zooming in or out. Disable the visible scale range by right-clicking on the 
layer in the table of contents and clicking Visible Scale Range.  

• If there is more than one data frame defined, the Back and Forward 
Tools will just work in the active data frame. To activate another data 
frame, click the desired one in layout view. 

Zooming to the extent of a layer 

1. To zoom to a layer, right-click the layer. 
2. Click Zoom To Layer. 
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Working with maps 

Creating a new map 

About creating maps  

Making maps starts really easy with creating a new map document regardless the kind of map. 
Choose one of the two options for map making. Either create a new completely empty map or 
use a  map template to start creating. Using a map template makes it even easier to design a 
new map since it already consists of a predefined page layout  arranging map elements such as 
North arrows, scale bars, and logos, on the virtual page. Thus you just add your data and the 
map is ready to be printed.  

 

How to create maps 

Creating a new map from the Startup dialog 

1. First, start Leica Zeno Office. 
2. Click one of the options on the Startup dialog: create a new empty map, create a map 

from a template, or browse for an existing map. 
3. Click OK. 

Creating a new empty map 

1. Click on New   on the Standard toolbar. 
2. If an open map is already displayed, a request appears to save your changes before 

creating a new map. 

Using a map template 

1. In the File menu, click New. 
2. Click the tab representing the type of map you want to create. The order of the tabs 

displayed will depend on how you've arranged custom templates. 
3. Select  the relevant template. 
4. To create a new map document, click Document.  
5. Click OK. 
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Starting a map from a template 

About starting a map from a template  

LEICA Zeno Office provides an easy and quick way to make a series of maps using map 
templates. It just takes a little work to add data, a title, and any other supporting information 
you prefer. 

You might want to learn more about map templates. 

How to start a map from a template 

Opening a template when you first start LEICA Zeno Office 

1. Start LEICA Zeno Office. 
2. Choose Browse for map... 
3. Select files of type Zeno Office Template (mxt). 
4. Select the desired template. 
5. Click Open. A new map will be opened. 
6. Save your new map (mxd). 
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Opening a map 

About map documents  

While opening a map, the referencing links to the data sources get automatically checked by 
LEICA Zeno Office. If no referenced location is found you can manually locate the data. There's 
also an option to display maps without a particular layer (the layer remains part of the map and 
shows up in the TOC), for instance, the data you tried to locate is still not available maybe 
because of a broken link. 

How to open a map 

Opening a map within LEICA Zeno Office 

1. Click File > Open... 
2. Click the Look in dropdown arrow to navigate to the folder including the map. 
3. Click the relevant map. 
4. Click Open. 

Opening a map using the Data Manager 

1. Click the Data Manager tab. 
2. Navigate to the map you want to open. 
3. Double-click the map either in the Contents tab or in the Catalog tree. The map opens in 

LEICA Zeno Office. 

Opening the last used maps 

1. Click the File menu. 
2. Select a map from the list of recently opened maps. 

Opening an existing map from the Startup dialog box 

1. First, Start Leica Zeno Office. 
2. Click on "Browse for map" to open an existing map. 
3. Click the Look in dropdown arrow to navigate to the folder including the map. 
4. Select the relevant map. 
5. Click Open. 
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Repairing broken data links 

About repairing layers  

To open a map in LEICA Zeno Office requires links between each map layer and its referenced 
data source. If such a link is broken, the data source can't be found. Therefore a red 
exclamation mark appears next to the layer's name in the TOC, the checkbox is disabled, and 
the layer is not displayed. 

Moving, renaming, or deleting the data source which a layer references could cause a broken 
link and thus repairing is necessary. Knowing the new location of the data source makes 
repairing the layer easy, see the two ways of repairing:  

How to repair a layer with a broken link 

1. Locate the layer which has to be repaired in the table of contents.  
2. Right-click the layer, point to Data, and then click the Set Data Source command. 
3. Navigate to the location of the data source in the Catalog Browser dialog box and click the 

data source. 
4. Click the Add button. 

The layer is repaired automatically by LEICA Zeno Office using the data source specified. 
Other broken layers will also be repaired, if their data sources will be find in the location of 
the data source specified. 

Tips 

• To distribute maps to other user, choose to reference data using relative 
pathnames. Go to Referencing data in the map. 

• Alternatively, run the Set Data Source command by clicking the red 
exclamation mark next to a broken layer in the table of contents . 
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Saving a map and exiting Zeno Office  

About saving maps and exiting LEICA Zeno Office  

Before you exit LEICA Zeno Office you might want to save your edited map. Instead of saving 
your map just after having finished your work, it is even better to do so during the process of 
editing in case something unexpected happens. 

Saving your map does not store the displayed data, because map layers reference the data 
sources in your GIS database. Thus the size of the map document is kept relatively small.  

If others shall work with your map or be able to display it, they need access to both the map 
document and the referenced data. 

How to save a map and exit LEICA Zeno Office 

Saving your map 

1. Click on Save  on the Standard toolbar. 

If the map hasn't been saved before, you'll need to name it. 

Saving a map as a new map 

1. In the File menu, click Save As. 
2. Navigate to the location where you want to save the map document. 
3. Type a filename. 
4. As file type select ArcMap Documents (*.mxd) by clicking the Save as type dropdown 

arrow. 
5. Click Save. 

Saving a map as a map template 

1. In the File menu, click Save As. 
2. Navigate to the location where you want to save the map template. 
3. Type a filename. 
4. As file type select ArcMap Templates (*.mxt) by clicking the Save as type dropdown 

arrow. 
5. Click Save. 

Exiting LEICA Zeno Office 

1. In the File menu, click Exit. 
2. If you haven't saved your map yet or the last changes a message box appears. Click Yes 

to save any changes, No to discard any changes, or Cancel to continue working on your 
map. 
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About querying maps 

Querying maps according to feature locations and attributes helps you to discover new spatial 
relationships and solve problems which may be: 

• Searching for a specific object. 
• Display all not already computed points! 
• Which points have been measured at which date? 

There are a number of tools provided by LEICA Zeno Office to help you find solutions.  

Ways to find features 

LEICA Zeno Office lets you: 

• Pointing to features to get some additional information such as a picture or Web page. 
• Retrieving features with particular attributes such as cities with a population greater 

than one million. 

What can you do with the features you find? 

If you found the features, you can: 

• Display the features' attributes.  
• Generate reports for the features. 
• Export them to a new feature class.  
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Adding the data you want to edit 

About adding the data you want to edit  

LEICA Zeno Office provides tools to add data, in shapefile or geodatabase format, which you 
want to edit. 

 

How to add the data you want to edit 

1. Start LEICA Zeno Office. 

2. Click on Add Data . 
3. Browse for the location of your data and click Add. 
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Exploring data on a map 

About exploring map data  

If looking at your map doesn't help to solve your problem, then LEICA Zeno Office provides a 
query-function to explore the data on your map and gather the information you need. 

Decide which way to take to explore your data, either: 

• Search for features with a particular characteristic or attribute, 
• Look through all the attributes of a specific layer,  
• Measure distances on the map, or alternatively 

use Map tips to browse map features very quickly. 

 

How to explore the data on a map 

Identifying features by pointing to them 

1. Click on Identify  on the Tools toolbar. 
2. Point over a map feature and click to identify it. Once you've clicked, you'll get an 

information for the features in all visible layers under the pointer. 

Displaying map tips 

1. To get map tips shown, right-click the relevant layer in the table of contents, and click 
Properties. 

2. On the Display tab check Show Map Tips. 
3. On the Fields tab click the Primary display field dropdown arrow to select the attribute field 

to be displayed as the map tip. 
4. Click OK. 
5. Point over a feature to see the map tip. 

 
Tip 

• If you still can't see map tips even after having enabled them, check that 
the layer is turned on and the features in the layer are not being hidden 
by features in overlapping layers. 

Finding features with particular attributes 

1. Click on Find   on the Tools toolbar. 
2. On the Features tab type the string you're looking for in the Find text box. 
3. Click the In layers dropdown arrow to choose the relevant layer for searching and click it. 
4. To only find exact matches, uncheck Find features that are similar to or contain the search 

string. 
5. Decide wether to search for the string in all fields, in a specific field, or in the primary 

display field. 
6. Click Find. 
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Measuring distance 

1. Click on Measure  on the Tools toolbar. 
2. To measure a particular distance, draw a line that represents the distance by using the 

mouse pointer. The line can consist of more than one line segment. 
3. Double-click to end the line. 
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Exporting a map 

About exporting a map  

After having composed a map, you can interchange the map data by exporting it from a map 
document to another file type. The export of maps is supported by several industry-standard 
image formats including EMF, BMP, EPS, PDF, JPEG, and CGM.  

• EMF (Enhanced Metafile), EPS (Encapsulated Postscript), AI (Adobe Illustrator Format) 
or PDF (Portable Document Format) - used as an interchange and/or print format 

• JPEG (Joint Photographic Expert Group) - compressed image file for use on the web 
(high-quality image with a small file size, choose a resolution of 96 or 72 dpi and use a 
medium to medium-high Quality setting) 

• TIFF (Tag Image File Format) or BMP (bitmap) - renders the creation of a 
georeferenced image possible (To add georeferenced information, turn on Create world 
file in the options dialog (*.tfw for TIFF, *.bpw for BMP) while exporting). This option is 
only available when exporting while you're in data view.  

 

How to export a map 

Exporting a map 

1. In the File menu, click Export Map. 
2. Navigate to where the export file should be saved. 
3. Click the Save as type dropdown arrow to select the format - JPEG, MF, EPS, AI, PDF, TIFF 

or BMP. 
4. Type a name for the export file. 
5. Select an option according to your need (quality, resolution, size) by clicking Options.  
6. Click Save. 
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Joining graphics 

About joining graphics  

You can join two or more polygon graphics you've drawn on your map to form a new graphic 
that is a combination of the input graphics. You can use the following join methods: 

• Union—joins all graphics creating one large graphic. Where the graphics overlap, the 
boundaries are removed. 

• Intersect—creates a new graphic from the shared area of the input graphics. 
• Remove overlap—creates a new graphic from the nonoverlapping areas of two input 

graphics. 
• Subtract—creates a new graphic by subtracting the overlapping area of one graphic 

from another. 

How to join graphics 

1. Select the polygon graphics on the map you want to join. 
2. Click Drawing on the Draw toolbar, point to Graphic Operations, and click the method you 

want to use (see choices above). The graphics are joined. 
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Making hyperlinks with relative pathnames 

About making hyperlinks with relative pathnames  

You will need to make hyperlinks with relative pathnames, if you want somebody else to read 
your map including hyperlinks who can not access your network resources - for instance, if the 
map is used by the surveyor in the field. LEICA Zeno Office provides two strategies to specify 
hyperlinks referring to a location in relation to the map. 

 

How to make hyperlinks with relative pathnames  

Strategy 1 (dynamic hyperlinks are not supported) 

1. First, store the hyperlinked filenames. Do so by generating a text field in the table of the 
features from which you are hyperlinking and add the hyperlinked filenames to that table. 

2. In the table of contents, right-click the layer  and click Properties. 
3. On the Display tab check the box to support hyperlinks. 
4. Click the dropdown arrow to choose the hyperlink field.  
5. Click OK. 
6. In the File menu, click Map Properties. 
7. To type the path to the hyperlinked documents, click in the Hyperlink base text box. 

Tip 

• To improve working with strategy 1 and to simplify the updating of a 
possibly changed location, you just have to store all of the linked 
documents in one location. 

• Dynamic hyperlinks won't be effected by a specified hyperlink base path.  

Strategy 2 (works for dynamic hyperlinks) 

1. First, store the hyperlinked file paths and names. Do so by generating a text field in the 
table of the features from which you are hyperlinking, and add the hyperlinked file pathes 
and names to that table. 

2. In the table of contents, right-click the layer and click Properties. 
3. On the Display tab check the box to support hyperlinks. 
4. Click the dropdown arrow to choose the hyperlink field. 
5. Click OK. 
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Add data to maps 

Adding data to maps 

About adding data to maps  

With the Data Manager, you can locate the layers or data sources that you want to use and then 
drag and drop them onto a map. You can drop the data from the Data Manager onto the data 
view or layout view in the LEICA Zeno Office.  

How to add data to maps 

1. In LEICA Zeno Office, open the map to which you want to add data. 
2. In the Data Manager, navigate to the data source you want to add to the map. 
3. Drag the data from the Data Manager. 
4. Drop the data on the data view or layout view, or in the map's table of contents. 

The new data appears in the map. 

Tip 

• While creating a new feature class or a new survey project, the data gets 
automatically added to LEICA Zeno Office. 
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Adding layers to a map 

About adding layers to a map  

A layer can be seen as the representation of Geographic data on a map. Either a particular type 
of feature or a particular type of data might be represented by a layer. Instead of storing 
geographic data itself, a layer refers to the data stored in shapefiles, rasters, CAD files and so 
on. 

How to add layers to a map 

Adding a layer from Data Manager 

1. On the Data Manager tab navigate to the relevant layer to add to the map. 
2. Click the layer and drag it from Data Manager. 
3. Drop it over the map display in LEICA Zeno Office. The layer is copied to the map. If you 

made any subsequent edits to the layer on disk you won't see them on this map. 

Tip 

• By adding a predefined layer to your map from the Data Manager, a copy 
will be placed on the current map. There won't be any changes to your 
current map, when the original layer is being modified. 

Adding a layer from the Add Data button 

1. Click on  Add Data   on the Standard toolbar. 
2. Click the Look in dropdown arrow and navigate to the folder comprising the layer. 
3. Select the layer. 
4. Click Add to get the new layer appear on your map. 

Adding a layer from another map 

1. Open the map comprising the layer you want to copy. 
2. In the table of contents, right-click the layer and click on Save As Layer File. 
3. Click the Look in dropdown arrow and navigate to the folder where the layer should be 

saved. 
4. Before clicking save, type a name for the layer. 

5. To open the map to which the layer should be added, click on Open  on the Standard 
toolbar . 

6. Click on Add Data   on the Standard toolbar. 
7. Click the Look in dropdown arrow and navigate to the folder comprising the layer. 
8. Select the layer. 
9. Click Add to get the new layer appear on your map. 

Tip 

• By adding a predefined layer to your map from the Data Manager, a copy 
will be placed on the current map. There won't be any changes to your 
current map, when the original layer is being modified. 
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Adding shapefiles and geodatabases to a map 

About adding shapefiles and geodatabases  

If there's no  predefined layer at your disposal, it is possible to create one directly from a data 
source such as a shapefile by simply inserting the data source to your map. Once you've added 
the data source, LEICA Zeno Office generates a new layer on the map in connection to the data 
source. 

As soon as a layer is part of a map, there are different options to select from: 

• Use the table of contents to display a layer 
• Use the appropriate scale for displaying a layer  
• Accessing layer properties to define the way the relevant features should be drawn on 

the map  

How to add shapefiles and geodatabases 

Adding data from Data Manager 

1. Click the Data Manager tab. 
2. Navigate to the relevant data source to add to the map. 
3. Click and drag the data source from Data Manager. 
4. Drop the data source over the map display, the new layer is generated.  

Adding data in LEICA Zeno Office using Add Data button 

1. Click on Add Data   on the Standard toolbar. 
2. Click the Look in dropdown arrow and navigate to the folder comprising the data source. 
3. Select the data source. 
4. Then click Add, the new layer is generated.  

Displaying a subset of the features in a layer that meet some criteria 

1. Right-click the layer in the table of contents and click Properties. 
2. Click the Definition Query tab. 
3. Decide, either to type an expression or click Query Builder. Using the Query Builder you 

can generate an expression for the identification of some particular features in the layer 
that should be displayed. For instance, only those cities with a population greater than 
500,000 can be shown. 

4. Click OK. 
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Adding a raster to a map 

About adding a raster to a map  

To overcome the fact of having raster data that cover the same geographic area but in different 
coordinate systems, LEICA Zeno Office provides a formula to transform automatically any other 
data into the coordinate system of the dataset first added. Transforming a raster dataset 
requires georeferencing information or a world file and its coordinate system. Go to how to 
georeference a raster to learn more about georeferencing if the raster is just available in pixel 
space. 

 

Besides, read further information about rasters. 

How to add a raster to a map 

Adding a single-band/multiband  raster 

1. Click on Add Data    on the Standard toolbar. 
2. Click the Look in dropdown arrow and navigate to the folder comprising the raster. If the 

single band is part of a multiband raster dataset, double-click the dataset to point out the 
bands. 

3. Click the single-band/multiband raster. 
4. Click Add. LEICA Zeno Office generates a new raster layer on the map that references the 

raster data source. 

   
Or  
   
Simply drag the raster from the Data Manager onto the map.  

Adding a raster as a picture 

1. In the Insert menu on the Standard toolbar, click on Picture. 
2. Click the Look in dropdown arrow and navigate to the relevant picture to add. 
3. Click the picture. 
4. Click Open. Depending on where you are the picture gets either included on the layout - 

you're in layout view -, or it gets included within the data frame - you're in data view. 
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Adding CAD drawings to a map 

About adding CAD drawings to a map  

Having already existing CAD drawing files, makes it easy for you to use the data, because 
there's no need to convert it. You only have to choose how you want to use the data.  

You either can just see the CAD drawing with your other data by adding them as a layer for 
display only, or you can control and edit the CAD data by adding them as features.  

There is no restriction to the type of entities you can have on a drawing layer even if CAD 
drawing files usually store different types of entities on different layers in a drawing file. 
Therefore it might be possible to have building footprints on the same drawing layer as streets 
whereas it is more typical that they are contained within different layers. 

 

How to add CAD drawings to a map 

Adding a CAD drawing from Data Manager 

1. On the Data Manager tab navigate to the desired CAD drawing to add to the map. 
2. Click and drag the CAD drawing from Data Manager. 
3. Drop the CAD drawing over the map display. A new layer is generated on the map 

corresponding to the CAD drawing. 

Adding a CAD drawing in LEICA Zeno Office 

1. Click on Add Data  . 
2. Click the Look in dropdown arrow and navigate to the folder comprising the CAD drawing. 
3. Select the CAD drawing. 
4. Click Add. A new layer is generated on the map corresponding to the CAD drawing. 

Adding a CAD drawing for display and analysis 

1. Click on  Add Data  . 
2. Click the Look in dropdown arrow and navigate to the folder comprising the CAD dataset. 
3. Double-click the CAD dataset and select the relevant CAD feature to add. 
4. Click Add. Only the subset of features in the layer will be shown. 
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Loading existing tabular data onto a map 

About loading existing tabular data onto a map  

LEICA Zeno Office provides the possibility of storing some tabular data in separate tables 
instead of the common attribute tables. Such tabular data could be additional point information 
or former measurements. The tabular data can directly be inserted to a map, so it can be used 
in association with the layers on the map. As these separate tables don't appear on the map, 
you can view them in the table of contents on the Source tab. 

How to load existing tabular data onto a map 

1. Click on Add Data . 
2. Navigate to the desired table to be added and click it. 
3. Click Add. 
4. On the Source tab click at the bottom of the table of contents. 
5. Right-click the table and click Open. 
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Adding x,y coordinate data to a map 

About adding x,y coordinate data to a map  

LEICA Zeno Office lets you add tabular data to your map that comprise x,y coordinates of 
geographic features. The coordinates, measured with GPS for example, characterize the location 
of a feature on the surface of the earth, i.e. locations of power line poles in a city. 

There are some restrictions for adding a table of x,y coordinates. As you can imagine, the table 
must consist of two fields to display both coordinates. The values of the coordinates can be part 
of any coordinate system represented by units such as latitude and longitude or meters. 

 

How to add a table with x,y coordinates to a map 

1. Click Add XY Data in the Tools menu on the Standard toolbar. 
2. Click the table dropdown arrow and select a table comprising x,y coordinate data. If there 

isn't any table on the map, browse for it to access it from disk. 
3. Click the X Field dropdown arrow and choose the field that includes the x-coordinate 

values by clicking it. 
4. Click the Y Field dropdown arrow and choose the field that includes the y-coordinate 

values by clicking it. 
5. To define the coordinate system and units displayed in the x and y fields, click Edit. To 

ensure the coordinates match the coordinate system of the data frame a transformation is 
automatically generated. 

6. Click OK. 
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Layer 

About managing layers 

A layer can be described in short as a way to get access to geographic data by specifying the 
display of the referenced geographic data and the location of that data in your database. 

To add layers just drag them from the Data Manager tab to your map. Then you can organize 
them the way you want your map to look like. Use the table of contents (TOC) to do so. Every 
newly generated feature class or Survey Project will automatically be added to the TOC of LEICA 
Zeno Office.   

 

The TOC allows you to control: 

• The timing of the layer drawing 
• The way the layer draws 
• In what data frame the layer will appear on the map 

 

It is also possible to: 

• Remove layers 
• Group layers 
• Save layers to disk 

 

Depending on how the layers are arranged in the TOC the layer's drawing order is determined. 
Therefore, a layer that should form the background of your map should get placed at the 
bottom of the TOC. Go to Changing a layer's drawing order. 

 

198 



Maps and Layers 

Creating a layer 

About creating layers  

It takes time to analyze a data and its attributes and to symbolize its features so that people 
will readily understand the information within the data. Layers you create in LEICA Zeno Office 
are stored as part of the map document file. After finalizing the symbolization and labeling of a 
layer, you can save it outside the map as a layer file. Reuse the layer in other maps, or e-mail it 
along with the data to people who want to add it to their maps. 

You can create layers for other people to use without having to open LEICA Zeno Office . You 
can create a series of layers on the same data with different symbology.  

How to create layers 

Creating a new layer 

1. Select the folder in which you want to store the new layer in the Catalog tree. 
2. Click the File menu, point to New, then click Layer. 
3. Type a name for the new layer. 
4. Click the Browse button. 
5. Navigate to and click the geographic data source for which you want to create the layer. 
6. Click Add. 
7. If you don't want the Catalog to create a thumbnail representing the entire layer, uncheck 

Create thumbnail. 
8. If you don't want the layer to store the full pathname identifying the location of the data, 

check Store relative path name. The location of the data will be recorded in relation to 
where the layer itself is stored. 

9. Click OK. 

The new layer appears in the folder's contents. 

Creating a layer from the data 

1. Right-click the data source from which you want to create a layer. 
2. Click Create Layer. 
3. Navigate to the folder in which you want to save the layer. 
4. Type a name for the layer file. 
5. Click Save. 

The layer file appears in the folder's contents. 
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Grouping layers 

About group layers  

Grouping several layers in one resulting layer - a group layer, renders working with layers 
easier, suppose they represent similar characteristics. For instance, you may gather a layer 
representing railroads and a layer representing highways together to a layer named 
transportation. 

Be aware that turning off a group layer turns off all its component layers. Therefore, if any 
conflicting properties of the constituent layers arise while creating a group layer with its own 
properties, these conflicting properties will be overridden. For instance, visibility scale ranges 
set on the constituent layers will be overridden by the visibility scale range of the group layer.  

 

How to manage group layers 

Creating a group layer 

1. Select the relevant data frame in which to create a group layer by right-clicking it. 
2. Once you've clicked New Group Layer, a new group layer appears in the table of contents. 

 
Further information can be found in the chapter Creating a group layer. 

Tips 

• Alternatively, select all the map layers you want to gather together in the 
table of contents, right-click on the selected ones, and click Group. 

Adding layers to a group layer 

1. In the table of contents, double-click the group layer to display its properties. 
2. On the Group tab click Add. 
3. Click the Look in dropdown arrow and navigate to the relevant data source to add. 
4. Click the data source. 
5. Click Add.  

 

Tip 

• Adding layers is even easier, if the layer is already on the map, you just 
drag the layer and drop it in the group. 

 

Changing the layer order in a group layer 

1. In the table of contents, double-click the group layer to display its properties. 
2. On the Group tab click the relevant layer to move. 
3. Click the appropriate arrow button to move it up or down. 
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4. Click OK.  

 

Tip 

• The Layer order can also be changed using drag and drop in the table of 
contents. 

 

Removing a layer from a group layer 

1. In the table of contents, double-click the group layer to display its properties. 
2. On the Group tab click the relevant layer to remove. 
3. Click Remove. 
4. Click OK.  

 

Tip 

• The Layer can also be removed by right-clicking it in the table of 
contents and clicking remove. 
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Creating a group layer 

About group layers  

Sometimes you want to group several data sources together in a layer because you want to 
manage them as one entry in the map's table of contents. A group layer can combine data from 
several data sources, each of which may store data in a different format. 

How to create group layers 

Creating a new group layer 

1. Select the folder in which you want to place the new group layer in the Catalog tree. 
2. Click the File menu, point to New, then click Group Layer. 
3. Type a name for the new group layer. 
4. Press Enter. 

The new group layer appears in the folder's contents. 

Adding layers to a group layer 

1. Right-click a group layer, click Properties, then click the Group tab. 
2. Click Add. 
3. Navigate to and click the geographic data source or layer that you want to add to the 

group. Click Open. 
4. Repeat step 3 until all layers have been added. 
5. Layers are drawn in order from the bottom to the top of the list. Click a layer and then 

click the arrow buttons to reorder the list. 
6. Click a layer and click Properties to set the properties of individual layers. 
7. Click OK. 

Creating a group layer from the data 

1. Hold down the Shift or Ctrl key, and click the appropriate geographic data sources in the 
Contents tab. The data sources must all have the same format— example, select three 
raster datasets. 

2. Right-click one of the selected data sources. 
3. Click Create Layer. 
4. Navigate to the folder in which you want to save the group layer. 
5. Type a name for the group layer file. 
6. Click Save. 

The new group layer appears in the folder's contents. 
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Creating survey layers 

About creating survey layers 

You can create a survey layer by adding a project, project folder, or survey dataset to the map.  

Once a survey layer exists in the map, you can choose to add or remove sublayers for the 
supported survey classes, define a scale range at which these sublayers are visible, and define 
how to draw them. When creating a new survey project using the Data Manager, the project is 
automatically added to the Table of Contents of LEICA Zeno Office. 

How to create survey layers 

Adding a survey dataset in LEICA Zeno Office 

1. Click the Add Data button  on the Standard toolbar in LEICA Zeno Office. 
2. Click the Look in dropdown arrow and navigate to the geodatabase that contains the 

survey dataset that you want to add to the map. 
3. Click the survey dataset. 
4. Click Add. 

LEICA Zeno Office creates a new layer on the map that represents all the projects in the 
survey dataset. 

Adding a survey project from Data Manager 

1. Click the Data Manager tab. 
2. Navigate to the survey project that you want to add to the map. 
3. Click and drag the project from Data Manager. 
4. Drop the project over the map display of LEICA Zeno Office. 

LEICA Zeno Office creates a new layer on the map that represents the project. 

Adding a new sublayer to a survey layer 

1. In the LEICA Zeno Office table of contents, right-click the survey layer to which you want 
to add a sublayer. 

2. Click Properties. 
3. Click the Sub-Layers tab in the Layer Properties dialog box. 
4. Click Add. 
5. Click the name of the survey class for the sublayer type you want to add. 
6. Click Add in the Add Sublayer dialog box. 
7. Click OK in the Layer Properties dialog box. 
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Accessing layer properties 

About layer properties  

The layer's properties let you determine all aspects of a layer by defining: 

• the way the layer should be displayed 
• the data source the layer should reference 
• labels for a particular layer  
• properties of attribute fields  

 

How to display layer properties 

1. In the table of contents, right-click on the layer and choose Properties. 
2. Click the tab comprising the properties you want to set up. 
3. Click OK after having finished your settings. 

Tip 

• You can also display the layer's properties by double-clicking the layer in the table of 
contents. 
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Changing a layer's text description 

About changing a layer's text description  

LEICA Zeno Office offers two possibilities to modify text description for a layer: either the layer 
name, or the map feature description(heading and label). 

 

While adding data to your map the name for the resulting layer is taken from its data source by 
default. See how you can name a layer more descriptively while retaining the name of the data 
source. 

How to change text descriptions 

Changing the name of a layer  

1. Click two times on the layer in the table of contents. This will highlight the name to enable 
changes. 

2. Type the new name and press Enter. 

Changing map feature descriptions 

1. Click two times on the relevant text in the table of contents. This will highlight the string 
to enable changes. 

2. Type the new description and press Enter. 
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Displaying layers 

The symbols used on map layers should be for direct understanding and they should get 
displayed quickly. See the following graphics to get an idea of direct understandable -intuitive- 
symbols (right) and unintuitive symbols (left). 

   

As a general rule you can say that maps should be symbolized in the way that they get 
displayed in a few seconds to keep the reader's attention. You'll get the smoothest performance 
for your map if the draw time takes less than three seconds. There are some things that will 
cause a slow-down of the draw time: Complex symbols and advanced drawing options available 
from the dataframe context menu. 

At least, you should try to not increase the draw time by avoiding symbols containing multiple 
layers or marker symbols. Just use simple style markers to improve the drawing performance.  

 

Line symbols 

If it is not necessary to use a dash pattern or an offset then avoid it. If not, then, at least, try to 
prefer a simple line symbol to a cartographic line symbol as long as the line width is less than 
1.0 pts because a simple line symbol is optimized to draw faster. Although, it may not manage 
drawing around acute angles as nicely.  
   

Area fill symbols 

• To render the drawing as quickly as possible just use simple fills, or area fills without 
outlines - set either the outline width to zero or the color to "No color". 

• Dot-density fills will cause a longer draw time especially, if they are used with a 
masking layer. Try to avoid dot-density fills, unless the number of dots is low enough to 
keep the draw time low. 
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Copying layers 

About copying layers  

Creating maps that are associated to one and the same data source can quickly be done by 
copying and pasting layers within a map or between maps. 

Whereby copying layers from a map is an easy way to grant access to the layers created for 
others. As soon as you've established the design of a layer's drawing, that information will be 
stored with the layer. So anyone who adds the layer to a map will see it the way you created it. 
  

Go to copy a layer to disk to learn more about it. 

 

How to copy layers 

Copying a layer between data frames 

1. Right-click the layer to add to another data frame and click Copy. 
2. Right-click the desired data frame and click Paste. 

Copying a layer to another map 

1. Right-click the layer to add to another map and click Copy. 

2. Click on Open  and select the relevant map to copy to the layer. 
3. Right-click the desired data frame where the layer should be added to and click Paste. 
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Removing layers from the map 

About removing layers  

To remove a layer simply means to delete it. Whereby the data source the layer is based on 
retains. 

How to remove layers from maps 

1. Right-click the relevant layer in the table of contents. 
2. Click Remove. 
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Changing a layer's drawing order 

About changing a layer's drawing order  

A layer's drawing order on the map is associated to the order of layers in the table of contents. 
The order within a data frame also determines the layer's drawing: the layers listed at the top 
will draw over those listed below them.  

 

How to move a layer to change its drawing order 

1. Click the relevant layer in the table of contents and drag it up or down by holding the 
mouse pointer. A black line shows you where the layer will be placed. 

2. To place the layer release the mouse. 
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Displaying layers at certain scales 

About displaying layers at certain scales  

Every layer checked in the table of contents will be displayed, no matter at which scale the map 
is shown. Therefore, it may sometimes become more and more difficult to differentiate features 
in layers the more you zoom out, especially, when the features consist of detailed information. 

LEICA Zeno Office provides a set up of a layer's visible scale range to render the automatic 
display of layers at appropriate scales feasible. Thus the layer will just be displayed, if the scale 
of the data frame is inside the layer's visible scale range. 

A dimmed scale bar will show up under the layer's check box in the TOC, if a layer is not being 
displayed because of a visible scale range specified.  

 

How to display layers at specified scales 

Setting the minimum visible scale for a layer 

1. In the table of contents, right-click the layer and click Properties. 
2. On the General tab click "Don't show layer when zoomed". 
3. Type a minimum scale for the layer. As long as you zoom in beyond this scale, the layer 

will be visible. 
4. Click OK. 

Setting the maximum visible scale for a layer 

1. In the table of contents, right-click the layer and click Properties. 
2. On the General tab click" Don't show layer when zoomed". 
3. Type a maximum scale for the layer. As long as you zoom out beyond this scale, the layer 

will be visible. 
4. Click OK. 

Clearing a layer's visible scale 

1. Right-click the relevant layer for which to clear a visible scale range. 
2. Point to Visible Scale Range and click Clear Scale Range. 
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Using layer scale ranges 

You can present multiple "levels" of data using layer scale ranges. The following diagram 
illustrates this.  
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Opening a layer's attribute table 

About opening a layer's attribute table  

To explore the attributes of a layer on a map, open its attribute table. Once open, you can 
select features and find features with particular attributes. 

How to open a layer's attribute table 

1. In the table of contents, right-click the layer for which you want to display a table. 
2. Click Open Attribute Table. 

The layer's attribute table opens. 
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Repairing the data source in a layer 

About repairing data sources  

One property common to all layers is their data source. Layer files identify their data sources 
using a path. There are two ways to create a layer file that uses a relative path name to its data 
source: 

• In Data Manager, right-click the folder in which you want to create the new layer, point 
to New, and choose the Layer command. In the dialog that appears, check the "Store 
relative path name' option. 

• In LEICA Zeno Office, choose Map Properties from the File menu. In the dialog that 
appears, click the "Data Source Options" button, and click the "Store relative path 
names" option. 

How to repair a layer 

1. Right-click the layer you want to fix and click Properties. 
2. Click the Source tab. 

When a layer can't find its data source, you'll see information about the data it's looking 
for, but no extent or coordinate system information. 

3. Click Set Data Source. 
4. Navigate to and click the layer's data source in the Browse dialog box. Click Add. 

The Source tab now shows the path to the data source as well as its extent and the 
properties of its coordinate system. 

5. Click OK. 
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Saving a layer outside a map 

About saving layers  

It takes time to analyze a feature class's attributes and symbolize its features so that people will 
readily understand the information within the data. After finalizing the symbolization and 
labeling of a layer, you can save it outside the map as a layer file. Reuse the layer in other 
maps, or e-mail it along with the data to people who want to add it to their maps. 

How to save a layer outside a map 

1. In LEICA Zeno Office, open the map containing the layer that you want to save as a layer 
file. 

2. Right-click the layer in the map's table of contents. 
3. Click Save As Layer File. 
4. Navigate to the folder in which you want to save the layer. 
5. Click Save. 
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Data frames 

Using data frames to organize layers 

About data frames  

As soon as you start creating a map a data frame will be listed in the table of contents because 
each map must have at least one data frame on it. You can modify the default settings for this 
data frame, i.e. give the data frame a more meaningful name, and insert more layers. 

It is possible to list several data frames for the same map. In the table of contents you can see 
the names of data frames; one name, the one of the active data frame is shown in bold text.  If 
you're in layout view the active data frame is highlighted on the map, whereas in data view it 
gets displayed. 

Step through the topic of data frames... 

How to use data frames to organize layers 

Adding a data frame 

1. In the Insert menu click Data Frame.  

The new data frame will be displayed in the center of the layout.  

Making a data frame active 

1. In the table of contents, right-click the data frame . 
2. Click Activate.  

Alternatively, click the frame in layout view to activate it.  

Removing a data frame 

1. Right-click the relevant data frame to remove in the table of contents. 
2. Click Remove.  

Alternatively, select the data frame in layout view and press the Delete key.  

Rotating the data in a data frame 

1. In the View menu, point to Toolbars, and click Data Frame Tools. 
2. Select the Rotate Data Frame tool. 
3. Click and drag the mouse over the data frame to rotate its contents.  

The original data source will retain while rotating the data in this manner.  
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Adding data frames 

 

About adding data frames  

Usually a map consists of one or more data frames (and data), plus one or more other map 
elements, whereas single maps generally have just a single data frames. Sometimes you may 
want to show more data than a single frame can hold. Therefore LEICA Zeno Office also 
facilitates the work with multiple data frames by adding data frames in different ways. 

To learn more about data frames see how to organize layer by making use of data frames. 

 

How to add data frames 

Adding a new data frame to a map 

1. In the Insert menu, click Data Frame to add any data to the new data frame. 

Duplicating a data frame 

1. To select the data frame simply click on it. 
2. Click Copy in the Edit menu. 
3. Then click the Edit menu again and choose Paste. 
4. Click the copy, located on top of the original data frame, and drag it to a new place on the 

page. 

Resizing a data frame 

1. To select the data frame simply click on it. 
2. Click a selection handle and drag it to change the size of the data frame. 
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Customizing data frames 

About customizing data frames  

Geographic data is displayed in a data frame on the virtual page when you are in layout view. 
Inserting grids to the data frame will help you to locate the geographic features because the 
data frame will be divided into sections of either latitude and longitude, projected linear units, or 
a specified number of rows and columns.  

Depending on the size of the area your mapped data covers you can choose one of the three 
types of grids: 

• Graticules - the mapped data covers a large area of the surface of the earth 
• Measured grids - the mapped data covers a region, such as a country of the surface of 

the earth 
• Reference grids - the mapped covers a local area of the surface of the earth 

How to customize data frames 

Renaming a data frame 

1. In the table of contents, click the data frame you want to name. 
2. Click on it a second time. The text field gets enabled. 
3. Type a new name for the data frame. Enter. 

Adding a border to a data frame 

1. Right-click the data frame in the table of contents and click Properties. 
2. On the Frame tab, click the Border dropdown arrow and select a border symbol. 
3. Click the Color dropdown arrow to choose a color by clicking it. 
4. To offset the border from the edge of the data frame, type an X and Y gap. 
5. To round the corners of the border, type a Rounding percentage . 
6. Click OK. 

Adding a background to a data frame 

1. Right-click the data frame in the table of contents and click Properties. 
2. On the Frame tab, click the Background dropdown arrow and select a background. 
3. Click the Color dropdown arrow to choose a color by clicking it. 
4. To offset the background from the edge of the data frame, type an X and Y gap. 
5. To round the corners of the background, type a Rounding percentage. 
6. Click OK. 

Rotating the data in a data frame 

1. Point to Toolbars in the View menu and click Data Frame Tools. 
2. Click the Rotate Data Frame tool. 
3. Click the data frame and drag the mouse over it to rotate its contents. While rotating the 

data just the display is changing, the data source remains constant. 

Tip 

• To rotate the data frame by a specific angle instead of dragging it, type 
in the angle on the Data Frame Tools toolbar. 

Adding a graticule 

217 



Printed Documentation 

1. To add a graticule, double-click the data frame in the table of contents. The Data Frame 
Properties dialog box opens. 

2. On the Grids tab click New Grid. The Grids and Graticules Wizard opens. If it does not, see 
the tip below. 

3. Click Graticule. 
4. Type a name for the new grid and click Next. 
5. Click an Appearance option to type the Intervals as desired. 
6. Click Next. 
7. Choose the Axes you want by checking them. 
8. Set the way they should appear. 
9. To set the text style, click Font and then Next. 
10. Choose a Graticule Border by clicking it. 
11. Check Place a border outside the grid. 
12. Decide, if you want the graticule to be static or to be updating with changes to the data 

frame by clicking one of the two options. 
13. Click Finish. 

Tip 

• If the Grids and Graticules Wizard doesn't appear, it hasn't been enabled. 
To change that, in the Tools menu click Options and check Show Wizards 
when available. 

Adding a measured grid 

1. To add a measured grid, double-click the data frame in the table of contents. The Data 
Frame Properties dialog box opens. 

2. On the Grids tab click New Grid. The Grids and Graticules Wizard opens. If it does not, see 
the tip below. 

3. Click Measured Grid. 
4. Type a name for the new grid and click Next. 
5. Click an Appearance option and then click Properties to set a coordinate system for the 

grid different from the one of the data frame. 
6. Type the Intervals you want. 
7. Click Next. 
8. Choose the Axes you want by checking them.  
9. Set the way they should appear. 
10. To set the text style, click Font and then Next. 
11. Choose a Measured Grid Border by clicking it. 
12. Check Place a border outside the grid. 
13. Decide, if you want the graticule to be static or to be updating with changes to the data 

frame by clicking one of the two options. 
14. Click Finish. 

Tip 

• If the Grids and Graticules Wizard doesn't appear, it hasn't been enabled. 
To change that, click in the Tools menu Options and check Show Wizards 
when available. 
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Rotating the data frame 

About rotating the data frame 

With the data frame rotation functionality you can orientate your map in every desired direction. 
If you are collecting features along a road which is orientated from e.g.east to west, you can 
rotate the map 90 degrees clockwise to display it 'Course up' for better orientation. 

How to rotate the data frame 

1. Click on Rotate Data Frame  on the Tools toolbar. 
2. Click into the map, hold the left mouse button and rotate the map to the desired position 

by moving around. 

3. To reset the map orientation, click on the Clear Rotation button  on the Tools toolbar. 
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Symbols 

Creating new symbols and map elements 

About creating new symbols and map elements  

The Style Manager dialog box lets you create symbols and map elements from scratch.  

Under the topic of Drawing features to show multiple attributes you get some more information 
about automating map production by matching symbol names to data attributes.   

 

How to create new symbols and map elements 

Creating a new symbol in the Style Manager 

1. In the Tools menu, point to Styles, and then click Style Manager. 
2. Click the symbol folder in the style tree, in which to create more symbols. 
3. In the Symbol contents window, right-click the open space, point to New, and then click 

Line Symbol.  
4. Click Properties in the Symbol Property Editor dialog boxes to set the symbol as you prefer 

and click OK. 
5. Name the new symbol. 

Using common symbol properties 

1. Follow steps 1 to 4 above. 
2. Adjust the symbol type and the units of measure. 
3. Click tabs to set applicable properties. 
4. Preview all layers, the mode options, and each layer. 
5. Turn layer drawing and color locking on or off. 
6. Choose layer options to add, delete, move up, move down, copy, and paste. 
7. Click OK. 
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Creating fill symbols 

About creating fill symbols  

To portray either polygonal features such as countries, provinces, land uses, habitats, parcels, 
and footprints, or graphic shapes and backgrounds, data frames, map elements, graphics, and 
text, fill symbols are provided by LEICA Zeno Office to perform that task. There are several 
kinds of fill symbols such as solid, gradients, hatched overlays, random markers, transparent 
pictures, or opaque pictures. 

 

Fill types 

As mentioned above there are five fill types: 

• Simple—fast-drawing solid fill with optional outline 
• Gradient—linear, rectangular, and circular color ramp fills 
• Line—hatched lines at any angle, separation, or offset 
• Marker—marker symbols drawn randomly or ordered 
• Picture—continuous tiling of a .bmp (Windows bitmap) or .emf (Windows enhanced 

metafile) graphic 

A single fill can contain any number of layers. 

How to create fill symbols 

Creating a solid fill 

1. In the Tools menu, point to Styles, and then click Style Manager . 
2. Choose the style folder in which a new symbol should be created by clicking the folder in 

the style tree. 
3. In the Symbol contents window, right-click the open space, point to New, and then click 

Fill Symbol. 
4. In the Fill Symbol Property Editor dialog, click the Type dropdown arrow and click Simple 

Fill Symbol. 
5. Click the Color dropdown arrow to select the color you prefer. Or to mix a new color, click 

More Colors and use the Color Selector dialog box. 
6. Click OK. 

Adding a fill outline 

1. In the Tools menu, point to Styles, and then click Style Manager. 
2. Choose the style folder in which a new symbol should be created by clicking the folder in 

the style tree. 
3. In the Symbol contents window, right-click the open space, point to New, and then click 

Fill Symbol. 
4. In the Fill Symbol Property Editor dialog, click Outline Color and select a color. 
5. Set the Outline Width or click Outline to choose a predefined line symbol. Or if you want to 

design a custom outline, click Properties and make use of the Line Symbol Editor dialog. 
6. Click OK. 

Creating a gradient fill 

1. In the Tools menu, point to Styles, and then click Style Manager. 
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2. Choose the style folder in which to create a new symbol by clicking the folder in the style 
tree. 

3. In the Symbol contents window, right-click the open space, point to New, and then click 
Fill Symbol. 

4. In the Fill Symbol Property Editor dialog, click the Type dropdown arrow and click Gradient 
Fill Symbol. 

5. Click the Style dropdown arrow and click Linear. 
6. Set the number of color Intervals and the color stretch Percentage from start to end. 
7. Click the Color Ramp Style dropdown arrow to select another fill. 
8. If you want to modify the ramp, right-click Style and click Properties. 
9. Click Color 1, click the dropdown arrow, and select a new color hue. 
10. Click OK, then right-click Style and click Save. 
11. To store the new color ramp type a name. It is stored in your personal style. 
12. Click OK on the current dialog. 
13. Click Outline and set the Width to 0 for no outline. 
14. Click OK on the Symbol Property Editor dialog. 

Creating a random dot fill 

1. In the Tools menu, point to Styles, and then click Style Manager. 
2. Choose the style folder in which to create a new symbol by clicking the folder in the style 

tree. 
3. In the Symbol contents window, right-click the open space, point to New, and then click 

Fill Symbol. 
4. In the Fill Symbol Property Editor dialog, click the Type dropdown arrow and click Marker 

Fill Symbol. 
5. Click Random and then click Marker. 
6. If you want, change the Color and the Size to 3, for instance. 
7. Click OK. 
8. On the Fill Properties tab you can render the distribution more dense by adjusting the X 

and Y Separation to 6, 6. 
9. Click OK. 

Creating an overlay fill 

1. In the Tools menu, point to Styles, and then click Style Manager. 
2. Choose the style folder in which to create a new symbol by clicking the folder in the style 

tree. 
3. In the Symbol contents window, right-click the open space, point to New, and then click 

Fill Symbol. 
4. In the Fill Symbol Property Editor dialog, click the Type dropdown arrow and click Line Fill 

Symbol. 
5. Click the Units dropdown arrow to select Inches. 
6. Click Line and then Properties. 
7. Click the Units dropdown arrow to select Inches. 
8. Click the Color dropdown arrow to select, for example, an orange shade. 
9. Set the Width to 0.05 and click OK twice. 
10. Adjust the Angle to 45 and set the Separation to 0.1. 
11. Click Outline and set it to 0. Click OK. 
12. Click on Add Layer and repeat steps 3 through 5.  
13. Set the Width to 0.01 and click OK twice. 
14. Adjust the Angle to 45, set the Offset to 0.12, and the Separation to 0.1. 
15. Click Outline and set it to 0. 
16. Click OK twice. 

Creating a picture fill 

1. In the Tools menu, point to Styles, and then click Style Manager. 
2. Choose the style folder in which to create a new symbol by clicking the folder in the style 

tree. 
3. In the Symbol contents window, right-click the open space, point to New, and then click 

Fill Symbol. 
4. In the Fill Symbol Property Editor dialog, click the Type dropdown arrow and click Picture 

Fill Symbol. 
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5. Navigate to a .bmp (raster image) or .emf (vector graphic) file. 
6. To set the new colors, click the Foreground and Background Color dropdown arrows.  
7. Adjust the Scale of the picture. 
8. Click OK. 

Tips 

• To create a transparent background or foreground choose No color (step 
6). 

• It is possible to set colors for both foreground and background on one-bit 
.bmp pictures. But on multibyte .bmp and .emf pictures only the 
background color can be changed.  

• To toggle the color which can be modified with the Symbol Selector 
Options just swap the color properties of a 1-bit .bmp image. But only 
the foreground color can be changed. 
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Creating line symbols 

About creating line symbols  

To portray linear data such as transportation networks, water systems, boundaries, or other 
connective networks and to outline other features such as polygons, points, and labels, line 
symbols are provided to meet that task. It is also possible to display lines as graphics in the use 
of borders, leaders for arrows and other annotation, and freehand drawing. There are four line 
types provided: Simple, Cartographic, Hash, and Marker, additional Picture as a continuous 
tiling of a .bmp or .emf graphic along the length of the line.  

 

How to create some common line symbols 

Creating an encased road 

1. In the Tools menu, point to Styles, and then click Style Manager . 
2. Choose the style folder in which to create a new symbol by clicking the folder in the style 

tree. 
3. In the Symbol contents window, right-click the open space, then point to New, and click 

Line Symbol. 
4. In the Symbol Property Editor dialog, click the Type dropdown arrow and select the 

Cartographic Line Symbol. 
5. Click the Color dropdown arrow to select black. 
6. Set the Width to 3.4 points. 
7. For Line Caps click Butt and for Line Joins click Round. 

8. Click on Add a New Layer . As you already chose the Cartographic Line Symbol it 
should be selected. 

9. Click red from the Color palette. 
10. Set the Width to 2.6 points. 
11. For Line Caps click Butt and for Line Joins click Round. 
12. Click OK. 

Tips 

• As a single wide layer produces more realistic symbology of the road's 
intersection and merging than two parallel lines, it is better to use the 
single wide layer for road encasements.  

Creating a railroad 

1. In the Tools menu, point to Styles, and then click Style Manager . 
2. Choose the style folder in which to create a new symbol by clicking the folder in the style 

tree. 
3. In the Symbol contents window, right-click the open space, then point to New, and click 

Line Symbol. 
4. In the Symbol Property Editor dialog, click the Type dropdown arrow and choose the 

Cartographic Line Symbol by clicking it. 
5. Click the Color dropdown arrow and select a gray shade. 
6. Set the Width to 0.5 points. 

7. Click on Add Layer . 
8. Change the predefined type to the Hash Line Symbol by clicking the Type dropdown arrow. 
9. On the Hash Line tab click Hash Symbol. 
10. Click the Color dropdown arrow and select a gray shade. 
11. Set the Width to 0.5 points. 
12. Click OK. 
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13. Click the Template tab. 
14. To create a pattern length of 10 units, slide the dark gray square to the eleventh position . 
15. To insert another hash, click the fourth position. 
16. On the Cartographic Line tab click the Color dropdown arrow and select a gray shade. 
17. Set the Width to 4. 
18. Click OK. 

Tip 

• To set up the color, width, caps, and joins a hash mark a line symbols. 

 

Creating arrowhead leaders 

1. In the Tools menu, point to Styles, and then click Style Manager . 
2. Choose the style folder in which to create a new symbol by clicking the folder in the style 

tree. 
3. In the Symbol contents window, right-click the open space, then point to New, and click 

Line Symbol. 
4. In the Symbol Property Editor dialog, click the Type dropdown arrow and choose the 

Cartographic Line Symbol by clicking it. 
5. On the Line Properties tab click the right-facing arrow. 
6. Click Properties and then click Rotate symbols to follow line angle. 
7. Click on Symbol and click Properties. 
8. Click the Type dropdown arrow to choose the Character Marker Symbol by clicking it. 
9. Click the Font dropdown arrow to choose the ESRI Arrowhead by clicking it. 
10. Click the Character dropdown arrow and click 37. 
11. Click the Color dropdown arrow to select a green shade. 
12. Set the Size to 18 points and click OK on all dialog boxes. 
13. On the Cartographic Line Symbol tab click the Color dropdown arrow to select again a 

green shade. 
14. For Line Caps click Butt and for Line Joins click Miter. 
15. Click OK. 

Tips 

• Use the marker you prefer to create start or end decorations. To set its 
length and height use the default arrow. If you don't want to use the 
additional arrow styles contained within the ESRI Arrowhead font just 
choose any other marker for line decorations. 

• It is also possible to toggle the arrowheads to follow the line orientation 
or stay at a fixed angle to the map, if your line arrows are shown as 
horizontal. See step 6 above. 

Creating picture lines 

1. In the Tools menu, point to Styles, and then click Style Manager . 
2. Choose the style folder in which to create a new symbol by clicking the folder in the style 

tree. 
3. In the Symbol contents window, right-click the open space, then point to New, and click 

Line Symbol. 
4. In the Line Symbol Property Editor dialog, click the Type dropdown arrow and then choose 

the Picture Line Symbol by clicking it. 
5. Click a .bmp or .emf file. 
6. Adjust the Width and the X and Y Scale. 
7. Click OK. 
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Creating text symbols 

About creating text symbols 

In a map, text symbols can be applied as labels, titles, descriptions, callouts, legends, scale 
bars, graticule labels, tables, or other textual and tabular information. Therefore text symbols 
are simply the drawing of text as fill symbols of polygon features or graphics. The only 
difference is that text symbols just have one layer. 

Using text symbols lets you affect the look of your text by setting a font, size, and color. Or 
even effects, using more advanced text symbol properties. 

Go to Displaying labels to read about modifying a text symbol for a dynamic label. 

 

Text callouts, with or without leader lines 

LEICA Zeno Office provides several callout types, whereby the balloon callout and the line 
callout are the most useful ones. The properties of both types are: 

•  a border-drawn around the text, and  
•  a leader line that extends from the text to a point on your map 

 

 

Using line callouts you can choose to turn on or off the border and leader line, whereas balloon 
callouts are always displayed with both the border and leader line.  

If the leader line is turned on, then a leader tolerance should be set. The leader tolerance is 
defined as the minimum distance between the leader anchor point and the text, where the 
leader line will be drawn. 

If you choose to display dynamic labels, then the leader anchor point is set on the feature which 
is labeled.  
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Text inside highway shields or other markers 

You may want to show text inside a character marker, for instance, inside highway shields to 
label roads. To do so just make use of a marker text background where you can also choose to 
match automatically the marker scale to the length of your text string. The marker text 
background belongs to the same category as the balloon and line callout mentioned above, 
namely the category of text backgrounds. 

 

How to create text symbols 

Creating balloon callouts (with leader lines) 

1. In the Tools menu, point to Styles, and then click Style Manager. 
2. In the left-hand pane of the style tree, double-click the style in which to create a new text 

symbol.  
3. Click the Text Symbols folder. 
4. In the right-hand pane of the symbol contents view, right-click in some open space, point 

to New, and click Text Symbol. The Text Symbol Properties Editor dialog box opens. 
5. Click Font and select a font, size, and color.  
6. Click OK.  
7. On the Advanced Text tab check Text Background and click Properties. 
8. Balloon Callout is already selected as the default text background. Click the rounded-style 

rectangle border to set a leader tolerance and margins. 
9. Click OK twice. 
10. In the Style Manager, type a name for your new text symbol. 

Creating line callouts (with or without leader lines) 

1. In the Tools menu, point to Styles, and then click Style Manager. 
2. In the left-hand pane of the style tree, double-click the style in which to create a new text 

symbol. 
3. Click the Text Symbols folder. 
4. In the right-hand pane of the symbol contents view, right-click in some open space, point 

to New, and click Text Symbol. The Text Symbol Properties Editor dialog box opens. 
5. Click Font and select a font, size, and color.  
6. Click OK.  
7. On the Advanced Text tab check Text Background and click Properties. 
8. Click the Type dropdown arrow to select the Line Callout.  
9. As you prefer, check on or off the Leader, Accent Bar, and Border. 
10. If a leader line is checked, adjust a leader tolerance and select a leader style. 
11. If a border is checked, set a fill symbol. Underneath Border, click Symbol. Select a fill 

color, outline width, and outline color. Click OK. 
12. If a border is checked, also set margins for the border. 
13. Click OK twice. 
14. In the Style Manager, type a name for your new text symbol. 
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Working with advanced symbolization 

About working with advanced symbols  

The provision of advanced symbols by LEICA Zeno Office allows you to check the layer's 
drawing. There are two options: 

• Draw layers transparently, or 
• Specify a reference scale for symbols. 

Transparency 

To be able to see the raster layer while viewing underlying features it is very helpful to draw 
raster layers transparently over other layers. 

Setting a reference scale 

Setting a reference scale for symbols and text will enlarge (reduce) them as you zoom in (out) 
on the map. To maintain at all scales the way symbol and text sizes look as at the reference 
scale, they will be "stuck" to the current scale of the data frame while setting the reference 
scale. Thus all symbols of all layers - except the raster layers - will be scaled according to the 
reference scale. If you don't want the scaling for all layers to be enabled, you can disable it. 

How to work with advanced symbols 

Drawing a layer transparently 

1. In the View menu, point to Toolbars, and then click Effects.  
2. In the Effects toolbar, click the Layer dropdown arrow to select the layer you want to 

adjust. 
3. Click Adjust Transparency. 
4. The slider bar lets you adjust the transparency by dragging it. 

Setting a reference scale for symbols 

1. Select a scale for the data frame that you want to use as the reference scale. 
2. Right-click the data frame in the table of contents and click Set Reference Scale. 

Clearing a reference scale 

1. Right-click the data frame in the table of contents and click Clear Reference Scale. 
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Working with symbols and labels 

About working with symbols and labels  

Deciding how to represent your data on a map is one of the most important aspects of 
mapmaking. 

For survey data, you must consider whether the map should convey the following information: 

• Measurement values 
• Names and elevations on survey points 
• Error ellipses for coordinate reliability 
• Ranges of coordinate reliability 
• How survey points are associated with features 

How to work with symbols and labels 

Creating a point sublayer symbol 

1. Right-click the survey point sublayer. 
2. Click Properties. 
3. Click the Symbology tab. 
4. Type the text you want displayed next to the symbol in the legend. 
5. Click the Symbol button. 
6. Click the Category dropdown arrow and select a point symbol category. 
7. Scroll through the available symbols and click the symbol you want to use. 
8. Click Color to choose a color for the new symbol. 
9. Type a symbol size. 
10. Type a symbol rotation value if you want the symbol to be rotated. 
11. Click OK on the Symbol Selector dialog box. 
12. Click OK on the Layer Properties dialog box. 

Changing the way TPS measurements are symbolized 

1. Right-click the TPS Measurements sublayer containing the symbol you want to change. 
2. Click Properties. 
3. Click the Symbology tab. 
4. Click the Measurement tab. 
5. Click the Symbol button to change the instrument measurement observations symbol. 
6. Click the Category dropdown arrow and choose a line symbol category. 
7. Scroll through the available symbols and click the line symbol you want to use. 
8. Click Color to choose a color for the new symbol. 
9. Click Properties. 
10. Click the Properties Type dropdown arrow and click the type you want to use. 
11. Click the Line Properties tab. 
12. Click the line decoration style you want to use and click Properties. 
13. Click the Category dropdown arrow and select a point symbol category. 
14. Scroll through the available symbols and click the symbol you want to use. 
15. Click Color to choose a color for the new symbol. 
16. Type a symbol size. 
17. Type a symbol rotation value if you want the symbol to be rotated. 
18. Click OK on the Symbol Selector dialog box. 
19. Click OK on the Symbol Property Editor.  
20. Click the Setup tab. 
21. Click the Symbol Selector button to change the symbol for instrument setup. 
22. Repeat steps 13 to 18. 
23. Click OK on the Layer Properties dialog box. 

Labeling all survey points in a sublayer 
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1. Right-click the sublayer you want to label and click Properties. 
2. Click the Symbology tab. 
3. Click the Point tab. 
4. Check Show Text. 
5. Click Settings.  
6. Click the Label Field dropdown arrow and click the field you want to use as a label. 
7. Click Expression. 
8. Double-click, in order, any additional fields you want to add to the end of the label. 
9. Click OK in the Expression Properties dialog box. 
10. Click OK in the Text Settings dialog box. 
11. Click OK in the Layer Properties dialog box. 

Labeling a subset of survey objects in a sublayer 

1. In the table of contents, right-click the sublayer you want to label and click Properties. 
2. Click Symbology. 
3. Click the tab for the measurement or point you want to label. 
4. Check Show Text and click Settings. 
5. Click the Method dropdown arrow and click Label using advanced options. 
6. Click the Label Field dropdown arrow and click the field you want to use as a label. 
7. Click SQL Query. 
8. Click the operators and double-click the fields in the Fields list to build an expression to 

identify the subset of survey objects that you want to label. 
9. Click OK. 
10. Click Label Styles to choose the style—for instance, font and size—of the label you want. 
11. If you want to create additional subsets of survey objects to label, click Add and type a 

new class name. 
12. Repeat steps 7 through 10 to create additional subsets of survey objects that you want to 

label. 
13. Click OK. 
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Modifying and saving symbols 

About modifying and saving symbols  

As you compose your map, you may want to modify the symbols you've used to draw data and 
graphics. You may also want to open a saved map document and make modifications. When you 
save your changes from the Symbol Selector dialog box, the new symbols are stored in your 
personal style. Later, you can use the Style Manager to move them into another style. 

How to modify and save symbols 

Modifying and saving symbols used to draw feature layers 

1. In the table of contents, click the symbol you want to modify. The Symbol Selector dialog 
box is displayed. 

2. Click a symbol. 
3. If you want to make further simple modifications, use the Color and Width Options to set 

specific properties. 
4. If you want to make further advanced modifications, click Properties to access the Symbol 

Editor dialog box and make the changes you want. 
5. Click Save. 
6. Type a Symbol Name. Your new symbol is saved in your personal style and appears at the 

top of the Style contents window. 
7. Click OK on the Save Symbol to Style dialog. 
8. Click OK on the Symbol Selector dialog. 

Tips 

• If you can't modify the color of a symbol, a layer may be locked. In this 
case, you can click Properties and use the Symbol Editor dialog to modify 
the colors you want. 

• When you save a symbol, you can specify a name and a category for 
class distinction. The category can be used to differentiate drawing 
methods and other criteria. It can be viewed in the Style Manager dialog 
box. 

• Click the preview area on the Symbol Selector dialog to display the 
properties of a symbol. 

• The Symbol Selector dialog menus and map element Properties dialog 
menus use points. The Symbol Property Editors can be set to use points, 
inches, centimeters, or millimeters. 

Modifying symbols used to draw graphics 

1. In layout view, double-click a graphic element on the map or click the context menu and 
click Properties. 

2. Change the Color, Size, and Angle options as needed or click Change Symbol and choose 
another symbol. 

3. Click Properties to access the Symbol Editor dialog box if you want to make further 
changes. Make the changes you want. 

4. Click OK. 
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Tips 

• If you can't modify the color of a symbol, a layer may be locked. In this 
case, you can click Properties and use the Symbol Editor dialog to modify 
the colors you want. 

• Click the preview area on the Symbol Selector dialog to display the 
properties of a symbol. 

• The Symbol Selector dialog menus and map element Properties dialog 
menus use points. The Symbol Property Editors can be set to use points, 
inches, centimeters, or millimeters. 

Using the Draw toolbar to make quick symbol changes 

1. In layout view, click the graphic element you want to modify. 
2. Click the appropriate shortcut button on the Draw toolbar. 
3. Click the new property. Your changes are immediately applied. 

Tips 

• The shortcuts on the Draw toolbar only modify graphic elements. They 
can't modify symbols used to draw features. 

• If you can't modify the color of a symbol, a layer may be locked. In this 
case, you can click Properties and use the Symbol Editor dialog to modify 
the colors you want. 

• Click the preview area on the Symbol Selector dialog to display the 
properties of a symbol. 

• The Symbol Selector dialog menus and map element Properties dialog 
menus use points. The Symbol Property Editors can be set to use points, 
inches, centimeters, or millimeters. 
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Labeling 

About labeling 

Labeling in Zeno Office refers to the process of automatically generating and dynamically 
placing a piece of text for map features and survey objects on the map. The text string of a 
label is deduced from one or more feature attributes. 

In Zeno Office the labels are: 

• positioned by automatically generating 
• not selectable 

Different ways to add text 

By typing a text and placing it next to the feature you can describe a few features. Alternatively, 
the text string can be deduced from one or more of a feature's attributes. 

Adding a label's text string for all of the features in a layer, or several layers, can be done 
automatically. Therefore LEICA Zeno Office provides a dynamical generating and placing of the 
labels. Especially, if your map is modified pretty often it is useful to work with dynamic labels.  

 

Controlling what features are labeled 

The process of controlling what features are labeled is as follows: 

1. Display dynamic labels— to get a "first look" at your map with text labels. 
2. You may want to polish your map: 

Use label classes to specify different labeling properties for features in the same layer. 

Set the label expression to control how text strings are derived from feature attributes. 

Change the label text symbol to control the appearance of the text on the map. 

Work with label priorities and label placement options to specify the features to be labeled, 
and the placement of the labels with respect to features. 

 

Displaying dynamic labels 

Assigning the attribute(s) of the features on which to base your labels, and turning on the 
labeling enables the display of the labels for a layer. The labels get automatically placed on or 
near the features. Using the dynamic labeling provided by LEICA Zeno Office makes it feasible 
to get placed as many labels on the map as possible without overlapping each other. That 
means the more you zoom in on your map, the more labels will appear since features do not get 
labeled when they are tightly clustered together. 

Further details about displaying dynamic labels. 
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Controlling where labels are placed 

The label placement options allow you to control the placement of labels. Using the placement 
options you can choose either to work at the layer level, or group the labels into several classes 
and then set placement properties for labels in the same layer. 

Prioritizing and positioning labels teaches you more about label placement options. 
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Displaying labels 

About displaying labels  

LEICA Zeno Office provides the use of dynamic labels to simplify and fasten the labeling on your 
map. Therefore the label text strings are deduced from one or more feature attributes and you 
can decide which labels should be displayed by turning them on or off.  

 

Label symbols and styles 

To specify the appearance of dynamic labels simply modify the label symbol - a text symbol 
used for all of the labels in a layer or label class. Go to Creating text symbols to get some 
further information. 

There are some options for the modification of your label's appearance: 

• change the properties of the existing label symbol 
• choose a different text symbol from a style file 
• choose a label style 

Since a label style contains both a text symbol and label placement options, it is possible to 
modify both the appearance and positioning of your labels. Once you chose a label style, any 
text symbol you've currently specified for your label symbol gets replaced by the label's text 
symbol. Go to Prioritizing and positioning labels for more details about label placement options. 

 

Text symbols and labeling 

Using dynamic labeling some text symbol properties are limited or not available. For instance, to 
place the labels of point features use the rotate function of the label placement options since the 
Angle property of the text symbol is ignored when labeling point features. You should also be 
aware that only while using multiline labels the horizontal alignment text symbol property will 
be available, and the vertical alignment property for noncurved labels is always bottom. 

Before getting  line features labeled, you can check the option "Produce labels that follow the 
curve of the line". Thus the horizontal alignment will always be placed left.  

 

How to display labels 

Labeling all features in a layer  

1. Right-click the relevant layer to be labeled in the table of contents and click Properties. 
2. On the Labels tab check Label Features. 
3. Click the Label Field dropdown arrow and choose the desired field to use as a label by 

clicking it.  
4. Click OK.  

Tips 

• By default  while zooming your map the size of your labels remains 
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constant. To scale the label text size in conjunction with the map, right-
click the data frame and click Set Reference Scale.  

• Duplicate labels will automatically be removed by LEICA Zeno Office. 
When labeling certain features such as land use categories where several 
features can consist of the same attribute value you may want to disable 
the automatic removing. Click Label Placement Options on the Labels tab 
of the Layer Properties dialog and uncheck Remove Duplicate Labels. 

Labeling all features in a layer dynamically 

1. Right-click the layer in the table of contents 
2. Check "Label Features to turn dynamic labels on". 
3. Uncheck "Label Features to turn labels off".  

Tips 

• By default, while zooming your map the size of your labels remains 
constant. To scale the label text size with the map, right-click the data 
frame and click Set Reference Scale.  

• Duplicate labels will automatically be removed by LEICA Zeno 
Office. When labeling certain features such as land use categories 
where several features can consist of the same attribute value you 
may want to disable the automatic removing. Click Label Placement 
Options on the Labels tab of the Layer Properties dialog and 
uncheck Remove Duplicate Labels. 

Using label classes to label features from the same layer differently 

1. Right-click the layer in the table of contents and click Properties. 
2. On the Labels tab check Label Features. 
3. Click the Method dropdown arrow to click "Define classes of features and label each class 

differently".  
4. Click the Label Field dropdown arrow to choose the desired field to use as a label by 

clicking it.  
5. Click SQL Query.  
6. Click on the operators to compose an expression for the identification of the first subset of 

features that should be labeled. This subset is designated as a label class. In the following 
example, the first label class will be cities with a population greater than 1,000,000 in 
2000.  
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7. Click OK.  
8. Click Rename to change the name of this label class to "Large Cities". 
9. Click Symbol to modify the text symbol properties—for instance, font and size—for "Large 

Cities" labels. 
10. If you want to create the second label class, click Add and type a new class name, i.e. 

"Small Cities". Click OK. 
11. Click SQL Query. 
12. Click on the operators to compose an expression for the identification of  the second label 

class. In the following example, the second label class will be cities with a population less 
than or equal to 1,000,000 in 2000. 
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13. Click OK.  
14. Click Symbol to modify the text symbol properties—for instance, font and size—for "Small 

Cities" labels. Choose different  text symbols than the ones used for the "Large Cities" 
labels. 

15. Click OK. 

Tips 

• LEICA Zeno Office lets you specify a different label field, symbol, scale 
range, label priority, and set of label placement options for each label 
class. 

Changing the appearance of labels by changing the label symbol 

1. Right-click the relevant layer to label in the table of contents and click Properties.  
2. On the Labels tab check Label Features.  
3. Click Symbol. 
4. You can decide to either choose a text symbol from the left pane, or click Properties to 

modify the properties of the existing label symbol. 
5. Click OK twice. 

Changing the appearance of labels by choosing a label style 

1. Right-click the relevant layer to label in the table of contents and click Properties.  
2. On the Labels tab check Label Features.  
3. Click Label Styles. 
4. You can decide to either choose a label style from the left pane, or click Properties to 

modify the properties of the existing label style. 
5. Click OK twice. 

238 



Maps and Layers 

About building label expressions 

To obtain a label string for each feature you have to build an expression by using the Lable 
Expression dialog box. Choose in the Parser dropdown list the rules of the scripting language 
which you want to use to encode the expression. Any valid statements - as long as they are 
supported by the selected scripting language (Visual Basic or Java)- can be comprised in the 
expression. 

Fields are enclosed using square brackets with no regard to the data type of the layer's data 
source. If you don't check the Advanced box, the limit of the expression will be a single line of 
code. Having the Advanced box checked lets you enter a function including programming logic 
and spanning multiple lines of code. 

Expression examples 

See some examples of the label expressions:  

• To connect strings use the VBScript & operator. For instance, using this expression a 
label is created where the text  "Point Name: " occurs before the value of the 
SurveyPointName field : 

                    "Point Name: " & 
[SurveyPointName]   

• The VBScript Round function allows you to control the displaying of decimal numbers. 
For instance, using this expression a field called X rounded to two decimal places is 
displayed: 

                      Round ([X], 2) 

• The VBScript UCase and LCase functions make it possible to commute your text labels 
to all uppercase or lowercase. For instance, using this expression a Name field is 
converted to all upper case:  

 UCase ([NAME])   

• Using the VBScript vbNewLine or vbCrLf constants between the field names helps to 
generate stacked text: 

"Name: " & [NAME] & vbNewLine & [ADDRESS_1] & vbNewLine & 
[ADDRESS_2]  

Zeno Office text formatting tags 

To change or revoke the way a symbol - specified on the Labels tab - appears for particular 
portions of the expression you just have to include  text formatting tags into the expression as 
text strings. Thus you can create mixed-format labels, one field in a label may be underlined, 
for instance. 

Make use of the Zeno Office text formatting tags: 
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Font "<FNT name='Arial' size='18'>" & [LABELFIELD] & "</FNT>" 

Color "<CLR red='255' green='255' blue='255'>" & [LABELFIELD] & 
"</CLR>" 
"<CLR cyan='100' magenta ='100' yellow='100' black='100'>" & 
[LABELFIELD] & "</CLR>" 

Bold "<BOL>" & [LABELFIELD] & "</BOL>" 

Italic "<ITA>" & [LABELFIELD] & "</ITA>" 

Underline "<UND>" & [LABELFIELD] & "</UND>" 

All caps "<ACP>" & [LABELFIELD] & "</ACP>" 

Small caps "<SCP>" & [LABELFIELD] & "</SCP>" 

Superscript "<SUP>" & [LABELFIELD] & "</SUP>" 

Subscript "<SUB>" & [LABELFIELD] & "</SUB>" 

Character spacing 
(%) 

"<CHR spacing='25'>" & [LABELFIELD] & "</CHR>" 

Word spacing (%) "<WRD spacing='150'>" & [LABELFIELD] & "</WRD>" 
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Prioritizing and positioning labels 

About prioritizing and positioning labels 

If you decide to use the dynamic labeling provided by LEICA Zeno Office, then as many labels as 
it is possible without any overlap get automatically displayed on the current map extent. 
Changing the map extent by zooming in or panning tells LEICA Zeno Office to fill the available 
space with labels which haven't been displayed already. 

To control the labeling of features and the placing of labels use the different label options. 

Contrary to the number of labels, the size of the labels remains constant while zooming in or 
out. To scale label text with the map, right-click on the data frame and click Set Reference 
Scale. You'll find more details about reference scales and labeling under the topic About 
labeling. 

Labeling priority 

The higher a label priority of features is set, the higher the chance that those features get 
actually labeled. Working with LEICA Zeno Office lets you define the labeling priority by 
arranging the order of layers. Read the chapter About labeling for more detailed information.   

Label weights, feature weights, and label overlap 

Weighting labels and features allows you to check the process of placing labels. It might be that 
some labels or features are overlapped with other labels or other features in other layers or 
label classes when displaying them on the map. If you don't mind the overlap, you can enable 
the placement of these additional labels. 

You can choose either one of the three allocated weights for labels - low, medium, high; or one 
of the four allocated weights for features - none, low, medium, high. Assigning weights for 
labels or features generally ensures that the higher weighted labels or features will not be 
overlapped by the lower weighted ones. But keep in mind that the higher the weight of features 
the longer the time to place the labels. Get further information about labeling. 

Label placement options 

Choose one of the following label placement options to check where the labels get placed 
relative to the kind of features being labeled. 

 

Placement options for point features: 

Select one of the four placement options: 

• Place label around the point.  
• Place label on top of the point. 
• Place label at specified angle by entering a list of proposed angles for the labels. 
• Place label at an angle specified by a field. If an attribute in your layer specifies an 

angle to rotate each label, then you should select the current option. 

 

Placement options for line features: 

241 



Printed Documentation 

Using placement options for line features allows you to work with all three categories at the 
same time. Thus you don't have to select a specific option. 

You can control: 

• which side of the line labels are placed 
• label position along each line 
• label orientation 

Label placement at which side of the line - To determine label placement at a particular side of 
a line feature you have to select an orientation system, for instance "Orient labels to page". It 
lets you constrain the labels to any of the following positions: above the line, centered on the 
line, or below the line. If the orientation system to use is "Follow line orientation", then it is 
possible to constrain the labels to any of the following positions: to the left of the line, centered 
on the line, or below the line.  

Label placement along each line -There's an option to specify whether or not placing labels at 
the start, end, or the "Along the line at best position" along the line. 

Label orientation - line label orientation is "Along the line" by default, labels are oriented 
straight and placed at an angle that follows the line. You may want to change the orientation to 
perpendicular to the line. Or choose the third option "Horizontal" to get the labels placed 
horizontally on the page. But only in combination with the option of constraining label placement 
to "Centered on the line". Placing curved labels will be possible by checking "Place labels that 
follow the curve of the line". 

 

Label placement options for polygon features: 

Since polygon labels get placed in the center of the features by default, there's no label 
placement option to select. 

 

Duplicate labels 

If you are not labeling point features but line and polygon layers, then one of the following three 
options is available to work with duplicate labels. 

• When two or more contiguous features should be labeled having the same label text 
string, all duplicate labels will be removed by default. 

• Opposite to the first option, duplicate labels will not be removed, so that every 
feature is labeled. 

• When labeling multipart features, choose to place one label per feature part while 
duplicate labels are being retained. 

 

How to prioritize and position labels 

Setting label priority 

1. In the table of contents, right-click the group layer consisting of the layers you are labeling 
and click Properties. 

2. On the Group tab select the relevant layer (or label class) to assign a different label 
priority.  
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3. To move the layer up or down in the priority list, click on the Up Arrow or Down Arrow 
buttons.  

4. Label placement follows the order of layers/labels in the list, starting on top. 
5. Click OK. 

Setting label weights and feature weights 

1. Right-click the layer you are labeling in the table of contents, and click Properties. 
2. On the Labels tab click Placement Properties... Change to the Conflict Detection tab. 

Adjust the weights for the labels and features. A higher weighted feature or label will not 
be overlapped by a lower weighted one. 

3. Click OK twice. 

Tips 

• To control that all labels in a layer or label class will be placed on the 
map, check if the layer or label class is at the top of the Label Priority 
list, if it has a high label weight, and if Place Overlapping Labels is 
selected. 

Placing overlapping labels 

1. Right-click the layer you are labeling in the table of contents, and click Properties. 
2. On the Labels tab click Label Placement Options.  
3. On the Conflict Detection tab check Place Overlapping Labels. 
4. Click OK twice.  

Tip 

• To control that all labels in a layer or label class will be placed on the 
map, check if the layer or label class is at the top of the Label Priority 
list, if it has a high label weight, and if Place Overlapping Labels is 
selected. 

Working with label placement options for point features 

1. Right-click the point layer you are labeling in the table of contents, and click Properties. 
2. On the Labels tab click Label Placement Options.  
3. Select a placement option. As mentioned above, choose one of the four options available. 
4. Click OK twice. 

Working with label placement options for line features 

1. Right-click the line layer you are labeling in the table of contents, and click Properties. 
2. On the Labels tab click Label Placement Options.  
3. Set the line label placement options.  
4. Click OK twice. 

Tip 

• If your layer has more than one label class, then you'll probably read 
"Define classes of features and label each class differently" in the Method 
dropdown list on the Labels tab. Go to Displaying labels for more details 
about label classes. 
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Working with duplicate labels 

1. Right-click the line or polygon layer you are labeling in the table of contents, and click 
Properties. 

2. On the Labels tab click Label Placement Options. 
3. Select Place one lable per feature part. 
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Specifying the text of labels 

About specifying text for labels  

To attain text for a layer to be labeled select one or more attribute fields. For each layer or label 
class a label expression will be defined. The label expression is the statement specifying the 
label text no matter on how many attribute fields the label is based. 

You might want to derive label text strings from your own written logic. Therefore, an advanced 
label expression is provided written as a script in VBScript or JavaScript. Any valid statements 
supported by these programming languages will also be supported by the advanced label 
expression script. 

How to specify the text of labels 

Labeling based on a single field  

1. Right-click the relevant layer to label in the table of contents and click Properties. 
2. On the Labels tab check the Label features in this layer check box. 
3. Click the Label Field dropdown arrow to select a the field to use for labeling.  
4. Click OK. 

Labeling based on one or more fields 

1. Right-click the relevant layer to label in the table of contents and click Properties. 
2. On the Labels tab check the Label features in this layer check box. 
3. Click Expression. 
4. To use the text of a field in your labels, select a label field and click Add. Do the same for 

each field you want to use for labeling. For more detailed information, check About 
building label expressions. 

5. Click Verify to ensure that there are no syntax errors. 
6. Click OK. 

Creating stacked labels 

1. Right-click the relevant layer to label in the table of contents and click Properties. 
2. On the Labels tab check the Label features in this layer check box. 
3. Click Expression. 
4. To use the text of a field in your labels, select a label field and click Add. 
5. Do the same for a second label field. 
6. Replace the " " in the Expression with the special character vbnewline. The expression 

should look like: 

       [PRECIP] 
& vbnewline & [WINDSPEED]    

      For detailed information, check About building label expressions.  
8.   Click Verify.  

A stacked label should appear in the Sample label window. 
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9.   Click OK three times. 

   

Writing advanced label expressions in VBScript or JavaScript 

1. Right-click the relevant layer to label in the table of contents and click Properties. 
2. On the Labels tab check the Label features in the layer check box. 
3. Click Expression.  
4. Check Advanced. 
5. On the Parser menu select a language, VBScript or JavaScript. 
6. Type an expression understood by the language you chose.  

For more detailed information, check About building label expressions. 

7. Click Verify to ensure that there are no syntax errors.  
8. Click OK twice. 

Tips 

• If you are using any ESRI text formatting tags in your expression, the 
special characters - & and < - are not valid anywhere in your label text. 
Instead, use their equivalent characters (&amp; and &lt;). To replace 
special characters in your label fields use the VBScript Replace function. 
For instance:  

      Function FindLabel ( [LABELFIELD] ) 
      NewString = 
Replace([LABELFIELD],"&","&")  
      FindLabel = "<ITA>" & NewString & 
"</ITA>" 
      End Function  

• For instance, if for a given record [LABELFIELD] = "Barnum & Bailey", 
the function mentioned above converts the string to "Barnum & Bailey". 
Thus it will be shown as Barnum & Bailey in your map.  

• For more detailed information, check About building label expressions. 
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Map layout 

Map layout 

A major component in the design of a static map is the layout of the various map elements on 
the page, since all relevant information has to be displayed on a single sheet. For an interactive 
map, the focus shifts to the manipulation of the data and map display, rather than the 
presentation of the data and map elements. However, there are still a few layout issues to 
consider for an interactive map. 

In some cases, the map layout will be set by the viewer software, and map elements such as 
the legend (or table of contents) and scalebar will appear in a specific place and style. (Of 
course, you can customize the viewer to change this). Traditional map elements such as titles, 
descriptive text, legends, scalebars, logos, and so on, may not be applicable for your interactive 
map. 

The table of contents often takes the place of a map legend. If it is present in a map, it should 
have clear intuitive names for dataframes, layer names, headings, and class names. The table 
of contents is also a good place to provide map readers with additional information about 
features in the map that will give them more information. For example, the heading or class 
name (particularly for simple symbology) might contain text such as, "Hyperlinks Available", or 
"Map Tips Show Name". However, you may need to incorporate this information elsewhere in 
the interactive map, such as somewhere on a Web page that contains the map.  
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Setting up the page 

About setting up the page  

While designing your map, you should think about what you want to do with the final product to 
set up the page correctly. Setting up the page is important because it influences the size of the 
features, symbols, labels, and other text, as well as other map elements. 

LEICA Zeno Office facilitates the page setup by providing the Page Setup dialog box where you 
can adjust the following elements: 

• The page size 
• The page orientation 
• The printer and printer engine 
• The visibility of printer margins in the layout 

While specifying the layout of a map for printing or publication, you work on the virtual page in 
layout view.  

Setting the page size and orientation 

The virtual page is set to the same size as the system printer's page by default. If you planned 
for you map a different page size and orientation, it is possible to modify the page setup by 
either using one of the standard sizes or customizing a size. 

When sharing your map document with other users it can be wise to make the map independent 
of your system printer to avoid that your map gets rescaled to fit the default page settings of 
the users printer. Therefore you can prevent differences between the map you created and the 
one printed on any other printer. 

How to set up the page 

Switching to layout view 

1. In the View menu on the Standard toolbar click Layout View. 

The entire map gets displayed. 

Setting the page size and printer properties 

1. Right-click the virtual page in layout view and click Page Setup. 
2. Click the Name dropdown arrow to select a printer. 
3. Click the Printer Page Size dropdown arrow to choose the right page size for your map by 

clicking it. 
4. Click OK. When the Same as Printer box is checked, the Map Width and Height text boxes 

will be updated with the new page size, and the page orientation will be set accordingly.  

Making the map page size independent of the system printer 

1. Right-click the virtual page in layout view and click Page Setup. 
2. Uncheck the Same as Printer box. 
3. Click the Standard Page Sizes dropdown arrow to choose the right page size for your map 

by clicking it. 
4. If you want to define a custom page size, type the page size for your map in the Width 

and Height text boxes. 
5. Click OK. 
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Setting the page orientation 

1. Right-click the virtual page in layout view and click Page Setup. 
2. To adjust the page orientation, click Landscape or Portrait on the left side of the dialog box 

(under Map Size). 
3. Click OK. 
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Maps, layers, and graphs 

You can access maps, layers, and graphs from Data Manager. 

A map document is essentially a printed map stored on disk. It can contain geographic data, 
insets, titles, and North arrows. You can embed map documents in other documents—for 
example, in Microsoft Word. 

Learn more about adding map elements to a map 

Layers can be stored either inside a map document or as individual layer files. They are an 
effective communication tool that can be shared in an organization.  

Several layers can be combined to form a group layer. For example, you might create a group 
layer representing all the background material for a map. Learn more about creating a group 
layer 
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About laying out and printing maps 

If you want to print or publish a map you should think about how you want it to look to decide 
on how to symbolize data for a map.  

Map templates 

Using a template for a series of maps to work from simplifies producing standardized maps. 
Besides, working with map templates saves a lot of time since you don't have to do the layout 
work for every single map of the series separately. 

 You may want to quickly make a variety of styles of maps, see About map templates for further 
information. 

   

Data frames 

The geographic data is probably the most important part of a map. It is displayed in the layout 
in a data frame. Whereas simple maps often have a single data frame, some maps may have 
multiple data frames. 

See Adding data frames, to get some more information. 
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Changing the layout 

About changing the layout  

If you don't want to spend to much time on modifying the look of your map by arranging and 
adding map elements, you can just change the layout so that it corresponds to the layout of a 

template. In this case simply use the Change Layout tool   

 

How to change the layout 

1. Click on Change Layout  on the Layout toolbar. 
2. Click the tab that comprises the desired template to use for modifying the layout. 
3. Click the template. 
4. If the original map and the layout you are applying both have a single data frame, click 

Finish. If there are multiple data frames, click Next and continue on the next step to order 
the data frames on the map. 

5. Select the desired data frame to place it on the map. 
6. Click Move Up or Move Down to modify its position in the list.  
7. Click Finish. 
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About map templates 

To make sure that a series of maps will have the same look and feel while your creating them, it 
is possible to set a standard for the layout using a map template. You can also include the 
background data in the template if it's the same for a series.  

LEICA Zeno Office templates 

To minimize the amount of layout work and thus to save time while still creating a good looking 
map just use the map templates provided by Leica Zeno Office. Simply select a template that 
fits your ideas best, add your data, make whatever changes you want, and your map is 
complete. 

 

How map templates work 

LEICA Zeno Office renders it possible to create either new templates by changing existing maps 
or templates, or new maps from scratch saving them as templates. LEICA Zeno Office will keep 
the original template document. 

To help you differentiating map templates from map documents (.mxd) they are saved with the 
file extension .mxt.   
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Looking at a map in data view and layout view 

About viewing maps in data view and layout view  

While using LEICA Zeno Office viewing a map is possible in: 

• data view, or 
• layout view. 

Being on data view enables to browse geographic data on the map, for instance. Using layout 
view helps you to prepare a map to hang on the wall, to put in a report, or to publish on the 
Web. 

How to switch to data view and layout view 

Switching to data view 

1. In the View menu, click Data View. The active data frame is shown. 

Tip 

• To switch to data view, it is also possible to click the Data view button  
placed in the lower left portion of the view window. 

Switching to layout view 

1. In the View menu, click Layout View. The entire map is drawn. 

Tip 

• To switch to layout view, it is also possible to click the Layout view 
button  placed in the lower left portion of the view window. 
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Using rulers, guides, and grids 

About using rulers, guides, and grids  

You might want to align the map elements on the page. Therefore use the provided layout aids 
rulers, guides and grids which act as visual indicators of element size and position. 

Rulers 

Using rulers helps you to determine the size of the page on the printed map. To simplify the 
precise aligning of map elements use the snapping tool that forces the elements to snap to the 
rulers. 

Guides 

Being in layout view you can align your map elements on the page by using guides. They'll will 
be displayed as straight lines on the virtual page, but won't get printed on your map. When a 
map size differs from the printer's page size make use of the guides to set margins since guides 
provide a visual indication of the margins. Thus it is easier to avoid positioning map elements in 
the margins. 

To simplify the precise aligning of map elements use the snapping tool that forces the elements 
to snap to the guides. 

Grids 

A grid displayed on the layout will give you a purely visual reference for the positioning of map 
elements. Additional, you can use the snapping tool to simplify the precise aligning of map 
elements as the position of elements will be constrained by the vertices of the snapping grid. In 
layout view, this snapping grid will be displayed as a grid of dots on the virtual page. But it 
won't be printed on your map. 

How to use rulers, guides, and grids 

Turning rulers on and off 

1. Right-click the page in layout view. 
2. Point to Rulers and click it. By default, the rulers are on. 

Snapping to rulers 

1. Right-click the page in layout view. 
2. Point to Rulers and click Snap to Rulers. 

Turning guides on and off 

1. Right-click the page in layout view. 
2. Point to Guides and click it. 

Snapping to guides 

1. Right-click the page in layout view. 
2. Point to Guides and click Snap to Guides. 

Adding a guide 
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1. In layout view, click the ruler at the place where a guide should be displayed. 

Removing a guide 

1. Point to a guide marker on the ruler in layout view. 
2. Right-click the guide marker and click Clear Guide. 

Removing all guides from a ruler 

1. Right-click the ruler in layout view. 
2. Click Clear All Guides to remove them from the ruler. 

Using guides to define map margins 

1. In layout view, click the rulers to add guides where the map's margins should be. 
2. You can also move the guides to fine-tune their position. 

Turning the grid on and off 

1. Right-click the page in layout view. 
2. Point to Grid and click it. 

Snapping to the grid 

1. Right-click the page in layout view. 
2. Point to Grid and click Snap to Grid. 

Changing the grid size 

1. In the Tools menu, click Options. 
2. On the Options dialog click the Layout View tab to start the Options dialog box. 

e snapping grid, click the Horizontal Spacing dropdown 

 

3. To set the horizontal spacing of th
arrow to choose a number of units by clicking it.  

4. To set the vertical spacing of the snapping grid, click the Vertical Spacing dropdown arrow
to choose a number of units by clicking it.  
Click OK. 5. 

Changing the snapping tolerance 

2. Click Options. 
olerance. 

1. Right-click the page in layout view. 

3. Type a number of units for the snapping t
4. Click OK. 
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Adding grids and graticules (reference systems) 

About adding grids and graticules  

You may want to add to your map in the layout view a certain type of grids and reference 
systems - so-called graticules . Therefore LEICA Zeno Office provides several ones and lets you 
choose different options: 

 

• To locate a grid describing the location by using degrees of latitude and longitude 
(geographic coordinates) select the Graticule type. 

• To locate a grid describing the location by using projected coordinates select the 
Measured Grid type; for instance, use a Measured Grid to locate UTM grids and State 
Plane grids.  

• To locate a grid that divides a map into a specified number of rows and columns select 
the Reference Grid type.  

 

How to add grids and graticules 

Accessing the grid/graticule wizard 

1. Click in the View menu Data Frame Properties. 
2. On the Grids tab click the New Grid button. 

Tips 

• It might be that the configuration of LEICA Zeno Office is set to not show 
wizards. If so, you can enable the grid/graticule wizard by clicking 
Options in the Tools menu, then click the Application tab and check the 
Wizard Mode option. 

Adding a graticule 

1. Start the grid/graticule wizard (see steps above). 
2. In the grid/graticule wizard, click the Graticule option. 
3. Type a name for the resulting grid which will appear in the list of grids in the Data Frame 

Properties dialog box. 
4. Simply follow the steps in the wizard and click Next when you've finished each panel. 
5. Click Finish at the end of the wizard. 

Tips 

• It might be that the configuration of LEICA Zeno Office is set to not show 
wizards. If so, you can enable the grid/graticule wizard by clicking 
Options in the Tools menu, then click the Application tab and check the 
Wizard Mode option. 

Adding a measured grid 

257 



Printed Documentation 

1. Access the grid/graticule wizard (see steps above). 
2. In the grid/graticule wizard, click the Measured Grid option. 
3. Type a name for the resulting grid which will appear in the list of grids in the Data Frame 

Properties dialog box. 
4. Simply follow the steps in the wizard and click Next when you've finished each panel. 
5. Click Finish at the end of the wizard. 

Tips 

• It might be that the configuration of LEICA Zeno Office is set to not show 
wizards. If so, you can enable the grid/graticule wizard by clicking 
Options in the Tools menu, then click the Application tab and check the 
Wizard Mode option. 

Adding a reference grid 

1. Access the grid/graticule wizard (see steps above). 
2. In the grid/graticule wizard, click the Reference Grid option. 
3. Type a name for the resulting grid which will appear in the list of grids in the Data Frame 

Properties dialog box. 
4. Simply follow the steps in the wizard and click Next when you've finished each panel. 
5. Click Finish at the end of the wizard. 
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Adding mixed format text to legend descriptions 
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Adding new text to a map 

About adding new text to a map 

Adding new text to a map could be the purpose of: 

• Making simply notes while you are doing your field survey. 
• Providing information on top of the map data delineating information about a map area. 

But the data might not be related to any geographic feature in the map data.  
• Inserting a title to specify the purpose of the map.  
• Presenting further information about the map or data, i.e. about the projection or the 

data source. 

How to add new text to a map 

Adding text at a point 

1. Click on New Text   on the Draw toolbar. 
2. On the map point to where the text should be added and click. 
3. A text box gets open to type the text string. 

Tips 

• Depending on which view you're using, LEICA Zeno Office will, by 
default, add new text to it;i.e. the text gets added to the layout, if you're 
in the layout view. Go to 'Adding text to the layout' for more details. 

• After having added new text the Select Elements tool  becomes 
enabled by default.  

Adding text along a curved line 

1. Click on New Splined Text   on the Draw toolbar. 
2. On the map point  to add vertices along which you want the text to be splined and click. 
3. If you've finished, double-click to end the line. 
4. A text box gets open to type the text string. 

Tips 

• Depending on which view you're using, LEICA Zeno Office will, by 
default, add new text to there;i.e. the text gets added to the layout, if 
you're in the layout view. Go to 'Adding text to the layout' for more 
details. 

• After having added new text the Select Elements tool  becomes 
enabled by default.  

Adding text with a callout box and leader line 

1. Click on Callout   on the Draw toolbar. 
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2. On the map point to where the leader line should start and click. While holding the mouse 
button drag with your mouse and release the button where the callout box and text should 
be placed. 

3. The box gets open to type the text string. 

Tips 

• Depending on which view you're using, LEICA Zeno Office will, by 
default, add new text to there;i.e. the text gets added to the layout, if 
you're in the layout view. Go to 'Adding text to the layout' for more 
details. 

• After having added new text the Select Elements tool  becomes 
enabled by default.  

Changing the font, color, or size of text 

1. Click on Select Graphics   on the Draw toolbar. 
2. Double-click the text element you want to edit. 
3. To modify the font, color, or size of the selected text, click the appropriate button on the 

Draw toolbar.  

Tips 

• If you want to change other text display properties, select some text, 
double-click one of the selected pieces of text, after that click Change 
Symbol.  

• Go to Creating text symbols for more details about text symbols. 

Editing a text string 

1. Click on Select Graphics   on the Draw toolbar. 
2. Double-click the text element you want to edit. 
3. Click OK, after having typed the new text string. 

Tips 

• If you want to change a text string in place, select the New Text tool  
on the Drawing toolbar and click on a piece of existing text with it. 

Adding text to the layout 

1. To do so, first Make sure you are in layout view. 

2. Then remove focus, if the data frame has focus, by using the Select Elements tool  and 
click somewhere else on the layout outside the data frame. (Focus is indicated by a 
hatched outline around the data frame.) 

3. To add new text to the layout, select the New Text tools on the Draw toolbar. 
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Adding North arrows, scale bars, and other map elements 

About adding map elements  

There are some map elements that are associated to the data in data frames; i.e. North arrows, 
scale bars, scale text, and legends. 

Read about other map elements such as titles; graphic elements, pictures, and neatlines; 
reports; and graphs. 

North arrows 

To specify the orientation of your map use a North arrow. 

Scale bars 

Scale bars indicate the scale of the map. They let you visualize the sizes of features and 
distances between features on the map. If you zoom your map, the scale bar remains correct.  

It might be that the characteristics of the scale bar added to your map won't exactly satisfy your 
demand. Adjust the number and size of the divisions for example, using the Scale Bar properties 
dialog box.    

 

Scale text 

Scale text also indicates the scale of your map and of features on the map by saying either "one 
centimeter equals 100,000 meters." So the map reader knows how many ground units a map 
unit represents. Or scale bars use an absolute ratio independent of units, i.e. "1:24,000" to 
represent that one unit on the map is equal to 24,000 of the same units on the ground.  

 

Legends 

A legend indicates an explanation of the symbols used to represent features on the map. To tell 
the map reader what all the symbols mean legends are composed of examples of the symbols 
used in combination with labels that comprise explanatory text. Using just a single symbol for 
the features in a layer, the layer is shown with its name in the legend. Whereas the use of 
multiple symbols representing features in a single layer converts the field for the feature 
classification to a heading in the legend. Each category gets labeled with its value.     

 

Frames 

Some map elements—such as scale bars, scale text, North arrows, legends, and data frames—
can have frames. Using frames allows you either to set map elements apart from other 
elements or from the background of the map, or to visually link map elements to other parts of 
the map by using similar frames for related elements. 

Converting map elements to graphics 
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Converting a map element - i.e. a legend - to graphics will let you control each element more 
precisely. You should be aware of the fact that after having converted a map element it is 
impossible to reconstruct the map element from the individual pieces. 

 

How to add map elements 

Adding a North arrow 

1. Click North Arrow in the Insert menu. 
2. Choose a North arrow by clicking it. 
3. Click OK, the North arrow appears on your map. 
4. To place it, click and drag the arrow. 
5. To resize it, click and drag a selection handle. 

Tip 

• To change the size of map elements select them and drag the selection 
handles - away from an element enlarges the element, toward an 
element reduces it. 

Adding a scale bar 

1. Click the Scale Bar in the Insert menu. 
2. Choose a scale bar by clicking it. 
3. To modify its properties click on Properties. 
4. Click OK, the scale bar appears on your map. 
5. To place it, click and drag the scale bar. 
6. To resize the text on the scale bar, click and drag a selection handle. 

Tip 

• To change the size of map elements select them and drag the selection 
handles - away from an element enlarges the element, toward an 
element reduces it. 

Customizing a scale bar's scale and units 

1. Right-click the scale bar and then click Properties. 
2. Click the Scale and Units tab. 
3. Set the number of divisions by clicking the arrow buttons. 
4. Set the number of subdivisions by clicking the arrow buttons. 
5. Click the When resizing dropdown arrow and click how you want the scale bar to respond 

when the map scale changes. Adjusting the division value lets it vary with the map scale, 
the number of divisions and the width of the scale bar remain constant. You can also 
adjust number of divisions or the width, to let them vary with the map scale. Thus the 
characteristics not adjusted remain constant. 

6. Choose the units for the scale bar. 
7. To set a text style for the scale bar labels, click Symbol. 
8. Click OK. 

Tips 

• The units label on a scale bar is set the same as the scale bar units, by 
default  If you want to change the label of the scale bar to another unit  
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type the new scale bar label in the Label text box. 

• Once you have placed the element on the map it is possible to change 
the size and position and frame of it. While inserting a map element, the 
Size and Position tab or the Frame tab in the Properties menu remains 
disabled. 

Customizing a scale bar's numbers and marks 

1. Right-click the scale bar and click Properties. 
2. Click the Scale and Units tab. 
3. By clicking the Numbers Frequency dropdown arrow you can choose where along the bar 

to place the numbers. 
4. By clicking the Numbers Position dropdown arrow you can choose where to place numbers 

relative to the bar. 
5. By clicking the Marks Frequency dropdown arrow you can choose where along the bar to 

place tick marks. 
6. By clicking the Marks Position dropdown arrow you can choose where to place tic marks 

relative to the bar. 
7. To increase or decrease the height of division tick marks just click the Division Height 

arrow buttons . 
8. To do the same for the subdivision tick marks click the Subdivision Height arrow buttons. 
9. Click OK. 

Adding scale text 

1. Click on Scale Text in the Insert menu. 
2. Choose a sample of the style of scale text and click it to add it. 
3. To customize the scale text click Properties. 
4. Click OK. 
5. To place the scale text on your map click and drag it. 
6. You might want to set a specific font size for the scale text. Select a font size from the font 

size dropdown list on the Draw toolbar. 

Tip 

• To change the size of map elements select them and drag the selection 
handles - away from an element enlarges it, toward an element reduces 
it. 

Adding a legend 

1. In the Insert menu, click on Legend to start the Legend Wizard. If it does not appear, 
wizards have been turned off. When that's the case a default legend will be added to your 
layout. To modify its properties double-click this legend. If you want to add a legend using 
the Legend Wizard, wizards have to be turned on again. Do so by clicking Options in the 
Tools menu. A dialog appears, on the Application tab check the 'Show wizards when 
available' box. 

2. Once a legend is added, all the layers on the map will appear as legend items in the 
legend. You may want to remove a legend item by first clicking the item and then the left 
arrow button. 

3. To arrange the legend items as you want them to be use the Up and Down arrow buttons. 
4. Click Next. 
5. Type a title for the legend. 
6. Set the text color, font, and size as you prefer. 
7. Click Next. 
8. Choose a border by clicking the Border dropdown arrow and click on it. 
9. Choose a background by clicking the Background dropdown arrow and click on it.  
10. Choose a drop shadow by clicking the Drop Shadow dropdown arrow and click on it. 
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11. Click Next. 
12. You can change the symbol patch by clicking a Legend Item in the list. 
13. Set the Patch properties as you prefer. 
14. Click Next. 
15. Set the spacing between legend elements by typing a value into the appropriate box. 
16.  To end the Wizard click Finish. 

Tips 

• It is possible to edit the text of the labels that are shown in the legend 
by changing the text either in the LEICA Zeno Office table of contents, or 
on the Symbology tab of the Layer Properties dialog box. 

Changing the patches in a legend 

1. Right-click the legend on the map and click Properties. 
2. On the Legend tab choose a new patch shape by clicking the dropdown arrow. 
3. Click OK. 

Changing the items in a legend 

1. Right-click the legend on the map and click Properties. 
2. On the Items tab choose a legend item in the Legend Items list and click on it. 
3. You can move the item up or down in the legend if you click the up and down arrows. 
4. There are some options you might want to carry out: 
5. To modify the item's style in the legend, click Style. 
6. To place the item in a new column, check Place in new column . 
7. To change the number of columns for the selected legend item, click the up and down 

arrow keys. 
8. To remove an item from the legend, click it and click the left arrow key. 
9. Click OK. 

Tip 

• If two layers have the same geometry in a data frame—for example, a 
layer of roads and a layer of streams— and you want them to be 
displayed with different lines, it is possible to set their legend patches 
independently. Select the desired item for the layer to change from the 
Legend Items list. Right-click on it and click Properties. Check the 
Override default patch box on the General tab. Click the Patch dropdown 
arrow and select a new patch. 

Framing a map element 

1. Right-click the element on the map and click Properties. 
2. On the Frame tab choose a border by clicking the Border dropdown arrow and click on it. 
3. Choose a background by clicking the Background dropdown arrow and click on it.  
4. Choose a drop shadow by clicking the Drop Shadow dropdown arrow and click on it. 
5. Click OK. 

Tips 

• Remember that the frame properties can only be set once an element 
has been placed on the map. 

• To set a frame for a group right-click the group of the elements you have 
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grouped together.  

Converting map elements to simple graphics 

1. Right-click an element, such as a legend, and click Convert to Graphics. First the element 
is a grouped graphic. 

2. To edit the individual graphics that include the map element, ungroup the graphic by right-
clicking it and then click Ungroup.  
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Aligning and grouping map elements 

About aligning and grouping map elements  

You may want to align multiple map elements on your map the way that for instance the left 
edges of two legends conform with one another. Use the Align tool to arrange your map 
elements. 

 

How to align and group map elements 

Aligning map elements 

1. Select one of the map elements. 
2. To select another map element in addition, hold the Shift key and click it. 
3. Right-click on one of the selected elements, point to Align, and click Align Center. 
4. To place the aligned map elements, click them and drag them into position. 

Grouping map elements 

1. Select one of the map elements. 
2. To select another map element in addition, hold the Shift key and click it. 
3. Right-click one of the selected elements and click Group. 
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Aligning, distributing, and grouping graphics 

About aligning, distributing, and grouping graphics  

If you want to arrange your graphics more precisely choose on of the following options: 

 

How to align, distribute, and group graphics 

Aligning graphics 

1. Click on Select Graphics   on the Draw toolbar. 
2. Click the relevant graphics to be aligned. 
3. Click Drawing on the Draw toolbar, point to Align, and then select an alignment. 

Distributing graphics 

1. Click on Select Graphics   on the Draw toolbar. 
2. Click the relevant graphics to be distributed. 
3. Click Drawing on the Draw toolbar, point to Distribute, and then select a distribution 

method. The graphics then gets distributed with equal spacing between the centroid of 
each graphic. 

Grouping graphics 

1. Click on Select Graphics  on the Draw toolbar. 
2. Click the relevant graphics to group. 
3. Click Drawing on the Draw toolbar and click Group.  

Ungrouping graphics 

1. Click on Select Graphics  on the Draw toolbar. 
2. Click the relevant graphics to ungroup. 
3. Click Drawing on the Draw toolbar and click Ungroup.  
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Changing map highlighting options 

About map highlighting options 

Measurements and survey points that are selected in the Survey Explorer are highlighted by 
default on the map. You can choose a highlight color or turn off highlighting. You can also 
choose to highlight active objects only.  

How to change map highlighting options 

1. Click the Survey Editor menu and click Options. 
2. Click the Highlighting tab. 
3. Click the Color button to choose a different highlight color. 
4. Click No Highlighting to turn off all map highlighting. 
5. Click Active Object to turn on map highlighting for the active objects only. 
6. Click Objects Selected on the List page for all selected objects. 
7. Click OK. 
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Displaying map tips 

About map tips 

As Map tips pop up when you pause the mouse pointer over a feature or a survey point map 
readers will obtain additional information about that object. 

Working with LEICA Zeno Office makes it possible to decide which attribute field should be 
displayed as a map tip. 

 

How to display map tips for features 

1. Right-click  the desired layer for which to show map tips in the table of contents and click 
Properties. 

2. On the Display tab check Show Map Tips. 
3. On the Fields tab click the Primary display field dropdown arrow to select the attribute field 

for displaying as the map tip. 
4. Click OK. 
5. You may want to see the map tip. Just move the mouse pointer over a feature. 

How to display map tips for survey points 

1. Right-click  the desired survey point layer for which to show map tips in the table of 
contents and click Properties. 

2. On the Display tab check Show Map Tips. Compared to feature map tips survey point map 
tips are always showing the point name. 

3. Click OK. 
4. You may want to see the map tip. Just move the mouse pointer over a survey point and 

the name will be displayed. 
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Managing categories 

About managing categories  

If you're drawing features by category, the number of categories you display will affect what 
patterns are revealed on the map. Most people can easily discern up to seven categories for a 
given layer. The more technical the audience, the more categories they will be able to identify 
and the more easily they will be able to interpret complex patterns. Conversely, a less technical 
audience may benefit more from a map with fewer categories. 

Combining categories 

When displaying your data, you can control how you organize and display categories for a layer. 
If you want to display fewer categories, you can combine similar categories into one category—
for example, combine two detailed land use categories into a more general one. Combining 
categories in this manner can make the patterns more apparent. However, the trade-off is that 
some information may be lost. 

Organizing categories 

Instead of reducing the number of categories, you might organize individual categories into 
groups that you define. This allows you to work with and view them as a group. Additionally, a 
map reader will see the groups listed in the table of contents. 

How to manage categories 

Combining two or more categories into one 

1. In the table of contents, right-click the layer drawn with unique values for which you want 
to combine categories and click Properties. 

2. Click the Symbology tab. You should already see categories in the scrolling list. If you 
don't, follow the steps for drawing a layer showing unique values. 

3. Click the first value you want to combine. Hold down the Shift or Ctrl key and click the 
additional values that you want to combine. 

4. Right-click over the values and click Group Values. The selected values will now be 
combined into one category. 

5. Click OK. 

Splitting up combined categories 

1. In the table of contents, right-click the layer drawn to combine categories and click 
Properties. 

2. Right-click over the combined category. 
3. Click Ungroup Values. 

Organizing categories in headings 

1. In the table of contents, right-click the layer drawn with unique values for which you want 
to organize categories and click Properties. 

2. Click the Symbology tab. You should already see categories in the scrolling list. If you 
don't, follow the steps for drawing a layer showing unique values. 

3. Click the first value you want to group together. Hold down the Shift or Ctrl key and click 
the additional values that you want to group. 

4. Right-click a selected value, point to Move to Heading, then click New Heading. 
5. Type a name for the new heading. 
6. Click OK. 
7. Click OK on the Layer Properties dialog box. 
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Tips 

• LEICA Zeno Office will automatically delete groups that contain no 
attribute values in them. 

• To rename a group, click the group heading in the table of contents and 
type a new name. 
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Modifying and saving map elements 

About modifying and saving map elements  

Once a map element is added to the map layout, you have the option to change the properties, 
and save these changes for use in other maps.   

How to modify and save map elements 

1. Double-click the relevant element in layout view. 
2. Click the Color drop down arrow to select a new color. 
3. Click on the Style button, then click Save. 
4. Type a name and click OK. 
5. On the Frame tab click Style to modify the border style. 
6. Click Properties. 
7. In the Symbol Border dialog box, choose the desired properties. 
8. Click Save. 
9. Type a name and click OK. 
10. To set the background style and properties, repeat steps 5 through 9 . 
11. Click OK. 
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Moving, rotating, and ordering graphics 

About moving, rotating, and ordering graphics  

A part of the process of creating a map is to find the right position for graphics and other map 
elements. For example, arranging titles, neatlines, or North arrows on the layout. 

How to move, rotate, or order graphics 

Moving a graphic 

1. Click on Select Graphics  on the Draw toolbar. 
2. Select the relevant graphic. 
3. Click and drag it to its new position. 

Nudging a graphic pixel by pixel 

1. Click on Select Graphics  on the Draw toolbar. 
2. Select the relevant graphic. 
3. On the Draw toolbar, click Drawing, move the pointer to Nudge, then define the direction 

you want to nudge the graphic by clicking it. The graphic moves one pixel in this direction. 

Positioning a graphic to a specific location 

1. Click on Select Graphics  on the Draw toolbar. 
2. Double-click the relevant graphic. 
3. On the Size and Position tab type an x and y position. 
4. Click OK. 

Ordering a graphic 

1. Click on Select Graphics  on the Draw toolbar. 
2. Click the relevant graphic to be placed in front of or behind other graphics. 
3. On the Draw toolbar, click Drawing, move the pointer to Order, and then click the ordering 

option. 

Rotating a graphic 

1. Click on Select Graphics  on the Draw toolbar. 
2. Click the relevant graphic. 

3. Click on Rotate  on the Draw toolbar. 
4. Point over the "x" that specifies the rotation point and move it as you prefer. 
5. To rotate the graphic, click and drag the mouse . 

Flipping a graphic horizontally or vertically 

1. Click on Select Graphics  on the Draw toolbar. 
2. Click the relevant graphic. 
3. On the Draw toolbar, click Drawing, move the pointer to Rotate or Flip, and then click Flip 

Horizontally or Flip Vertically. 

Making graphics the same size 
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1. Click on Select Graphics  on the Draw toolbar. 
2. Click the relevant graphics. 
3. Click Drawing on the Draw toolbar, move the pointer to Distribute, and then click Make 

Same Size. 
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Setting a classification 

About setting a classification  

Setting a classification for your data can be done either by choosing one of the standard 
classification schemes or by specifying class ranges to generate custom classes based on them. 

Using a classification scheme and adjusting the number of classes lets LEICA Zeno Office do the 
classification work. 

Defining your own classes 

To set a classification appropriate for your data, make use of creating your own classes by 
inserting class breaks and defining class ranges as needed.  

If you've never generated a classification before, you might want to start using a standard 
classification and specifying it as you prefer.  

How to set a classification 

Setting a standard classification method 

1. In the table of contents, right-click the layer representing a quantitative value to modify 
the classification for and click Properties. 

2. On the Symbology tab click Quantities. You'll see the current classification. 
3. Click Classify. 
4. Click the Method dropdown arrow to select a classification method. 
5. Click the Classes dropdown arrow to choose the number of classes to be displayed. 
6. Click OK on the Classification dialog box. 
7. Click OK on the Layer Properties dialog box. 

Editing a class range 

1. In the table of contents, right-click the desired layer to set class breaks for and click 
Properties. The current classification should be displayed. 

2. On the Symbology tab click the Range (not the label) you want to edit.  
3. Type a new value to set the upper value of the range. 
4. Click OK. 

Tips 

• It is also possible to click and drag a break in the histogram on the 
Classification dialog box. 
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Taking advantage of map scale 

The provision of interactive maps makes it possible for mappers to take advantage of map scale 
because the more you zoom in the more details can be displayed. But zooming from one scale 
to another shouldn't be obvious, so that map users would see a big difference in the amount of 
the data displayed at each scale. See the three possibilities of how to provide a smooth map-
viewing by progressively revealing more and more features while zooming in: 

• Set visible scale ranges 
• Definition queries (showing a subset of features) - to limit the number of features in a 

given layer 
• Constrain which features get labels within the set features at a given scale 

To learn how, click here. 

See the following list of scale ranges to make a decision at which scale to display your data to 
ensure that all the important details will be shown. Therefore scale ranges let you separate data 
consisting of different detailed information concerning the resolutions and the number of 
features.  

1:0 to 1:10,000 
1:10,001 to 1:50,000 
1:50,001 to 1:250,000 
1:250,001 to 1:1,000,000 
1:1,000,001 to 1:5,000,000 
1:5,000,001 to 1:10,000,000 
1:10,000,001 to 1:25,000,000 
1:25,000,001 to 1,80,000,000 
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Using survey class fields for symbology 

About using survey class fields for symbology 

Using an attribute-based query definition on sublayers, you can draw survey points or 
measurements differently based on the attributes of the survey classes that the sublayers 
represent. For instance, you can use different symbols for survey points that occur above and 
below a specific elevation. 

How to define which survey objects to display based on 
their attribute fields 

1. Right-click the survey point sublayer. 
2. Click Properties. 
3. Click the Symbology tab. 
4. Click Query Builder. 
5. Double-click the field you want to use in the query. 
6. Click the logical operator you want to use. 
7. Scroll through the unique values list and click the value you want to use as part of the 

query, or type the value in the query box. 
8. Click Verify to verify the query. 
9. Click OK. 
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Visualizing error information 

About visualizing error information 

Where error information is available in the covariance matrix of a survey point, it is possible to 
display this information for a point’s GIS coordinate. If you alter the GIS coordinate using the 
Coordinate Manager tab, the new error information is updated on the map. 

Since the error ellipse is only visible at very large scales, you can select a magnification based 
on the typical map scales that you use. In this way, you can get a relative indication of error in 
the coordinates based on others. 

How to visualize error information 

1. Double-click the survey point sublayer name for which you want to display error ellipses. 
2. Click the Symbology tab. 
3. Check the Show Error Ellipse check box. 
4. Click the Symbol Selector button if you want to change the symbol for the error ellipse. 
5. Type a value for magnification of the error ellipse for displaying it on the map. 
6. Type a text description to be used in the legend for the survey point sublayer. 
7. Click OK. 
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Working with color 

About working with color 

Color is one of the fundamental properties of all symbols and map elements. The color palette 
on each dialog box shows the color contents of all the referenced styles. Your personal 
modifications are also shown at the top of the palette. You can use a variety of dialog boxes to 
create the colors you want. You can access the Selector dialog boxes from the color palette. You 
can access the Property dialog boxes from the Selector dialog boxes and the Style Manager.  

Color definitions 

LEICA Zeno Office can define color in these five color models:  

• RGB—red, green, blue  
• CMYK—cyan, magenta, yellow, black  
• HSV—hue, saturation, value  
• Gray—gray shade ramp  
• Names—ArcInfo color names 

How to work with color 

Defining the colors you want to use on your map 

1. Click the Tools menu, point to Styles, then click Style Manager.  
2. Click the Colors Style folder to view its contents.  
3. Right-click in the Contents window, click New, and choose a color model.  
4. Click a color in the Color window or use the color model spinners to mix a color.  
5. Click OK.  
6. Type the name of the new color in the Contents window. 

Tips 

• The color palette is a combination of all the referenced styles. As you 
create custom colors, they are displayed on the palette.  

• You can right-click a color on the color palette to see its name as a tip. 
• A null color lets you turn off outline drawing or create transparent areas 

in your symbols. However, a null color can’t be used to knock out or 
block other colors. 

• You can use the Eye Dropper tool  to identify the RGB values of any 
color on your map and save the color to your personal style. You can add 
the Eye Dropper tool to an LEICA Zeno Office toolbar from the Page 
Layout category on the Commands tab of the Customize dialog box. 

• The Eye Dropper tool is useful if you want the patches in your legend to 
display the opaque color values for symbols that have been assigned 
transparency. 

Learn more about colors and other map elements  

Redefining colors as you work 

1. Click the Color dropdown arrow on a dialog box or right-click a symbol in the table of 
contents.  

2. Click a new color or click More Colors to view additional colors.  
3. Use the Color Selector dialog box to mix a new color if you chose More Colors.  
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You can toggle the color model with the Arrow buttons or click the color preview to display 
the Property dialog boxes.  

4. Click the Arrow button and click Save Color.  
5. Type a name for the new color.  

The color is saved in your personal style.  

6. Click OK. 

Tips 

• The color palette is a combination of all the referenced styles. As you 
create custom colors, they are displayed on the palette.  

• You can right-click a color on the color palette to see its name as a tip. 

Defining the color of a base symbol 

1. Right-click the layer in the table of contents containing the base symbol whose color you 
want to define.  

2. Click Properties.  
3. Click the Symbology tab.  
4. Click the symbol button.  
5. Click the Color dropdown arrow and click a color or click More Colors to mix your own 

color.  
6. Click OK on the Symbol Selector dialog box.  
7. Click OK on the Layer Properties dialog box. 

   

Defining a null color from the Style Manager 

1. Click the Tools menu, point to Styles, then click Style Manager.  
2. Click the Colors Style folder to view its contents.  
3. Right-click in the Contents window, click New, then click Gray.  
4. Click the Arrow button and click Advanced Properties.  
5. Check the Color is Null option.  
6. Click OK. 

Tips 

• A null color lets you create transparent areas in your symbols. It also lets 
you turn off outline drawing. However, a null color can't be used to knock 
out or block other colors.  
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• The No Color option on the color palette produces the transparency effect 
of Color is Null, but LEICA Zeno Office maintains the previous color value 
with Color is Null. (In the graphic above, unchecking Color is Null 
displays the original coral fill color. With No Color, the coral color is lost.) 

• The color palette is a combination of all the referenced styles. As you 
create custom colors, they are displayed on the palette.  

• You can have the patches in your legend display the opaque color values 
for symbols that have been assigned transparency.  

Learn more about colors and other map elements  

Defining a null color from a Symbol Selector dialog box 

1. Click the Color dropdown arrow on a dialog box.  
2. Click More Colors.  
3. Click the Properties tab.  
4. Check the Color is Null option.  
5. Click OK. 

Tips 

• A null color lets you create transparent areas in your symbols. It also lets 
you turn off outline drawing. However, a null color can't be used to knock 
out or block other colors. To see an example of a null color, see 'Defining 
a null color from the Style Manager'. 

• The No Color option on the color palette produces the transparency effect 
of Color is Null, but LEICA Zeno Office maintains the previous color value 
with Color is Null.  

• The color palette is a combination of all the referenced styles. As you 
create custom colors, they are displayed on the palette. 

• You can have the patches in your legend display the opaque color values 
for symbols that have been assigned transparency.  

Learn more about colors and other map elements  
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Working with graphic elements, pictures, and neatlines 

About graphic elements, pictures, neatlines 

Geographic data, scale bars and other typical map elements as well as graphic elements, 
pictures, neatlines, and objects can be presented by a map. 

Graphic elements 

If you want to: 

• Ornament a map, 
• Group related parts of a map together, or 
• Identify a map with an organization 

make use of the graphic elements.  

Graphic rectangles 

If you want to frame a group of other map elements then use the option of graphic rectangles. 
Just choose one of the map elements, right-click it, click Properties and then select the Frame 
tab. This method lets you select several elements, for instance borders and backgrounds for 
legends, North arrows, data frames, scale bars, scale text, and data frames. 

Pictures 

Pictures, or geographic images - a company's logo or a nation's flag -, can also be drawn on a 
map to indicate its source or subject, or to ornament a map. Simply add the desired images to 
the map.  

Objects 

An object can almost be any type of data that you can insert to your map, and edit.   

How to work with graphic elements, pictures, and 
neatlines 

Adding a graphic element 

1. On the Drawing toolbar click the graphics dropdown arrow. 
2. Click the New Rectangle button. 
3. Once you've clicked on the map and dragged a box where the rectangle should be 

displayed, the graphic element appears. 

Applying color to a graphic element 

1. Select a graphic element. 
2. Click the Fill Color dropdown arrow to choose a color by clicking it.  

Applying a line color to a graphic element 

1. Select a graphic element. 
2. Click the Line Color dropdown arrow to choose a color. 
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Placing a graphic element behind other elements 

1. Select the graphic element. 
2. Right-click on it, point to Order, and click Send to Back. 

Adding a neatline 

1. In the Insert menu, click Neatline. 
2. Click the desired Placement option. 
3. If you want, check Group neatline with elements. 
4. Click the Border dropdown arrow to select a type of neatline. 
5. Click OK. 

Adding a picture 

1. In the Insert menu, click Picture. 
2. To select a picture, navigate to the folder comprising the picture. If you want choose a 

type of the picture. 
3. Click the picture. 
4. Click Open. 
5. To place the picture on your map, click and drag it. 
6. If you want, you can resize the picture.  Just click a selection handle and drag the picture. 

Adding an object 

1. In the Insert menu, click Object. A dialog appears. 
2. Either select Create New and specify the type of object to be added, or select Create from 

File and specify the existing file to be added. 
3. As soon as you click OK the application registered for this object type is launched. 
4. After having finished to edit the object, select Close and Return from the application's File 

menu. 
5. Position and size the object on your map. 
6. If you want to modify the object, double-click it. 
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Working with spatial bookmarks 

About bookmarks  

Working with spatial bookmarks allows you to save a geographic location to which you want to 
refer later. Additionally, a particular area on the map can be highlighted using a bookmark. 

To create a spatial bookmark you have to be in data view since bookmarks can just be defined 
on spatial data.  

The bookmarks refer to a data frame and therefore they are listed for each frame separately. If 
you're in layout view you'll see the bookmarks of the active data frame. 

How to use bookmarks 

Creating a spatial bookmark 

1. Pan and zoom the map to the area a bookmark should be created for. 
2. In the View menu, point to Bookmarks, and click Create. 
3. Type a name for the bookmark. 
4. Click OK. 

Using a spatial bookmark 

1. In the View menu, point to Bookmarks. 
2. Select the bookmark by its name. 

The bookmarked display shows up. 

Creating a spatial bookmark from the Identify Results dialog box 

1. Click on Identify  on the Tools toolbar. 
2. Point over the map feature and click to identify it. 
3. In the Identify Results dialog box, right-click the identified feature. 
4. Click Set Bookmark. The bookmark gets the same name as the feature. 

Creating a spatial bookmark from the Find dialog box 

1. Click on Find  on the Tools toolbar. 
2. Fill in the dialog box to search for the desired features. 
3. Right-click the Value in the Find Results list. 
4. Click Set Bookmark. The bookmark gets the same name as the feature. 

Removing a spatial bookmark 

1. In the View menu, point to Bookmarks, and click Manage. 
2. Select a bookmark. 
3. Click Remove. 
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Working with titles 

About working with titles  

Beyond the basic elements that are related to data frames, there are some map elements that 
provide additional information, frame or group the elements of the map, or ornament the map. 
These elements comprise titles, graphic elements and reports. 

Usually a title is used when creating a map to communicate the topic of the map and to 
facilitate the reference to the map.  

How to work with titles 

Adding a title to a map 

1. In the Insert menu, click Title. 
2. Type a title. 
3. To place the title on your map, click and drag it. 
4. If you want you can change the appearance of the title text. 

Modifying a title 

1. Select the title. 
2. Click the Font dropdown arrow to choose a font by clicking it. 
3. Click the font size dropdown arrow to select a font size. 
4. Modify the style of the text by choosing Bold, Italic, or Underline and then click on it . 
5. Click the Text Color dropdown arrow to select a color. 
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Legend with mixed format descriptions 
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Printing a map 

Printing a map 

About printing a map 

There are a few basic concepts to understand regarding printing a map:  

• Printer paper setup and map page setup 
• ArcMap printer engines 
• Output resolution 

If you're printing a map with labels, you must first control the labeling process.  
Learn about labeling  

Setting up your printer paper and map page to print 

There are two basic printing scenarios for how the paper and page are setup:  

• You have Use Printer Paper Settings selected on the Page and Print Setup dialog box. 
• You are not using printer paper settings and have chosen a standard page size or 

defined your own custom page size. 

If you are using the printer paper settings, then your virtual map page is actually the printer 
paper and the ArcMap Layout is basically a print preview.  
If you are not using the printer paper settings and have chosen either a standard page size or 
defined a custom page size, you will need to do one of the following:  

• Match the page size of the printer you have chosen to your virtual map page or change 
the page size of the map. For example, if your virtual map page is E-sized landscape, 
choose an E-sized paper size on your printer and change the orientation to landscape. 
Remember to select the printer you want to print to first. Note that your map may shift 
slightly on the page when it is printed. To verify that your map will print without 
clipping, use print preview. 

• If your printer can't accommodate a page the size of the map, you can print the map as 
tiles on separate pages or scale the map to the printer page size. If you want to 
proceed with printing and clipping the map, choose to print just the first tile.  

• If you have another printer on the network that will print your large map on a single 
page, you can switch to that printer. Simply choose the new printer and the correct 
page size on the Page and Print Setup dialog. You can also change the page size of the 
map on the Page Setup dialog box. 

Learn more about setting up the page  

You do not need to worry about saving a map document that has the Use Printer Paper Settings 
option. When ArcMap opens a map document with this option and it cannot find the printer that 
is referenced, ArcMap will simply turn off this option and continue opening the map with no 
changes.  

Choosing ArcMap printer engines 

The Windows printer engine is the default print engine, and should be your first choice for 
printing. This print engine generally produces extremely high quality output, but can be very 
resource intensive.  
The PostScript printer engine should be used in cases where you need to produce special output 
required for publication and commercial printing, such as color plate separation and registration 
marks. While this print engine does provide these special features, its output quality does not 
exceed that of the Windows printer engine.  
The ArcPress printer engine is available via extension license and should be used when you have 
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a large number of people printing simultaneously to relieve the load on the printer(s), when you 
have printers with limited onboard processing abilities (no PostScript onboard rasterizer, lower 
amount of RAM and/or hard drive), or when your maps seem to exceed the processing 
capabilities of your existing printers. See the ArcPress documentation for more information.  

Setting output resolution 

There are two settings which effect the print quality and ultimately, the amount of time it will to 
process and print the map:  

• Output resolution 

Windows printer engine: Setting the output resolution will vary according to the 
Windows printer driver installed and chosen. For some printer drivers, it may be listed 
as the print mode (for example, high, normal, and fast) or may include an actual dots-
per-inch or DPI setting.  
PostScript printer engine: Since the PostScript printer engine is intended for the 
production of color separates, choosing the highest resolution possible for the printer 
you have selected is usually the best option.  
Note that the print processing time will be longer when you choose a higher output 
resolution. Increasing the resolution does not always ensure a higher quality print, as 
the printed image might become too dark or the difference between the lower and 
higher dpi prints might not be varied enough to justify the longer processing time.  
To determine which resolution or combination of output resolution settings to use, 
create a small map containing samples of the data and other map elements you intend 
to include, and print the sample at various settings. You may find that printing with the 
Windows printer engine set to 300 dpi with the printer set to print in best quality mode 
may produce the highest quality output with minimal processing time.  

• Output Image Quality 

The Output Image Quality (OIQ) option allows you to control the amount of raster 
resampling.  
The OIQ slider set to Best or 1:1 will do no resampling. It is then a non-linear scale; 
increasing the amount of resampling decreases the file size and time required to 
process and print the map.  
By default, OIQ is set to Normal or 1:3. It is recommended to use either Normal, or 
move the slider to the right to NormalBest or 1:2.  

How to print a map 

Previewing a map 

1. Click the File menu and click Print Preview.  
2. Examine the preview. 
3. Click Print if you want to continue on and print. 

Otherwise, click Close.  

Tips 

• Large maps with raster layers may look excessively dark in the small 
print preview window because rasters are not resampled for the preview. 
This won't affect the way your map appears when it is printed at full 
scale. 

• If you need to use print preview to verify that your map page will fit 
properly on the printer paper size you have chosen or on the print tiles, 
you can greatly increase the speed of print preview by turning off all the 
layers in your map. By just leaving on your map surrounds (scale maps, 
titles, and so on), you can get a quick idea of how the map will print 
without having to wait for print preview to display the data. 
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Choosing a printer engine 

1. Click the File menu and click Print.  
2. Click the Printer Engine dropdown arrow and choose a printer engine. 
3. Click OK. 

Tip 

• The Windows printer engine usually produces the best possible output 
because it derives the most printer-specific information from the 
Windows printer driver.  

The PostScript printer engine is an excellent choice for those who require 
user-defined, high-end cartographic options, such as color separates and 
page marks.  
The ArcPress printer engine is an add-on extension that is useful for 
printing a large quantity of maps and providing a different printing 
option.  

Printing a map 

1. Click the File menu and click Print.  
2. Click the Printer Engine dropdown arrow and click a printer engine.  

The Windows printer engine is the default and recommended printer engine.  

ity of the print. 
4. If the map page size is larger than the printer page size, then the Tile Map to Printer Paper 

r Paper. If 
you wish to proceed with printing, regardless of any possible clipping, click Tile Map to 

3. Click along the Output Image Quality slider to choose the image qual

will be selected. If you don't wish to tile your print, click Scale Map to fit Printe

Printer Paper and choose to print Tiles 1 to 1. 
5. Click the Number of Copies arrows to increase or decrease the number of printed maps. 

Optionally, check Print to File if you wish to print to a file and not directly to a printer.  

6. Click OK. 

Tips 

• By default, OIQ is set to Normal or 1:3. It is recommended to use either 
Normal or move the slider to the right to NormalBest or 1:2 .  

• For large or very complex maps or maps with rasters or transparent 
layers, the Windows and PostScript printer engines may produce print 
files that are larger and more complex than your printer can handle. If 
your printer is unable to print your map, you should purchase the 
ArcPress printer engine to use with ArcMap.  

• If you are printing with the PostScript printer engine, you should select 
the appropriate PPD file for the currently selected printer. See 'Creating 
color separates' for more information. 

Tiling a map that's bigger than your printer page 

1. Click the File menu and click Print Preview.  

will see a portion of the map 
in the preview.  
If the map page size is larger than the printer page size, you 
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2. Click Next, First, Previous, or Last to view each tile. 
3. Click Print.  
4. Click Tile Map to Printer Paper.  

 5. Click All, or Tiles and enter the range of tiles to print.
6. Click OK. 

Tips 

• If you have Use Printer Paper settings in Page Setup, printing your map 
will be very simple—just click File, click Print, then click OK.  

Learn more about setting up the page  

• If you want to proceed with printing and clip the map, choose to print 
just the first tile. 

Printing multiple copies 

1. Click the File menu and click Print.  
ou want to print.  

3. Click OK. 
2. Type the Number of Copies y

   

Printing to a file 

1. Click the File menu and click Print.  
 

gine. If you choose the Windows printer engine, you'll 
nter file, *.prn. If you choose the PostScript printer engine, you'll 

create a PostScript file, *.ps. If you choose the ArcPress printer engine, you'll create a 

5. Type a name for your print file.  

  

2. Check Print to File. 

Optionally, choose another printer en
create a Windows pri

raster file with the extension of the ArcPress driver you've selected.  

3. Click OK.  
4. Navigate to where you want to save the output print file.  

6. Click Save. 

 

Creating color separates 

1. Click the File menu and click Print. 
own menu and click PostScript printer. 

3. Click Properties. 

the Vendor dropdown 
nd click your 

2. Click the Printer Engine dropd

4. Click the Color Separation tab. 
5. Choose the appropriate PPD (PostScript printer description) file, click 

list and click your printer manufacturer, then click the Device dropdown list a
printer model.  

If you cannot find your exact printer model, you will need to install it.  

6. Click the Separates button.  

Optionally, also click the PostScript Level 3 check box.  
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7.  that color in the Value table and 
then edit the screen angle. 
To change the screen angle of C, M, Y or K, double-click

8. Click the Halftone dropdown list if halftone is supported on the selected printer, and 
choose the appropriate resolution/lines per inch you need. 

9. Click OK. 
10. Click OK to print or follow the instructions to print to file. 

Tip 

• You can only create PostScript color separates for PostScript enabled 
printers; you also must have the PostScript Windows printer driver 
installed for your printer. 
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Using Leica Data Manager in Zeno Office 

Using Leica Data Manager in Zeno Office 

The Leica Data Manager toolbar in Zeno Office includes following tools:  

• EasyOut: Used to extract data from your office database to use with Zeno Field 
including automatic data transfer. 

• EasyIn: Used to Check in edits that you made in Zeno Field including automated post 
processing and data transfer. 

• Import Survey Data: Import of several survey data formats 
• Export Survey Data: Export to several survey data formats 
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Preparing your data for Zeno Field 

Zeno Field is a mapping tool for working with your GIS data in the field. GIS tasks in the field 
are often quite different from the GIS tasks performed in the office, and so too are the 
computers used in these different environments. Desktop computers usually have fast CPUs, 
large amounts of RAM and disk space, and large display monitors. In contrast, field computers 
have relatively slow CPUs and limited RAM and storage capacity. Furthermore, the field work 
environment ranges from working in bright sunlight to rain to subzero snow conditions, 
compared to the constant temperature and lighting conditions of the office environment. 
Consequently, you need to consider all of these factors before preparing your GIS data for use 
in the field with Zeno Field. 

 

Answers to the following questions will determine how you need to prepare your data for 
optimum use in the field: 

• What tasks will be performed in the field, and what data will be needed for these tasks?  
• What data will be updated, and what data will be needed for background reference?  
• What is an appropriate amount of data, taking into account the field tasks as well as the 

field computer’s CPU, RAM, and storage capacity?  
• What symbology needs to be used for effectively displaying the data on the field 

computer in the expected weather and lighting conditions?  

 

This is an important issue. The artificial light and large monitors used in the office environment 
enable the use of a wide range of colors and symbols, whereas only a limited number of colors 
and symbols provide sufficient contrast when used in the field with small computer screens and 
strong sunlight. 

 

Although Zeno Field supports most of the symbology available with Zeno Office, it may not 
always be appropriate for field conditions to use the complex symbology supported by Zeno 
Office and Zeno Field. In many cases simple, high-contrast symbols using primary colors are 
more effective in the field than detailed symbols using a wide spectrum of colors. 

 

There are a number of different operations that you may need to perform to prepare your data 
for use in the field with Zeno Field, including: 

• Extracting an appropriate subset of the data  
• Converting the data into a format supported by Zeno Field 
• Projecting the data into a projection supported by Zeno FieldSpecifying symbology that 

has sufficient contrast for the expected field lighting conditions  
• Preparing data input forms and validation rules to ensure that data is captured 

accurately in the field  

 

The Zeno Field Data Manager for Zeno Office provides some of the tools for preparing data for 
use with Zeno Field. Additional tools for tasks such as projecting data are included with Zeno 
Office. 
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In summary, it is essential to always bear in mind that field computers, tasks, and conditions 
are very different to computers, tasks, and conditions in the office. Therefore, what works in the 
office environment may often not be effective in a field environment. 

Important NOTE: Data not supported by the Zeno Field Data Manager 

The following data types are not currently supported by the Zeno Field Data Manager: 

• Geometric Networks: you can check out the feature classes that participate in 
a geometric networks but the network itself is not supported in Zeno Field.  

• Table to table, and table to feature class relationships  

• Annotations are not supported in Zeno Field 

• Zeno Office online services are not supported in Zeno FieldLEICA MobileMatriX 
Professional is required to check data in and out, and to edit an ArcSDE check-
out geodatabase. 
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Suggested workflows using EasyOut and EasyIn 

Single EasyOut and EasyIn 

 

 

1. Use EasyOut to check out project from the database and copy it to the Zeno 10/15 field 
device. 

2. Complete the field survey. 
3. Use EasyIn to check in and post process the field work and copy to the database. 

 

Repeat the full process for your next field project. This means for every EasyOut there is an 
EasyIn process.  

 

This process can be done by multiple field crews at the same time. After the next EasyOut, the 
field project contains the latest state of the data in the office database. 
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Single EasyOut and multiple EasyIn 

 

 

1. Use EasyOut to check out project from the database and copy it to the Zeno 10/15 field 
device. 

2. Complete the field survey. 
3. Use EasyIn to check in and post process the field work and copy to the database. The field 

project is synchronized. It is important to apply EasyIn process directly from the controller 
because it requires an update of the field project. 

4. Complete the field survey. 
5. EasyIn (directly from device, field project gets synchronized) 
6. Repeat step 4 and 5 till project is complete. 

   
NOTE: Both processes work for single or multiple field crews. 

The field project created by the EasyOut can be used by multiple field crews to be 
updated. Multiple EasyIn brings all data back to the office. 
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Zeno Field Exchange Format 

Overview of Zeno Field Exchange Format (AXF) 

An Zeno Field AXF file is a single file that is made up of multiple components, as shown below: 

 

 

 

• Feature Layers, which can be thought of as a representation of the feature data. A 
feature layer can be considered as the equivalent of an Zeno Field Layer Definition 
(.APL) file associated with a shapefile. The feature layer defines the symbology, forms, 
layer name, layer folder (for grouping), and layer icon for a feature table. There can be 
multiple feature layers defined for a single feature table.  

• Feature Tables, which contain all of the data for the feature class, including the 
geometry and attribute data. A feature table can be considered as the equivalent of a 
shapefile. The feature table stores the feature’s geometry, attributes, and projection 
meta data—data that is stored in a shapefile’s SHP, SHX, DBF, and PRJ files.  
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• Data Tables, which are data tables that have no spatial component (for example, 
related tables and coded value domains).  

• Files, which include any external file used by the Zeno Field AXF file (for example, script 
files).  

• Properties of the AXF file (for example, the date and time when the Zeno Field AXF file 
was created).  

The Zeno Field file can also store the following:  

• Customization for each feature layer, including custom forms and scripts  
• Coordinate system meta data  
• Spatial and attribute indexes, which are automatically maintained  
• Icons for feature layers  
• Data rules, such as subtypes, coded value domains, and range domains  
• Relationships between feature tables and data tables  

 

An Zeno Field or AXF file is a Microsoft SQL Server Compact Edition relational database. The 
Microsoft SQL Server Compact Edition runtime needs to be installed on your device in order for 
Zeno Field to recognize and use an AXF file. The runtime is automatically installed together with 
Zeno Field on the Zeno10/15 via the Zeno Field Deployment Manager. All data in AXF files is 
stored using Unicode character encoding, eliminating the need to specify a codepage for AXF 
files. 
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Creating Zeno Field AXF files 

AXF files can be created using the EasyOut to Zeno Field tool in Zeno Office/ArcMap.  

This tool allows you to create AXF files from selected geodatabase feature layers. These tools 
automatically read the geodatabase schema, including any relationship classes, and use the 
schema to construct the resultant AXF file. AXF files can only be created when layers are 
checked out from a geodatabase—and are always created when layers are checked out from a 
geodatabase. AXF files can be created from shapefiles or from geodatabase layers that are 
selected for copy out. You cannot check in the edits to you made to the copy out layers. The Get 
Data for Zeno Field tool also generates data input forms automatically for the checked out AXF 
files. 
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Using Zeno Field AXF files 

AXF Feature Layers can be added to and removed from the Zeno Field map, just as you would 
do with shapefiles. Related tables are only visible in Zeno Field when you select a feature from a 
Feature Layer that has an associated related table. Once the AXF feature layer has been added 
to Zeno Field, features and related table records can be added, modified, or deleted.  
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Advantages of Zeno Field AXF files 

AXF files provide many advantages over shapefiles, including the following: 

 

• A single AXF file can store multiple feature classes (or feature tables) and multiple 
feature layers; and all of the related tables, customization, projection information, and 
other data associated with these feature classes and tables. In contrast, a shapefile can 
only store a single feature class.  

• An AXF file consists of a single file, whereas a shapefile is comprised of a number of 
files. The single file results in more robust behavior during power interruptions or 
rebooting of the mobile device.  

• Less memory is required for opening and working with AXF files.  
• AXF files support related tables, subtypes, and domains (both coded-value and range 

domains). These relationships are managed at the database level—whereas with 
shapefiles extensive scripts and forms are required.  

• All text data in AXF files is stored using Unicode character encoding, eliminating the 
codepage issues associated with the shapefile DBF files.  

• Spatial and attribute indexes for AXF files are maintained on-the-fly during editing. This 
results in consistent performance when viewing or editing AXF files, and eliminates the 
need to rebuild the indexes after editing. In contrast, the spatial and attribute indexes 
for shapefiles are deleted as soon as the layer is activated for editing, resulting in much 
slower draw and query performance when editing shapefiles and the need to rebuild the 
indexes when editing is completed.  

• AXF files can be encrypted, requiring a password to open and use the contents of the 
AXF file. This provides some level of protection of the contents of the AXF file.  

 

Although AXF files provide many advantages over shapefiles in some situations shapefiles are 
preferable to AXF files. Shapefiles perform better than AXF files when shapefiles are not being 
edited and the spatial and attribute indexes exist. In these cases shapefiles draw faster than 
AXF files. As a result, shapefiles are preferred for large, read-only background or reference data. 
However, the performance of shapefiles slows down considerably once the shapefile has been 
activated for editing and the indexes have deleted. 
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EasyOut 

EasyOut overview 

The EasyOut tool allows you to get data for layers represented in the active data frame and 
transfer it directly into a mobile device for use with Zeno Field. Any feature or raster data in the 
active data frame can be copied out, including shapefile, coverage, geodatabase, and CAD data. 
You can also copy out any graphics present in the map. Data that is copied out is automatically 
converted into a format that Zeno Field can use.  

 

A Zeno Field Layer Definition is created for each feature layer you choose to get. The Zeno Field 
Layer Definition contains the layer properties that Zeno Field supports, including symbology 
definition, scale dependencies, and basic labelling properties. An ArcPad Map file (.apm) 
referencing the selected data gets created automatically.  

 

Geodatabase layers and their related tables can be checked out for editing in Zeno Field, 
providing the layers and related tables are in the same geodatabase. The geodatabase layers 
and related tables that are checked out are exported to a single ArcPad Exchange Format (AXF) 
file. Together with the feature, all linked survey points get checked out as well. They are stored 
in the SurveyedVertex shape file. 

 When checking out geodatabase layers, you can select an existing Layer Definition from a 
shapefile or ArcPad AXF layer to use as a template. This allows you to re-use forms, scripts, 
icons, and other layer definition elements. 

 

It is recommended that you always check out from a version of your geodatabase (if you are 
using a versionable geodatabase), and never from the DEFAULT version. Checking out from this 
field version will allow you to verify all field edits that have been checked in before applying the 
edits back to the DEFAULT version. If you have multiple field users and your workflow allows the 
possibility for more than one user to edit the same feature, then it is recommended that you 
create a version for each user as children of the field editing version. This allows for conflict 
detection between field users as well as verifying all field edits before applying the edits back to 
the DEFAULT version.  

 

EasyOut: Step-by-step 
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EasyOut step-by-step 

1. Start Zeno Office on your PC by clicking Start > All Programs > Leica Zeno > Leica Zeno 
Office or by double-clicking the Leica Zeno Office shortcut on your Desktop. 

 

2. Open the project from which you want to extract data for your field work. 

 

3. Define the data which should be extracted. There are 3 possibilities which require settings 
before you start EasyOut: 

• Current display extent: Use the pan and zoom tools or a bookmark to define 
the desired extent in the map from which features should be extracted. 

• Full extent of selected feature(s): Select the features you want to extract. Use 

Select Features  to select them interactively in the map or select by attributes 
or location. 

• Full extent of selected graphic(s): Select one or more graphics using Select 

Elements  . If necessary create new graphics or move/resize existing ones. 
This allows extracting data from several sites in just one step. Multiple selections 
can be done by pressing the Ctrl key. 

 

4. Click the EasyOut button   on the Leica Data Manager toolbar. 

 

5. The EasyOut to Zeno Field dialog appears. All layers of the map are selected for check out 
by default. 

 

6. Select the layers from which data should be extracted using check out or copy out in the 
according columns. Not checked layers will be ignored. To select all or deselect all just 
right click on the according column header to open a context menu. 
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Tip 

• Check Out is the right choice if the changes in the field should be merged 
into the data of origin in the office using EasyIn. 

• Use Copy Out if you don’t want to merge the changes with the version of 
origin or for background layers. Copied out layers perform faster, but can 
not be checked in. 

• The Raster layer can only be copied out. 
• All values of a column can be changed at once by a right click on the 

column header and setting the desired value using the context menu. 
• The wizard will only let you check out data from one database per 

transaction. By default the data source of the topmost layer in the 
Display tab is used to extract data from. If you need to edit multiple 
geodatabases, you will need to change the layer drawing order and start 
the wizard again to complete additional transactions. 

 

7. Specify which feature should be extracted. Therefore change the settings in the Feature 
Selection column. There are the following options which can be set separately for every 
layer: 

• All: All features of the layer are considered 
• Selected features: Only selected features of the layer are considered 
• Layer’s definition query: Only features which fulfill the definition query of the 

layer are considered. The layer definition query is set in the Definition Query tab 
of the Layer Properties dialog. 

 

8. Specify which attribute fields should be checked/copied out. There are the following 
options which can be set separately for every layer: 

• All: All attribute fields of the feature class are considered. 
• Visible: Only visible attribute fields of the feature class are considered. The 

visible fields are defined in the Fields tab of the Layer Properties dialog. This 
option helps to reduce the size of the feature properties in Zeno Field. 

 

9. Layer definition files can be browsed in the last column. Therefore click on the   button of 
the according layer and browse the desired file. 

 

10. Check the check out schema of data check box if the schema only should be checked out. 
This means, that empty feature classes with the same attribute fields get checked out. Use 
this option if you plan to collect new data in the field and existing features are not 
required. 
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11. The image output format can be defined if one or more raster layers are checked for copy 
out. Select one of the following settings: 

• Original Format: the output format is the same as the input format 
• JPEG 2000:  
• TIFF:  Tagged Image File Format. Please note, that the output raster files can 

have a bigger file size than the original picture. 

 

12. Define the data which should be extracted. There are 4 possibilities: 

• Current display extent: The display extent of the map specified in step 3. It is 
possible to have multiple graphics selected 

• Full extent of selected layer(s): All features included in the layer. 
• Full extent of selected feature(s): All selected features in the map. 
• Full extent of selected graphic(s): The extent of all selected graphics specified 

in step 3. It is possible to have multiple graphics selected. 

 

13. Enter a Project Name. 

 

14. Browse a project location. You can click the Folder icon   to browse for a new folder 
location. 

 

Tip 

• You can directly browse your mobile device via a mobile connection  
 (recommended). 

• Alternatively browse the ActiveSync data exchange folder. 

 

15. Click Finish to perform the transaction.  
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16. Click OK after the process has been completed. 
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EasyIn 

EasyIn overview 

The EasyIn tool allows you to check in the edits made in Zeno Field back into the geodatabase 
from which the data was checked out. You can also import Zeno Field graphics files into 
ArcMap's graphics layer.  

 

You can check in edits from one or more feature classes at a time. Just import GNSS raw data 
from a local source or web address and let Zeno Office post process your GNSS observations to 
make your data more accurate and reliable. Summaries of all added, modified, and deleted 
features are presented for each feature class and its related tables. All edits on related table 
records are checked in when their parent feature classes are checked in.  

 

All edits that occurred in Zeno Field, including adding features and related table records, 
deleting features and records, modifying attribute values, and changing feature geometry can 
be checked back into the geodatabase. Edits are stored to the Zeno Office geodatabase in the 
same order as they occurred in Zeno Field. 

 

EasyIn: Step-by-step 
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EasyIn step-by-step 

1. Start Zeno Office on your PC by clicking Start > All Programs > Leica Zeno Office or by 
double-clicking the Leica Zeno Office shortcut on your Desktop. 

 

2. Open the project from which you extracted the data for your field work using EasyOut. 

 

3. Click Editor > Start Editing on the Editor toolbar. 

 

4. Click the EasyIn button  on the Leica Data Manager toolbar. 

 

5. Click Browse   to browse for your project file. The project file can be located directly on 

the Zeno device via a mobile connection   

 

Tip 

• It is recommended to browse the project directly on the Zeno device via 

a mobile connection , as the Zeno Field project will be updated with 
the EasyIn information.  

 

 

6. All modified feature classes are selected by default for check in. Modify the default settings 
if necessary. The number of added, modified and deleted features is shown in the 
according columns   

 

7. Check the Import GNSS Raw Data check box if you want to import the GNSS raw 
observations collected in Zeno Field during the field work. It is mandatory to import this 
data for post processing. 
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Tip 

• A later post-processing is only possible, if the raw observations where 
checked in. 

• Raw data only exists for your measurements, if you had raw data logging 
enabled in your field project. If you measured with real time corrections, 
it is usually not necessary to import raw observations.  

 

 

8. Check the Post Process GNSS Observations check box to automatically post process your 
observations during the EasyIn process. The EasyIn process automatically uses the best 
possible processing parameters for your data. 
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Tip 

Automatically all feature classes with added, modified and deleted features are 
checked. 

• Added: Displays the number of new features and records that were 
added to the feature class and related tables in Zeno Field. 

• Modified: Displays the number of features and records that were 
modified in Zeno Field. These modifications include both geometry and 
attribute changes.  

• Deleted: Displays the number of features and records that were deleted 
from the feature class in Zeno Field.  

 

 

9. Define the location of your reference data: 

• Local: A local folder on your PC contains the reference data for your observation 
period. You may have downloaded this data from your own reference station or 
your reference data provider. 

• IGS Network: Automatic reference data download from a IGS server. This 
service is free of charge. 
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10. Click Settings…: 

• For Local: There are two options for defining the reference data location: 
• Browse for Reference Data: During the processing of EasyIn, the user will be 

asked to browse for the reference data file manually. Only a single file can be 
selected. 

• Auto select Reference Data: Predefine a reference data location. The system 
will select the correct files automatically in this location with its sub folders. This 
option selects all reference data files which fit to the rover measurement intervals. 

 

Tip 

Please note, that RINEX files only are supported on a local drive and no 
compressed RINEX formats like HATANAKA. 

 

• For IGS Network: Prepare the settings for importing the reference data file for 
existing GNSS observations by selecting IGS Network then click Settings… 
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1. Select the desired server 
2. There are two options for IGS Network download: 

 

1. Use nearest site: EasyIn automatically selects the site with the shortest distance 
to your project area. 

 

 

 

2. Use selected site: Using this option, you can define, from which site you would 
like to download reference data from. 
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11. Click OK 

 

12. Click OK to start the EasyIn process. 

 

13. The Select Reference Station Data dialog appears if you’ve selected Browse for Reference 
data. Select the desired reference station data file and click Open. 

 

14. Then EasyIn Live Data Viewer appears. This dialog reports in real-time all steps done by 
the automated EasyIn process. Use the Live Data Viewer report to review your processing 
results. 

 

Please note the following sections: 

• Backup Project: An automatic backup of the field data gets created. Please 
note, that the backup file gets deleted automatically after 30 days. If EasyIn 
would fail, you can unzip the backup file and try again. 

• Check-In Features: Summary of all changes per feature class. 
• Create Survey Points: Survey Points contain the quality information of your 

measured points. 
• Post Process Observations: Accuracy summary of the processed points 
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• Post Processing Details: 
i. Processing Parameters 
ii. Reference station details 
iii. Details of every processed point including coordinate and accuracy 

information 

 

 

 

15. Print or Save the report (optional). 
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16. Click Close. The Zeno Office project now contains the imported field data. 

 

17. Click Editor > Save edits to persist the changes in your database. 
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Creating a new survey point using XY Point tool 

About creating a new survey point  

Survey points define the positions of geographic features. The XY tool is used to add new 
coordinates to existing survey points or to create new survey points. This tool also allows you to 
define quality information for new points. 

How to create a new survey point 

Typing coordinates for a new survey point 

1. Start LEICA Zeno Office, add the Editor toolbar, and add the Survey Editor toolbar. 
2. Add to the map the survey project in which you want to create a survey point. 
3. On the Editor toolbar, click the Editor menu and click Start Editing. 
4. Click the Editor menu and click Snapping. Click Survey Points in the Snapping Environment 

window. 
5. Click the Project dropdown arrow on the Survey Editor toolbar, then click the survey 

project that should own the new survey point. 
6. Click the Computation tool palette dropdown arrow, move the cursor to the first row of 

buttons on the palette, and click the XY tool .  
7. Type a name for the point if you do not want to use the default name. 
8. Press Tab. 
9. Type the Easting value into the first coordinate field. 
10. Press Tab. 
11. Type the Northing value into the second coordinate field and press Tab. 
12. If an elevation is available, type an Elevation value into the third coordinate field and press 

Enter. 

The new survey point is added into the survey dataset. 

13. Skip steps 13 through 16 if you do not want to add standard deviations for the survey 
point coordinates. 

14. Click the Quality tab. 
15. Type a standard deviation value for Position and press Tab. 
16. Type a standard deviation value for Elevation. 
17. Press Enter. 

The new survey point has standard deviations assigned. 

Digitizing a sequence of new survey points 

1. On the Editor toolbar, click the Editor menu and click Snapping. Click Survey Points in the 
Snapping Environment window. 

2. Click the Project dropdown arrow on the Survey Editor toolbar, then click the survey 
project that should own the digitized survey points. 

3. Click the Computation tool palette dropdown arrow, move the cursor to the first row of 

buttons on the palette, and click the XY tool . If a detail page for the XY tool is open, 

click the new object button . 
4. Type a name for the point if you do not want to use the default name. Press Tab. 
5. Click the map at the location where you want to digitize a new survey point.  

6. Click the New Object button .  
7. Repeat steps 4 and 5 for each new digitized survey point. 
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Tip 

• Instead of clicking the New Object button  after creating each survey 
point, you can check the Autocomplete check box on the Active Object 
context menu for any point. 

318 



COGO 

Using circular curve computations 

About using circular curve computations  

A circular curve computation is available for computing the coordinates at the end of a circular 
curve. The computation optionally lets you calculate coordinates for the center of the curve.  

The curve's geometric elements define the size and shape of the circular arc, and comprise any 
two of the following: radius, central angle, chord length, arc length, and tangent length. 

You must also specify whether the computed coordinates lie toward the left or right. This is 
defined as the side of the circular curve on which the central point of the circle is located when 
traversing the curved line from the startpoint to the endpoint. 

In addition to defining the curve's geometric elements, a direction is required to define the 
curve's orientation. 

An orientation for a curve can be any of the following three direction types: 

• Radial 
• Chord 
• Tangent 

The fillet curve computation allows you to calculate coordinates for points based on two known 
starting points, two directions, and a radius. The two coordinated locations are computed so 
they fall along the lines of direction. The circular arc is created such that the radius defines an 
arc that lies tangent to both lines. 

How to use circular curve computations 

Computing coordinates from a circular curve's chord 
direction, arc length, and radius 

1. Click the Computation tool palette dropdown arrow, point the mouse to the third row of 

buttons on the palette, and click the Circular Curve button . 
2. Snap to and click the from point on the map. 

The name of the point appears in the From Point field. 

3. If the point is not visible on the map, type its name and press Tab. 
4. Click the Reference Direction dropdown arrow, click Chord and press Tab. 
5. Click the direction value and press Tab. 
6. Click the First parameter dropdown arrow, click Arc Length, and press Tab. 
7. Type the arc length value and press Tab. 
8. Click the Second parameter dropdown arrow, click Radius, and press Tab. 
9. Type a length for the radius of the circular arc and press Tab. 
10. Click the Solution dropdown arrow and click Left to choose the left solution, or click Right 

to choose the right solution. 
11. Accept the default name, or type a new name, and press Tab. 
12. Follow steps 13 and 14 if you want to compute coordinates and create a center point for 

the circular curve. 
13. Click the Create Center Point check box. 
14. Accept the default center point name, or type a new point name and press Enter. 

Computing coordinates from a circular curve's radial 
direction, chord length, and delta angle 
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1. Snap to and click the from point on the map. 

The name of the point appears in the From Point field. 

2. If the point is not visible on the map, type its name in the text box, then press Tab. 
3. Click the Reference Direction To/Of dropdown arrow, click Radial, then press Tab. 
4. Type the direction value and press Tab. 
5. Click the First parameter dropdown arrow, click Chord, and press Tab. 
6. Type the chord length value and press Tab. 
7. Click the Second parameter dropdown arrow, click Delta, and press Tab. 
8. Type an angle value for the central angle of the circular arc and press Tab. 
9. Click the Solution dropdown arrow and click Left to choose the left solution, or click Right 

to choose the right solution. 
10. Accept the default name or type a new name and press Tab. 

Computing coordinates using a Fillet curve 

1. Click the Computation tool palette dropdown arrow, point the mouse to the third row of 

buttons on the palette, and click the Fillet Curve button . 
2. Snap to and click the from point on the map. 

The name of the point appears in the First Point field. 

3. If the point is not visible on the map, type its name in the text box and press Tab. 
4. Type the first direction and press Tab. 
5. Repeat step 2 for the second point. 
6. Type the second direction and press Tab. 
7. Type the radius for the fillet and press Tab. 
8. Accept the default name for the first result point or type a new name, then press Tab. 
9. Repeat step 8 for the second result point. 
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Using intersection computations 

About using intersection computations 

You can compute a new coordinate by defining intersections between two distances, two 
directions, or a direction and a distance. 

The Distance–Distance intersection allows you to choose two known points and two distance 
values.  To create the computation, choose one of two possible solutions. The left solution is 
defined as the point on the left-hand side as you look along the line from the first point to the 
second point. The right solution is the point on the right-hand side. If either of the distances are 
too short, they will not intersect and the computation will be flagged as incorrect. 

Intersecting a direction and distance 

The Direction-Distance-Intersection computation lets you choose two known points and define a 
direction from the first and a distance from the second.  Since, in most cases, two solutions are 
possible, you need to specify the first or second solution. Looking along the line from the first 
point toward the second, the first solution is the first computed coordinate location, while the 
second solution is the second coordinate location. When the direction and the distance do not 
have a solution for their intersection, the computation is flagged as incorrect. 

Intersecting two directions 

The project’s scale correction and angle correction are applied to the direction and distance 
values, respectively, affecting the location of the computed coordinate. 

How to use intersection computations 

Computing a coordinate using intersection of distances 

1. On the Editor toolbar, click the Editor menu and click Snapping. Click Survey Points in the 
Snapping Environment window. 

2. Click the Project dropdown arrow on the Survey Editor toolbar and click the survey project 
that should own the measurements, points, and computations. 

3. Click the Computation tool palette dropdown arrow, point the mouse to the second row of 

buttons on the palette, and click the Distance–Distance button . 
4. Snap to and click the first point on the map. 

The name of the point appears in the First Point field. 

5. If the point is not visible on the map, type its name in the text box and press Tab. 
6. Type the distance from the first point and press Tab. 
7. Repeat step 4 for the second point. 
8. Type the distance from the second point and press Tab. 
9. Press L if you want the left solution or press R for the right solution, then press Tab.  
10. Type a name for the point if you do not want to use the default name. Press Enter. 

Computing a coordinate using an intersection of a distance 
and a direction 

1. Click the Computation tool palette dropdown arrow, point the mouse to the second row of 

buttons on the palette, and click the Direction-Distance-Intersection button . 
2. Snap to and click the first point on the map.  

The name of the point appears in the First Point field. 
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3. If the point is not visible on the map, type its name in the text box and press Tab. 
4. Type the direction value and press Tab. 
5. Repeat step 2 for the second point.  
6. Type the distance value and press Tab. 
7. Using the keyboard, press the F key to select the first solution or the S key to select the 

second solution. 
8. Press Tab. 
9. Type a name for the Result Point if you do not want to use the default name and press 

Enter. 

Computing a coordinate using intersection of direction with 
offsets 

1. Click the Computation tool palette dropdown arrow, point the mouse to the second row of 

buttons on the palette, and click the Direction-Direction-Intersection button . 
2. Snap to and click the first point on the map. 

The name of the point appears in the First Point field. 

3. If the point is not visible on the map, type its name in the text box, and press Tab. 
4. Check Use Offset. 
5. Type the direction in the Direction field and press Tab. 
6. Type the Offset distance from the first direction. 
7. Repeat step 2 for the second point. 
8. Repeat step 5 for the second direction. 
9. Repeat step 6 for the offset distance from the second direction. 
10. Type a name for the point if you do not want to use the default name, and press Enter. 
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Using simple COGO computations 

About using simple COGO computations  

You can compute coordinates for a survey point based on a known difference (delta x,y) in 
coordinates from a given start point. The direction of the computed coordinates from the start 
point is defined by the sign of the delta values as shown below: 

• Northeast: +X, +Y  
• Northwest: -X, +Y 
• Southeast: +X, -Y 
• Southwest: -X, -Y 

Direction Distance 

A familiar coordinate geometry computation is the calculation of a coordinate from an existing 
coordinate using known distance and direction values. 

Deflection Angle Distance 

You can compute a new coordinate by defining a deflection angle offset, based on a reference 
direction, and a distance from a known point. 

How to use simple COGO computations 

Computing a coordinate using delta x,y values 

1. On the Editor toolbar, click the Editor menu and click Snapping. Click Survey Points in the 
Snapping Environment window. 

2. Click the Project dropdown arrow on the Survey Editor toolbar. Click the survey project 
that should own the delta values, the survey point coordinate, and the computation. 

3. Click the Computation tool palette dropdown arrow, move the mouse to the first row of 

buttons on the palette, and click the Delta XY button . 
4. Snap to and click the from point on the map. 

The name of the point appears in the From Point field.  

5. If the point is not visible on the map, type its name and press Tab. 
6. Type the Delta X value and press Tab. 
7. Type the Delta Y value and press Tab. 
8. Create a name for the point if you do not want to use the default name. Press Enter. 

Computing a coordinate using a direction and a distance 
from a known point 

1. On the Editor toolbar, click the Editor menu and click Snapping. Click Survey Points in the 
Snapping Environment window. 

2. Click the Project dropdown arrow on the Survey Editor toolbar and click the survey project 
that should own the direction and distance values, the survey point coordinate, and the 
computation. 

3. Click the Computation tool palette dropdown arrow, point the mouse to the first row of 
buttons on the palette, and click the Direction Distance button. 

4. Snap to and click the from point on the map. 
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The name of the point appears in the From Point field.  

5. If the point is not visible on the map, type its name and press Tab. 
6. Type the Direction value and press Tab. 
7. Type the Distance value and press Tab. 
8. Type a name for the new point if you do not want to use the default name, then press 

Enter. 

Computing a coordinate using a reference direction, angle 
offset, and a distance from a known point 

1. On the Editor toolbar, click the Editor menu and click Snapping. Click Survey Points in the 
Snapping Environment window. 

2. Click the Project dropdown arrow on the Survey Editor toolbar, then click the survey 
project that should own the measurement, point, and computation survey objects. 

3. Click the Computation tool palette dropdown arrow, point the mouse to the first row of 
buttons on the palette, and click the Deflection-Angle-Distance button. 

4. Snap to and click the from point on the map.  

The name of the point appears in the From Point field.  

5. If the point is not visible on the map, type its name and press Tab. 
6. Type the Reference Direction and press Tab. 
7. Type the Angle value and press Tab. 
8. Type the Distance value and press Tab. 
9. Type a name for the point if you do not want to use the default name. Press Enter. 
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Using the COGO traverse 

About using the COGO traverse  

The coordinate geometry (COGO) traverse is used to compute a sequence of survey point 
locations starting from an initial known point. Each new survey point is defined by a traverse 
course and is used as the take-off point for the next course in the sequence. Two methods are 
used: 

• The Bearing method uses directions for the orientation of each course. 
• The Angle Right method uses an angle measured clockwise from the line of the previous 

course. 

A traverse course can be defined using various combinations of directions, distances, angles, 
and circular arc parameters. 

The COGO traverse is primarily used for defining coordinates based on values taken from 
subdivision plans. The TPS Traverse computation, by contrast, should be used for processing 
field traverse data. A side-shot course is used to compute a coordinate that is not a part of the 
main traverse course sequence. 

There are two primary categories for traverses: open or closed. An open traverse ends its 
sequence with a new survey point, whereas in a closed traverse, the final course ends at an 
existing survey point. 

When a closed traverse starts and ends with the same survey point, it is called a loop traverse 
or a closed loop traverse. Since the final point of a closed traverse has known coordinates and 
the final course of the traverse computes coordinates for the same survey point, there is often a 
discrepancy between the existing coordinates and the computed coordinates—this discrepancy is 
called a misclosure or a closure error. 

The closure error in a COGO traverse may be the result of any of the following: 

• Precision 
• Mistyped values 
• Incorrect values in the source 
• Measurement error 

A closure error that is identified as being caused by incorrect source values indicates a potential 
problem in the original survey data. Closure error caused by a typing error can be handled by 
reentering the value. 

Misclosure caused by numerical precision, or measurement error can be solved by applying an 
adjustment to distribute the error through each of the courses. 

You can define the allowable limits of closure error on the General tab of the COGO traverse 
computation. There are three adjustment methods available: 

• Compass rule 
• Transit rule 
• Crandall rule 

The Compass rule, also known as the Bowditch rule, distributes the misclosure in the northings 
and eastings in proportion to the distance along all the courses from the first point to each of 
the unadjusted coordinate locations. 

The Transit rule assumes distances have no measurement error and distributes the error only 
through the directions and angles. 
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The Crandall method distributes the error in the distances only, assuming directions and angles 
have no measurement error. 

For more information about defining circular curves, see Using circular curve computations. 

How to use the COGO traverse 

Computing coordinate locations using a Bearing COGO 
traverse 

1. On the Editor toolbar, click the Editor menu and click Snapping. Click Survey Points in the 
Snapping Environment window. 

2. Click the Project dropdown arrow on the Survey Editor toolbar and click the target survey 
project. 

3. Click the Computation tool palette dropdown arrow, point the mouse to the fourth row on 

the palette, and click the COGO Traverse button . 
4. Type a name for the computation and press Tab. 
5. Type a comment for the COGO traverse computation and press Tab. 
6. Click Bearing. 
7. Type the maximum allowable limit for the misclosure in easting and northing. 
8. Type the maximum allowable relative error as a percentage. 
9. Click the Parameters tab. 
10. Snap to and click the start point on the map. 

The point name appears in the Start Point field. If the point is not visible on the map, type 
its name and press Tab. 

11. If you are doing an open traverse, press Tab, and skip to step 13. 
12. Repeat step 10 for the endpoint of the traverse. 
13. Double-click the TR/SS field, click SS to choose the next course as a side-shot, or choose 

TR if the next course is part of the main traverse. 
14. Press Tab. 
15. Press Tab to accept the default to point name. If you are entering the final course for a 

closed traverse, double-click the To Point field, and type the endpoint name. Press Tab. 
16. If the course you are entering is a circular curve, skip to step 18. Otherwise, continue to 

step 17. 
17. Double-click the Direction field, click ST, press Tab, then skip to step 19. 
18. Double-click the Direction field and click the type of direction for the circular curve. Press 

Tab. 
19. Type the direction value and press Tab. 
20. Skip to step 23 if the course you are entering is a circular curve. Otherwise, continue with 

steps 21 and 22. 
21. Accept the distance parameter type (DI) and press Tab. 
22. Type the distance value for the course and skip to step 28. 
23. Double-click the Curve Parameter 1 (CP1) field and click the first parameter type. Press 

Tab. 
24. Type the value of the first parameter. Press Tab. 
25. Double-click the Curve Parameter 2 (CP2) field and click the first parameter type. Press 

Tab. 
26. Type the value of the second parameter. Press Tab. 
27. Double-click the solution field and click the direction in which the circular curve bends. 
28. Press Enter. 
29. Repeat steps 13 through 28 for each of the courses in the traverse. 

Tip 

• To choose a curve parameter from a dropdown field, press the first letter 
of the parameter’s name. 
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Adjusting the closure error in a closed COGO traverse 

1. Click the Adjustment tab. 
2. Click the Method dropdown arrow and click the method you want to use to adjust the 

error. 

3. Click the Compute button . 

The adjusted values and their residuals are displayed. 

Computing an area with a COGO traverse 

• When you compute a traverse that is a closed loop, an area is reported 
on the Adjustment tab. 

Computing coordinates using an open Angle Right COGO 
traverse with straight line courses 

1. Click the Computation tool palette dropdown arrow, move the mouse to the fourth row on 

the palette, and click the COGO Traverse button . 
2. Type a name for the computation and press Tab. 
3. Type a comment for the COGO traverse computation and press Tab. 
4. Click Angle Right as the Angle Format. 
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Using the snapping environment 

About the snapping environment  

Setting the snapping environment facilitates the placement of features in association to other 
features. Besides, precise locations can be defined with the use of the snapping environment by 
specifying a snapping tolerance, snapping properties, and a snapping priority. 

The snapping tolerance 

Locating features within a specified snapping tolerance will automatically snap the pointer or the 
feature to another location such as a vertex, an edge, or an endpoint. Set the distance for the 
snapping tolerance as you prefer. 

The snapping properties 

Snapping properties can be set to specify the part of the feature, vertex, edge, or endpoint to 
which the desired feature should be snapped. Additional, you can set the snapping property to 
snap to Survey Point. 

The snapping priority 

The snapping priority determines in which layer snapping will occur first, second, and so on. The 
arrangement of layers in the Snapping Environment defines the snapping order. Therefore, a 
layer listed at the bottom will have snapping performed last. To change that order just drag a 
layer's name to the desired position.  

How to use the snapping environment 

Setting the snapping tolerance 

1. In the Editor menu, click Options. 
2. On the General tab, click the Snapping tolerance dropdown arrow and select a type of 

measurement unit to use for snapping tolerance—pixels or map units. 
3. In the Snapping tolerance text box, set the number of measurement units. 
4. Click OK. 

Setting the snapping properties 

1. In the Editor menu, click Snapping. 

Then, the Snapping Environment window is displayed. 

2. As soon as you check the desired snapping properties they'll be effective. 

Setting the snapping priority 

1. In the Editor menu, click Snapping. 

Then, the Snapping Environment window is displayed. 

2. To specify the order of snapping, click and drag the layer names to list them as desired. 
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General 

Modeling computations 

A computation is a process that requires a predefined set of input parameters to apply a set of 
rules and an algorithm to calculate output parameters. 

 

The computed coordinates can be added either to new survey points or to existing survey 
points.  

Computation states 

A computation is always in one of four states: valid, incomplete, out-of-date, or incorrect. The 
state of a computation is displayed as an icon in the status bar of the detail page. 

 

A computation is valid when the latest edits to the computation have been stored and it has 
been successfully computed. A computation is incomplete until all the required parameters of 
the computation have been defined. 

After a stored computation is edited, it is in the out-of-date state until it is recomputed. A 
computation can also be out-of-date if one or more of the points that it uses as a source of 
coordinates have been edited. If you make changes to a computation that cause it to be out-of-
date, any other computations that depend on this computation also have their states changed to 
out-of-date. 

LEICA Zeno Office assigns the incorrect state to computations that are outside the geometric or 
error limits. 

Computation networks 

A computation network is a sequence of computation dependencies—the output coordinates of 
computations are used as input for others. This creates computation dependencies, which 
creates computation dependencies.  
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A computation network models this sequence of computations, by tracking dependencies and 
managing the associated changes in computation states. 

 

When reprocessing a network, the system detects all the source computations that are out-of-
date and updates downstream computations, setting their states to valid. 

During this process, some dependent computations may be assigned incorrect states. In these 
cases, the relevant downstream computations are not processed and remain in the out-of-date 
state. 

Learn more about computation networks 
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Survey points, measurements, and spatial reference 

The geodatabase stores information about the geometry or shape of an object as a field in a 
table. This shape field represents a geometry type (point, line, polygon, or multipoint) and a 
sequential set of x and y coordinates that optionally contain z and m values and vertex IDs. 

Geometry stored in a shape field requires a spatial reference to relate it to the surface of the 
earth. The spatial reference has two components: a coordinate system and a spatial domain. 

The coordinate system is used to project coordinates from a mathematical approximation of the 
earth’s surface, called the ellipsoid, to the planar surface of a map. 

The spatial domain is the minimum and maximum value for the geometry attributes. The extent 
of this domain defines the precision at which geometry attributes (x, y, z, m, ID) can be stored 
as integers. A finite number of integers are available in the system, so the x and y spatial 
domain is analogous to a square grid that always contains the same number of rows and 
columns (approximately two billion, or 2 to the power of 31).  

Precision and the spatial extent are inversely proportional. Since the x and y values must 
correspond to the intersection of lines in this theoretical grid, the larger the chosen extent, the 
lower the precision of the geometry attributes. 

The spatial reference for features in the geodatabase is stored as a property of a feature dataset 
or standalone feature class. Similarly, the spatial reference for survey points and measurements 
is stored as a property of a survey dataset. Each survey project also has its own coordinate 
system but does not require a spatial domain. 

When processing survey data in computations, it is important to maintain numerical precision. 
Since the coordinates stored in the shape field are snapped to an integer grid, they do not 
provide sufficient precision for this purpose. Therefore, the survey data model enforces the 
maintenance of x,y,z coordinates in separate fields of double precision. Only these fields are 
used when performing computations. (Measurement values are also stored in fields of double 
precision.) 

Additionally, the survey projects in the survey dataset each have independent coordinate 
systems. 

An update of a feature based on links to survey points results in the feature vertices being 
snapped to the geometry of the survey point. 
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Modeling survey points and coordinates 

In different surveys, the same physical locations can be computed with different coordinates. 
For instance, the named location P2 in the example below has one set of coordinates measured 
in the Blue survey and another set measured in the Red survey. This is also the case for the 
point called P3. 

The GIS coordinate 

You can define a single coordinate for a survey point that is the best representation for its 
location. This coordinate is called the GIS coordinate. It may be the coordinate from a single 
survey project, or it may be the weighted average from a number of different projects. 

 

The current coordinate 

A current coordinate is required when the same project computes or imports more than one 
coordinate for a particular survey point. In this example, the Green project has two computed 
coordinates for point P2. 

 

When defining the GIS coordinate, only the current coordinate of each survey project is used in 
the weighted average.  
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Preparing the computation environment 

About preparing the computation environment 

Creating a new survey point described how you can enter the coordinates for new survey points.  

Display units 

While working with computations, you will need to enter the measurements in the same units as 
the data source. You can change the display units for: 

• Direction fields 
• Angle fields 
• Length and Height (distance) fields 
• Coordinate fields 

In addition, you can create your own specific unit based on scalar reference. For more 
information on scalar reference, see Using scalar references and defining measurement units. 

Automated point naming and automated point referencing 

Automated point naming 

When point identifier fields are used to define new survey points, they automatically provide a 
default point name.  You control the default name by typing the alpha portion of the string and 
choosing an increment to be added to the numerical portion of the string. This naming format 
and increment is applied for each new default point name displayed.  

Automated behavior for survey point referencing 

Computations can use the survey points created and owned by other projects. When using these 
survey points, a copy of the coordinate is added to the survey point for exclusive use in your 
project. This is called referencing a survey point. When you reference a survey point, you are 
required to choose one of the following coordinates: 

• GIS coordinate  
• Current coordinate of the owning survey project  

You can automate the choice for this coordinate in the Survey Editor options. 

How to prepare the computation environment 

Setting the display units 

1. In LEICA Zeno Office, click the Tools menu and click Options. 
2. Click the Survey Measurement Formats tab. 
3. Click the Defined Formats dropdown arrow and click the unit type for which you want to 

set the display. 
4. Click the unit in the units list. 
5. Verify the name in the Format Details box to make sure it is the unit that you want to use. 
6. Type the Precision for the unit by entering the number of decimal places to display. 
7. Click the Set As Display Format button. 
8. Click OK. 

Creating a custom display unit 

1. In LEICA Zeno Office, click the Tools menu and click Options. 
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2. Click the Measurement Formats tab. 
3. Click the Defined Formats dropdown arrow and click the unit type for which you want to 

create a custom unit. 
4. Click the unit in the units list on which you want to base the custom unit. 
5. Check Advanced. 
6. Click the New button. 
7. Type a name for the new unit in the Name text box and press Tab. 
8. Type the Precision for the unit by entering the number of decimal places to display. Press 

Tab. 
9. Type the number of units per master unit.  
10. Click Tab and type an abbreviation for the unit. 
11. Click the Set As Display Format button. 
12. Click OK. 

Using a point naming increment 

1. Click the Survey Editor menu and click Options. 
2. Click the Points tab. 
3. Type the alpha portion of the default point name in the Start Point text box. 
4. Type the increment for the numerical portion of the name in the Increment text box. 
5. Verify that the Next Point Name is as expected based on your choices. 
6. Click OK. 

Automate referencing in the GIS coordinate/current coordinate of the 
owning project in computations 

1. Click the Survey Editor menu and click Options. 
2. Click the Points tab. 
3. Click the option to copy the GIS coordinate and make it current or click current coordinate 

of the owner survey project option. 
4. Click OK. 
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Tools for survey point and coordinate analysis 

About survey point and coordinate analysis tools 

A survey point and its contained coordinates represent a single physical location. The point 
analysis tools and commands are used to authenticate the relationship between survey points, 
coordinates, and the physical locations they represent. 

Survey Point Merge tool 

When finding in your data points that represent the same location, it is likely that you will want 
to merge them. 

When merging two survey points, coordinates from the source point are added to the target 
point, then the source point is deleted. The new current coordinate is the mean of all 
coordinates used to define the current coordinates for both survey points. If all the coordinates 
have quality information, a weighted mean is used for the new current coordinate. 

If any of these coordinates do not have quality information, then the arithmetic mean is used for 
the new coordinate. 

To merge now the coordinates of two survey points, use the Survey Point Merge tool. To use 
this tool, first choose a source point and then a target point on the map. 

Coordinates from the source point are added to the target point, then the source point is 
deleted. 

Point in Tolerance command 

To find clusters of survey points that fall within a specific distance tolerance of each other, use 
the Point In Tolerance command. 

To use the command, you must specify a horizontal search tolerance and, optionally, a vertical 
search tolerance. The command uses the GIS coordinate of each survey point to find these 
clusters. After running the command, a window presents a set of locations for all places where 
survey point clusters are found. 

You can then use the Point Merge tool to solve the conflicts that you recognize as data 
inconsistencies (this tool is automatically activated after the command is run). Once a pair of 
points has been merged, you can remove the conflict from the set by clicking the Solved button. 

Coordinate out of Tolerance command 

To find survey points for which coordinates are outside a defined tolerance limit, use the 
Coordinate out of Tolerance command. To use the command, you must specify a tolerance circle 
that defines the maximum acceptable spread for the coordinates. 

This limit can be defined vertically, horizontally, or in both directions at once. The command can 
be applied using one of the following two methods: 

• Local check—searches within each survey project 
• Global check—searches within the whole survey dataset 

You must also specify the set of survey points within which the command should perform the 
search, such as Points selected in the Survey Explorer. 
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The local check method 

According to the local check method, a point has coordinates that are out of tolerance if both 
the following criteria are true: 

• The current coordinate is the mean coordinate of the survey point. 
• Any coordinate used to define the mean coordinate falls outside the tolerance circle 

limits. The center of the tolerance circle is the current coordinate. This method will only 
return conflicts found in the set of coordinates defined by the project that owns a 
survey point. 

Depending on the cause of the conflicts, the following methods can be used to solve them: 

• Exclude the coordinate from defining the mean (if the mean coordinate is used as the 
currrent coordinate) 

• Delete the coordinate 
• Correct the coordinate by editing it (only possible if it’s an imported coordinate) 
• Correct a mistake in measurements of the defining computation 

Survey points that are outside your defined tolerance limits are listed in the Coordinate out of 
Tolerance dialog box. All coordinates for these points are listed, regardless of whether or not 
they were used for the current coordinate. 

The first row listed is the current coordinate used for the local check. Different fields are 
displayed in the list, and these fields depend on your choice of horizontal and vertical options. 

The global check method 

Using this method, a survey point is out of tolerance if any of the current coordinates used to 
define its GIS coordinate fall outside the tolerance circle. Coordinates that are used for the 
mean are also tested against the tolerance limit.  

If a vertical check is not defined, then Elevation and Delta Height are not shown. Similarly, if no 
horizontal check is defined, then Easting, Northing, Delta Easting and Delta Northing are not 
shown. 

Click in the Solved button removes the displayed conflict. The Coordinate out of Tolerance dialog 
box is not automatically updated when values are changed in the Survey Explorer. You can 
update the dialog box view by clicking the Refresh button. 

Conflicts in coordinates derived by computation can be solved in the details view of the relevant 
computation. Conflicts in imported coordinates are fixed by editing the relevant coordinates in 
the survey point’s detail page. 

You can navigate to the computations or points from the Coordinate out of Tolerance dialog box. 
The resulting detail pages are displayed in the Survey Explorer. 

How to perform survey point and coordinate analysis 

Using the Survey Point Merge tool 

1. Start LEICA Zeno Office and add the Leica Survey Network toolbar. 
2. Add the survey projects and feature layers that you want to edit to the map. 
3. Click the Editor menu on the Editor toolbar and click Start Editing. 

4. Click the Survey Point Merge tool . 
5. Snap to and click the Source survey point. 
6. Snap to and click the Target survey point. 
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Using the Point in tolerance command 

1. Click the Leica Survey Network menu in the Leica Survey Network toolbar and click Point 
In Tolerance. 

2. Type a horizontal search tolerance value. 
3. Check Vertical tolerance limit for search and type a vertical search tolerance value, if you 

also want to define a height range tolerance. 
4. Click the Find points dropdown arrow and click your choice for specifying the set of survey 

points that must be tested. 
5. Click OK. 

The Point in Tolerance window is displayed.  

6. Use the Survey Point Merge tool  to merge pairs of survey points, where required. 

7. Click the Previous Page  and Next Page  buttons to show the different conflicts 
collected in the window. 

8. Click the Solved button to remove conflicts from the set shown in the window. 
9. Repeat steps 6 through 8 for all conflicts with which you want to work. 
10. Click the Close button. 

Using the current coordinate of survey points to find coordinates that 
are out of horizontal tolerance 

1. Click the Leica Survey Network menu on the Leica Survey Network toolbar and click 
Coordinate out of Tolerance. 

2. Check Horizontal Distance Limit for the search tolerance. 
3. Type a value for the Horizontal Distance Limit. 
4. Click Local Check. 
5. Click the Find points dropdown arrow and click points from active network survey. 
6. Click OK. 

If survey points are found that fall outside the limits you specify, the Coordinate out of 
Tolerance dialog box appears. Otherwise, a message is displayed indicating that no 
coordinates are out of tolerance for the criteria you specified. 

7. Click the Previous Page  and Next Page  buttons to view the details of all the points 
with coordinate displacements that fall outside your tolerance limits. 

8. Click Close. 

Navigating from the Coordinate out of Tolerance dialog box to delete an 
incorrect coordinate 

1. Run the Coordinate out of Tolerance command. 
2. Click in the table of the coordinate conflicts to select any one of them from the table. 
3. Right-click in the table of coordinate conflicts and click Go To Point. 

The Detail page for the survey point appears in the Survey Explorer. 

4. Click the leftmost column of the incorrect coordinate to select it. 
5. Right-click the leftmost column and click Delete. Only imported coordinates can be 

deleted. 
6. Click the Refresh button in the Coordinate out of Tolerance dialog box.  
7. Review the details page of the survey point to make other changes, if necessary. 
8. Click Solved. 

9. View other conflicts by clicking the Next Page  and Previous Page  buttons. 
10. Repeat steps 2 through 8 to delete other coordinates from points that are out of tolerance. 
11. Click Close. 
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Navigating from the Coordinate out of Tolerance dialog box to edit an 
incorrect measurement 

1. Run the Coordinate out of Tolerance command. 
2. In the Coordinate out of Tolerance dialog box, click the row for the coordinate of the 

computation to which you want to navigate. 
3. Right-click in the selected row and click Go To Computation 

The detail page for the computation that defines the coordinate appears in the Survey 
Explorer. 

4. Make the necessary edits to the measurement values in the computation.  

5. Click the Compute button . 
6. Click the Refresh button and verify that the delta values are within the limits you specified 

for the Coordinate out of Tolerance command. 
7. Click Solved to continue with further analysis of the remaining survey points, if necessary. 
8. Click Close. 

Using the GIS coordinate of points selected in the Survey Explorer to 
find coordinates that are out of tolerance 

1. Click the Leica Survey Network menu on the Leica Survey Network toolbar and click 
Coordinate Out of Tolerance. 

2. Check Horizontal Distance Limit for the search tolerance. 
3. Type a value for the Horizontal Distance Limit. 
4. Check Vertical Distance Limit for the search tolerance if you want to use a vertical limit. 

Type a value for the Vertical Distance Limit. 
5. Click Global Check. 
6. Click the Find points dropdown arrow and click points selected in the Survey Explorer. 
7. Click OK. 

If survey points are found that fall outside the limits you specify, the Coordinate out of 
Tolerance dialog box appears. Otherwise, a message is displayed indicating that no 
coordinates are out of tolerance for the criteria you specified. 

8. Click the Previous Page  and Next Page3  buttons to view the details of all the 
points with coordinate displacements that fall outside your tolerance limits. 

9. Click Close. 

Choosing the projects that define the GIS coordinate for a survey point 

1. Add a detail page to the Survey Explorer for the survey point for which you want to choose 
projects. 

2. Click the Coordinate Manager tab. 
3. Click a project to view its list of coordinates for the point. 
4. Double-click the row of the project that you want to have participate in defining the GIS 

coordinate. 
5. Click Yes. 
6. Press Enter. 
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About analyzing and editing survey data 

A computation network defines a sequence of dependent processes that calculate a series of 
coordinates.  

Leica Zeno Office can be used to validate a computation network by detecting and repairing 
these sequence breaks and cycles. 

Learn more about computation networks 
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Computation network concepts 

A computation stored in the survey dataset represents a process that calculates and updates 
coordinates for survey points. Computations use the current coordinates of survey points to 
calculate new coordinates. 

Most survey point coordinates are calculated in a sequence—the output coordinates of 
computations are used as input to one or more others. 

Datum points 

Certain computations do not depend on others in the network. This is because the coordinates 
used as input are not calculated by other computations. Survey points that contain 
noncalculated current coordinates for a survey project are the datum points for that project. 

Computation states 

A state is a property of a computation categorized into four possible conditions: 

• Valid - everything is ok. 
• Incomplete - some input parameter are missing. 
• Out-of-date - some input parameter have been changed. 
• Incorrect - the results are incorrect, e.g. the limits are exceeded. 

A new computation always starts out as incomplete. It remains incomplete until all the input 
and output points have been defined and all the required measurements have been entered. 

Once it has executed successfully, the computation is valid. If a computation ever loses a 
reference to one of its input points, or measurements in the computation are removed, it is set 
back to an incomplete state. 

If measurements are altered, or the names of input and output points are changed, the 
computation is set to out-of-date until it is recomputed. 

Occasionally, the output points of a computation do not have the expected results, or else 
coordinates cannot be calculated. In these cases, the computation is incorrect. 

After editing and reprocessing a single computation, all of its dependent computations are out-
of-date. 

When processing a network, the system detects all the source computations that are out-of-
date and reprocesses all downstream computations. The results are reported in the Computation 
Network Analysis window.  

Network cycles 

When processing a computation network, the dependencies described in this section may cause 
cycles in the network. Cycles need to be fixed before the whole network can be validated and 
brought to a state where all computations are valid. 

The following is an example of how cycles are created and how they can be solved. 

A computation, C1, uses known points P1 and A1 as input, and creates the point P2 as output. 
This computation uses P1 as the start point and A1 as a reference point for defining an 
orientation. 
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Since these points are the first reference points in the network, they are the network’s datum 
points. 

The point P2 is the start point for the next computation, C2. The computation C2 uses the point 
P1 as a reference point and creates a new point, P3. The points P1 and P2 are input for the 
computation C2. 

 

The point P3 is the start point of the next computation, C3. This computation uses the point P2 
as a reference point and re-measures the point P1. In normal circumstances, this would change 
P1’s current coordinate. However, since P1 is used as input for an earlier computation in the 
sequence, a cycle has been created. LEICA Zeno Office will automatically detect these cycles, 
and, in this example, would not permit C3 to change the point P1. 

 

This problem can be solved in a number of different ways. In this example, some typical 
methods for fixing this cycle are to: 

• Deactivate the measurement that targets point P1 
• Disallow the new coordinate from participating in defining the current coordinate for the 

survey point 
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Analyzing and computing the active network 

About analyzing and computing the active network  

LEICA Zeno Office allows you to find instances of cycles and breaks in sequences for any 
computation network in a survey dataset. Using the Network dropdown list in the Leica Survey 
Network toolbar, you can specify the active network with which you want to work.  

How to analyze and compute the active network 

Computing and analyzing the active network to remove cycles 

1. Start LEICA Zeno Office, add the Editor toolbar, and add the Leica Survey Network toolbar. 
2. Add the survey projects and feature layers that you want to edit to the map. 
3. Click the Editor menu on the Editor toolbar and click Start Editing. 
4. Click the Network dropdown arrow and click the name of the network that you want to 

compute. 

5. Click the Compute Survey Network button . 

The Computation Network Analysis window appears and lists the sequence of out-of-date 
computations processed. 

6. Click the Cycles tab in the Computation Network Analysis window. 
7. Click the Cycles dropdown arrow and click the cycle you want to analyze. 
8. Right-click the row in the cycle list for which you want to see details and click Show 

Details. 

The set of detail pages for the points and computations that appear in the row are added 
to the Survey Explorer. 

9. Click the Previous Page  and Next Page buttons  to view the detail pages for the 
points and computations that participate in the cycle. 

10. Identify the problem that is causing the cycle and make the required edits to correct it.  

11. Click the Compute Survey Network button  again.  
12. In the Computation Network Analysis window, click the Cycles dropdown arrow to verify 

that there is one less cycle. 
13. Repeat steps 7 through 12 until you have solved all the cycles. 
14. Click the Close button on the Computation Network Analysis window. 

Opening the Computation Network Analysis window 

1. Click the Computation log button  on the Leica Survey Network toolbar. 

The results listed from the previous network analysis are displayed. 

Listing the datum points of a computation network in the Survey 
Explorer 

1. Click the Network dropdown arrow and click the name of the network for which you want 
to list datum points. 

2. Click the Datum Points button  on the Leica Survey Network toolbar. 

The datum points appear in a list page in the Survey Explorer. 
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Computing and analyzing the active network to detect breaks in 
computation sequences 

1. Click the Editor menu on the Editor toolbar and click Start Editing. 
2. Click the Network dropdown arrow, and click the name of the network that you want to 

analyze. 

3. Click the Compute Survey Network button . 

The Computation Network Analysis window appears. The computations listed include those 
that are incorrect or incomplete. 

4. Make note of the additional information provided for these computations. 
5. Right-click the computation in the list for which you want to make corrections, or that you 

need to complete. 

A navigation context menu appears. 

6. Click Show Details. 
7. Refer to the information you noted in step 4 and correct or add the required data to the 

computation. 
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Editing survey objects 

About editing survey objects  

During the analysis of computation networks, you will need to correct any problems. The 
procedures in this topic show you how to: 

• Rename survey points and computations 
• Change and add coordinate values for points 
• Edit measurement and computation values 
• Delete survey objects - be always aware that deleting survey objects can cause errors 

in your computation network 
• Change project properties 

Renaming survey points 

You can directly change a point's name in the details page of the point. If the new name that 
you choose already exists in the survey project, a message is displayed and LEICA Zeno Office 
prevents the name change until an unused name is typed. You are not able to change the point 
prefixes. 

Renaming computations 

Certain types of computations can be named. Unlike survey points, a computation name is 
optional. However, if a name is used, it must be unique within the survey dataset. 

Editing coordinates 

Whereas imported coordinates can be directly edited, computed coordinates can be altered only 
by making changes to the measurements and computations that create them. 

You can also change the role of the coordinate within the survey point. The two types of roles 
for coordinates that you can change are based on whether the coordinate is: 

• Included in or excluded from the mean 
• The current coordinate or not 

Editing measurement values 

There are circumstances when you recognize obvious mistakes in entered measurement values, 
then you need to edit the measurement values in the computations. When making these 
changes the computation is out-of-date until it’s executed again. 

Editing a computation 

In addition to renaming computations, you may also need to change their limits and settings or 
alter their input and output points. In these cases, the computation becomes out-of-date. When 
reprocessing these computations, the computed coordinates of the output points are updated. 

Changing survey project properties 

In Data Manager, you can alter the properties for a survey project. When making changes that 
affect computations, such as altering the correction methods, all the computations in the project 
become out-of-date. 
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Deleting survey objects 

It is not possible to delete a measurement if it is used in a computation—this is prevented by 
LEICA Zeno Office. 

Also, deleting a survey point is not permitted until its measurements have been deleted. To 
delete survey points or measurements, an ordered approach is required; you need to delete 
computations first, then the measurements, and finally, the survey points can be 
deleted. 

You can delete sets of measurements, points, and computations by selecting them in the list 
page in Survey Explorer and clicking the Delete button on the Survey Explorer toolbar. Or you 
can also individually delete survey objects by clicking the Delete button while you are in the 
Details page. 

Deleting coordinates 

To delete a coordinate, you need to be in the details page of a survey point. Instead of using the 
Delete button, you use the coordinate list’s context menu option - otherwise you will delete the 
survey point. 

Only imported coordinates can be deleted. If you delete a current coordinate, the mean 
coordinate is used as the current coordinate. 

If you delete the last coordinate, the survey point is empty and the computations that depend 
on the point are set to the incomplete state. If the current coordinate changes after a coordinate 
is deleted, the computations that use the survey point are out-of-date. 

Deleting survey points 

If there are any computed coordinates for a survey point, then deleting the point is not 
permitted. Otherwise, all imported coordinates are deleted along with the survey point. 

Deleting measurements 

If the system permits you to delete a measurement, this means that there are no computations 
using it. Deleting measurements has no effect on other survey objects in the survey dataset. 

Deleting computations 

LEICA Zeno Office will permit you to delete any computation if you are editing the survey 
project that created it. The coordinates computed by this computation are deleted from its 
output survey points. 

Deleting survey projects 

In Data Manager you can delete an entire survey project. When you delete a survey project, the 
following survey objects are removed from the survey dataset: 

• Computations owned by the project 
• Measurements owned by the project 
• Coordinates created by the computations of the project 
• Survey points that are not used as input or output for computations of another project 

Note that due to dependencies of points across projects, it is not always permitted to completely 
delete a project. 

How to edit survey points 
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Changing a point's name 

1. Select the point in the list page of the Survey Explorer. 
2. Right-click the leftmost column in the list and click Go To Details. 
3. Click the General tab in the details page of the survey point. 
4. Click in the Point Name field to the right of the prefix pin and change the existing text to 

the new point name. 
5. Press Enter. If the Invalid Point Name message appears, you typed a name that is already 

in use by another point in the project. In this case, go to step 6. Otherwise, you have 
completed the task. 

6. Click OK in the Invalid Point Name message. 
7. Repeat steps 4 and 5. 

Changing a computation's name 

1. Select the computation in the list page of the Survey Explorer. 
2. Right-click the leftmost column in the list and click Go To Details. 
3. Click the General tab in the details page of the computation. 
4. Click in the Computation Name field and change the existing text to the new name. 
5. Press the Enter key. If the Information message appears, you typed a name that is 

already used in the dataset. In this case, go to step 6. Otherwise, the task is complete. 
6. Click the No button in the Information message. 

Clicking the Yes button will add a detail page for the existing computation to the Survey 
Explorer. 

7. Repeat steps 4 and 5. 

Changing imported and computed coordinate values 

1. Select the survey point in the list page of the Survey Explorer for which you want to 
change coordinates. 

2. Right-click the leftmost column in the list and click Go To Details. 
3. Click the Coordinate Manager tab in the details page of the point. 
4. Double-click the Easting column of the imported coordinate you want to edit and type a 

new Easting value. 
5. Press Tab and type a new Northing value. 
6. Optionally, press Tab and type a new elevation value.  
7. Press Enter. 
8. Click the leftmost column to select the computed coordinate that you want to change. 
9. Right-click the coordinate, then click Go To Computation. 

The detail page of the computation that defines this coordinate is added to the Survey 
Explorer.  

10. Make the necessary changes to correct the mistake in the measurement value. 

11. Click the Compute button . 

12. Click the Previous Page button  in the Survey Explorer toolbar. This returns the Survey 
Explorer to the detail page for the survey point. 

13. Verify that the coordinate has changed. 
14. To make the updated coordinate current, double-click the Current column for the 

computed coordinate and click Yes in the dropdown list. 
15. Press Enter. 

Deleting imported coordinates 

1. Select the survey point in the list page of the Survey Explorer for which you want to delete 
the coordinates. 

2. Right-click the leftmost column in the list and click Go to Details. 
3. Click the Coordinate Manager tab in the details page of the point. 
4. Click the leftmost column to select the imported coordinate that you want to delete. 
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5. Right-click the coordinate and click Delete. 

Deleting computation measurements and survey points 

1. Click the Survey Objects List from Map tool in the Survey Editor toolbar. 
2. Click and drag a box around the measurements and survey points that you want to delete. 

A new list page is added to the Survey Explorer containing the points and measurements. 

3. Click the leftmost column of the first row to select it. 
4. Hold down the Shift key while clicking the leftmost column of the last row in the list. All 

measurements and points are selected. 
5. Right-click the leftmost column and click Go To Computations. 
6. Check Input and Output in the Navigate to Computations dialog box, then click OK. This 

adds a new list to the Survey Explorer that has all the computations that use the selected 
measurements and the selected points. 

7. Use the method described in steps 3 and 4 to select all the computations. 

8. Click the Delete Survey Objects button  on the Survey Explorer toolbar. 

9. Click the Previous Page button  to return to the list of measurements and survey 
points. 

10. Select all the measurements; click the first one listed, then, while holding down the Shift 
key, click the last one listed. 

11. Click the Delete Survey Objects  button. 
12. Select all the survey points using the method described in step 10. 

13. Click the Delete Survey Objects button . 

Tip 

• Delete survey points only after you have deleted all the survey objects 
that use these points. 
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Modeling survey object dependencies 

There are relationships between measurements, computations, coordinates, and survey points. 
These relationships define dependencies between survey objects. It is necessary to be aware of 
these dependencies when working in the LEICA Zeno Office environment. 

The following list of dependencies are enforced and maintained by the survey dataset as a set of 
relationship tables: 

• A survey point can contain multiple coordinates. 
• Many computations can define coordinates for the same survey point. 
• Many survey points can be created or used by one computation. 
• Many measurements can start and end at the same two survey points. 
• The same measurement value can be used between many pairs of survey points. 
• Many computations can use the same measurement.  
• Many measurements can be used in a single computation. 
• Multiple simple measurements are used within a composite measurement. 
• Many composite measurements can use the same simple measurement. 
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Survey Explorer 

Working with the Survey Explorer 

You can explore and edit survey objects in the Survey Explorer. The Survey Explorer is a 
container for pages of survey information. You create these pages as you work. There are two 
types of pages: 

• The List page, which lists multiple survey objects 
• The Detail page, which displays a detailed view of individual survey objects 

There are different phases to working with the Survey Explorer. First, use tools or commands to 
collect survey objects from the survey dataset; a List page is created to represent this 
collection. Next, make a selection from this list of survey objects. Then you can either navigate 
from the selection to a list of the dependent survey objects in the computation network, or you 
can create a Detail page of a stored survey object. 

Using the Previous Page and Next Page buttons, you can step through the Survey Explorer. A 
survey object selection is represented in a list page as one or more selected rows. A survey 
object is active either when its detail view is the visible page in the Survey Explorer or if it is the 
last row clicked in the list. Only one survey object can be active at a time. 
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Navigating dependencies and navigate to detail pages 

About navigating dependencies and to detail pages 

Navigating dependencies 

Computations depend on the stored measurements and survey points that they use. These 
dependencies can be navigated through the Survey Explorer, allowing you to find stored 
computations using a navigation menu. 

The easiest way to get to computations is to use the List Survey Objects tool, select the points 
or measurements in the list, then navigate to the computations using the Navigation menu. 

Navigating to detail pages 

You will need to edit, view, and work with the numerical values for measurements and 
coordinates as well as the details of survey points and computations. Adding detail pages to the 
Survey Explorer is easy—select the computations and click Go To Details in the navigation 
menu. 

If you select more than one survey object, you will be able to step through the detail pages 
using the Next Object and Previous Object buttons. 

How to navigate dependencies 

Navigating from selected survey points to a list of measurements 

1. Select survey points in the Survey Explorer. 
2. Right-click the leftmost column in the Survey Explorer. 
3. Click Go To Measurements. 

A new list page of computations is added to the Survey Explorer. 

Navigating from selected measurements to their list of computations 

1. Select measurements in the Survey Explorer. 
2. Right-click the leftmost column in the Survey Explorer. 
3. Click Go To Computations. 

A new list page of computations is added to the Survey Explorer.  

Navigating from selected survey points to a list of dependent 
computations 

1. Select survey points in the Survey Explorer. 
2. Right-click the leftmost column in the Survey Explorer. 
3. Click Go To Computations. 
4. Check using the selected Survey Point(s) if you want a list of computations that use the 

selected points as input. 
5. Check providing coordinates for the selected Survey Point(s) if you want a list of 

computations that target the selected points. 
6. Click OK. 

A new list page of computations is added to the Survey Explorer. 

How to navigate to details 
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Navigating to computation details 

1. Click the computations in the list for which you want to see detail pages. 
2. Right-click the leftmost column in the list and click Go To Details. 

A new set of detail pages for your selected computations is added to the Survey Explorer. 

3. Click the Previous Object and Next Object buttons to walk through each of the detail 
pages. 

Navigating to survey point details 

1. Select the survey points in the list for which you want to see detail pages. 
2. Right-click the leftmost column in the list and click Go To Details. 

A new set of detail pages for your selected survey points is added to the Survey Explorer. 

3. Click the Previous Object and Next Object buttons to move through each of the detail 
pages. 
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Survey Explorer - Creating list pages 

About creating list pages 

There are different ways to add pages to the Survey Explorer. A page is added when you: 

• Draw a box around objects on the map using the List Survey Objects tool. 
• Use the Survey Explorer query command. 
• Open the detail view for a survey object. 
• Navigate from a set of survey objects to another related set, from features to 

computations, or to a detail view from an object selected in the Survey Explorer list. 

How to create list pages 

Using the List Survey Objects tool 

1. Click the Zoom In button  on the Tools toolbar. 
2. Click and drag a box to zoom to the area of interest on your map for the measurements 

and points you want to explore. 

3. Click the List Survey Objects tool . 
4. Click and drag a box around the survey points and measurements you want to list. 

The Survey Explorer opens, and a new list page is added that contains the measurements 
and points you listed from the map. 

Filtering the type of objects used by the List Survey Objects tool 

1. Click the Survey Editor menu on the Survey Editor toolbar and click Set Survey Layers For 
List. 

2. Check the survey layers from which you want to list survey objects. 
3. Check the sublayers in a checked survey layer from which you want to list survey objects. 
4. Uncheck the sublayers in a checked survey layer from which you do not want to list survey 

objects. 
5. Click Close. 

6. Click the List Survey Objects tool . 
7. Click and drag a box around the survey points and measurements you want to list. 

The Survey Explorer displays a new filtered list page containing the measurements and 
points within the box you defined and stored in the sublayers that are checked in the Set 
Survey Layers For List dialog box.  

Adding list pages based on specific survey classes 

1. Click the List Survey Objects By Query button on the Survey Editor toolbar. 
2. Check the survey classes from which you want to list survey objects. 
3. Click OK. 

The Survey Explorer displays a new list page containing all the survey objects from the 
classes you checked in the List Survey Objects By Query dialog box. 

Adding list pages based on survey class attributes 

1. Click the List Survey Objects By Query button  on the Survey Editor toolbar. 
2. Check the survey classes from which you want to list survey objects. 
3. Click the survey class for which you want to refine the list based on the class attributes. 
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4. Click the Query Builder button. 
5. Double-click the field you want to use in the query. 
6. Click the logical operator you want to use. 
7. Double-click the value in the Unique values list that you want to use as part of the query 

or type the value in the query box. 
8. Click OK on the Search Criteria dialog box. 
9. Click OK on the List Survey Objects By Query dialog box. 

The list page is added. 

Tip 

• After you have defined your query, click the Verify button to get 
information back about whether the query is valid or not. 

Adding list pages based on projects 

1. Click the List Survey Objects By Query button  on the Survey Editor toolbar. 
2. Check the survey classes from which you want to list survey objects. 
3. Click the survey layer name. 
4. Click the Survey Projects button. 
5. Click the Survey Projects Subset option. 
6. Check the projects from which you want to list survey objects. 
7. Click OK in the Owning or Referencing Survey Projects dialog box. 
8. Click OK in the Create Survey Objects List By SQL dialog box. 
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Using computation detail pages - Overview 

There are a number of ways to add pages to the Survey Explorer while exploring your data. 
Though the detail pages for computations can be different, they all have a common environment 
with standard input fields for specific types of information.  

Point identifier field 

For identifying points for use in computations, either as a source of coordinates or as a target 
for coordinates, the point identifier fields are displayed on each computation page. The point 
identifier field has useful functionality, providing: 

• A prefix pin separating the prefix and point name strings 
• A point name flag that gives an immediate visual indication after each keystroke of 

whether or not a point with the name you type exists in the survey dataset 

Angle field 

Angles are used as input for several COGO computations, and also for most computations that 
process TPS measurements. The angle field is used to represent horizontal angles and zenith 
angles. 

You can use the map options to change the display format and units for angles, and you can 
also create your own custom angle unit. The units supported for angles are: 

• Gradians/gons 
• Decimal degrees  
• Degrees-minutes-seconds 

Direction field 

Directions are used as input for many computations. The direction fields displayed in 
computation pages are used to enter bearings or azimuths between an input survey point and a 
computed survey point.  

Use the Survey Editor options to change the display format and units for directions. The 
direction units supported are: 

• North azimuth based on gradians/gons 
• Decimal degrees 
• Degrees-minutes-seconds 

Length and Height fields 

Lengths are used as input for most computations. You can use the Survey Editor options to 
change the display units for lengths and heights, and you can also create your own custom 
length or height units. The units supported include meters, International feet, and U.S. feet. 

Coordinate fields 

Coordinates can be easting, northing, and elevation values used to identify a position in space 
with origins based on a projected or geographic coordinate system and on a vertical datum. 
Coordinate fields are used to display and enter these values for survey points; they are one of 
the following: 
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• X coordinate (easting) 
• Y coordinate (northing)  
• Z coordinate (elevation) 

You can use the Survey Editor options to change the display units for projected coordinate 
system coordinates or for geographic coordinate system coordinates. Geographic coordinates 
are supported in units of degrees-minutes-seconds, and projected coordinates are supported in 
units of meters, International feet, and U.S. feet. 

Entering values using the map 

The previous sections describe how to enter measurement values and point names into the 
computation detail pages. In addition to directly typing point names and computation values, 
LEICA Zeno Office offers map-based entry methods.  

Angle field entry 

You can enter an angle from the map by defining two directions using any combination of the 
methods described in the previous sections for defining directions. The angle entered is defined 
by the difference between the two directions. 
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Selecting survey objects 

About selecting survey objects 

Select survey objects in the Survey Explorer list pages by clicking the objects’ row numbers. 

How to select survey objects 

Selecting one or more survey objects 

1. Scroll through the list page to find the row of the survey object you want to select. 
2. Click the row number in the leftmost column of the list. 
3. Scroll through the list to find other objects to add to the selection. 
4. Add to the selection by holding down the Ctrl key while repeating step 2. 

Selecting multiple survey objects in a block of rows 

1. Scroll through the list page to find the first row in the block of rows you want to select. 
2. Click the row number in the leftmost column of the list. 
3. Scroll through the list to find the last row in the block of rows you want to select. 
4. Hold down the Shift key and click the leftmost column of the list. 
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Using the Active Object context menu 

About using the Active Object context menu 

You can use the Survey Explorer list pages to manipulate the map extents so that you can zoom 
or pan to specific survey points and measurements using the Active object context menu. 

You can also use this context menu to flash measurements or survey points. 

How to use the Active Object context menu 

Panning to a survey point or measurement 

1. Right-click any cell of a row for the measurement or survey point that you want to bring 
into view on the map. 

2. Click Pan To. 

The map extents shift so that the survey point or measurement is displayed in the center 
of the map. 

Flashing active objects 

1. Right-click any cell of a row for the measurement or survey point that you want to flash on 
the map. 

2. Click Flash. 

The active measurement or survey point flashes. 
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Coordinate Manager 

About the Coordinate Manager 

With LEICA Zeno Office it is possible to store more than one coordinate within one Survey Point. 
The coordinate manager can be used to manage these coordinates. 

See also Editing survey objects and other topics in this chapter. 

How to use the Coordinate Manager 

Tabular view 

1. Select the Survey Point to be managed. 
2. Select the Survey Point(s) in the list and right click to open the details page. 

 

 
3. The coordinates stored with the Survey Point will be shown in a table and can be 

managed. 

Graphic view 

1. Select the Survey Point to be managed. 
2. Select the Survey Point(s) in the list and right click to open the details page. 
3. Step to the desired Survey Point and open the graphic view of the coordinate manager 

. 
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4. Move the cursor to one coordinate to show details like source, distance to mean and 

standard deviation. The symobol for that coordinate will change color to identify it in the 
other window also. 

5. Right click on a symbol to manage the coordinate. 
 

 



 

Reports 

About reports 

If you want to know something about the facts and figures behind your analysis you may want 
to read the report which is an invaluable companion to the process of map making. It displays 
attribute information about map features in a tabular format.  

Two ways to create reports 

LEICA Zeno Office provides two methods for creating reports: 

• Using the LEICA Zeno Office built-in reporting tool to store them with your map 
• Using the XML Reporting for report your survey field work 

Once the report has been created, you can add it to your map layout and print it out. 
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Adding report elements 

About adding report elements  

If you care much about how your report looks like, you can make it more attractive by adding 
some of the elements: 

• A title 
• A subtitle 
• Page numbers 
• The current date 
• Images (for example, a company logo) 
• Footnotes 

Adding elements lets you control the way it looks. For instance, you may want to add your 
company logo and place it on the upper right corner. 

How to add report elements 

First click Tools -> Create Report to open the dialogue. 

Adding a title 

1. Click the Display tab on the Report Properties dialog. 
2. Click Elements. 
3. Check Title. 
4. To type the text for the title, double-click Text. 
5. Click Font and click the button to open the Font dialog. 
6. Set the font, size, style, and color as you prefer and click OK. 
7. Click Back Color and click the button to open the Color dialog . 
8. Select a color. 
9. Click Border and click the button to open the Border Properties dialog. 
10. Select a border style. 
11. Click OK. 

Adding a subtitle 

1. Click the Display tab on the Report Properties dialog. 
2. Click Elements. 
3. Check Subtitle. 
4. To type the text for the subtitle, double-click Text. 

Adding page numbers 

1. Click the Display tab on the Report Properties dialog. 
2. Click Elements. 
3. Check Page Numbering. 
4. Click Section and then click the dropdown arrow. 
5. Click Top of Page or Bottom of Page. 
6. Click Font and click the button to display the Font dialog. 
7. Set the font, size, style, and color as desired. 
8. Click OK. 

Adding the date 

1. Click the Display tab on the Report Properties dialog. 
2. Click Elements. 
3. Check Date. 
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4. Click Section and then click the dropdown arrow. 
5. Click Top of Page or Bottom of Page. 
6. Click Number Format and then click the dropdown arrow. 
7. Select a date format. Dates can be shown as: 

mm/dd/yy 1:00:00 AM 
Monday, July 26, 1999 
mm/dd/yy 

Adding footnotes 

1. Click the Display tab on the Report Properties dialog. 
2. Click Elements. 
3. Check Page Footnote or Report Footnote. 
4. To type the text for the footnote, double-click Text. 
5. Click Font and click the button to display the Font dialog. 
6. Set the font, size, style, and color as you prefer. 
7. Click OK. 

Adding an image at the top of the report 

1. Click the Display tab on the Report Properties dialog. 
2. Click Elements. 
3. Check Image. 
4. Click Picture and then click the button to open the Open Image dialog. 
5. Click the desired image. 
6. To type a height, double-click Height. 
7. To type a width, double-click Width. 
8. Click Picture Display and then click the dropdown arrow. 
9. Click Fit, Clip, or Stretch. 

Adding an image in the background 

1. Click the Display tab on the Report Properties dialog. 
2. Click Background. 
3. Check Image. 
4. Click Picture and then click the button to open the Open Image dialog. 
5. Click the desired image. to display. The image appears in the background of the report 

data on all pages. 

Adding text in the background 

1. Click the Display tab on the Report Properties dialog. 
2. Click Background. 
3. Check Text. 
4. Double-click the Text property and type the text string that should appear in the 

background. The text will be shown behind the report data on all pages. 
5. Click Font and click the button to display the Font dialog. 
6. Set the font, size, style, and color as you prefer. 
7. Click OK. 
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Creating a simple report 

About creating a simple report  

To organize and display the tabular data related to your geographic features make use of 
creating a report. While creating a report you can decide what fields to display and what 
features to list, whether all features in a layer or just the selected ones. After having finished 
the generation of your report you may want to print it out or display it on the layout next to 
your map panel. 

How to create a simple tabular report 

1. Click Create Report in the Tools menu. 
2. Click the Layer/Table dropdown arrow on the Fields tab and select the layer or table where 

the report should be based on by clicking that layer. 
3. In the Available Fields list, choose the fields that your report should contain by double-

clicking them. 
4. Check Use Selected Set to create your report with only the selected features. 
5. To arrange the report fields, click the arrow buttons. 
6. On the Sorting tab click a field to sort in the Sort column. 
7. On the Display tab click Settings, and then click Elements. 
8. If you want to add a title to the report check Title. 
9. Locate the Text property and type a title for the report. 
10. To set the font and size of the title click the Font property. 
11. To preview the report click Show Settings. 
12. Finally, click Generate Report. 
13. To insert the report to the map layout, click Add at the top of the Report Viewer. 
14. Click OK. The report gets inserted to the layout as a graphic element having each page of 

the report added as a separate graphic element on the layout. 
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Organizing report data 

About organizing report data  

One advantage of displaying your data in a report is that a report allows you to organize your 
data. For example: 

• You can sort records based on the values in one or more fields - for example, given a 
list of cities, you could sort them by total population. 

• You can group records together and calculate summary statistics. For instance, you 
could group cities by what country they're in. This lets you easily see which city has the 
largest population in a given country. 

• You can further calculate summary statistics - for example, compute the sum, average, 
count, standard deviation, minimum, and maximum value. 

How to organize report data 

Sorting records 

1. Click the Sorting tab on the Report Properties dialog. 
2. Click a field to sort in the Sort column. 
3. Click Ascending, Descending, or None. 
4. If you want to sort other fields, click them, then click the sorting method. LEICA Zeno 

Office sorts the fields based on the sort order. For example, you could sort cities 
alphabetically by country, then by their name. 

Tip 

• You can sort records using up to three fields in ascending or descending 
order. 

Grouping records 

1. Click the Grouping tab on the Report Properties dialog. 
2. Double-click the field you want to use to group data. 
3. Click Grouping Interval and click the method for grouping data. 
4. Click Ascending or Descending for the sort method. 
5. Check Include Group Fields to repeat the group value in the report display. 

Calculating summary statistics 

1. Click the Summary tab on the Report Properties dialog. 
2. Click the Available Sections dropdown arrow and click the section you want the statistics to 

appear in. 
3. For each numeric field, check the box that corresponds to the statistic you want to display. 
4. To display statistics in each available section, repeat steps 2 and 3 for each section. 

Tips 

• You can compute the average, count, minimum, maximum, standard 
deviation, and sum for any numeric fields on your report. 

• You can display summary statistics for a field at the end of the report, at 
the end of each page, and at the end of each group you've defined. 
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• To make the data in your reports easier to read, you can shade every 
other record with a color. 
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Setting the report type and size 

About setting the report type 

A report type can be set as a tabular or columnar one. Whereas a tabular report can be 
compared to a spreadsheet, a columnar report reminds on a newspaper column layout. 

• Use the tabular report to get your data organized in rows and columns with each row 
representing one record of data and each column one field. 

• Use the columnar report to get the fields and their values displayed vertically in 
columns. Choose the number of columns that should be shown. 

How to set the report type 

Setting the report type 

1. On the Display tab of the Report Properties dialog click Report. 
2. Click the Style property, click the dropdown arrow and then select Tabular or Columnar. 
3. If you choose a columnar report, specify the Column Count and Column Style properties. 

Setting the report's page size, orientation, and margin 

1. On the Display tab of the Report Properties dialog click Report. 
2. Click the Page Setup property and click the button to open the Page Setup dialog. 
3. Click the Paper Size dropdown arrow to select a size. To include the report in a layout, 

specify a size that's close to the available space on the layout. 
4. Choose either Portrait or Landscape by clicking it. 
5. Type the Left, Right, Top, and Bottom margins. 
6. Click OK. 
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Reporting computation results 

About reporting computation results 

After succesfully completing a computation, you can present its results in a report. Reports can 
be created for any of the following computations: 

• COGO traverse 
• TPS free station 
• TPS traverse 
• TPS resection 
• TPS tacheometry 

 

A report can only be created if the state of the computation is valid. 

Reporting for computations is based on XML. You can select a style for the report by choosing a 
stylesheet. Leica Zeno Office provides a stylesheet for each computation. 

How to create a computation report 

1. Confirm that the state of the computation is valid. 
2. Click the Report tab. 
3. Click the Style Sheet dropdown arrow and click the stylesheet that you want to use. 
4. Click the Browse button and navigate to the location of the style sheet if the style sheet 

you need is not listed. 
5. Skip to step 16 if you want to use a predefined style. 
6. Check the boxes of the items in the computation you want included in the report. 
7. Click the element of the computation for which you want to change the font. 
8. Double-click the Value field for the Font property you want to change. 
9. Click the font property’s dropdown arrow and click the property you want to use. 
10. Repeat steps 7 through 9 for all other elements you want to change. 
11. Click the Preview button to see how the report will appear based on your style changes. 
12. Click the Close button. 
13. Return to step 6 if you want to make changes. 
14. Click Save Style. 
15. Type a name for the new style and click OK. 
16. Click the Style dropdown arrow and click the style you want to use for the report. 
17. Click Save Report. 
18. Navigate to the folder in which you want to save the report. 
19. Type a name for the report. 
20. Click Save. 
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Survey Objects Reporting 

About Survey Objects Reporting 

Survey Point Reporting allows you to report detailed information about your Survey Points. This 
can be coordinates, standard deviation, creation date, parent Survey Project, source and many 
more. These reports are generated as XML files. Reporting TPS measurements provides 
information like setup point, target points, Hz and V angle, distance, etc. 

How to report Survey Objects 

Create a standard survey point report 

1. Select the Survey Points to be reported - e.g. with the graphic selection tool . These 
Survey Points will be shown in the Survey Explorer. 

2. Mark the desired Survey Points. 
3. Right click on the first column (line numbers) and select Survey Object Report... 
4. Click the Style Sheet dropdown arrow and select the stylesheet Leica.SurveyPoints.xsl 

Click the Browse button and navigate to the location of the style sheet if the style sheet 
you need is not listed. 

5. Skip to step 16 if you want to use a predefined style. 
6. Check the boxes of the items in the computation you want included in the report. 
7. Click the element of the computation for which you want to change the font. 
8. Double-click the Value field for the Font property you want to change. 
9. Click the font property’s dropdown arrow and click the property you want to use. 
10. Repeat steps 7 through 9 for all other elements you want to change. 
11. Click the Preview button to see how the report will appear based on your style changes. 
12. Click the Close button. 
13. Return to step 6 if you want to make changes. 
14. Click Save Style. 
15. Type a name for the new style and click OK. 
16. Click the Style dropdown arrow and click the style you want to use for the report. 
17. Click Save Report. 
18. Navigate to the folder in which you want to save the report. 
19. Type a name for the report. 
20. Click Save. 

Create a detailed survey point report 

1. Select the Survey Points to be reported - e.g. with the graphic selection tool . These 
Survey Points will be shown in the Survey Explorer. 

2. Mark the desired Survey Points. 
3. Right click on the first column (line numbers) and select Survey Object Report... 
4. Click the Style Sheet dropdown arrow and select the stylesheet 

Leica.SurveyPointDetails.xsl 
Click the Browse button and navigate to the location of the style sheet if the style sheet 
you need is not listed. 

5. Skip to step 16 if you want to use a predefined style. 
6. Check the boxes of the items in the computation you want included in the report. 
7. Click the element of the computation for which you want to change the font. 
8. Double-click the Value field for the Font property you want to change. 
9. Click the font property’s dropdown arrow and click the property you want to use. 
10. Repeat steps 7 through 9 for all other elements you want to change. 
11. Click the Preview button to see how the report will appear based on your style changes. 
12. Click the Close button. 
13. Return to step 6 if you want to make changes. 
14. Click Save Style. 
15. Type a name for the new style and click OK. 
16. Click the Style dropdown arrow and click the style you want to use for the report. 
17. Click Save Report. 
18. Navigate to the folder in which you want to save the report. 
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19. Type a name for the report. 
20. Click Save. 

Create a TPS measurement report 

1. Select the TPS measurements to be reported - e.g. with the graphic selection tool . 
These measurements will be shown in the Survey Explorer. 

2. Mark the desired measurements. 
3. Right click on the first column (line numbers) and select Survey Object Report... 
4. Click the Style Sheet dropdown arrow and select the stylesheet 

Leica.TPSMeasurements.xsl 
Click the Browse button and navigate to the location of the style sheet if the style sheet 
you need is not listed. 

5. Skip to step 16 if you want to use a predefined style. 
6. Check the boxes of the items in the computation you want included in the report. 
7. Click the element of the computation for which you want to change the font. 
8. Double-click the Value field for the Font property you want to change. 
9. Click the font property's dropdown arrow and click the property you want to use. 
10. Repeat steps 7 through 9 for all other elements you want to change. 
11. Click the Preview button to see how the report will appear based on your style changes. 
12. Click the Close button. 
13. Return to step 6 if you want to make changes. 
14. Click Save Style. 
15. Type a name for the new style and click OK. 
16. Click the Style dropdown arrow and click the style you want to use for the report. 
17. Click Save Report. 
18. Navigate to the folder in which you want to save the report. 
19. Type a name for the report. 
20. Click Save. 
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About coordinate systems 

The actual locations of the real world objects are represented by the features on a map. Using 
geographic coordinates -latitude and longitude- the exact positions of objects will be located on 
the earth's spherical surface. But these measurements are not uniform; only along the equator 
does the distance represented by one degree of longitude approximate the distance represented 
by one degree of latitude. Transforming data from 3D geographic coordinates to 2D projected 
coordinates is useful to deal with the measurement difficulties. 

 

How to specify a coordinate system in Zeno Office 

 

Find out more about coordinate systems at the 'Map projections' section in this Help system. 

Map projections 

To get information from the earth having a curved surface to the map being flat a mathematical 
formula is needed. Processing this formula - simply called projection, or map projection - will 
provoke distortions in one or more of the following spatial properties:    

• Distance 
• Area 
• Shape 
• Direction 

Since it is not possible to retain all these properties by any projection, all flat maps will have 
distortions to a certain degree. There are different map projections distinguished by its 
capability to represent a particular portion and amount of the earth's surface and by its 
efficiency to retain some or all of the spatial properties. While some map projections aim for 
balancing the overall distortion, others seek to minimize distortions in one property at the 
expense of another. Choose from the different projections provided to find the one that satisfies 
your demands best. 
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Coordinate systems 

There are two types of coordinate systems: geographic and projected. Geographic coordinate 
systems use latitude and longitude coordinates on a spherical model of the earth's surface. 
Projected coordinate systems use a mathematical conversion to transform latitude and longitude 
coordinates that fall on the earth's three-dimensional surface to a two-dimensional surface. 

Each data source stores the parameters that define its coordinate system as an integral part of 
its data.  
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About geographic coordinate systems 

A geographic coordinate system (GCS) uses a three-dimensional spherical surface to define 
locations on the earth. A GCS includes an angular unit of measure, a prime meridian, and a 
datum (based on a spheroid). 

A point is referenced by its longitude and latitude values. Longitude and latitude are angles 
measured from the earth's center to a point on the earth's surface. The angles often are 
measured in degrees (or in grads). The following illustration shows the world as a globe with 
longitude and latitude values. 

 

The line of latitude midway between the poles is called the equator. It defines the line of zero 
latitude. The line of zero longitude is called the prime meridian. For most geographic coordinate 
systems, the prime meridian is the longitude that passes through Greenwich, England. The 
globe is then divided into four geographical quadrants that are based on compass bearings from 
the origin. North and south are above and below the equator, and west and east are to the left 
and right of the prime meridian. Latitude values are measured relative to the equator and range 
from -90° at the South Pole to +90° at the North Pole. Longitude values are measured relative 
to the prime meridian. They range from -180° when traveling west to 180° when traveling east. 
If the prime meridian is at Greenwich, then Australia, which is south of the equator and east of 
Greenwich, has positive longitude values and negative latitude values. 
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About projected coordinate systems 

A projected coordinate system is defined on a flat, two-dimensional surface. Unlike a geographic 
coordinate system, a projected coordinate system has constant lengths, angles, and areas 
across the two dimensions. A projected coordinate system is always based on a geographic 
coordinate system that is based on a sphere or spheroid. 

In a projected coordinate system, locations are identified by x,y coordinates on a grid, with the 
origin at the center of the grid. Each position has two values that reference it to that central 
location. One specifies its horizontal position and the other its vertical position. The two values 
are called the x-coordinate and y-coordinate. Using this notation, the coordinates at the origin 
are x = 0 and y = 0. 
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Cylindrical and conic projections 

Cylindrical projections 

Like conic projections, cylindrical projections can also have tangent or secant cases. The 
Mercator projection is one of the most common cylindrical projections, and the equator is 
usually its line of tangency. Meridians are geometrically projected onto the cylindrical surface, 
and parallels are mathematically projected. This produces graticular angles of 90 degrees. The 
cylinder is "cut" along any meridian to produce the final cylindrical projection. The meridians are 
equally spaced, while the spacing between parallel lines of latitude increases toward the poles. 
This projection is conformal and displays true direction along straight lines. On a Mercator 
projection, rhumb lines, lines of constant bearing, are straight lines, but most great circles are 
not. 

For more complex cylindrical projections the cylinder is rotated, thus changing the tangent or 
secant lines.  

 

Conic projections 

The most simple conic projection is tangent to the globe along a line of latitude. This line is 
called the standard parallel. The meridians are projected onto the conical surface, meeting at 
the apex, or point, of the cone. Parallel lines of latitude are projected onto the cone as rings. 
The cone is then "cut" along any meridian to produce the final conic projection, which has 
straight converging lines for meridians and concentric circular arcs for parallels. The meridian 
opposite the cut line becomes the central meridian. 

In general, the further you get from the standard parallel, the more distortion increases. Thus, 
cutting off the top of the cone produces a more accurate projection. You can accomplish this by 
not using the polar region of the projected data. Conic projections are used for midlatitude 
zones that have an east–west orientation. 
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Datums 

While a spheroid approximates the shape of the earth (see Spheroids and spheres), a datum 
defines the position of the spheroid relative to the center of the earth. A datum provides a 
frame of reference for measuring locations on the surface of the earth. It defines the origin and 
orientation of latitude and longitude lines. 

Whenever you change the datum, or more correctly, the geographic coordinate system, the 
coordinate values of your data will change.  

Geocentric datums 

In the last 15 years, satellite data has provided geodesists with new measurements to define 
the best earth-fitting spheroid, which relates coordinates to the earth's center of mass. An 
earth-centered, or geocentric, datum uses the earth's center of mass as the origin. The most 
recently developed and widely used datum is WGS 1984. It serves as the framework for 
locational measurement worldwide. 

Local datums 

A local datum aligns its spheroid to closely fit the earth's surface in a particular area. A point on 
the surface of the spheroid is matched to a particular position on the surface of the earth. This 
point is known as the origin point of the datum. The coordinates of the origin point are fixed, 
and all other points are calculated from it.  

 

The coordinate system origin of a local datum is not at the center of the earth. The center of the 
spheroid of a local datum is offset from the earth's center. NAD 1927 and the European Datum 
of 1950 (ED 1950) are local datums. NAD 1927 is designed to fit North America reasonably well, 
while ED 1950 was created for use in Europe. Because a local datum aligns its spheroid so 
closely to a particular area on the earth's surface, it's not suitable for use outside the area for 
which it was designed. 
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Equation-based methods 

Equation-based transformation methods can be classified into the following four method types. 

Three-parameter methods 

The simplest datum transformation method is a geocentric, or three-parameter, transformation. 
The geocentric transformation models the differences between two datums in the X,Y,Z 
coordinate system. One datum is defined with its center at 0,0,0. The center of the other datum 
is defined at some distance (DX,DY,DZ) in meters away. 

 

Usually the transformation parameters are defined as going "from" a local datum "to" WGS 1984 
or another geocentric datum. 

 

The three parameters are linear shifts and are always in meters. 

Seven-parameter methods 

A more complex and accurate datum transformation is possible by adding four more parameters 
to a geocentric transformation. The seven parameters are three linear shifts (DX,DY,DZ), three 
angular rotations around each axis (rx,ry,rz), and scale factor(s). 

 

The rotation values are given in decimal seconds, while the scale factor is in parts per million 
(ppm). The rotation values are defined in two different ways. It's possible to define the rotation 
angles as positive either clockwise or counterclockwise as you look toward the origin of the 
X,Y,Z systems.  
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The previous equation is how the United States and Australia define the equations and is called 
the Coordinate Frame Rotation transformation. The rotations are positive counterclockwise. 
Europe uses a different convention called the Position Vector transformation. Both methods are 
sometimes referred to as the Bursa–Wolf method. In the Projection Engine, the Coordinate 
Frame and Bursa–Wolf methods are the same. Both Coordinate Frame and Position Vector 
methods are supported, and it is easy to convert transformation values from one method to the 
other simply by changing the signs of the three rotation values.  

Unless explicitly stated, it's impossible to tell from the parameters alone which convention is 
being used. If you use the wrong method, your results can return inaccurate coordinates. The 
only way to determine how the parameters are defined is by checking a control point whose 
coordinates are known in the two systems. 

Molodensky method 

The Molodensky method converts directly between two geographic coordinate systems without 
actually converting to an X,Y,Z system. The Molodensky method requires three shifts 
(DX,DY,DZ) and the differences between the semimajor axes (Da) and the flattenings (Df) of 
the two spheroids. The Projection Engine automatically calculates the spheroid differences 
according to the datums involved.  

 

h ellipsoid height (meters) 
j latitude 
l longitude 
a semimajor axis of the spheroid (meters) 
b semiminor axis of the spheroid (meters) 
f flattening of the spheroid 
e eccentricity of the spheroid  

M and N are the meridional and prime vertical radii of curvature, respectively, at a given 
latitude. The equations for M and N are: 

 

You solve for Dl and Dj. The amounts are added automatically by the Projection Engine.  
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Abridged Molodensky method 

The Abridged Molodensky method is a simplified version of the Molodensky method. The 
equations are: 

 

379 



Printed Documentation 

Geocentric Coordinate System 

Description 

The geocentric coordinate system is not a map projection. The earth is modeled as a sphere or 
spheroid in a right-handed X,Y,Z system.  
The X-axis points to the prime meridian, the Y-axis points 90° away in the equatorial plane, and 
the Z-axis points in the direction of the North Pole.  
   

 

Uses and applications 

The geocentric coordinate system is used internally as an interim system for several geographic 
(datum) transformation methods.  
   
Learn more about geographic transformation methods  
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Geographic Coordinate System 

Description 

The geographic coordinate system is not a map projection. The earth is modeled as a sphere or 
spheroid. The sphere is divided into equal parts usually called degrees; some countries use 
grads. A circle is 360° or 400 grads. Each degree is subdivided into 60 minutes, with each 
minute composed of 60 seconds.  
The geographic coordinate system consists of latitude and longitude lines. Each line of longitude 
runs north-south and measures the number of degrees east or west of the prime meridian. 
Values range from -180 to +180°. Lines of latitude run east-west and measure the number of 
degrees north or south of the equator. Values range from +90° at the North Pole to -90° at the 
South Pole.  
   
Learn more about the geographic coordinate system  
The standard origin is where the Greenwich prime meridian meets the equator. All points north 
of the equator or east of the prime meridian are positive.  
   
   

 

Uses and applications 

Map projections use latitude and longitude values to reference parameters such as the central 
meridian, the standard parallels, and the latitude of origin.  
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Geographic transformation methods 

Moving your data between coordinate systems sometimes includes transforming between the 
geographic coordinate systems.  

 

Because the geographic coordinate systems contain datums that are based on spheroids, a 
geographic transformation also changes the underlying spheroid. There are several methods, 
which have different levels of accuracy and ranges, for transforming between datums. The 
accuracy of a particular transformation can range from centimeters to meters depending on the 
method and the quality and number of control points available to define the transformation 
parameters. 

A geographic transformation always converts geographic (longitude–latitude) coordinates. Some 
methods convert the geographic coordinates to geocentric (X,Y,Z) coordinates, transform the 
X,Y,Z coordinates, and convert the new values back to geographic coordinates.  
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List of supported map projections 

Map projection Description 

Aitoff A compromise projection developed in 1889 and used for world 
maps. 

Alaska Grid This projection was developed to provide a conformal map of Alaska 
with less scale distortion than other conformal projections. 

Alaska Series E Developed in 1972 by the United States Geological Survey (USGS) to 
publish a map of Alaska at 1:2,500,000 scale. 

Albers Equal Area 
Conic 

This conic projection uses two standard parallels to reduce some of 
the distortion of a projection with one standard parallel. Shape and 
linear scale distortion are minimized between the standard parallels. 

Azimuthal 
Equidistant 

The most significant characteristic of this projection is that both 
distance and direction are accurate from the central point.  

Behrmann Equal 
Area Cylindrical 

This projection is an equal-area cylindrical projection suitable for 
world mapping. 

Bipolar Oblique 
Conformal Conic 

This projection was developed specifically for mapping North and 
South America and maintains conformality.  

Bonne This equal-area projection has true scale along the central meridian 
and all parallels.  

Cassini–Soldner This transverse cylindrical projection maintains scale along the 
central meridian and all lines parallel to it. This projection is neither 
equal area nor conformal.  

Chamberlin 
Trimetric 

This projection was developed and used by the National Geographic 
Society for continental mapping. The distance from three input 
points to any other point is approximately correct. 

Craster Parabolic This pseudocylindrical equal-area projection is primarily used for 
thematic maps of the world.  

Cylindrical Equal 
Area 

Lambert first described this equal-area projection in 1772. It is used 
infrequently. 

Double This azimuthal projection is conformal. 
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Stereographic 

Eckert I This pseudocylindrical projection is used primarily as a novelty map. 

Eckert II A pseudocylindrical equal-area projection. 

Eckert III This pseudocylindrical projection is used primarily for world maps. 

Eckert IV This equal-area projection is used primarily for world maps. 

Eckert V This pseudocylindrical projection is used primarily for world maps. 

Eckert VI This equal-area projection is used primarily for world maps. 

Equidistant Conic This conic projection can be based on one or two standard parallels. 
As the name implies, all circular parallels are spaced evenly along 
the meridians.  

Equidistant 
Cylindrical 

One of the easiest projections to construct because it forms a grid of 
equal rectangles.  

Equirectangular This projection is very simple to construct because it forms a grid of 
equal rectangles.  

Gall's Stereographic The Gall's Stereographic projection is a cylindrical projection 
designed around 1855 with two standard parallels at latitudes 45° N 
and 45° S. 

Gauss–Krüger This projection is similar to the Mercator except that the cylinder is 
tangent along a meridian instead of the equator. The result is a 
conformal projection that does not maintain true directions.  

Geocentric 
Coordinate System 

The geocentric coordinate system is not a map projection. The earth 
is modeled as a sphere or spheroid in a right-handed X,Y,Z system. 

Geographic 
Coordinate System 

The geographic coordinate system is not a map projection. The earth 
is modeled as a sphere or spheroid.  

Gnomonic This azimuthal projection uses the center of the earth as its 
perspective point.  

Great Britain 
National Grid 

This coordinate system uses a Transverse Mercator projected on the 
Airy spheroid. The central meridian is scaled to 0.9996. The origin is 
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49° N and 2° W. 

Hammer–Aitoff The Hammer–Aitoff projection is a modification of the Lambert 
Azimuthal Equal Area projection. 

Hotine Oblique 
Mercator 

This is an oblique rotation of the Mercator projection. Developed for 
conformal mapping of areas that do not follow a north–south or 
east–west orientation but are obliquely oriented. 

Krovak The Krovak projection is an oblique Lambert conformal conic 
projection designed for the former Czechoslovakia. 

Lambert Azimuthal 
Equal Area 

This projection preserves the area of individual polygons while 
simultaneously maintaining true directions from the center.  

Lambert Conformal 
Conic 

This projection is one of the best for middle latitudes. It is similar to 
the Albers Conic Equal Area projection except that the Lambert 
Conformal Conic projection portrays shape more accurately than 
area.  

Local Cartesian 
Projection 

This is a specialized map projection that does not take into account 
the curvature of the earth.  

Loximuthal This projection shows loxodromes, or rhumb lines, as straight lines 
with the correct azimuth and scale from the intersection of the 
central meridian and the central parallel. 

McBryde–Thomas 
Flat-Polar Quartic 

This equal-area projection is primarily used for world maps. 

Mercator Originally created to display accurate compass bearings for sea 
travel. An additional feature of this projection is that all local shapes 
are accurate and clearly defined. 

Miller Cylindrical This projection is similar to the Mercator projection except that the 
polar regions are not as areally distorted. 

Mollweide Carl B. Mollweide created this pseudocylindrical projection in 1805. It 
is an equal-area projection designed for small-scale maps. 

New Zealand 
National Grid 

This is the standard projection for large-scale maps of New Zealand. 

Orthographic This perspective projection views the globe from an infinite distance. 
This gives the illusion of a three-dimensional globe. 
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Perspective This projection is similar to the Orthographic projection in that its 
perspective is from space. In this projection, the perspective point is 
not an infinite distance away; instead, you can specify the distance.  

Plate Carrée This projection is very simple to construct because it forms a grid of 
equal rectangles.  

Polar Stereographic The projection is equivalent to the polar aspect of the Stereographic 
projection on a spheroid. The central point is either the North Pole or 
the South Pole.  

Polyconic The name of this projection translates into "many cones" and refers 
to the projection methodology.  

Quartic Authalic This pseudocylindrical equal-area projection is primarily used for 
thematic maps of the world.  

Rectified Skewed 
Orthomorphic 

This oblique cylindrical projection is provided with two options for the 
national coordinate systems of Malaysia and Brunei. 

Robinson A compromise projection used for world maps. 

Simple Conic This conic projection can be based on one or two standard parallels.  

Sinusoidal As a world map, this projection maintains equal area despite 
conformal distortion.  

Space Oblique 
Mercator 

This projection is nearly conformal and has little scale distortion 
within the sensing range of an orbiting mapping satellite such as 
Landsat.  

State Plane 
Coordinate System 
(SPCS) 

The State Plane Coordinate System is not a projection. It is a 
coordinate system that divides the 50 states of the United States, 
Puerto Rico, and the U.S. Virgin Islands into more than 120 
numbered sections, referred to as zones.  

Stereographic This azimuthal projection is conformal. 

Times The Times projection was developed by Moir in 1965 for 
Bartholomew Ltd., a British mapmaking company. It is a modified 
Gall's Stereographic, but the Times has curved meridians. 

Transverse Mercator Similar to the Mercator except that the cylinder is tangent along a 
meridian instead of the equator. The result is a conformal projection 
that does not maintain true directions.  
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Two-Point 
Equidistant 

This modified planar projection shows the true distance from either 
of two chosen points to any other point on a map. 

Universal Polar 
Stereographic (UPS) 

This form of the Polar Stereographic maps areas north of 84° N and 
south of 80° S that are not included in the UTM Coordinate System. 
The projection is equivalent to the polar aspect of the Stereographic 
projection of the spheroid with specific parameters.  

Universal 
Transverse Mercator 
(UTM) 

The Universal Transverse Mercator coordinate system is a specialized 
application of the Transverse Mercator projection. The globe is 
divided into 60 zones, each spanning six degrees of longitude.  

Van Der Grinten I This projection is similar to the Mercator projection except that it 
portrays the world as a circle with a curved graticule.  

Vertical Near-Side 
Perspective 

Unlike the Orthographic projection, this perspective projection views 
the globe from a finite distance. This perspective gives the overall 
effect of the view from a satellite. 

Winkel I A pseudocylindrical projection used for world maps that averages the 
coordinates from the Equirectangular (Equidistant Cylindrical) and 
Sinusoidal projections.  

Winkel II A pseudocylindrical projection that averages the coordinates from 
the Equirectangular and Mollweide projections.  

Winkel Tripel A compromise projection used for world maps that averages the 
coordinates from the Equirectangular (Equidistant Cylindrical) and 
Aitoff projections.  
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MGRS Grid components 
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Planar projections 

Planar projections project map data onto a flat surface touching the globe. A planar projection is 
also known as an azimuthal projection or a zenithal projection.  

This type of projection is usually tangent to the globe at one point but may be secant, also. The 
point of contact may be the North Pole, the South Pole, a point on the equator, or any point in 
between. This point specifies the aspect and is the focus of the projection. The focus is identified 
by a central longitude and a central latitude. Possible aspects are polar, equatorial, and oblique. 

Polar aspects are the simplest form. Parallels of latitude are concentric circles centered on the 
pole, and meridians are straight lines that intersect with their true angles of orientation at the 
pole. In other aspects, planar projections will have graticular angles of 90 degrees at the focus. 
Directions from the focus are accurate. 

Great circles passing through the focus are represented by straight lines; thus the shortest 
distance from the center to any other point on the map is a straight line. Patterns of area and 
shape distortion are circular about the focus. For this reason, azimuthal projections 
accommodate circular regions better than rectangular regions. Planar projections are used most 
often to map polar regions. 
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Spheroids and spheres 

The shape and size of a geographic coordinate system's surface is defined by a sphere or 
spheroid. Although the earth is best represented by a spheroid, the earth is sometimes treated 
as a sphere to make mathematical calculations easier. The assumption that the earth is a 
sphere is possible for small-scale maps (smaller than 1:5,000,000). At this scale, the difference 
between a sphere and a spheroid is not detectable on a map. However, to maintain accuracy for 
larger-scale maps (scales of 1:1,000,000 or larger), a spheroid is necessary to represent the 
shape of the earth. Between those scales, choosing to use a sphere or spheroid will depend on 
the map's purpose and the accuracy of the data. 

Definition of a spheroid 

A sphere is based on a circle, while a spheroid (or ellipsoid) is based on an ellipse.  

 

The shape of an ellipse is defined by two radii. The longer radius is called the semimajor axis, 
and the shorter radius is called the semiminor axis.  

 

Rotating the ellipse around the semiminor axis creates a spheroid. A spheroid is also known as 
an oblate ellipsoid of revolution. The following graphic shows the semimajor and semiminor axes 
of a spheroid. 

 

A spheroid is defined by either the semimajor axis, a, and the semiminor axis, b, or by a and 
the flattening. The flattening is the difference in length between the two axes expressed as a 
fraction or a decimal. The flattening, f, is:  

f = (a - b) / a  

The flattening is a small value, so usually the quantity 1/f is used instead. The spheroid 
parameters for the World Geodetic System of 1984 (WGS 1984 or WGS84) are: 

a = 6378137.0 meters 
1/f = 298.257223563  

The flattening ranges from zero to one. A flattening value of zero means the two axes are equal, 
resulting in a sphere. The flattening of the earth is approximately 0.003353. Another quantity, 
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that, like the flattening, describes the shape of a spheroid, is the square of the eccentricity, e2. 
It is represented by:  
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Applying a coordinate transformation to a CAD 
layer 

About applying a coordinate transformation to a CAD layer  

To ensure that the features used in CAD drawings will be in the same coordinate system as the 
data in other layers displayed on your map you can apply a coordinate transformation to your 
CAD layers. 

LEICA Zeno Office provides both one-point and two-point transformations. Whereas the one-
point transformation only shifts the CAD layer to a new location in geographic space, the more 
advanced two-point transformation computes a transformation matrix applying a coordinate 
offset, scale, and rotation for all coordinates read from the drawing source. To generate a 
coordinate transformation you can either use a World file, or type coordinate values in the 
Transformations Properties dialog box. 

 

How to apply a coordinate transformation to a CAD layer 

Transform by World File 

1. Choose the desired layer to be transformed in the table of contents. 
2. Right-click on it, click Properties, and then click the Transformations tab. 
3. Check Enable Transformations. 
4. In the Transform By box, click the World File option. 
5. Click the Browse button. 
6. Click the Look in dropdown arrow and navigate to the folder comprising the World file to 

be added.  
7. Click the relevant World file and then click Open. The full path to the World file is displayed 

in the World File Name text box. 
8. Click OK. LEICA Zeno Office creates the layer using the new coordinates. 

Transform by Coordinates 

1. Choose the desired layer to be transformed in the table of contentss. 
2. Right-click on it, click Properties, and then click the Transformations tab. 
3. Check Enable Transformations. 
4. In the Transform By box, click the Coordinates option. 
5. Type the From and To coordinate values. Keep in mind, a one-point coordinate 

transformation requires two pairs of x,y coordinate values, a two-point coordinate 
transformation requires four pairs. 

6. Click OK. LEICA Zeno Office creates the layer using the new coordinates. 

Transform by Rotate, Scale, Translate 

1. Choose the desired layer to be transformed in the table of contents. 
2. Right-click on it, click Properties, and then click the Transformations tab. 
3. Check Enable Transformations. 
4. In the Transform By box, click the Rotate, Scale, Translate option. 
5. Type the From and To coordinate values. Keep in mind, a Rotate, Scale, Translate 

transformation requires two pairs of x,y coordinate values. 
6. Type the Angle value and the Scale value. 
7. Click OK. LEICA Zeno Office creates the layer using the new coordinates. 
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CAD drawings 

You can access computer aided design (CAD) drawings directly in Data Manager. CAD drawings 
typically have many layers, each of which represents a different type of geographic feature. For 
example, the drawing might have different line layers for streets, water mains, and parcel 
boundaries.  

For each CAD drawing on disk, there is both a CAD dataset item and a CAD drawing item in the 
Catalog tree. The CAD dataset contains point, line, polygon, and annotation feature classes.  

If you create a layer file from a CAD feature class, you can change the symbology used to draw 
its features, join attributes stored in separate tables to them, and select which features to 
display according to their attribute values. You can only analyze and edit features in LEICA Zeno 
Office when the layer references a CAD feature class. 

Several CAD formats can be directly accessed in LEICA Zeno Office. Supported CAD drawing 
files include: 

• AutoCAD drawing files (.dwg) up to AutoCAD 2000 
• All ASCII, binary, and partial drawing interchange files (.dxf) that comply with DXF 

standards 
• MicroStation design files (.dgn) up to Version 7 
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CAD field to geodatabase field mapping 

The attribute table of the output feature class lists the specific properties preserved for CAD 
features, such as entity type, layer, color, and linetype, and complex information like tag data, 
block attributes, and database linkage values. See the table below - a summary of mapping CAD 
field type to geodatabase field type: 

CAD field type Geodatabase field type 

string text 

integer long integer 

double double 
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CAD to geodatabase geometry type mapping 

Mapping geometric feature classes contained within CAD drawings to geodatabase geometry is 
applied when CAD feature classes are converted to geodatabase feature classes. CAD feature 
classes can be included in AutoCAD's DWG, MicroStation's DGN, or Drawing Interchange File 
(DXF) formats. 

CAD feature class Geodatabase geometry 

point point 

polyline line (polyline) 

polygon polygon 
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Drawing CAD layers 

About drawing CAD layers  

The same as any other data type, computer-aided design (CAD) drawings can be presented on 
your map 

while selecting the CAD layers to draw and deciding how to display the entities on the layer. 

There are two display options dependant on how CAD drawing is inserted to your map: 

• If added for display only, then select the CAD layers which to show or to hide. 
• If added as features, then all the symbolization options will be available as other feature 

layers. 

 

For further information go to symbolizing the features in a CAD dataset. 

How to draw CAD layers 

Displaying a CAD drawing file 

1. Right-click the CAD drawing layer in the table of contents and click Properties. 
2. On the Display tab click and drag the sliders to adjust the CAD display. 
3. On the Drawing Layers tab check the desired CAD layers to display. 
4. Click OK. 

Drawing CAD features as points, lines, or polygons 

1. Right-click the CAD dataset in the table of contents and click Properties. 
2. On the Symbology tab you can change the drawing properties as you need. There's no 

difference between the drawing options available to you and other feature layers. 
3. On the Drawing Layers tab check the desired CAD layers to display. 
4. Click OK. 
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Importing a CAD feature class 

About importing a feature class  

Either importing a CAD feature class from AutoCAD's DWG, MicroStation's DGN, and Drawing 
Interchange File (DXF) formats, or importing feature classes from a CAD dataset to another 
geodatabase can be done using the Import Feature Class command. Whereby it is possible to 
modify the spatial reference, the output fields, and the field names. 

How to import a CAD feature class 

1. Click the Data Manager tab. 
2. In the Catalog tree, right-click the geodatabase in which the new feature class should be 

imported. 

3. Click Import and New Features Class. 
4. In the appearing dialogue box navigate to the relevant CAD data files and select them. 
5. If you want to keep the default settings, skip to step 12. 
6. Otherwise, the output spatial reference, grid size, or field names can be modified. 

Therefore, click Environment. 
7. Specify a spatial reference by clicking on one of the buttons to set a coordinate system. To 

do so, choose one of the following options:  
• Select a preexisting coordinate system, 

• Import a coordinate system from a shapefile, coverage, or feature class, 

• Define a new coordinate system, or 

• Modify the default parameters of the coordinate system. 

8. On the X/Y Domain tab, the default parameters can be changed. 
9. On the Grid Size tab, the grid size can be modified. 
10. Click OK. 
11. Click OK to import the feature class into a personal geodatabase. 
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About georeferencing 

While scanning maps or collecting aerial photographs and satellite images to obtain raster data, 
usually you don't get any information about where the area represented on the map fits on the 
surface of the earth; processing analysis, or displaying in accurate alignment with other data by 
using the locational information delivered with aerial photos and satellite imagery will lead to 
insufficient results. Therefore, you often may want to georeference the raster data to a map 
coordinate system to be able to use it in combination with other spatial data. 

Aligning the raster 

Georeferencing means basically to move the raster into the same space as the target data by 
defining a series of ground control points (GCPs). GCPs are used to combine the location on the 
raster with the location in the target data in map coordinates; this combination is called a link. 

Depending on the method you decide to choose for the transformation the number of links you 
need will differ a lot. To obtain the best results, you should distribute the links over the entire 
raster, typically, one link near each corner of the raster and some throughout the interior. 
Adding more links than the number actually required will not necessarily render a better 
registration. As a general rule you can keep in mind, the greater the overlap between the raster 
and target data, the better the alignment results since the points with which to georeference the 
raster will be spaced more widely.    

Transforming the raster 

Once you finished generating links, you can start warping the raster by using a mathematical 
transformation for the determination of the correct map coordinate location for each cell in the 
raster. By using an affine transformation warping will include three mathematical calculations: 
the shifting, scaling, and rotating of your raster. Generally, squares and rectangles on the raster 
will be changed into parallelograms of arbitrary scaling and angle orientation as straight lines on 
the raster are kept as straight lines in the warped raster. 

At least three links are needed to exactly map each raster point to the target location. Using 
more than three links just leads to errors, or residuals, spread throughout all the links. Even 
though the mathematical error may increase, you should add more than three links to degrease 
the impact of a possibly positional wrong link on the transformation. Thus the overall accuracy 
of the transformation will increase as well.  

Interpreting the root mean square error 

The comparison of the actual location of the map coordinate to the transformed position in the 
raster lets you determine the degree of accuracy to which the transformation can map all 
control points. While comparing these two points the distance will be measured known as the 
residual error. To describe the consistency of the transformation between the different control 
points the total error has to be computed by taking the root mean square (RMS) sum of all the 
residuals to compute the RMS error. 

Using a georeferenced tiff 

Anyway, in practice you will mostly use an already georeferenced tiff where you don't have to 
georeference it by yourself. Information is stored with the tiff and while importing the raster it 
moves already to the right position. 
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About rasters 

Whereas vector data represents geographic features using lines, points, and polygons; rasters 
represent them by arranging the real world into discrete squares called cells. Shapefiles are 
typical vector data, images and grids typical rasters.  

What do rasters represent? 

A raster can represent: 

• Thematic data such as land use, temperature, and elevation 
• Pictures such as scanned maps and building photographs 

Raster bands 

Since there are some rasters having a single band of data and others having multiple bands you 
can choose  to display either a single band, or form a color composite from three bands when 
generating a layer from a raster.  
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Changing the default RGB band combination 

About changing the RGB band combination  

Adding a single-band raster dataset displays the value of each cell as a color or a shade of gray, 
depending on the data. Adding a multiband raster dataset combines three of its bands to create 
a composite image, where each band provides either the red, green, or blue display value. From 
the Raster tab in the Options dialog box, you can modify the settings of the band combination. 

How to change the RGB band combination 

1. Click Options in the Tools menu. 
2. Click the Raster tab. 
3. Type the different numbers of the bands to choose which band will supply which display 

value for raster datasets.  
4. You have to repeat step 3 three times if your dataset consists of three bands, four times if 

there are four bands and so on... 
5. Click OK. 
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Creating raster pyramids 

About raster pyramids  

The amount of detail you see when drawing a raster depends on its cell size. If each cell covers 
a very small area so that details are maintained, then more cells are required to cover the same 
region; more detailed rasters will occupy more space on disk and take longer to draw. To speed 
up display of large rasters, you can create pyramids in which the original data has several levels 
of resolution. Without pyramids, the entire raster dataset must be queried to determine the 
subset of cells that need to be displayed. 

How to create raster pyramids 

Building pyramids in Data Manager 

1. Right-click the raster dataset in the Catalog tree. 
2. Click Build Pyramids. 

Tip 

• Pyramids are created for the whole dataset, including all bands, when 
you choose to build them. 

• To check if pyramids are present, right-click the raster and click 
Properties, then click the General tab. 

Changing the default settings for building pyramids 

1. Click the Tools menu and click Options. 
2. Click the Raster tab. 
3. Click the appropriate choice describing when pyramid layers should be created. 
4. Click OK. 

Tip 

• Pyramids are created for the whole dataset, including all bands, when 
you choose to build them. 
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Displaying rasters 

About displaying rasters  

Displaying rasters is dependant on the type of data a raster consists of and your decision of 
what you choose to show about a raster. If a raster contains a pre-defined color scheme, it will 
automatically be drawn by using the scheme. If there is no pre-definition included you can 
choose one of the appropriate display methods provided by LEICA Zeno Office and adjust this 
method to suit your needs. 

 

Raster resolution 

The ratio of screen pixels to dataset pixels at the current map scale is defined as the raster 
resolution. To determine how close you are to the maximum resolution of the raster it is 
possible to show the raster resolution. Having displayed a ratio of 1:1 tells you that the best 
display is already reached, because every screen pixel is displaying exactly one raster cell. The 
smaller the ratio gets the more raster cells have to be displayed by every screen pixel - 1:20 
means 20 raster cells by 1 screen pixel-, and the less details will be seen in the raster layer. On 
the opposite, the higher the ratio gets the more of a portion of a raster cell is displayed by every 
screen pixel. 

 

How to display rasters 

Drawing thematic rasters that represent unique categories 
such as land use 

1. Right-click the raster layer to represent unique categories in the table of contents and click 
Properties. 

2. On the Symbology tab click Unique Values. 
3. Click the Value Field dropdown arrow to choose the relevant field to map by clicking it. 
4. Click the Color Scheme dropdown arrow to select a color scheme. If the raster you are 

using has a color map, click Default Colors to reset the raster display to the colors 
specified in the color map. 

5. You may want to change the label. Click a label and type in a more meaningful name. 
6. Click OK. 

Tip 

• Through the Effects toolbar it is possible to alter the overall brightness 
and contrast of a raster .  

Drawing thematic rasters that represent continuous data 
such as elevation 

1. In the table of contents, right-click the desired raster layer to be drawn by grouping values 
into classes and click Properties. 

2. On the Symbology tab click Classified. 
3. Click the Value dropdown arrow to select the relevant field to map. 
4. If you want to normalize your data, click the Normalization dropdown arrow and click a 

field. 
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5. Click the Classes dropdown arrow to choose the number of classes as desired by clicking 
it. 

6. Click Classify to select the classification method to make use of. 
7. Click the Color Ramp dropdown arrow to choose a color ramp by clicking it. 
8. Click OK. 

Tip 

• Through the Effects toolbar it is possible to alter the overall brightness 
and contrast of a raster .  

Displaying the raster resolution in the table of contents 

1. Right-click the layer in the table of contents and click Properties. 
2. On the Display tab check "Display raster resolution in the table of contents". 
3. Click OK. 

Tip 

• Through the Effects toolbar it is possible to alter the overall brightness 
and contrast of a raster .  
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Georeferencing a raster 

About georeferencing rasters  

Georeferencing a raster consists of the general steps of: 

1. Add the raster to your map. 
2. Add control points to link known raster positions to known target data positions in map 

coordinates. 
3. Save the georeferencing information with the raster when the registration is acceptable. 

The georeferencing information of a raster is most of the time stored in a separate file with the 
same name as the raster but with an .aux file extension.  

How to georeference a raster 

Georeferencing a raster 

1. First, add the layers stored in map coordinates (target data) and the desired raster to 
georeference. 

2. Right-click a target layer in the table of contents and click Zoom to Layer. 
3. From the Georeferencing toolbar, click the Layer dropdown arrow to select the relevant 

raster layer. 
4. Click Georeferencing and click Fit to Display to display the raster in the same area as the 

target layers. Alternatively, the Shift and Rotate tools can be used to move the raster as 
desired. 

5. To add control points, click on the Add Control Points button. 
6. To add a link, point over a known location on the raster, click the mouse, and then point 

over a known location on the target data. Click. Optional, to have a better view of the 
data, make use of a Magnification window. 

7. Add enough links for the transformation order - at least three links are required for a first-
order transformation, six links for a second order, and 10 links for a third order. 

8. To evaluate the transformation, click View Link Table. It is possible to check the residual 
error for each link and the RMS error. Once the registration is acceptable, stop entering 
links. 

9. Click Georeferencing.  
10. To save the transformation information with the raster, click Update Georeferencing.  

Tips 

• Right-click the Tools menu, point to Toolbars, and click Georeferencing to 
get the Georeferencing toolbar displayed. 

• If you want to delete a link, just go to the Link Table dialog box. 
• To remove a link while you're in the process of creating it, press Esc. 

Entering explicit x,y map coordinates 

1. Click the Control Points button and add links. 
2. On the Georeferencing toolbar, click View Link Table. 
3. Click a map coordinate and type in a new value. 

Tips 

• Right-click the Tools menu, point to Toolbars, and click Georeferencing to 
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get the Georeferencing toolbar displayed. 
• If you want to delete a link, just go to the Link Table dialog box. 
• To remove a link while you're in the process of creating it, press Esc.  
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Improving raster display 

About improving raster display  

Improving raster display basically means to enhance the display using additional tools provided 
by LEICA Zeno Office. It is possible to modify the brightness and contrast of your raster for 
example, or you can render the raster display transparent over other layers. 

How to improve raster display 

Improving the brightness or contrast of your raster layer 

1. In the View menu, point to Toolbars, and then click the Effects toolbar. 
2. Click the dropdown arrow to select the relevant raster layer of which to change the 

brightness or contrast. 

3. Click on Brightness   or Contrast . 
4. By dragging the slider bar, you can adjust the brightness and contrast. 

Drawing a raster layer transparently 

1. In the View menu, point to Toolbars, and then click Effects. 
2. Click the dropdown arrow to select the relevant raster layer. 

3. Click on Adjust Transparency . 
4. Drag the slider bar to increase and degrease the transparency. 

Stretching a raster to improve the visual contrast 

1. In the table of contents, right-click the relevant raster layer of which to improve the visual 
contrast and click Properties. 

2. On the Symbology tab click Stretched. 
3. Click the Color Ramp dropdown arrow to select a color ramp. 
4. Click the Stretch Type dropdown arrow and choose a stretch by clicking it. 
5. To change the stretch settings you can click Histogram. 
6. Type in labels describing the attributes. 
7. If the raster also consists of a background or border around the data that you want to 

hide, you have set the background to no color. Do so by first checking the Display 
Background Value, then typing the value of the background, and finally setting the color to 
No Color. After you've finished, the cells will be shown transparently. 

8. Click OK. 
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Removing the background area of a raster layer 

About removing the background area of a raster layer 

There are several ways to remove or hide the background area of a raster layer. The ways differ 
with the renderer used to display a raster layer. 

How to remove a background area of a raster layer 

Removing the background area of a raster layer using the 
RGB Composite or Stretched renderers 

1. Right-click the relevant raster layer to hide the background in the table of contents and 
click Properties. 

2. On the Symbology tab select one of the two renderer, either the RGB Composite or 
Stretched renderer. 

3. Check Display Background Value and type in the value of the background. 
4. To display the background cells transparently, set the color to No Color. 

Tips 

• If you want to know the value of the background cells, use the Identify 

tool  from the Tools toolbar and click on the relevant background 
cells in the raster layer. 

Removing the background area of a raster layer using the 
Unique Values renderer 

1. Right-click the relevant raster layer in the table of contents and click Properties. 
2. On the Symbology tab click Unique Values from the Show list. 
3. Select the symbol that represents background (usually with a value of zero). 
4. Click Remove Values. 
5. Once you've clicked Apply the value of the background cells will be removed.  
6. To display them again, click Add All Values. 

Removing the background area of a raster layer using the 
Classified renderer 

1. Right-click the raster layer in the table of contents and click Properties. 
2. On the Symbology tab click Classified from the Show list. 
3. First, click  the Classify button and then the Exclusion button in the Classification dialog. 
4. On the Values tab type the desired background value to be removed from the classification 

in the Excluded Values text box. These values will not be displayed anymore. 
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Setting the default band for a raster 

About previewing rasters  

When you preview a single-band raster dataset, the value of each cell is drawn as a color or a 
shade of gray depending on the data. When you preview a multi-band raster dataset, three of 
its bands are combined to form a composite image, where each band supplies either the red, 
green, or blue display value. 

How to change a raster's previewing properties 

1. Click the Tools menu and click Options. 
2. Click the Raster tab. 
3. Type the number of the band that will provide the red display value for raster datasets 

with three bands. 

Type the number of the band that will provide the green values. Type the number of the 
band that will provide the blue values. 

4. Repeat step 3 for raster datasets with four or more bands. 
5. Click OK. 
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Supported raster formats 

The following table gives a description of the supported raster formats and their extensions. 

Format Description Extension(s) 

Arc Digitized Raster 
Graphics (ADRG) 

Distributed on CD–ROM by US NIMA. ADRG 
is geographically referenced using the 
equal arc-second raster chart/map (ARC) 
system in which the globe is divided into 18 
latitudinal bands or zones. The data 
consists of raster images and other 
graphics generated by scanning source 
documents. 

Multiple files:  

Data file—extension 
*.img or *.ovr 

Legend file—extension 
*.lgg 

Band Interleaved by 
Line (ESRI BIL), Band 
Interleaved by Pixel 
(ESRI BIP), Band 
SeQuential (ESRI 
BSQ) 

This format provides a method for reading 
in and displaying uncompressed, BIL, BIP, 
and BSQ image data. By creating an ASCII 
description file that describes the layout of 
the image data, black-and-white, 
grayscale, pseudocolor, and multiband 
image data can be displayed without 
translation into a proprietary format. 

Multiple files:  

Data file—extension 
*.bil, *.bip, or *.bsq 

Header file—extension 
*.hdr 

Colormap file—
extension *.clr 

Statistics file—
extension *.stx 

Bitmap (BMP), 
Device-Independent 
Bitmap format (DIB), 
or Microsoft Windows 
Bitmap 

BMP files are Windows bitmap images. 
They are usually used to store pictures or 
clip art that can be moved between 
different applications on Windows 
platforms. 

Single file—extension 
*.bmp 

Compressed ARC 
Digitized Raster 
Graphics (CADRG) 

Distributed on CD–ROM by US NIMA. 
CADRG is geographically referenced using 
the equal arc-second raster chart/map 
(ARC) system in which the globe is divided 
into 18 latitudinal bands or zones. The data 
consists of raster images and other 
graphics generated by scanning source 
documents. CADRG achieves a nominal 
compression ratio of 55:1. 

Single file—no 
standard file 
extension 

Controlled Image 
Base (CIB) 

Panchromatic (grayscale) images which 
have been georeferenced and corrected for 
distortion due to topographic relief 
distributed by US NIMA. Thus, they are 
similar to digital orthophoto quads, and 
have similar applications—such as serving 
as a base or backdrop for other data, or as 
a simple map. 

Single file—no 
standard file 
extension 

Digital Terrain 
Elevation Data (DTED 

Created by the National Imagery and 
Mapping Agency (formerly the Defence 

Single file—various 
file extensions. The 
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Level 1 & 2) Mapping Agency—DMA). default is .dt1 

ER Mapper A proprietary raster format from ER 
Mapper. Produced using the ER Mapper 
image processing software. 

Multiple files:  

Header file—extension 
*.ers 

Data file—usually 
same as header file 
without the *.ers 
extension, but could 
be any and is defined 
in the header file. 

Graphics Interchange 
Format (gif) 

A proprietary image format that is highly 
compressed and requires an LZW license 
from UNISYS. Allows high-quality, high-
resolution graphics to be displayed on a 
variety of graphics hardware and is 
intended as an exchange and display 
mechanism for graphics images. 

Single file—extension 
*.gif 

ERDAS 7.5 GIS Single-band thematic images produced by 
the ERDAS 7.5 image processing software. 

Multiple files:  

Data file—extension 
*.gis 

Colormap file - 
extension *.trl 

ESRI GRID file format 
(ESRI GRID) 

A proprietary ESRI format that supports 
32-bit integer and 32-bit floating-point 
raster grids. Grids are useful for 
representing geographic phenomena that 
vary continuously over space and for 
performing spatial modeling and analysis of 
flows, trends, and surfaces such as 
hydrology. 

Directory 

Colormap file—
extension *.clr 

ESRI GRID Stack Used to reference multiple ESRI GRIDs as a 
multi-band raster data set. A stack is 
stored in a directory structure similar to a 
grid or coverage. 

Directory 

ESRI GRID Stack file Used to reference multiple ESRI GRIDs as a 
multi-band raster data set. A stack file is a 
simple text file that stores the path and 
name of each ESRI GRID contained within 
it on a separate line. 

Single file, possible 
file extension—*.stk 

ERDAS IMAGINE file Produced using the IMAGINE image 
processing software created by ERDAS. 
IMAGINE files can store both continuous 
and discrete, single-band and multi-band 
data. 

Single file—extension 
*.img 

JPEG File Interchange 
Format (JFIF) 

A standard compression technique for 
storing full color and grayscale images. 
Support for JPEG compression is provided 

Single file, possible 
file extensions of 
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through the JFIF file format. *.jpg, *.jpeg, *.jfif 

ERDAS 7.5 LAN Single or multi-band continuous images 
produced by the ERDAS 7.5 image 
processing software. 

Multiple files:  

Data file—extension 
*.lan 

Colormap file - 
extension *.trl 

Multiresolution 
Seamless Image 
Database (MrSID) 

A compression technique especially for 
maintaining the quality of large images. 
Allows for a high compression ratio and fast 
access to large amounts of data at any 
scale. 

Single file—extension 
*.sid 

Spatial Database 
Engine Raster file 
format (ArcSDE 
Raster) 

Raster data stored within the ArcSDE 
database. 

Stored in SDE 
database 

Tag Image File 
Format (GeoTIFF tags 
are supported) (TIFF) 

Widespread use in the desktop publishing 
world. It serves as an interface to several 
scanners and graphic arts packages. TIFF 
supports black-and-white, grayscale, 
pseudocolor, and true color images, all of 
which can be stored in a compressed or 
uncompressed format. 

Single file, possible 
file extensions *.tif, 
*.tiff, *.tff 

ERDAS Raw Provides a method for reading in and 
displaying files which are not otherwise 
supported by another format, but which are 
formatted in such a way that the 
arrangement of the data may be described 
by a relatively small number of parameters. 
By creating an ASCII description file that 
describes the layout of the raster data it 
can be displayed without translation into a 
proprietary format. The format is defined in 
the ERDAS IMAGE software. 

Single file—extension 
*.raw 

Portable Network 
Graphics (PNG) 

Provides a portable, legally unencumbered, 
well-compressed, well-specified standard 
for lossless bitmapped raster files. It is 
meant as a replacement for gif and 
supports a large range of bit depths, from 
monochrome all the way to 64-bit color. Its 
features include: indexed-color images of 
up to 256 colors, effective, 100% lossless 
images of up to 16 bits per pixel. 

Single file—extension 
*.png 

National Image 
Transfer Format 
(NITF) 

Developed by NIMA as a standardized 
format for images and supporting data. It 
has become the standard for digital 
imagery and imagery-related products for 
the United States intelligence community, 
and other departments and agencies of the 
U.S. government, and is now being 

Single file—extension 
*.ntf 

412 



Raster Data 

adopted as a standard by civilian 
organizations (ISO/ANSI) and governments 
outside of the U.S. (e.g., NATO). 
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Split Tool 

About Split Tool  

The split tool allows you to split polygon features. The split line can be defined 

• As line through one vertex of the source polygon resulting a defined area or proportion 
of the resulting areas 

• As a parallel line to a reference line resulting a defined area or proportion of the 
resulting areas 

• As a parallel line to a reference line with a defined offset 

How to work with the Split Tool 

Split line through one vertex of the polygon 

1. Select the polygon feature to split using . 
2. Make sure that the snapping environment is set correctly. 

3. Start the split tool . 
4. Select the polygon vertex, which is the start point of the split line. 
5. Enter the size of the split area or the proportion between the two resulting areas and press 

Compute. The accuracy value defines the end of the iteration process. 
 

 
6. Click next. 
7. Select the desired solution, which is also shown in the map. 
8. Copy, delete or enter the attributes for the resulting areas and press Finish. The area will 

be splitted and survey points will be created on the new feature vertices. 
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Split line parallel to a reference line 

1. Select the polygon feature to split using . 
2. Make sure that the snapping environment is set correctly. 

3. Start the split tool . 
4. Define the reference line by clicking an existing line or two points. The split line will be 

parallel to this reference line. 
5. Enter the size of the split area or the proportion between the two resulting areas and press 

Compute. The accuracy value defines the end of the iteration process. The offset of the 
resulting split lines to the reference line will be shown. 
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6. Click next. 
7. Select the desired solution, which is also shown in the map. 
8. Copy, delete or enter the attributes for the resulting areas and press Finish. The area will 

be splitted and survey points will be created on the new feature vertices. 
 

 

Split line parallel to a reference line and defined offset 

1. Select the polygon feature to split using . 
2. Make sure that the snapping environment is set correctly. 

3. Start the split tool . 
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4. Define the reference line by clicking an existing line or two points. The split line will be 
parallel to this reference line. 

5. Enter the offset of the split line to the reference line and press Compute. The resulting 
areas and proportion will be shown. 
Note: The offset depends on the direction of the selected line. Please use a "-" sign to 
change the side of the split line. 
 

 
6. Click next. 
7. Select the desired solution, which is also shown in the map. 
8. Copy, delete or enter the attributes for the resulting areas and press Finish. The area will 

be splitted and survey points will be created on the new feature vertices. 
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Move Vertices to Reference Line Tool 

About Move Vertices to Reference Line Tool  

This tool allows you to move measured vertices to a selected reference line in order to correct 
poor accuracy of measured points or to force vertices to a straight line. 

How to work with the Move Vertices to Reference Line Tool 

1. Select the Move Vertices to Reference Line Tool . 
2. Right-click and select Vertices to start with the selection of the vertices to be moved. 
3. Right-click and select Reference Line to start with the selection or definition (two points) of 

the reference line. 
 

 

4. If necessary, change your settings by clearing the selections. 
 

 
5. Click Update Features. 
6. If needed, define an offset to the reference line. 

 

 
7. Check the results and click Ok to finish. 
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Copy Feature Tool 

About Copy Feature Tool  

The Copy Feature Tool allows you to copy or move selected features from one layer to another 
layer in order to change the type of this feature (or to re-code it). 

E.g. you measured an object as road edge but it is also the edge of a parcel. It is also possible 
to change the meaning (coding) of features: To do so, simply move the feature to the desired 
layer by deleting the original ones. 

The type of the feature has to fit the type of the target layer. For example, it is not possible to 
copy or move a point feature to a polyline or polygon layer. Copying or moving a polyline 
feature to a polygon layer results in an closed polygon. A polygon copied or moved to a polyline 
layer results in its outline. 

How to work with the Copy Feature Tool 

1. Select the features to copy/move with . 

2. Click the Copy Feature Tool . 
3. Select the target layer. 
4. Check 'Delete Original Feature' to move, uncheck it to copy the features. 

 

 
5. Ok to finish. 
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Examine Tool 

About Examine Tool  

The examine tool allows you to query or calculate useful information from one or between two 
points: 

• Coordinates - Coordinates and height of one point 
• Coordinate differences - Coordinate and height difference between two points 
• Vertical Angle - V angle and gradient between two points 
• Horizontal Angle - Hz angle between two lines (defined by three points) 
• Offset - Station and offset of one point to a reference line (defined by two points) 
• Distance and Height - Horizontal and slope distance and height difference between two 

points 
• Segment Information - Line length 

How to work with the Examine Tool 

1. Set the snapping environment to the desired features. 

2. Click the examine tool . 
3. Select the desired query. 
4. Select the required object(s). 
5. See the result of the query in the status bar at the bottom of the screen. 
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